
Welcome to NetObjects Fusion
NetObjects Fusion™ 3.0 is the essential tool for building dynamic Web sites. You can use NetObjects 
Fusion to create and maintain an entire site whether or not you know HTML. NetObjects Fusion’s 
Everywhere HTML™ eliminates the problems and confusion caused by browser differences. Because 
NetObjects Fusion generates HTML pages based on page layout and publish settings you control, you 
can build your site once and publish it everywhere.

In NetObjects Fusion’s open site environment you can work the way you want to. You can design pages 
using NetObjects Fusion’s position-based editor, its text-based editor, an external HTML editor, or a 
combination of all three. Powerful message-based animation and interactive authoring features included 
in NetObjects Fusion make it easy for you to create sophisticated effects. You’ll also find it easy to add 
scripts, Java™ applets and servlets, Shockwave™ Flash, Headspace® RMF, ActiveX™ controls, and 
more.



About the Manuals and Help System
This help system explains how to build a Web site using NetObjects Fusion. In addition to the basics of 
designing with text and graphics, creating links, and so on, you’ll find sections that elaborate on special 
topics, including data publishing and using Net Objects Fusion components (pre-built mini-applications 
that add functionality to your site).

Before you begin your projects, refer to the NetObjects Fusion 3.0 Installation and Quick Start card and 
work through the lessons in NetObjects Fusion 3.0 Getting Started. This is the most efficient way to learn 
NetObjects Fusion. If you are already familiar with an earlier version of NetObjects Fusion, read Chapter 
11, “Upgrading From a Previous Version of NetObjects Fusion,” in NetObjects Fusion 3.0 Getting Started.

The manuals and online help assume you are proficient with Windows® 95 or Windows NT™. If you need
help using these systems, consult their respective user guides.

The manuals and help system also assume you are familiar with the World Wide Web and its terminology.
For general advice about the web and examples of how to use NetObjects Fusion, visit the NetObjects™ 
Web site, www.netobjects.com.

For readability, this help system presents all file names, path names, file extensions, HTML tags, and 
URLs in boldface. Example names that you should replace with your own appear in bold italic.



Getting Online Help
l Select Help Topics from the Help menu to launch the help system and display the table of contents.

l Right-click an object in any NetObjects Fusion window or a control in a dialog or palette, then select 
What’s This? from the shortcut menu.

l Click the question mark icon in the title bar of a dialog or palette, then click the item you want to learn 
about.

l Highlight a menu command, then press F1.

l Select NetObjects Web Site from the Help menu to open your browser and display the NetObjects 
Home page, which contains links to information about NetObjects Fusion. You must be connected to 
the Internet for this to work.

This Help system is arranged by subject.

l Double-click a book in the Help Contents to display all topics in the subject.

l To read all topics within a subject, display the subject's first topic, then click the Browse Forward button 
>> until the sequence ends.



NetObjects Fusion Basics
NetObjects Fusion 3.0 incorporates new technologies with the current browser environment to help you 
meet today’s site building challenges. Using NetObjects Fusion you’ll find it easy to build dynamic, 
content-rich sites that use the latest interactive technologies, including CSS Positioning and Dynamic 
HTML. And you don’t need to build multiple versions of your site; you can depend on NetObjects Fusion’s 
Everywhere HTML to generate HTML that works on all browsers.



Introducing NetObjects Fusion 3.0
NetObjects Fusion is a fully integrated, visual Web site builder. It provides an open environment that lets 
you work in your own way with a variety of tools. Using NetObjects Fusion you can design and publish 
visually enticing, dynamic content using the latest interactive technologies.



Work in an Open Environment
NetObjects Fusion provides an open site-building environment. You can use a variety of other tools for 
specialized purposes and then return to NetObjects Fusion to integrate the content into one cohesive site.
Think of NetObjects Fusion as the control center where you create and manage all of the site’s resources.

Depending on your preference, you can lay out pages in graphical mode, text mode, or using an HTML 
editor. In graphical mode, you can place objects anywhere on the page and see exactly how they will look
when you publish the site. In text mode, you can work on a page as if you were working in a word 
processor. You draw a text box and then use it to contain graphics, Java applets and servlets, 
components, and other objects, as well as text. This design method keeps your HTML code lean. For 
more information about graphical and text layout options, see Laying Out the Page.

If you want more control over HTML, you can use your favorite HTML editor for all or part of a page, for as
many pages as you want. For more information, see Referencing and Editing External HTML.



Generate HTML That Works Everywhere
A major challenge when building sites today is overcoming browser disparity problems. If you use the 
wrong site-building tool, you can waste time and energy building and maintaining several versions of a 
site, each one targeting a different browser. When you use NetObjects Fusion 3.0 these problems 
disappear. You can depend on the NetObjects Fusion 3.0 HTML generation capability to provide 
Everywhere HTML. Whether you’re designing for a 2.0 browser or for the latest DHTML-capable browser, 
NetObjects Fusion 3.0 generates HTML that works. For information about the publishing options available
in NetObjects Fusion 3.0, see Planning Your Site.



Add Dynamic Content
NetObjects Fusion 3.0 makes it easy for you to add dynamic content to your site whether you want simple
object animation or custom JavaScript™ actions.

You can have objects fly across the screen as the result of a site visitor’s action. Or you can launch a 
sequence of animations at any given time. You can also reduce your visitors’ download time by having 
text, graphics, or other objects appear as needed.

NetObjects Fusion 3.0 contains powerful message-based animation and interactive authoring capabilities 
that you can use to achieve these effects. For complete information, see Building Dynamic Pages.



NetObjects Fusion Views
NetObjects Fusion provides five views that correspond to the tasks you complete when you design and 
build a Web site. Changes you make in one view are reflected in the other views. You can go to any view 
at any time by clicking one of the view buttons on the control bar at the top of the NetObjects Fusion 
window.

Start with Site view to create the hierarchical structure of a new site or to import
an existing site. You can see a structure map of your site, which is a graphical 
view that shows how the pages relate to each other, or an outline view that is 
similar to the Windows Explorer. You can quickly rearrange your site by 
dragging and dropping pages and sections. For complete information about 
working in Site view, see Creating and Managing Sites.

Use Page view to design pages and add content. In Page view you see the 
MasterBorder and Layout area of each page. The MasterBorder contains 
objects that repeat on a set of pages, much as headers and footers appear in a
word processing document. The Layout area displays objects that are unique to
that page.

In Page view you can use the Undo command on the Edit menu repeatedly to 
step back through a series of changes.

Note: If you try to use Undo and nothing happens, click in the Layout 
area or MasterBorder and then select Undo again.

For information about working in Page view, see Page View Basics.

A SiteStyle consists of a variety of elements, including navigation buttons, 
banners, lines, and text color. In Style view, you can create your own SiteStyle, 
or choose from more than 50 pre-built SiteStyles™ to give your entire site a 
consistent look and feel. For information about working with SiteStyles, see 
Using SiteStyles.

Assets include the files, links, data objects, and variables that you reference in 
your site. Assets view gives you centralized control over all these referenced 
entities. When you change an asset, NetObjects Fusion updates every 
reference to that asset throughout the site. For example, if your company’s logo
changes, you just replace the old logo file with the new one in Assets view and 
NetObjects Fusion automatically updates every page that displays the logo. For
information about working in Assets view, see Managing Assets.

When you are ready to publish the completed site, go to Publish view to 
configure your file transfer settings, generate the HTML for your site, and 
transfer your site to a local or remote server. For information about working in 
Publish view, see Publishing Your Site.

Using the New Button
To create a new page in Site or Page view, click the New button on the control 
bar. In Style view, you use this button to create a new SiteStyle; in Assets view, 
to create a new file, link, data object, or variable; and in Publish view to create 
a new folder.

NetObjects Fusion Window
When you start NetObjects Fusion and create a new site, you see a window containing a Home page 
icon, a Standard toolbar docked at the left side of the screen, and a properties palette.



The title bar, menu bar, and control bar are at the top of the application window. The title bar shows the 
name of the current site.



About the Properties Palette
When you click an object in Site or Page view, the properties palette changes to display the properties 
available for that object. Properties appear on tabs that also might change when the selected object 
changes. For example, when you select a text box in Page view, the Text Properties palette includes Text 
Box and Actions tabs. When you double-click in the text box to edit the text, the Format tab is added to 
the display.

You might not always be aware of making a selection, but in NetObjects Fusion, something is always 
selected. For example, when you switch from Site view to Page view, the Layout Properties palette 
appears. You might not immediately see evidence that the Layout is selected, but it is indicated on the 
properties palette. To check what is selected at any time, look at the properties palette.

To shrink the properties palette to display just its title bar, click the minimize button; click the button again 
to restore the full display. To completely hide the properties palette, click its close box. To show the palette
again, from the View menu, select Palettes, Properties Palette. A check mark on the menu indicates the 
palette is displayed.



About Toolbars
When you first open NetObjects Fusion, the Standard toolbar is docked at the left side of the Site view 
window. Additional toolbars are available in Page view.

You can move a toolbar by positioning the pointer over the double line at its top and dragging it anywhere 
in the window. To dock the toolbar again, double-click its title bar or drag it to the left side or top of the 
window.

A small triangle in the lower right corner of a tool button indicates the tool is one of a group. To see the 
entire group, point to the tool and hold down the left mouse button. A flyout containing the other tools in 
the group appears. As you move the pointer over each tool, a ToolTip identifies the tool group and the 
name of the specific tool.

To select a tool from a flyout, position the pointer over the tool and release the mouse button. The tool you
select is displayed on the toolbar. For example, if you point to the Draw tool on the Page view Standard 
toolbar and hold down the left mouse button, you can select the Rectangle, Rounded Rectangle, Ellipse, 
or Polygon tool.

In Page view, after you use a selected tool to create an object on the page, the Select tool automatically 
becomes active. If you want to use a tool repeatedly to add several objects, you can double-click it to 
keep it active.

To hide and show toolbars, from the View menu choose Toolbars, Name of toolbar. A check mark on the 
menu indicates a toolbar is displayed.



Previewing Your Site
As you build your site, to see how it will appear in the browser of your choice, 
click the Preview button on the control bar.

NetObjects Fusion generates HTML from your pages and displays your site in the browser specified in 
the Preferences dialog. In the Preferences dialog you can also choose to preview the whole site or just 
the page you are working on. For information, see Setting Preferences.

Although previewing creates folders and files on your disk, they do not comprise a working site. Certain 
information critical to a published site—for example, relative paths to assets—are not included in preview 
files. By not including this information, previewing displays your site quickly. When you’re satisfied with 
your preview, go on to publish your site as described in Publishing Your Site.



Navigating in NetObjects Fusion
NetObjects Fusion offers several navigation tools, including the Go menu and buttons on the control bar.

You use the buttons on the left side of the control bar to move between views. For an introduction to the 
NetObjects Fusion views, see NetObjects Fusion Views.



Finding an Object
Use the Go To button on the control bar to find any named object in NetObjects
Fusion. Click the Go To button, enter the name, or partial name, of the object 
you want to locate in the Go To dialog, and click OK. 

If only one object meets your criteria, NetObjects Fusion opens the appropriate view or dialog to display 
the object. If several objects meet your criteria, NetObjects Fusion displays a list you can pick from.



Switching Between Views
To return to the previous view, click the Last button on the control bar. Click the 
button again to redisplay the current page or view. Use this button to quickly 
switch back and forth between the current and last view or page.

Using the Go Menu
The Go menu provides all the navigation features in one place and shows equivalent keyboard shortcuts. 
A dot to the left of a command indicates your current view.

The Go menu commands vary slightly from view to view.

l From all views you can go to any other view. From Site view and Assets view you can also navigate to 
the subviews; from Page view you can go to other pages.

l Use the Go To command the same way you use the Go to button on the control bar to find any named 
NetObjects Fusion object in your site.

l Use the Last command to go to the last page or view you were working on.

l Use the Recent command to select from a list of the views and pages you displayed during the current 
NetObjects Fusion session.

l Use the Preview command to launch your browser and display a preview of your site.



Using Shortcut Menus
NetObjects Fusion provides shortcut menus you open by right-clicking an item in Site, Page, and Publish 
views. The menu lists commands you can use on the item you clicked. In all views, and in dialogs and 
properties palettes, you can right-click an item and select What’s This? from the menu to display context-
sensitive help for the item.



Page View Object Icons
These icons appear in Page view when Object Icons is selected in the View menu.

Link icon; object has an associated link. Does not appear on text links.
Anchor icon; the object has an anchor point to which you can link.
Script icon; the object has an associated HTML script.
HTML tag icon; the text has an HTML tag inserted at this point.
Warning icon; indicates an error condition, such as an overlapping object. 
Embedded object icon; indicates an object's insertion point.
Action icon; indicates an action is associated with the object.



Choosing Colors

In NetObjects Fusion, whenever the properties palette includes a Color button, you can change the color 
of the selected object. For example, you can change the color of the page icons or the background in Site
view, objects in Page view, or link text color in Style view.

To choose a color for a selected object:

1. Click the Color button in any properties palette where it is offered or double-click a text style 
element in Style view.

The Color Picker appears.

The name of the current palette is shown above the color display. The last eight colors you 
selected from the palette are displayed in the Recent Colors boxes.

2. Click the color you want to assign to the object.

The Original and New boxes show the original color and the color you just selected. The RGB 
and HTML hexadecimal values are also displayed.

If you are not using the Browser Safe Palette, you might see a warning that the selected color is 
not Web safe. To avoid unexpected results for your site visitors, it is best to choose colors that are
Web safe.

3. Click OK.

The new color appears in the selected object.



Using Color Palettes
When you choose colors for the objects in your site, you select from the palette offered in the Color 
Picker. You can use the Browser Safe Palette, which contains colors that are Web safe, the palette used 
by Windows, a palette you import from another application such as Adobe Photoshop, or a custom palette
you create.



Choosing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2. Select a palette from the drop-down list at the top of the dialog. If you choose Custom Palette and
want to load an existing custom palette, see Loading a Custom Color Palette. If you want to 
create your own custom palette, see Creating or Editing a Color Palette.

The palette is displayed in the Color Picker until you change it.

3. Click OK.



Loading a Custom Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears with a blank palette.

2. Select Custom Palette from the drop-down list at the top of the dialog.

3. Click Load.

4. In the Open dialog, navigate to the palette you want to use, then click Open.

This palette is displayed in the Color Picker until you change it.

5. Click OK to close the Color Picker.



Creating or Editing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears with a blank palette.

2. Select Custom Palette from the drop-down list at the top of the dialog.

3. Click a blank box in the palette area.

4. Set the RGB values for the color you want to add to the palette or type the hexadecimal (HTML) 
value for the color.

5. Repeat step 4 for each color you want to add to the palette

6. Click Save.

7. In the Save As dialog, type a file name for the palette, and click Save.

The new palette is displayed in the Color Picker until you change it.

To reload this palette, follow the steps in Loading a Custom Color Palette.



Setting Preferences
You can change your preferences from any view at any time. Changes take place as soon as you click 
OK to close the Preferences dialog. General and Backup preferences apply throughout NetObjects 
Fusion and affect all sites; Page preferences affect the current site only and are saved with the site.

1. From the Edit menu, choose Preferences.

The Preferences dialog appears.

2. Set the preferences on the General tab.

l Auto Save. When this option is selected, your site is saved each time you change views 
or pages. If you clear the Auto Save check box, be sure to save your site periodically by 
choosing Save Site from the File menu.

l Application window maximized at startup. If you clear the check box for this option, 
the NetObjects Fusion window opens in the last size you set, rather than full screen size.

l Open to most recently used file at startup. If you select this option, when you start 
NetObjects Fusion, the last site you worked on opens automatically, displayed in the last 
view you worked in.

l Use Small Fonts in Properties Palette. If you clear this check box, you see larger 
properties palettes in Page view. To maximize the area available for your page Layout, 
leave this option selected.

l Preview. Choose the Web browser you want to use for previewing sites by selecting it 
from the Browser drop-down list.

If you have more than one version of a browser installed, when you select Preview, 
NetObjects Fusion launches the version that was most recently opened. To use other 
versions, you must launch them manually from the Windows Start menu. For example, 
suppose you have both Netscape Navigator™ 3.0 and 4.0 installed. You open 4.0 to 
check your stock portfolio, then close it and begin working on a site in NetObjects Fusion.
When you preview the site, NetObjects Fusion launches Navigator 4.0 because it was the
last version opened. To preview in Netscape Navigator 3.0, you must launch it manually. 
Once you open 3.0, NetObjects Fusion uses it for previews until you manually launch 
another version.

Also choose whether you want to preview only the Current Page or the Entire Site. 
Previewing the entire site takes longer, but you can move from page to page in the 
browser to test your site’s navigation buttons. Set the Current Page option to preview only
the current page or the current section of pages.

You can also use keyboard shortcuts to preview either the whole site or just the current 
page or section:
l If Entire Site is selected in Preferences, pressing Alt + P or clicking the Preview 

button previews the entire site; pressing Ctrl + Alt + P or clicking the Preview 
button while pressing Ctrl previews just the current page or section.

l If Current Page is selected in Preferences, pressing Alt + P or clicking the 
Preview button previews the current page or section; pressing Ctrl + Alt + P or 
clicking the Preview button while pressing Ctrl previews the entire site.

l WYSIWYG Optimization. Choose whether Page view should display text spacing as it 
will appear in Netscape Navigator or in Microsoft® Internet Explorer.

l HTML editor. Click Browse and find the file that launches your editor. When you want to 
edit the HTML of an External HTML object, double-click the External HTML’s X in Page 
view to launch the editor you specify here. For example, you can designate Allaire 



HomeSite™ 3.0 as your HTML editor if you installed it with NetObjects Fusion 3.0. See 
Working with HTML Directly.

3. To set Page preferences, click the Page tab.

l Browser Font Settings. Choose Proportional and Fixed Width font settings. To ensure 
your pages appear in your browser the way you design them in NetObjects Fusion, 
choose the same font settings in your browser. For example, if you use Times, size 12, 
and Courier, size 10, for your browser proportional and fixed width fonts, choose the 
same fonts and sizes in NetObjects Fusion. Note that the suggested settings are the 
defaults used by the browser when it was installed.

Be aware that NetObjects Fusion sizes text boxes based on the expected font size, so 
when you change sizes, you change the Layout of the page slightly.

l General. Choose the measurement unit you want to use as you build your site. Then 
specify a width and height in this unit of measurement for your default page and grid 
sizes. When you add a new page to your site, it will have this size. Changing this option 
does not change the size of existing pages in your site. However, if you change the Grid 
Size setting, it will change the size of the grid on both new and existing pages. For more 
information about page size, see Displaying a Page in Page View.

l Background Image (pixels). Most Web browsers add a margin at the top and left of the 
page; this margin can vary from 6 to 16 pixels. However, no margin is added for 
background images; a background image is aligned at the top and left edges of the page.
If you need to match a background pattern to objects on the page, use this setting to 
compensate for the shift of your content in the browser. Note that this option does not 
affect the generation of HTML in any way; it affects only the appearance of your page 
Layout in NetObjects Fusion.

The default settings (Offset selected, Left 10, Top 16) are optimized for Netscape 
Navigator 3.0 and Microsoft Internet Explorer 3.0 and 4.0 running on Windows. However, 
not all browsers on all platforms use the same margin. For example, Netscape Navigator 
4.0 for Windows and 3.0 for Macintosh use Offset selected, Left 8, Top 8. These settings 
also do not apply if you use frames; in that case the settings are always Left 2, Top 2. If 
you set the Background Image Offset, be sure to test your pages using the browsers you 
want to support.

4. To set Backup preferences, click the Backup tab.

l Automatic Backup. This option is selected by default. When you close NetObjects 
Fusion, the program automatically backs up your .nod file and saves it in the \backups 
subfolder under the User Sites\sitename folder. If you need to use one of these backup 
files, drag it from the \backups folder into the User Sites\sitename folder before you 
open it so the asset paths will be correct.

If you do not want NetObjects Fusion to automatically back up your sites, clear the check 
box.

l Backup Settings. NetObjects Fusion saves backup files in the User Sites\sitename 
folder by default. To change the location of the backup files, type a new path name in the 
Backup location field, or click Browse and select a new location

Select a backup file name convention from the drop-down list: you can choose a plain 
format or one that includes the date and time.

Indicate the number of backups you want NetObjects Fusion to keep. The oldest backups
are overwritten as newer backups are created.

l Compact database upon exit. This option is selected by default. Compacting the files 
can save you substantial hard disk space. In addition, when this option is selected, 
NetObjects Fusion performs an error-checking procedure to verify your database as it 
compacts the files. It is recommended that you do not change this setting. 



WARNING: Do not shut down Windows while the file is being compacted. This could cause 
your .nod file to become unstable.



Editing Objects and Assets
You can edit objects created in other software applications from within NetObjects Fusion. In Page view, 
you select the object on the page, and then from the Object menu, select Open Object. In Assets view, 
you select the Asset, and then from the Asset menu, select Open Asset. If the correct application does not
open, the file type of the object or asset is probably not associated with the correct application. 

For example, if you want to edit a .gif image, you select the picture in Page view and select Open Object 
from the Object menu. If Microsoft Internet Explorer opens rather than an image-editing application, you 
must change the application associated with .gif files.

To set the application associated with a specific file type in Windows:

1. Double-click the My Computer icon on your Windows Desktop.

2. From the View menu, select Options.

3. Click the File Types tab.

4. For every image file type in the list, click Edit and choose the appropriate Content Type.

5. Click OK to close the Options dialog and close the My Computer window.



NetObjects Fusion Folder Structure
The NetObjects Fusion 3.0 folder contains all the files you need to use NetObjects Fusion.

Do not move or rename the NetObjects Fusion 3.0 folder or any folders within it. NetObjects Fusion 
performs best when the application and its parts remain in the folder recommended during installation. 
This is especially true with the User Sites folder. Since NetObjects Fusion keeps track of assets and links,
folder names and locations are very important. If you change names and/or locations using Windows 
Explorer or File Manager, Net Objects Fusion might not be able to track assets and links properly. 

The subfolders organize files according to their use:

l Components contains the NetObjects Fusion Components, mini-applications that can add 
sophisticated functions to your site. See Using NetObjects Fusion Components.

l Samples contains design parts such as picture files and animated .gifs, as well as plug-in parts such 
as media files and Java applets that you can use to enhance your site design.

l NetObjects System contains files used by the program; do not delete or remove these files.

l Styles contains a separate folder for each SiteStyle, including the ones you create. NetObjects Fusion 
style files have an .ssf extension. See Using SiteStyles.

l Templates contains AutoSites™ and Page templates. A NetObjects Fusion Template file has an .nft 
extension and its own Assets folder. See Creating and Managing Sites.

l Tutorial contains the assets you need for the lessons in NetObjects Fusion Getting Started.

l User Sites contains all the sites you create. NetObjects Fusion automatically creates a new subfolder 
within User Sites to keep your projects organized. Each NetObjects Fusion site is saved with a .nod 
extension. The site folder also includes an Assets folder where all the assets used in the site are saved
and a Backups folder where backup .nod files are saved. You can also save sites in other locations.



Creating and Managing Sites
Site view is where you create, view, and maintain the architecture of your site. Site view frees you from 
the details of file and link management, so you can focus on organizing and updating your site. For 
example, you can drag a page or section to any location in Site view, and NetObjects Fusion updates the 
links to other pages automatically.



Starting NetObjects Fusion
When you install NetObjects Fusion, it is automatically added to the Windows 95 Start menu. 

To start NetObjects Fusion:

u From the Start menu, choose Programs, NetObjects Fusion.

Creating a blank site and opening an existing site are described in Creating and Opening Sites. Creating 
a new site based on a NetObjects Fusion AutoSite or template is described in Importing and Exporting.

The default option in the Welcome To NetObjects Fusion dialog is to open the last file you were working 
on. You can set preferences so NetObjects Fusion automatically opens your last file each time you start 
the program. See Setting Preferences.



Working with Site Files
A NetObjects Fusion site file is a database of information about your site. Site files have a .nod extension.

Site files are stored in a folder that has the same name you give the site. For example, if you name the 
site Apples + Oranges, the site’s folder is called Apples + Oranges, and the site file—Apples + 
Oranges.nod—is saved inside the folder. In addition, the site folder contains a folder with the site’s 
assets—embedded files, links, data objects, and variables—as well as a Backups folder.

By default your site folder is saved inside the User Sites folder, but you can store the site in any location 
on your computer. Because the paths to the assets in a site file are absolute—they include the drive and 
folder names—you cannot save the site file on another computer on a network. To do that, export the site 
as a template, as described in Importing and Exporting.



Creating and Opening Sites
When you create a site, you always work from a template, ranging from the most simple—the Blank Site 
template—to the professionally designed templates provided with NetObjects Fusion. You can even 
derive templates from your own sites.

A template is a fully designed page or site that you can use as a starting point for your own pages or sites.
A typical template might include a banner and navigation buttons, an assigned SiteStyle, and—in some 
cases—text or other content. You can start a new site from a template or insert one into your current site. 
Templates are described in detail in Importing and Exporting.

You can also open an existing site and add to it, change its style, or modify it.



Starting with a Blank Site
You can start building a new site from a blank site, which is a template consisting of a Home page with a 
banner and navigation buttons. The blank site provides a starting point for creating a new site.

To start with a blank site:

1. From the File menu, choose New Site, Blank Site.

The New Blank Site dialog appears.

You can also start a blank site by selecting the Blank Site option in the Welcome To NetObjects 
Fusion dialog.

2. Enter a site name in the dialog.

Note: For compatibility with NetObjects Fusion for Macintosh and Macintosh Web servers, do not 
give your site a name with more than 26 characters.

3. Click Save.

Site view opens a new site, based on the Blank Site.nft template, and displays a Home page. 
You’re ready to begin adding pages to create your site’s structure.



Opening an Existing Site
1. From the File menu, choose Open Site.

The Open dialog appears.

2. Double-click the folder that contains the site you want to open.

3. Select the site’s .nod file and click Open.

You can also open an existing site by doing any of the following:

l Select it in the Welcome To NetObjects Fusion dialog.

l Choose it from the list of recently used files on the File menu. NetObjects Fusion remembers the last 
four site files opened.

l Drag the .nod file name from the Windows 95 Explorer and drop it in the NetObjects Fusion window.

l Double-click the .nod file name in the Windows 95 Explorer.



Viewing a Site
In Site view, the structure of your site is represented by page icons. As in a family tree, pages have 
parent, child, and sibling relationships.

In Site view you can add pages to the site, rename pages, move them, and complete other site-oriented 
actions. To add content to a particular page—for example, to add text or pictures—use Page view. As you 
construct a site, you typically go back and forth between Site view and Page view.

In Site view one page is always selected, as indicated by a blue border. See Selecting Pages.



Saving Your Work
To save your work, choose Save Site from the File menu. NetObjects Fusion also has an Auto Save 
feature that saves your work each time you change views. See Setting Preferences.



Using the Site View Tools

When you work in Site view, the toolbar contains one tool for selecting pages and another for zooming in 
and out on the Site view.



Selecting Pages
Before you can add, rename, or move pages, or set page properties, you must first select a page. By 
selecting a page, you identify it as the one you will work with. NetObjects Fusion places a blue border 
around the selected page.

To select a page, do either of the following:

u Using the mouse, click the Selection tool and then click the icon for the page you want to select. If you 
click directly on the page name, NetObjects Fusion selects the page name and switches into text 
editing mode. See Renaming Pages.

u Using the keyboard, press the arrow keys to select the current page’s parent, child, or sibling pages.



Working with Sections
In addition to selecting individual pages, you can select sections of your site. A section is any page and all
its children, their children, and so on. You can move a section to a different location in the site, set section
properties including MasterBorders—see Managing MasterBorders and AutoFrames—and preview a 
section independently of the rest of the site.

To select a section, do either of the following:

u Hold down the Shift key as you click the parent page of the section.

u With the keyboard, select the parent page of the section and then press Shift + Enter.

NetObjects Fusion places a blue border around the pages in the section.

Sections are not permanent entities. You can deselect the section by clicking any page in the site, by 
clicking the Site view background, or by pressing an arrow key or Shift + Enter. You can preview just the 
selected section.



Setting Page and Section Properties
Pages and sections have a number of properties. Some properties affect the published site; others are for
your information. For example, you can assign colors to the page icons to create visual groups that 
indicate which pages are finished or which are assigned to a particular author. You can instruct 
NetObjects Fusion whether to publish a particular page, note whether a page is done, and enter 
comments about the selected page.

To set properties, select a page or section to display the Properties palette.



Page Properties
l Page Name: The name assigned to the page. See Renaming Pages and Using Custom Page Names 

and Extensions.

l Custom Names: See Using Custom Page Names and Extensions.

l Page Type: Shows whether the page is a normal page or a stacked page. Stacked pages are created 
when you use a data list. For information about stacked pages, see Data Publishing.

l Color: Sets the color of individual page icons in Site view. You can use colors to help you manage work
on the site. For instance, use colors to specify pages that need updating or for sections that you need 
from another designer. The page icon’s color has no effect on the published site.

l Status: Marks pages as Done or Not Done, a convenient way to manage individual pages in a large 
site. This setting is for your information only and has no effect on the functioning of the site. The page 
icon displays a check mark when you select Done.

l Publish/Don’t Publish: Makes it possible to publish some pages while not publishing others that might
be under construction or private. The page icon displays a red bullet when you select Don’t Publish.

NetObjects Fusion removes pages marked Don’t Publish from the navigation bars of other pages in the
site, disables manually created links to such pages, and does not produce HTML for these pages 
during publishing. However, you can preview a page that is designated Don’t Publish as an individual 
page.

Do not use the Don't Publish setting to exclude pages in an attempt to publish changed pages only to 
an already published site. Doing so causes broken links and other undesirable results.

l Comments: Enter notes to yourself or your co-workers about the status or content of individual pages.



Section Properties
l Custom Names: You can only set a custom file extension. See Using Custom Page Names and 

Extensions.

l Color: Applies a color to the section.

l Status: Marks the section as Done or Not Done.

l Publish/Don’t Publish: Sets the publication flag for the section.

l MasterBorder: Sets a MasterBorder for a section of pages. Setting a MasterBorder for a section is 
described in Applying a MasterBorder to a Section.



Zooming In and Out

You can select the Zoom In or Zoom Out tool from the toolbar. The Zoom In tool is a magnifying glass with
a plus sign; the Zoom Out tool has a minus sign. For information on using the toolbar, see About Toolbars.

You can reverse the function of the current Zoom tool by holding down the Alt key. For example, if the 
current tool is Zoom In, pressing Alt makes it Zoom Out. As soon as you release the Alt key, it becomes 
Zoom In again.



Adding, Deleting, and Moving Pages
In Site view, you can modify the structure of a site at any time by adding, deleting, and moving pages. 
NetObjects Fusion automatically changes the links between pages when you modify the structure.



Adding Pages
1. In Site view, select the page you want to be the parent of the new page.

2. Do any of the following:

l  Click the New button on the control bar.
l From the Edit menu, choose New Page, or press Ctrl + N.
l Right-click the parent page and choose New Page from the shortcut menu.

In Site view, the new page appears beneath the selected page. The new page is named Untitled.



Deleting Pages
1. In Site view, select the page you want to delete and do any of the following:

l From the Edit menu, choose Delete Page.

l Right-click the page and choose Delete Page from the shortcut menu.

l Press the Delete key.

2. Click Yes in the NetObjects Fusion warning dialog to confirm the deletion.

Note: Deleting a page removes all its child pages and cannot be undone. You cannot delete the Home 
page.



Moving Pages
When you move pages in Site view, NetObjects Fusion automatically updates all affected links within the 
site.

1. In Site view, select the page you want to move. You cannot move the Home page.

2. Drag the page to the target page, where it becomes either a sibling or a child in its new location.

As you drag the page, a colored outline highlights the target page. The outline is red unless you change 
the Site view background color. 

A triangle to the left or right of the target page’s border indicates the moved page will be a sibling.

A triangle below the target page’s border indicates the moved page will be a child.

If the moved page will be the child of a page that already has children, the moved page becomes a sibling
of those children. In that case, the outline and triangle appear on the target sibling page.



Renaming Pages
You can rename a page to suggest its contents.

By default, NetObjects Fusion uses the page name on banners and navigation buttons that identify the 
page. When you publish your site, NetObjects Fusion uses the page name as the HTML file name for the 
page. It also uses the page name when it creates links to the page.

NetObjects Fusion converts spaces and non-alphanumeric characters except periods (.) and hyphens (-) 
in the page name to underscores (_) in the HTML file name. To change this default, see Defining Server 
Profiles.

If you give two pages the same name, NetObjects Fusion adds a numeral to the file name when it creates
the HTML files for the second and any additional pages. For example, if you have two pages named 
Great, NetObjects Fusion creates great.html and great1.html.
You can change the name directly on the page icon or in the Name field on the Page tab of the Properties
palette.

To rename a page on the page icon:

1. In Site view, click the page name text and type a new name. 

2. Press Enter or click anywhere outside the page icon to enter the name.

You can switch immediately into edit mode on a selected page by pressing Enter. Once in edit mode, you 
can tab between sibling pages to edit their names. NetObjects Fusion remains in edit mode until you 
press Enter. If the page has no siblings, pressing Tab moves the text edit selection to the page’s parent.

To rename a page in the Properties palette:

1. Select the page you want to rename.

2. Edit the text in the Name field. 

3. Press Tab or click anywhere outside the page icon.

Note: For compatibility with NetObjects Fusion for Macintosh and Macintosh Web servers, do not give 
your page a name with more than 26 characters. 



Using Custom Page Names and Extensions
By default, the browser window title bar, banners, and navigation buttons use the page name. If you 
prefer, you can specify different values to be used for your title, navigation buttons, banner, and HTML file 
extension. If you have a long page name, you can break it into two lines so it fits on the banner and button
pictures.

To specify custom page names:

1. In Site view, select the page you want to give a custom name.

2. On the Page tab of the Properties palette, click the Custom Names button, or choose Custom 
Names from the Edit menu.

3. Set the Custom Names options.

l Page Title: Appears in the title bar of the browser window when it displays this page. 
When your site visitors create a bookmark on this page, it is named from the page title. 
The title is also emphasized in search engine queries.

l Navigation Button: Appears in navigation buttons leading to this page—useful when 
your page’s name is too long for a button. To add a second line to the button text, press 
Enter after the first line.

l Banner: Appears in the page’s banner—makes possible a banner with a longer name 
than practical for a file name or button. To add a second line to the banner text, press 
Enter after the first line.

l File Extension: Specifies a custom extension for your page file. Page files usually have 
an .htm or .html extension. In some special cases, a page requires a different extension 
to function with some server software. For example, pages for secure locations use the 
extension .shtml. For information on changing the default extension for pages, see 
Defining Server Profiles.

When a section is selected, you can only set a custom file extension, which applies to the
whole section.

4. When you finish, click OK.



Setting Site View Properties
The Site tab of the Properties palette displays site information: the site name, date created, date last 
modified, the number of pages in the site, and the site’s author. When you enter an author name, 
NetObjects Fusion includes it in a <META> tag that appears in each page’s HTML file header when the 
site is published.

On the View tab of the Properties palette, you can change the Site view orientation and background color.
The orientation and background color are strictly for working in Site view. They have no effect on the 
published site.

To change background color, click the Color button and select a new color from the Color Picker. To 
change orientation, click the button for the orientation you want.



Collapsing the Site Structure Display
By collapsing the display of the site structure, you hide the child pages of a selected page, displaying only
the page icons you want to see. A page with hidden child pages displays a plus sign beneath its icon.

To collapse the display of child pages, click the triangle beneath the parent’s page icon. To expand the 
display to see child pages again, click the plus sign.

You can also collapse the display by selecting a parent page and pressing Tab. To expand the display, 
press Tab again.

The Structure and Outline views display the same expanded and collapsed pages. If you change the child
pages hidden and shown in one view, the other view reflects your changes. See Sorting the Display in 
Outline View for a description of Outline view.



Printing Site or Section Structures
In Site view, the Print command on the File menu prints the Site Structure view of your site or of a section.
You cannot print the Site Outline view. The printed structure shows the same magnification, colors, 
orientation, and expanded or collapsed child pages that you see on the screen. Its footer includes the 
author name, number of site or section pages, and the date the site was last modified.

l To print the entire site, select the Home page, or click All in the Print dialog.

l To print a specific page and its children, do any of the following:

– Select the top-level page.

– Select a section.

– Click Selected page and its children in the Print dialog. This option is selected by default.

l To view what will be printed, select Print Preview from the File menu.

l If you have a large site that might not fit on a single page, you can scale the printed site to the page. 
From the File menu, choose Print Setup and select the Print to fit option in the Print Setup dialog.



Working in Site Outline View
Site Outline view displays the site structure in outline format, including a table of the properties—child 
name, page type, status, publishing status, and comments—of the child pages of the currently selected 
page. If the selected page has no children, the table describes the selected page itself. To see the site as 
an outline:

u Click the Outline tab.

Like Site Structure view, Site Outline view shows if a branch of the site is collapsed. A collapsed branch is 
indicated by a plus sign to the left of the page icon; an expanded branch is indicated by a minus sign.

u To expand a branch, click the plus sign to the left of a page.

u To collapse a branch, click the minus sign to the left of a page.

You can select sections in Site Outline view. See Working with Sections.



Sorting the Display in Outline View
In Outline view you can sort the child pages by their properties so you can quickly identify pages with 
common characteristics.

u Click the heading of the column you want to use to sort the list.

NetObjects Fusion sorts the list in ascending (A-Z) order. To sort the list in descending (Z-A) order, point 
to the column heading and press Shift + Click.

For information about managing your site, see Managing Assets.



Backing Up Your Site
You can back up your site manually or automatically.

To make a manual backup:

1. From the File menu, choose Save Site As.

The Save Site As dialog appears.

2. Type a descriptive file name for your backup file and select a location.

3. Click Save.

NetObjects Fusion creates a copy of your .nod file in the location you specified and automatically opens 
that file.

Note: The backup you make with the Save Site As command does not collect all assets and make all 
links relative. Your backup will still refer to assets and components in the original site file folder. To make a
backup with assets and relative links, export your site file as a template, as described in Importing and 
Exporting.

For information on automatic site file backups, see Setting Preferences.



Importing and Exporting
NetObjects Fusion offers several ways for you to create or expand the structure and content of your site. 
You can create new sites from templates such as the AutoSites provided with NetObjects Fusion. You can
expand an existing site quickly by importing page or section templates. You can import existing HTML 
sites and pages and convert them to NetObjects Fusion format. You can also expand your site by 
referencing external HTML resources; see Referencing and Editing External HTML.

You can export your completed NetObjects Fusion site as a site template, so you can share your work 
with other NetObjects Fusion authors or move your site to another computer system.



Using Templates and Sample Sites
A NetObjects Fusion template is a predefined set of pages and assets that you can modify to meet your 
needs. A template folder contains:

l The source site’s collected assets, stored in a TemplateName\Assets folder. A site’s assets are its 
pages, pictures, media, and other content sources—any files other than the Sitename.nod file that 
make up the site.

l The SiteStyles used by the source site, stored in a TemplateName\Styles folder. SiteStyles are 
discussed in Using SiteStyles.

l A template file, TemplateName.nft, that includes the source site’s structure, page layouts, and 
references to the site’s assets.

Templates can contain a single page, a site section, or an entire site. NetObjects Fusion comes with a 
variety of site and page templates; see Templates Included with NetObjects Fusion.

You can open a template to create a new site. NetObjects Fusion includes several templates that provide 
the basic structure for common types of sites. See Creating New Sites.

You can import any NetObjects Fusion or custom templates into your current site to expand its structure 
or content. To ensure consistency with the current site, all imported pages, sections, and sites take on the
SiteStyle of the current site. See Expanding Your Site.

You can also export your current site into template format, so you can move or distribute it. See Exporting
a Site.

When you add a new blank page to your site, the appearance and content of that page is set by the 
default Blank Site template. To change the default appearance of new blank pages, you can modify the 
Blank Site template. See Changing an Existing Template.



Templates Included with NetObjects Fusion
NetObjects Fusion includes three types of templates that you can use as a starting point for your site, or 
import as a section or page that you add to your current site:

l AutoSite™ templates provide a complete site with predesigned pages, a suggested site structure, and 
placeholder content. AutoSite templates are stored in the NetObjects Fusion 3.0\Templates\
AutoSites folder. There are five AutoSite templates included with NetObjects Fusion:

– An Internet-style company site

– A departmental intranet site

– A business presentation site

– An import site

– A Blank site

l Page templates are professionally designed pages containing generic content that you can replace with
your own information. Page templates are stored in the NetObjectsFusion\Templates\Pages 
folder. NetObjects Fusion includes:

– A Blank Page template that is used whenever you add a new page to your current NetObjects Fusion
site

– Special-use pages, such as a table of contents, a calendar, an FAQ page, an office directory, and a 
“what’s new” page

– Sample navigation pages, which provide examples of top and left frame navigation, a text-based 
page, and an empty page

– Data-derived pages, such as an employee directory, a “who’s who” function, and a press release 
catalog

l Form templates, which are predesigned form pages containing generic or placeholder content for 
typical forms:

– A billing form

– A guestbook

– An order form

– A shipping form

You can also modify or replace these templates with your own. See Creating a Template or Changing an 
Existing Template.



Sample Sites Included with NetObjects Fusion
In addition to AutoSite and page templates, NetObjects Fusion comes with two sample sites: a small 
business site and a demonstration site. These are templates with real content rather than placeholder 
content; they’re designed to showcase many NetObjects Fusion features. You can use them as examples 
of how to implement various effects and results. See Creating a Site from a Template.

Sample site templates are stored in the NetObjects Fusion 3.0\Samples\Sites folder.



Creating New Sites
When you want to create a new NetObjects Fusion site, you have three choices:

l You can start with a blank site and add all pages and content yourself. Starting from a blank site is 
described in Creating and Opening Sites.

l You can start from an AutoSite, a NetObjects Fusion page template, or a custom template, and add or 
delete content as needed. Starting from a template is described in Creating a Site from a Template.

l You can start from an existing site created without NetObjects Fusion, import it into NetObjects Fusion, 
and add, delete, or re-arrange content as needed. Starting from an HTML-based site is described in 
Importing an Existing Site.



Creating a Site from a Template
AutoSite templates provided by NetObjects Fusion provide a complete site structure with predesigned 
pages and suggested content. You can also use templates that you or your colleagues create, or 
templates created in previous versions of NetObjects Fusion. 

If a template contains a data object, NetObjects Fusion stores its image fields only as path names to the 
image files. Therefore, if you create a new site from a template created on your computer, the image 
fields on stacked pages will still display the image, but if you move the template to another computer and 
create a new site from it, the image fields will be empty.

To create a new site based on an AutoSite or other template:

1. If your preferences are set to display the Welcome dialog when the program opens:
a. Open NetObjects Fusion.

The Welcome To NetObjects Fusion dialog appears.
b. Select From AutoSite or Template (*.nft) in the Create a New Site section of the dialog, 

and click OK.

If NetObjects Fusion is already running, select New Site, From Template from the File menu of 
any view.

The Select a Template File dialog appears with the AutoSites folder shown by default.

2. Navigate to the folder containing the template you want. Select the appropriate 
TemplateName.nft file and click Open.

The Save Site As dialog appears. 

3. Enter a site name in the File name field. To ensure cross-platform compatibility, limit your site 
name to a maximum of 26 characters.

The site name is the file name for the NetObjects Fusion site (.nod) file and the name of the 
parent folder for the site’s assets and content folders.

4. Select the location where you want your site saved. By default NetObjects Fusion saves your site 
in the NetObjects Fusion 3.0\User Sites folder, but you can store it in the location of your 
choice.

5. Click OK.

NetObjects Fusion creates the \Sitename folder, which contains a Sitename.nod file and a 
Sitename\Assets subfolder.

NetObjects Fusion opens in Site view and displays the page icons of the site you created. You can now 
modify the site structure as described in Adding, Deleting, and Moving Pages.

The first time you work with an AutoSite or page template, explore the individual pages in Page view 
before you delete or rearrange them. These pages include helpful content that can save you significant 
development time.



Importing an Existing Site
You can create a new site by importing and converting an existing site that was created using a different 
site or page development tool. When you import and convert an existing site, NetObjects Fusion:

l Analyzes and duplicates the structure of the source site

l Analyzes and duplicates the content of each page

l Arranges source content into objects in a layout design as close as possible to the original

l Duplicates navigation and content links

l Assigns the default Plain SiteStyle and the default MasterBorder, if you select one

You can use this import and conversion function to bring previously created sites into NetObjects Fusion 
format. Then you can use NetObjects Fusion for updates, revisions, and maintenance.

When you create a new site by importing and converting an existing site, follow these guidelines:

l When you begin to import and convert a source site, you can select one MasterBorder from the 
currently displayed site to apply to the new site. If you have an existing site with a MasterBorder similar 
to what you want the newly created site to have, open that site first, then create the new site. 
NetObjects Fusion applies the selected MasterBorder to the new site as it is created.

l Be aware that importing a complex site might take more processing time than you expect. If the source 
site was created in NetObjects Fusion, it is more efficient to import it as a template than to import the 
published HTML pages.

l You can import an existing site from a local or networked drive, or from a remote location such as an 
intranet server or the World Wide Web.

– To import from a local drive, you must know the drive and folder where the site’s Home page, usually 
named index.htm or index.html, is stored.

– To import from a remote location, you must know the URL of the main site file, such as index.htm.

– You can limit the number of pages and the number of levels that NetObjects Fusion captures from 
either a local or remote site. Levels are based on the hierarchy of pages in the source site, defined 
by the site’s navigation. The first level is always the site’s Home page. The second level of the 
source site consists of pages that are linked from the Home page. Third-level pages are those linked 
from second-level pages, and so on.

– You must be connected to the Internet when you’re ready to activate the remote capture.

l When NetObjects Fusion imports a site, it starts with the page you specify and stops importing when it 
hits the page number limit, the site level limit, or the end of the site. If you don’t define import limits, 
NetObjects Fusion imports to the end of the site—no matter how long that takes or how much it 
requires in system resources.

l In determining the number of levels, NetObjects Fusion counts the designated top-level page as level 
1, then works down the site’s structure, stopping when it reaches the limit you set. NetObjects Fusion 
imports as many pages as possible at a higher level before going to a lower level.

l HTML coding practices vary, so the contents of the source site pages are unpredictable. Not all HTML 
coding syntax translates identically into NetObjects Fusion format, particularly incomplete or 
nonstandard tags. Some pages will convert more accurately than others. Spaces in .html file names 
might cause problems importing a site.

l NetObjects Fusion imports assets such as Java applets, Shockwave, and other media. It does not 
import server-side imagemaps or manage server-side resources. If the imported site originally used 
server resources such as a CGI script or Server-Side Includes, you must manually recreate these on 
your server.

l NetObjects Fusion imports and converts HTML tables. If the source table has a visible border, no row 
or column spans, and a maximum size of 20 x 20 cells, then NetObjects Fusion converts it as a table. 



This works for regular and nested tables that meet the criteria. Otherwise, NetObjects Fusion converts 
the table into a series of text boxes and positions them on the page to represent the table structure. 
NetObjects Fusion tables do not support vertical alignment attributes.

l NetObjects Fusion’s import feature supports the HTML 3.2 specification. Cascading Style Sheet (CSS) 
coding is removed from pages during import. Content with no other alignment formatting is placed flush
left on its respective page.

l When you import a site that was built using HTML frames, NetObjects Fusion imports the frameset’s 
content pages as regular pages, and references the original frameset page as an external HTML page.

l Be prepared to perform some cleanup on an imported and converted site. Adjust font size and style if 
needed, and add NetObjects Fusion navigation bars and banners as appropriate to your design. If a 
page does not import the way you expect, check the original source file for incorrect HTML code or 
data.



Creating a New Site from an Existing Site
1. To use an existing site’s MasterBorder when building the new site, open the existing site first.

2. From the File menu, choose New Site, From Local Import or From Remote Import.

l Select From Local Import to import a site located on your hard disk or network drive.

The Import Local Web Site dialog appears.

l Select From Remote Import to import a site stored in a remote location such as an 
intranet server or the World Wide Web.

The Import Remote Web Site dialog appears.

3. Enter the exact file location and path to the top-level page you want to import:

l To specify a local site, enter the full drive and path to the local site’s top-level source page
in the Home page field, or click Browse.

A file Open dialog appears. Navigate to and select the appropriate top-level page and 
click OK.

l To specify a remote site, enter the full URL to the site’s top-level source page in the Home
Page URL field. To ensure accuracy, navigate to the site or page using your browser, then
cut and paste the URL from the browser.

The starting page of your site import does not have to be the source site’s Home page, usually 
named index.htm or index.html; it can be any page of any accessible Web or intranet site.

4. From the Assign MasterBorder drop-down list, select the MasterBorder you want to apply to the 
imported site or section.

NetObjects Fusion displays the list of MasterBorders available in the current site; if there is no site
currently open, the MasterBorder Import is applied by default.

5. Set the limits for the number of pages and number of levels you want to apply to the import 
process.

6. If you are importing and converting a local site, enter the domain name for the site’s Home page 
in the Domain name field. If the local site was ever published on the Web, use the domain name 
that was used to access it; if not, leave the placeholder www.domain.com in the field.

When it imports a local site, NetObjects Fusion needs to know the “home base” domain of that 
site, so it can tell whether to convert the links it finds into external or internal links. It does that by 
comparing the targeted domain, if there is one, to the domain name you entered.

7. If you are importing and converting a remote site, make sure your system is connected to the 
Internet or intranet so NetObjects Fusion can link to and import the site.

8. Click OK.

NetObjects Fusion imports the site and converts its content, structure, and links into NetObjects 
Fusion format. It stores the site’s assets in the Sitename\Import folder, and assigns the 
MasterBorder you selected earlier to each page in the new site.

9. Navigate to each page and make necessary adjustments.



Expanding Your Site
One of the most efficient ways to expand your site and add new content is to import structures and 
content from other sources:

l You can import NetObjects Fusion templates at selected locations in your site. See Importing 
Templates.

l You can import and convert existing sites or parts of sites using Site view and attach them to selected 
locations in your site. You can also import existing pages using Page view. See Importing Existing 
Sites.



Importing Templates
One way to expand your site is to import NetObjects Fusion templates into a specific location in your site. 
Templates can be either pages or whole sites; you can use either to assemble the basic structure of your 
site very quickly.

Importing templates is especially helpful if you have standard boilerplate sections or pages that you want 
to add to multiple sites, or share among multiple authors. You can save those sections or pages as 
templates, and then incorporate them anywhere in your site with a few mouse clicks.

When you import templates, follow these guidelines:

l Before you import, select the location where you want to append the imported section. The imported 
site, page, or section becomes a child of the selected page. You can move pages as needed once they 
are imported.

l When you import a site or multi-page template, you are in effect adding a section to your site. See 
Working with Sections.

l All imported pages take on the SiteStyle of the current site. For example, if several authors separately 
develop parts of a site, export their work as templates, and import the templates into a single master 
site for publishing, the master site’s SiteStyle ensures that the compiled site has a consistent look and 
feel. See Using SiteStyles.

l When NetObjects Fusion imports a template, it renames the template’s MasterBorders by prefixing 
them with Imported, and adds them to the current site’s library of MasterBorders. For example, if the 
template has a MasterBorder named NoFrames, it is renamed and stored with the current site as 
ImportedNoFrames.

You can rename, manipulate, or delete these extra MasterBorders as appropriate. See Modifying and 
Creating MasterBorders.

l Every template begins with a single root page, which is helpful if you are adding the template to your 
site as a page or section. However, if you want the root page of your template to be the Home page of 
your site, you must create a new site based on the template, rather than importing it. See Creating New
Sites.

l Although this information refers to the templates provided with NetObjects Fusion, the procedure is the 
same for importing custom templates.

l You can also reference external HTML pages as a part of your NetObjects Fusion site. NetObjects 
Fusion attaches referenced pages to the site, but does not import or convert their contents to 
NetObjects Fusion format. See Referencing and Editing External HTML.

l If a template contains a data object, NetObjects Fusion stores its image fields only as path names to 
the image files. Therefore, if you import a template created on your computer, the image fields on 
stacked pages will still display the image, but if you move the template to another computer and import 
it, the image fields will be empty.

l If you add custom actions to a site, save the site as a template, and then import the template into a new
site, the custom actions will not display in the custom actions menu in the new site.

To import a site or page template:

1. In Site view, right-click the page under which you want to import the template. This page becomes
the parent of the imported page or pages.

2. Select Import Template from the shortcut menu. 

The Import Template dialog appears.

3. Select the template you want to import:

l To import an AutoSite template, open the \AutoSites folder and find the folder containing 
the template you want to use. Open the selected template folder and select the 



TemplateName.nft file.

l To import a page template, open the \Pages folder and find the folder containing the 
template you want to use. Open the selected template folder and select the 
TemplateName.nft file.

l To import a template located elsewhere on your system or network, use the Import 
Template dialog to find the folder containing the template you want to use. Open the 
folder and select the TemplateName.nft file within it.

4. After you select the template, click Open.

NetObjects Fusion imports the template and appends it under the page you selected. The page 
data and all assets are stored in your current site folder. The original template is still available in 
the NetObjects Fusion 3.0\Templates folder.



Importing Existing Sites
You can expand your current site by importing and converting an existing site that was built without 
NetObjects Fusion. The process is similar to creating a new site from an existing site, but you are 
appending the existing site to your current site structure, rather than building a new site from scratch with 
it.

Be aware that importing a complex site might take more processing time than you expect. If you created 
the site in NetObjects Fusion, it is far more efficient to import it as a template than to import the published 
HTML pages.

To expand your site by importing an existing site:

1. In Site view, select the page you want to serve as the parent of the imported and converted 
content.

2. From the File menu, choose Import Web Site, From Local Import or From Remote Import.

l Select From Local Import if you want to import a site located on your hard disk or network
drive. 

The Import Local Web Site dialog appears.

l Select From Remote Import to import a site stored in a remote location such as an 
intranet server or the World Wide Web.

The Import Remote Web Site dialog appears.

3. Enter the exact file location and path to the top-level page you want to import:

l To specify a local site, enter the full drive and path to the local site’s top-level source page
in the Home page field, or click Browse.

A file Open dialog appears. Navigate to and select the appropriate top-level page and 
click OK.

l To specify a remote site, enter the full URL to the site’s top-level source page in the Home
Page URL field. To ensure accuracy, navigate to the site or page using your browser, then
cut and paste the URL from the browser.

The starting page of your site import does not have to be the source site’s Home page, usually 
named index.htm or index.html; it can be any page of any accessible Web or intranet site.

4. From the Assign MasterBorder drop-down list, select the MasterBorder you want to apply to the 
imported site or section.

NetObjects Fusion displays the list of MasterBorders available in the current site; if there is no site
currently open, the MasterBorder Import is applied by default.

5. Set the limits for the number of pages and number of levels you want to apply to the import 
process.

6. If you are importing and converting a local site, enter the domain name for the site’s Home page 
in the Domain name field. If the local site was ever published on the Web, use the domain name 
that was used to access it; if not, leave the placeholder www.domain.com in the field.

When it imports a local site, NetObjects Fusion needs to know the “home base” domain of that 
site, so it can tell whether to convert the links it finds into external or internal links. It does that by 
comparing the targeted domain, if there is one, to the domain name you entered.

7. If you are importing and converting a remote site, make sure your system is connected to the 
Internet or intranet so NetObjects Fusion can link to and import the site.

8. Click OK.

NetObjects Fusion imports the site, converts its content, structure, and links, stores its assets in 



the Sitename\Assets folder, and assigns the MasterBorder you selected earlier to each page in 
the new site.

9. Navigate to each page and make necessary adjustments.



Exporting a Site
You can export any site as a template to use its style or content in another site. When you export a site as
a template, NetObjects Fusion copies all assets into the \Assets folder of the template and converts 
absolute paths to relative paths. NetObjects Fusion includes in the exported template the SiteStyle files 
and resources for any SiteStyle in use by the source site. Therefore, exporting a site as a template (.nft) 
is the only way to share sites with other NetObjects Fusion authors or to incorporate it into another site.

You cannot move or replicate your site by copying and distributing the Sitename.nod file and its \Assets 
folder because:

l Your site’s assets are not necessarily stored in the Sitename\Assets folder; they could be elsewhere 
on your disk, somewhere on the network, or out on the Web. The Sitename.nod file contains absolute 
paths to all asset locations, so it doesn’t need to move or copy your assets until you publish your site.

l The new computer to which you move the Sitename.nod file might not have the same assets in the 
same locations. If it doesn’t, the site will be missing assets.

l A customized SiteStyle used for the site might not be available in the site’s new location.

Export is only available from Site view.



Creating a Template
1. To export the template to a new folder, create the folder first, using the Windows Explorer or NT 

File Manager.

2. In Site view, from the File menu, choose Export Site.

The Select Destination dialog appears.

3. Navigate to and select the folder where you want to store the template and click OK.

NetObjects Fusion creates the template and stores it in a subfolder of the folder you selected. 
The current site remains open.



Changing an Existing Template
You can change or customize any NetObjects Fusion template. For example:

l If you have a standard company template for department pages, you can customize your copy so it 
contains your department name, location, and personnel information.

l If your company develops sites for customers and other organizations, you can customize the 
templates you use most frequently with your company name, contact information, and default links.

l If you routinely create new pages or new sites, but need them to have a consistent look and feel, you 
can customize NetObjects Fusion’s Blank Site template to contain the standard objects you want.

To preserve the original template, copy the entire template folder, including the TemplateName\Assets 
subfolder, before you edit or modify a default template. If you need to undo changes to a default 
NetObjects Fusion template, you can re-install it.

If your modified template includes a custom SiteStyle, see Customizing a Template with a SiteStyle.



Customizing a Template
1. In Site view, from the File menu, choose Open Site to display the file Open dialog.

2. Select NetObjects Fusion Template Files (*.nft) from the Files of Type drop-down list.

3. Navigate to and select the template, then click OK.

4. Identify new assets you want to add to the template and copy them to the template’s \Asset 
folder, using Windows Explorer or NT File Manager.

5. Modify the template page(s) as needed.

6. To record the changes as part of the original template, chose File, Save Site.

To rename or move the template to a different folder, choose File, Save Site As. Navigate to and 
select a new parent folder, or enter a new name for the site.

7. Click OK.

You can now import the customized template as needed.



Customizing a Template with a SiteStyle
1. In Site view, from the File menu, choose New Site, From Template.

The New Site from Template dialog appears.

2. Navigate to and select the template you want to customize and click Open.

The Save Site As dialog appears.

3. Enter a new name for the template.

NetObjects Fusion creates a new site based on the selected template, and gives it your new 
name.

4. Make changes to the template’s content, structure, or properties.

5. Switch to Style view. From the Style menu, choose Add Style to List.

The file Open dialog appears with a Files of Type setting of Style Sheet Files (*.ssf).

6. Navigate to and select the Stylename.ssf file of the SiteStyle you want to apply to the template, 
and click OK.

NetObjects Fusion adds the SiteStyle to the list and displays an alert box asking if you want to 
apply the new SiteStyle to the site.

7. Click Yes.

8. Switch to Site view and from the File menu, choose Export Site to display the Export Destination 
dialog.

9. To replace the original template:
a. To export the template to a new folder, create the folder first, using the Windows Explorer 

or NT File Manager.

b. In Site view, from the File menu, choose Export Site to display the Select Destination 
dialog.

c. Navigate to and select the folder under which you want to store the template and click 
OK.

NetObjects Fusion creates the template and stores it in a subfolder of the folder you selected. 
The current site remains open.

10.To create a new template, export the site to a new location.

You can now import the customized template as needed.



Sharing NetObjects Fusion Site Files
Templates are the only effective way to share NetObjects Fusion site files among multiple authors or 
across operating platforms. You cannot simply copy a Sitename.nod file created by NetObjects Fusion to
another computer and open it, because the Sitename.nod file refers to files and styles that are not 
contained in the Sitename.nod file itself.

Note: If most of your sites involve the efforts of three or more developers using NetObjects Fusion, you 
should consider NetObjects TeamFusion, which uses client-server technology to manage, integrate, and 
safeguard the contributions of each team member. See www.netobjects.com for information.

To distribute or move a NetObjects Fusion site:

1. Export the site as a template according to the information in Creating a Template.

2. Copy the new template folder to the target computer via network, diskette, or other storage 
media. Make sure the folder and file names are not truncated or changed in the process.

3. Start NetObjects Fusion on the destination computer.

4. From the File menu, choose New Site, From Template.

The New Site dialog appears.

5. Navigate to and open the template’s folder and select the TemplateName.nft file.

6. Enter a name for the new site in the Site Name field and click OK.

The site that was created in NetObjects Fusion on the source computer is now the active site, 
with its own Sitename.nod file, on the destination computer.



Page View Basics
NetObjects Fusion supports three ways to lay out your page: position-based, text-based, and HTML-
based. Once you select a layout method, you either place objects within a layout container or import an 
HTML page to construct your page.

Tools, properties palettes, and layout aides, such as rulers, guides, and grids, help you arrange and align 
objects on the page.



Displaying a Page in Page View

From Site view, there are several ways to display a page in Page view:

u Double-click the page icon.

u Click the page icon, then click the Page view button on the control bar.

u Click the page icon, then from the Go menu, choose Page.

u Click the page icon, then press Ctrl+2.

The page you selected appears in Page view.

Pages consist of a Layout area and a MasterBorder area. The Layout area is the body of the page. It 
contains objects that are unique to a page. MasterBorders are optional margin sets. They contain objects,
such as navigation bars, that appear on multiple pages.

You can define multiple Layouts and MasterBorders, then assign one of each to a page. Modifying and 
Creating MasterBorders describes how to create MasterBorders; Creating and Selecting Layouts 
describes how to create Layouts.

The size of a NetObjects Fusion page is defined by the combined size of the MasterBorder and Layout. 
The Blank Site template sets the default page size at 600x555 pixels, which is appropriate for the majority
of site visitors. You can redefine the default page size setting or adjust the size of the MasterBorder area, 
the Layout area, or both.



Adjusting the Size of the Layout and MasterBorder Areas
You can adjust the size of the MasterBorder and Layout areas. Resizing these areas also changes your 
page size.

To resize the Layout and MasterBorder areas, do one of the following:

u Click in the Layout area, then change the Layout width, height, or both in the Layout Width and Height 
fields on the General tab of the Layout Properties palette.

u With the rulers showing, click one of the Layout handles and drag it to change the Layout height and 
width.

u With the rulers showing, click the rightmost MasterBorder handle to increase the size of the right 
MasterBorder. Click the bottom MasterBorder handle to increase the size of the bottom MasterBorder.



Forcing Objects to Snap to Grids, Guides, and Each Other
When you select a Snap to command, NetObjects Fusion creates a “magnetic” attraction between the 
selected object and the grids, guides, or other objects. Forcing objects to snap to grids, guides, and each 
other helps create more efficient HTML code.

u To force objects to snap to grids, select Snap to Grids from the View menu. 

u To force objects to snap to guides, select Snap to Guides from the View menu.

u To force objects to snap to each other, select Snap to Object Outlines from the View menu.



Adding, Moving, and Deleting Guides
You can add as many guides as you want to either the MasterBorder area or the Layout area, move the 
guides, and delete them.

u Click in the area for which you want to add, move, or delete a guide, then do one of the following: 

l To add a vertical guide, click in the top ruler.

l To add a horizontal guide, click in the side ruler.

l To move a guide, click its arrow on the ruler and drag it.

l To delete a guide, click its arrow and drag it off the ruler.



Showing and Hiding Rulers, Guides, and Grids
Grids, rulers, and moveable guides help you place and align objects in the MasterBorder and Layout 
areas. Guides associated with a MasterBorder appear on all pages that use that MasterBorder.

You can set the size of the grid. To show and hide rulers, guides, and grids in Page view, do one of the 
following:

u Select Rulers & Guides from the View menu to show and hide rulers and guides.

u Select Grids from the View menu to show and hide grids.



Moving Between Pages In Page View
You can easily move between pages in Page view using the page navigation buttons, the Site Navigation 
window, or the Go To command on the Go menu.

The Page Navigation buttons and button for displaying the Site Navigation window are at the bottom of 
the NetObjects Fusion window.



Using Page Navigation Buttons

To move between pages using the page navigation buttons, do one of the following:

u On a child page, click the Parent page button to display its parent page.

u On a parent page, click the Child page button to display its child page.

u Click the Previous page button to move to the preceding sibling page.

u Click the Next page button to move to the next sibling page.



Using the Site Navigation Window
1. In Page view, click the Site Navigation window button.

The Site Navigation window appears.

2. Double-click the page you want to open, or select the page and press Enter to open it.



Importing HTML Pages
In Page view, you can import an HTML page authored elsewhere and convert it to NetObjects Fusion 
format, so you can visually edit its contents as you would any other page. You can import HTML 
documents with .htm or .html extensions.

If you prefer not to convert the HTML page to NetObjects Fusion format, place it as an object as 
described in Referencing HTML from Page View.

Note: Because of variations in HTML code, not all pages import exactly as you see them, especially if 
their content is not in defined tables. Unpredictable results can occur if the page contains incorrect HTML.
Non-HTML, such as JavaScripts and CGI scripts, do not import.

1. In Page view, display the page on which you want to import the HTML page.

It is easiest to import an HTML file onto a Layout that contains no content, because objects from 
the HTML file overlay any existing objects.

2. From the File menu, choose Import HTML Page.

The Open dialog appears.

3. Select an .htm or .html file from your hard disk, CD-ROM, or LAN.

4. Click Open.

NetObjects Fusion places the contents of the .htm or .html file on the current page, beginning in 
the upper left corner of the Layout area.



Placing Objects
You can use the tools on the four toolbars, or drag and drop files onto the page to place objects. To place 
an object using a tool:

1. In Page view, select the tool you want to use. Double-click the tool if you want to place multiple 
objects of the same type.

2. Draw a box where you want to place the object on the page.

If you are placing a picture, select from the Picture File Open dialog and click Open.

The object appears on the page as well as the appropriate Properties palette.

3. Set the properties of the object. 

The tabs and options displayed on the Properties palette vary depending on the object you are 
placing. See the appropriate topic for information about setting properties for objects.



Dragging and Dropping Objects
You can drag and drop text or Rich Text Format (.rtf) files from Microsoft Explorer or a word processor.

1. Locate and select the text or text file you want to place.

2. Drag the text or file into the NetObjects Fusion application window and drop it on the page.

3. Use the Properties palette to set the text’s properties.



Selecting Objects

Use the Selection tool to select, then move, or resize objects.

u Click the Selection tool on the Standard toolbar. Then:

l Click an object to select it. Click elsewhere to deselect it.

l Drag an object to move it.

l Click an object and drag the selection handles to resize the object.

l Drag a marquee around multiple objects, or Shift + Click to select multiple objects.

l Shift + Click selected objects one-by-one to deselect them.



Zooming In and Out 

Use the Zoom tools to zoom in and out on an object or area on your page. You can press Alt while using 
the tool to toggle between zooming in and out on an object, or you can use the Zoom command on the 
View menu to select a magnification.



Moving and Copying Objects
u Click and drag an object to move it.

u To prevent an object from dropping into a container, such as a Layout Region or text box, select the 
object and press Alt while moving it over a container.

u Press Ctrl, then click and drag an object to copy it.



Editing Objects
You can edit the objects you place on your page by launching editing applications from NetObjects 
Fusion. To learn how to link a file type to the application of your choice, see Editing Objects and Assets.

1. In Page view, select the object and choose Open Object from the Object menu.

2. The object appears in the application associated with it.



Adding and Modifying Alt Tags
To make pages load faster, some visitors set up their browsers so they do not display images. To ensure 
that your pages provide the information you want to convey regardless of how the site visitor’s browser is 
set up, use alt tags to provide descriptive text that appears when images are not displayed. Also, 
Microsoft Internet Explorer 3.x and 4.x can display alt tag text in a ToolTip when the site visitor points at 
an object, so make sure every alt tag is appropriate for a ToolTip.

NetObjects Fusion assigns a picture’s file name as the alt tag when you place picture objects. You can 
change the name to a more descriptive one in the Alt Tag field on the Picture Properties palette. You can 
add an alt tag to Java, drawn shape, hotspot, generic plugin, QuickTime™, Shockwave, audio, and video 
objects in the Alt Tag field of their Properties palette.

To add or modify an alt tag:

u In the object’s Properties palette, type a descriptive name in the Alt Tag field.



Embedding Objects in Containers
In NetObjects Fusion, a container is an object into which you can embed other objects. A container can be
any size and can hold any kind of object. NetObjects Fusion provides four types of containers you can 
use to design and lay out your page:

l The Layout is the body of the page, surrounded on all four sides by the MasterBorder. Each page has 
at least one Layout, although you can create additional layouts as needed.

l Text boxes are a special class of objects because you can embed other objects within them. You can 
also maximize a text box so it fills the entire Layout—in effect, using a single text box to lay out the 
entire page.

l Layout Regions are mini-layouts that you can use to subdivide the page. You can draw and place 
Layout Regions anywhere on the page, and place any kind of objects—including text boxes or other 
Layout Regions—within their borders.

l Tables serve as containers for objects. If your page design calls for a tabular design, you can create a 
table to fill the page, and lay out your content within the cells of the table. Each cell of a table is a text 
box, so you can embed any other objects in the cell.

Note: If your page design requires hand-coded HTML pages, you can incorporate them as-is into your 
NetObjects Fusion page by referencing them. See Referencing HTML from Page View.

u To embed an object in a container, select it and drag it over the container into which you want to embed
it.

The object automatically drops into the container. For details, see Laying Out the Page.



Creating Overlapping Objects
NetObjects Fusion supports CSS and Layers, an advanced form of HTML output that lets you overlap 
objects. Site visitors with newer browsers—Microsoft Internet Explorer 4.x or Netscape Communicator 4.x
—can see an object superimposed on top of another object.

When you choose the CSS and Layers output option, you can place overlapped objects anywhere in a 
Layout, or embed them in a Layout Region.

To overlap two or more objects:

1. In Page view, in the Layout Properties palette, if you have not selected CSS and Layers for your 
entire site, select CSS and Layers from the Use drop-down list.

2. Place two or more objects in the Layout or a Layout Region.

3. Determine the object you want to be on the bottom layer, then drag the object you want to be on 
the next layer on top of it.

4. Repeat step 3 to continue layering objects.

See Selecting HTML Output for a complete discussion of the CSS and Layers output type. If you want to 
change the order by which objects are layered, see Rearranging Layered Objects.



Locating and Renaming Objects
The Object Tree provides a convenient way to locate and rename objects on a page. This is particularly 
useful when you are working with layered or hidden objects. If you added several of the same type of 
objects, NetObjects Fusion numbers each object in the order in which you placed it.

1. In Page view, from the View menu, choose Palettes, Object Tree.

The Object Tree appears. 
2. Click an object in the Object Tree to locate it on the page.

Selection handles appear around the object on the page.

3. To rename the object, select the name of the object and type a new name.



Rearranging Layered Objects
You can rearrange the layering of objects using commands on the Object menu or by moving the object in
the Object Tree.

1. In Page view, open the Object Tree, and click the object you want to move.

Handles appear around the object on the page.

2. Click and drag the object up or down the tree to move it to a different layer, or from the Object 
menu, choose Arrange Objects and:

l Select Bring to Front to bring the object to the top of the layer.

l Select Bring Forward to bring the object up one layer.

l Select Send to Back to send the object to the bottom layer.

l Select Send Backward to send the object down one layer.



Aligning and Distributing Objects
In a Layout or Layout Region, you can align two or more objects to each other and distribute three or 
more objects equidistant from each other. Or, you can align and distribute objects relative to the Layout or
Layout Region.

1. In Page view, select the objects you want to align by Shift + Clicking each one.

The Multi-Object Palette appears.
2. If you want the objects to align or be distributed relative to the Layout or Layout Region in which 

the objects are placed, select Relative to Layout.

3. In the Align section, specify the horizontal and vertical alignment.

l Select an option from the Horizontally section to align objects’ left or right sides, or to 
center them on top of each other. If you select Relative to Layout, the objects align to the 
right or left side of the layout, or are centered in the Layout, one on top of the other.

l Select an option from the Vertically section to align objects’ top or bottom sides, or to 
center them next to each other. If you select Relative to Layout, the objects align to the 
top or bottom of the layout, or are centered in the layout side-by-side.

l Select Horizontally from the Distribute section to make three or more objects that are on 
top of each other equidistant. Select Vertically from the Distribute section to make three 
or more objects that are next to each other equidistant.

Note: Object alignment can have an impact on preserving your design. See Optimizing Nested Tables 
Output.



Making Multiple Objects the Same Size
1. In Page view, select the objects by Shift + Clicking each one or by dragging a marquee around 

them.

The selected objects size to match the largest object you select.

2. From the Objects menu, choose Size Objects, Width to make two objects the same width. From 
the Objects menu, choose Size Objects, Height to make two objects the same height.



Using the Standard Toolbar
Standard objects—such as text, pictures, tables, forms, and so on—are the basic building blocks of any 
site.

Use the Text tool to add text to your pages. See Designing with Text.

Use the Picture tool to add pictures to your pages. See Placing Pictures.

Use the tools in the Hotspot tools group to create imagemaps. See Creating an Imagemap.

Use the Layout Region tool to add Layout Regions to your pages. See Using Layout Regions.

Use the Table tool to place tables on your pages. See Adding Tables.

Use the Form Area tool to add a form container to your page. See Designing and Implementing Forms.

Use the Navigation Bar tool to add navigation bars to a page. See Creating Navigation Bars and Banners.

Use the Banner tool to add a banner based on your SiteStyle to your page. See Creating Navigation Bars 
and Banners.

Use the tools in the Draw Shape group to draw shapes. See Drawing Shapes and Lines.

Use the tools in the Line tools group to draw rules, lines, and arrows. See Drawing Shapes and Lines.



Using the Advanced Toolbar
The Advanced toolbar contains tools you use to add media that require plugins, such as Shockwave and 
QuickTime, Java applets and servlets, ActiveX controls, data objects, and external HTML.

Use the tools in the Media tools group to add popular plugins, such as Shockwave for Director, 
Shockwave Flash, or QuickTime movies to your pages. See Placing Media.

Use the Java tool to place Java applets and servlets. See Adding Java and ActiveX.

Use the ActiveX Control tool to place ActiveX (.ocx) files on your page. See Adding Java and ActiveX.

Use a Data List tool to add data list objects. See Data Publishing.

Use the External HTML tool to reference an external HTML page. See Referencing and Editing External 
HTML.



Using the Components Toolbar
The Components toolbar contains tools you use to add components, such as a Ticker Tape or Message 
Board, to your pages.

DynaButtons are buttons site visitors use to navigate to links, including pages or sites. See Adding 
DynaButtons.

Ticker Tape adds a scrolling LED message to your site. See Using Ticker Tape.

Site Mapper helps site visitors create a site map. See Adding a Site Map Button.

Message Board provides visitors with a means to post, read, and reply to messages. See Adding a 
Message Board.

Use the Form Handler tool to add a Submit button to forms. See Submitting Responses as Plain Text.

Picture Rollover displays different images when a site visitor moves the mouse pointer over an image. 
See Loading Pictures onto Your Site.

Time Based Picture displays an image for a specified period of time. See Adding Time Based Pictures.

Picture Loader loads an image dynamically at browser request from a URL. See Loading Pictures onto 
Your Site.

Rotating Picture displays several images in a continuous loop. See Adding Pictures That Roll Over .

Use the NetObjects Fusion Components tool to add components to your site. See Adding Other 
NetObjects Fusion Components.



Using the Form Toolbar
A form provides a way for you to collect information from site visitors and provides the visitor with a way to
request information. You use the Form tools to design forms after you designate an area of the page as 
the form area.

Use this tool to add a reset button or, if your form will use either your own or a third party’s CGI script, to 
add a submit button. See Adding Submit, Reset, and Custom Buttons.

Check boxes provide site visitors with a way to select one or more items from a group of items, or to 
toggle a single item on and off. See Adding Check Boxes.

Radio buttons limit the site visitor to selecting one item at a time. See Adding Radio Buttons.

Single-line text fields accept text input from site visitors. They can be any width but only one line high. 
See Adding a Single-Line Text Field.

Multiple-line text fields can hold more than one line of text. See Adding a Multiple-Line Text Field.

Combo boxes create drop-down lists to display multiple options. Combo boxes allow site visitors to select 
one or several items from a list. See Adding a Combo Box.



Interpreting the Warning Icon

NetObjects Fusion displays a warning icon on an object when it detects a potential layout problem or 
other error condition.

Mouse over the warning icon to display a ToolTip that identifies the problem, which can be one of the 
following:

l A picture is not Web safe, because it is in an unsupported file format. To remove the icon, replace the 
picture with one in a supported format. See Choosing an Image Format.

l A form object, such as a Submit button, is outside a form. To remove the icon, drag the form object 
inside a form. See Adding Objects to a Form.

l Two or more objects overlap and you have not selected CSS and Layers as your HTML output option. 
To remove the icon, drag objects apart so they don’t overlap or choose CSS and Layers as the output 
option. See Creating Overlapping Objects.



Planning Your Site
The default settings for NetObjects Fusion generate efficient HTML that faithfully reproduces your visual 
design on the published page. The design of your text content, however, is subject to the browser settings
of each site visitor. Preserving Your Design Intentions describes potential variations that can happen in 
the site visitor’s browser.

NetObjects Fusion offers several ways to control published output:

l You can manipulate the HTML output method used to generate your site. NetObjects Fusion supports 
three output methods, each of which provides unique benefits in selected circumstances.

l You can control the table formatting priority—horizontal or vertical—used to generate the page. This 
helps preserve your design intentions when a browser’s font settings change the size of your text.

l You can select from four different types of page containers, each with different characteristics, to serve 
as your page layout medium. Laying Out the Page describes these containers and their use.



Preserving Your Design Intentions
When you place a text box on a page, it’s shown in the default display font. You then format the text, size 
the object, and position it relative to other objects on the page—basing your efforts on the effects of your 
default display font and the size of the text box it creates.

When you preview or publish the page and view it in your browser, the size of the text box—and its 
alignment with the objects around it—is controlled by the base font settings in your browser. If your 
NetObjects Fusion base font is 10-point Times Roman, and your browser base font is set to 14-point Arial,
you’ll see an immediate difference in the arrangement and spacing of your objects, because your text 
boxes expand to accommodate the new font size.

This is why you are advised to set the display fonts in NetObjects Fusion to match those of your browser
—so you are working in a WYSIWYG environment. See Setting Preferences.

This font variation is not caused by NetObjects Fusion; it’s a consequence of site visitors controlling their 
browser environment. It might not be an issue when you preview, but when you publish your site, you 
should be aware of potential problems:

l If a site visitor has a different browser base font setting, the text boxes on your page change size and 
other objects are re-arranged around them.

l Microsoft Internet Explorer places slightly more blank space between text lines than the Netscape 
browsers do. If you design your page using one browser as a preview tool, visitors using the other 
browser see different results. You can set WYSIWYG optimization for either Netscape or Microsoft 
Internet Explorer to account for the browser differences. See Setting Preferences.

l There are differences in font display between operating systems: if your site visitor is using a 
Macintosh, for example, its “version” of 14-point Arial is physically smaller than yours.

Using the Nested Tables output method you can control this rearrangement of content. You can also 
specify the horizontal or vertical formatting priority.



Selecting HTML Output
Ongoing advances in browser technology and HTML standards have created several possibilities for 
controlling the way your site presents content. NetObjects Fusion supports these advances by offering 
three HTML output methods:

l Nested Tables uses nested table tagging and other features of the 3.2 HTML specification to produce 
your site. This is NetObjects Fusion’s default output because it produces the most predictable and 
consistent results onscreen, regardless of the type, version, or font configuration of the browser.

l Regular Tables uses basic, non-nested HTML table tagging to format your site pages. Regular Tables is
the “lowest common denominator” output setting, generating basic HTML that is compatible with the 
widest range of browser versions.

l CSS and Layers uses a combination of Cascading Style Sheets positioning code, Jscript™, and the 
<LAYER>tag to control the placement and delivery of content. Content published with CSS and Layers 
requires an advanced browser: site visitors must use Microsoft Internet Explorer 4.0 or higher or 
Netscape Navigator 4.0 or higher to get the full effect of your design. CSS and Layers is also the best 
output method to use for dynamic pages and objects with actions. See Building Dynamic Pages.

NetObjects Fusion gives you several options for applying these HTML output methods. You can:

l Publish your entire site with any method.

l Override the site publishing method for a specific page.

l Override the site or page publishing method for a specific Layout Region.



Publishing with Nested Tables
When NetObjects Fusion publishes your site, Layout, or Layout Region using the Nested Tables method, 
it places all your content in nested table cells. This method has several advantages:

l You get relative placement of your content as you designed it in Page view, with relative spacing 
preserved regardless of the site visitor’s display configuration—such as browser fonts, browser type 
and version, and operating system. 

l You can prioritize either the vertical or horizontal relationship between objects. As a result, site visitors 
are more likely to see the pages as you designed them, regardless of their local browser, font, and 
display configurations. By default, NetObjects Fusion assumes vertical relationships are most 
important.

l Pages published using Nested Tables can be viewed in most browsers that support the 3.2 HTML 
specification. This includes Microsoft Internet Explorer 3.0 or higher and Netscape Navigator 3.0 or 
higher.

Nested Tables is the default publishing method for NetObjects Fusion.



Publishing with Regular Tables
When NetObjects Fusion publishes your site, Layout, or Layout Region using Regular Tables, it translates
each page or Layout Region into an HTML table with rows and columns, and places your content into 
table cells. This table is the underlying structure of the page, not a visible table object.

This output method gives you relative placement of content on the page; your content maintains its 
position in the underlying table. If text content expands because of a browser font setting, its table row 
expands with it, and the content below it on the page is moved down.

Regular Tables is the recommended output method in the following circumstances:

l When you want your pages to display successfully in older versions of some browsers.

l When you have embedded form objects in the page’s Layout or Layout Region.

l When you have objects with actions on the page, and you choose not to use CSS and Layers as the 
output method.



Publishing with CSS and Layers
CSS and Layers is an application of CSS concepts that NetObjects Fusion uses to express the location of
content in terms of absolute positioning. For example, instead of using HTML workarounds such as empty
table rows and transparent .gif files to position a line of text a certain amount of space below the top of 
the page, the absolute positioning supported by CSS and Layers defines placement of the text box a 
specific distance from the top left corner of the page in a simple statement of x,y coordinates.

CSS and Layers uses a combination of CSS positioning code, JScript, and browser-specific codes such 
as Netscape’s <LAYER> tag to control the placement and delivery of content. Pages published using 
CSS and Layers can only be viewed accurately in Microsoft Internet Explorer 4.0 or higher or Netscape 
Communicator 4.0 or higher. Older browsers can view the pages, but their results will be unpredictable; in
most cases the page content is stacked flush left down the page.

When you select CSS and Layers as your output method, NetObjects Fusion generates Everywhere 
HTML—HTML code that produces the same results in either browser. You can use this to take advantage 
of the advanced capabilities built into newer versions of Microsoft Internet Explorer and Netscape 
Communicator, without worrying about browser compatibility issues.

Like the other two HTML output methods, you can apply CSS and Layers as:

l The default output method for your site. Note that this makes a 4.0-level browser the minimum 
requirement for viewing your entire site, which can exclude site visitors who use older browsers.

l The HTML output method override for a specific Layout. When you publish selected pages in CSS and 
Layers—while publishing the rest of the site in one of the table-based formats—you can keep the bulk 
of your site accessible to most browsers, while providing specialized content to those with browsers 
that support it.

l The HTML output method override for a specific Layout Region. Publishing a selected Layout Region in
CSS and Layers—while publishing the rest of the page and site in a table-based format—makes an 
even finer distinction between the content available in basic HTML format and specialized content for 
newer browsers.



CSS and Layers: Pros
l Pages published using CSS and Layers as the output method are typically more compact and 

download faster than table-based HTML pages.

l You can overlap objects on Layouts or Layout Regions that are published with CSS and Layers. 
Because CSS and Layers includes a way to express depth, NetObjects Fusion can generate code that 
designates one object to display in front of another. See Creating Overlapping Objects.

l CSS and Layers is the most efficient output method for dynamic pages containing objects that have 
actions. See Building Dynamic Pages for information on developing DHTML.



CSS and Layers: Cons
l If you publish using CSS and Layers, site visitors who have older browser versions see the content 

stacked vertically against the left margin of the browser—not laid out in your page design.

l Because of its use of absolute positioning, CSS and Layers is less suited for text-rich pages. If a CSS 
and Layers page is viewed in a browser with large font settings, the text boxes expand without regard 
for other objects on the page; the result can be unintended overlapping of objects.



Optimizing Nested Tables Output
If you use Nested Tables to output HTML for a Layout or Layout Region, you can control the text flow for 
each container by setting the table formatting priority—columns or rows—that NetObjects Fusion uses to 
generate the page. This helps preserve your design intentions when a browser’s font settings change the 
size of your text content.

For example, a Columns or vertical priority keeps text together in a vertical orientation when text size 
changes rearrange the page. A Rows or horizontal priority keeps text together in a horizontal orientation 
when text size changes rearrange the page.

In addition to selecting the formatting priority that best supports your design, you can also make your 
pages more efficient and more predictable by optimizing the placement of objects—particularly text 
objects— within the site’s underlying table structure. There’s no fixed standard, but as a general rule it’s 
best to align objects to each other, and to isolate text boxes in their own cells within the underlying table 
structure so they can resize themselves as necessary in response to browser font changes.

To help you determine the best alignment, you can preview the underlying table row and column structure
to see if NetObjects Fusion can divide your Layout into cells efficiently or if you need to rearrange some 
objects.

To preview NetObjects Fusion’s arrangement of underlying table cells on your page and set your table 
alignment setting:

1. In Page view, select the Layout or Layout Region you want to preview.

The General tab of the appropriate Properties palette appears.

2. Select Columns or Rows in the HTML Output section of the General tab to set the table alignment
priority.

3. Click and hold the Show button.

NetObjects Fusion hides grid lines, guide lines, and object borders in the Layout and displays 
solid grey lines that show where it is dividing the Layout into rows and columns.

4. Identify underlying table cells that contain multiple text or other objects.

5. Release the Show button.

6. Move objects around as needed to improve the efficiency of your HTML output. If the row and 
column dividers are not separating objects the way you think they should, those objects might not 
be aligned to each other with pixel accuracy.

To correct this, Shift + Click all the objects you want to align. The Multi-Object palette appears.

Click the alignment setting that your design requires for the selected objects.

7. Repeat steps 3 through 6 as needed.

8. Preview the site or page.

9. To test the results, reset your browser display fonts to a significantly larger size and preview the 
site again.

You can also preview table structure in the browser by holding down Shift when you click the Preview 
button.



Optimizing AutoFrames
You can control realignment of AutoFrame content by selecting, for each frame, the primary table 
alignment setting that best preserves your design intentions. When you press and hold the Show button 
to preview the Layout’s table row and column structure, the preview includes the table structure that 
NetObjects Fusion expects to use within AutoFrames.



Locking or Maximizing a Text Box
There are three text box properties you can apply to reduce the impact of variations in browser 
configurations: locking the minimize size of the text box, sizing the text box to fill the Layout, and wrapping
the text box contents to the browser width.

l Locking the minimum size of a text box prevents automatic resizing by the browser if the display font is 
smaller than anticipated. When you publish a page with a locked text box, NetObjects Fusion 
generates HTML code that “hard-wires” the minimum size of the text box. If the display font is bigger 
than expected, the height of the text box expands as needed; it will not shrink to a size less than the 
locked size.

l You can set the text box to automatically maximize itself to the full size of the Layout that contains it. If 
you embed all the page’s objects in a text box, for example, then you might want to make sure the text 
box grows to fill the Layout so there’s no unexpected white space if your MasterBorders or page 
dimensions change.

If you embed your page content in a maximized text box, NetObjects Fusion generates extremely 
efficient HTML when it publishes your site. See Embedding Objects in a Text Box.

l If you size your text box to the Layout and you select the ZeroMargins MasterBorder, you can set the 
text box to wrap to the width of the browser window. Text and images embedded in the text box rewrap 
themselves to fit within the browser window. If the browser window is resized, then the text box 
contents rewrap themselves to the new size.

Note: If you wrap the page contents to the browser window, then NetObjects Fusion generates 
the page’s HTML without using tables.

For information on formatting text, see Designing with Text. For information on designing layouts with text 
boxes, see Using Text Boxes.



Locking or Maximizing the Text Box Size
1. In Page view, create or select the text box.

2. Select the Text Box tab on the Text Properties palette.

3. Select Lock height to lock the text box’s minimum height.

4. Select Size to Layout to maximize the text box to fill the Layout.



Setting the Text Box to Wrap to Browser Width
1. In Page view, click the MasterBorder or select it from the Object Tree.

2. On the General tab of the MasterBorder Properties palette, select the ZeroMargins MasterBorder.

3. Select the text box.

4. Select the Text Box tab of the Text Properties palette.

5. Select the Contents wrap to browsers width option.



Supporting Your Design with HTML Output
To determine which HTML output method best supports your site’s design and delivery priorities, find the 
description that best matches your main priority, then note the suggested HTML output choices.

See Laying Out the Page for details about choosing the layout method that most effectively supports your 
HTML output method. Design Priorities and Method Choices matches design priorities with appropriate 
HTML output and layout methods.



Managing MasterBorders and AutoFrames
NetObjects Fusion divides a page into two areas: the Layout area and the MasterBorder area. The 
MasterBorder is the set of margins—top, bottom, left, and right—on your page. Although MasterBorders 
are especially suited to repeating objects such as navigation buttons and logos, you can place anything in
a MasterBorder that you can place in the Layout, including banners, pictures, and text. You can set any or
all of the margins as an AutoFrame, which permits site visitors to scroll the body of the page while objects 
in the AutoFrame, such as navigation buttons, remain in view.

You can create a MasterBorder and apply it to all the pages in your site or just to selected pages; a site 
can use more than one MasterBorder. When you modify a MasterBorder, NetObjects Fusion automatically
makes that change on every page that shares the MasterBorder.



Looking at MasterBorders
By default, the left, right, and bottom margins are separated from each other visually by an outline. The 
lack of an outline between the left margin and the top margin indicates that objects can straddle that 
boundary. This is not the case if the top or left margin is set as an AutoFrame. For information, see 
Adding an AutoFrame. You can turn the outline display off by selecting Page Labels from the View menu.

All pages have a MasterBorder, including those with a ZeroMargins MasterBorder, where all margins are 
set to zero and the MasterBorder is not visible. You can change the size of any MasterBorder margin, 
even those set to zero. See Modifying a MasterBorder.

The MasterBorder margins use the unit of measure selected for the site in Preferences. See Setting 
Preferences.



Working with MasterBorders
When you create a new site, NetObjects Fusion automatically creates a default MasterBorder. The default
MasterBorder for a new blank site contains three navigation aids—a banner showing the page name at 
the top, a graphical navigation button bar on the left, and a text navigation bar on the bottom. These 
objects are included in the MasterBorder of the Blank Site template. For information on the Blank Site 
template, new sites, and how to use templates, see Creating and Managing Sites and Importing and 
Exporting.

When you import a template or create a new site based on a template, the new pages bring their 
MasterBorders and names with them from the source site. The Edit MasterBorder List dialog identifies 
imported MasterBorders. You can rename or delete imported MasterBorders. To display the Edit 
MasterBorder List dialog, click Add/Edit in the Masterborder Properties palette.

When you create a new site based on the template Import.nft, the default MasterBorder has a zero top, 
left, and right margin, and the bottom margin is 50 pixels. Unless you change the default MasterBorder, 
new pages you create in the site will also have these margins.



Modifying and Creating MasterBorders
You can modify a site’s default MasterBorder, or you can create your own MasterBorders. When you 
modify the MasterBorder on one page, NetObjects Fusion updates all pages that use the same 
MasterBorder; any object you place in a border automatically appears on all pages with that 
MasterBorder.



Modifying a MasterBorder
1. In Page view, display the MasterBorder Properties palette by clicking inside the MasterBorder. If 

the page has a ZeroMargins MasterBorder, click outside the page.

The MasterBorder Properties palette appears. The Name field shows the name of the 
MasterBorder assigned to the current page. If you started with a new blank site and have not 
changed the MasterBorder, this name is DefaultMasterBorder.

2. To change the size of the margins, you can do either of the following:

l In the Margins section of the MasterBorder Properties palette, type values into the fields 
or click the arrows.

l Drag the handles on the ruler.

Note: If an object is in the way—such as a banner occupying both the top and left margin—you 
cannot resize the MasterBorder until you move the object.

3. Use the Selection tool to arrange objects such as a banner or navigation buttons.

4. Delete unwanted objects.

5. Use the tools in Page view to insert additional text or objects.



Resizing a MasterBorder
You can easily make a MasterBorder fit the objects in it—buttons, banners, text, pictures, and so on.

1. In Page view, select one of the objects in the MasterBorder.

2. From the Object menu, choose Size MasterBorder to Objects.



Creating a New MasterBorder
1. In Page view, click in the MasterBorder area.

The MasterBorder Properties palette appears. The Name field shows the name of the 
MasterBorder assigned to the current page. If you have not created a new MasterBorder or 
selected a different MasterBorder from the MasterBorder list, this name is DefaultMasterBorder.

2. Click the Add/Edit button.

The Edit MasterBorder List dialog appears.

3. The dialog lists all the MasterBorders in your site, with the current MasterBorder selected. To add 
a MasterBorder, click Add.

The New MasterBorder dialog appears.

4. Type a name for the new MasterBorder, select an existing MasterBorder to base it on, and click 
OK.

NetObjects Fusion creates a new MasterBorder based on the selected MasterBorder. The new 
MasterBorder is applied to the current page, and its name is added to the drop-down Name list in 
the MasterBorder Properties palette.

5. From this point, create the MasterBorder by following the steps in Modifying a MasterBorder.



Changing MasterBorders
1. In Site view or Page view, navigate to a page where you want to apply a different MasterBorder, 

and display the page in Page view.

2. Click inside the MasterBorder area.

The MasterBorder Properties palette appears.

3. Select the MasterBorder you want from the Name drop-down list.

The margins of the page now display the contents of the selected MasterBorder.



Applying a MasterBorder to a Section
You can apply a MasterBorder to a section of pages in Site view. A section is any page and all its children,
their children, and so on. 

1. In Site view, select a section of pages.

l Hold down the Shift key as you click the parent page of the section.

l With the keyboard, select the parent page of the section and then press Shift-Enter.

The Properties palette displays the Section tab.

2. Select the MasterBorder you want from the MasterBorder drop-down list.

The MasterBorder is applied to all the pages in the section.



Renaming MasterBorders
1. In Page view, click inside the MasterBorder area to display the MasterBorder Properties palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want to rename and click 
Rename.

4. In the Rename MasterBorder dialog, type a new name and click OK.

The new MasterBorder name now appears in the Edit MasterBorder List dialog and in the drop-
down list in the MasterBorder Properties palette.



Deleting MasterBorders
1. In Page view, click inside the MasterBorder area to display the MasterBorder Properties palette.

2. Click Add/Edit.

3. In the Edit MasterBorder List dialog, select the MasterBorder you want to delete and click Delete.

You see a warning that deleting a MasterBorder cannot be undone.

4. If you choose to continue, click OK.

Note: When you delete the MasterBorder that is currently in use, NetObjects Fusion resets the page to 
the ZeroMargins MasterBorder.



Using AutoFrames
An AutoFrame is a special instance of a MasterBorder margin that corresponds to an HTML frame. It 
subdivides the browser window into independent “panes,” each displaying its own content—including 
links, form objects, regions, or any text, graphic, or media objects you want. The combination of frames 
that completes the browser window is called a frameset.

Frames can take on properties not available to standard MasterBorders.

l The scrolling properties of a frame are independent of other areas of the page. If the site visitor scrolls 
the Layout, the frame doesn’t scroll with it. This makes it possible—among other things—to keep 
navigation buttons in view at all times, regardless of where the visitor is in the Layout. Conversely, you 
can make a frame scrollable, so the site visitor can scroll the frame without affecting the Layout.

l You can specify whether the site visitor can resize the frame, making it wider or narrower, taller or 
shorter. This enlarges the visible content area of the frame. It has nothing to do with scrolling, which 
brings another part of the frame into view.

l You can specify a background for the frame: the current SiteStyle background, a solid color, or even a 
picture.

l You can define targets for the links contained in one frame so they retrieve content into another frame.

NetObjects Fusion supports two ways of creating frames:

l AutoFrames

AutoFrames gives you a graphical interface to set frames and then to add navigation controls, banners,
text, graphics, links, and scroll bars.

l Custom frames

NetObjects Fusion gives you direct access to HTML so you can manually code frames using the HTML 
page description language. This method requires knowledge of HTML codes and the NetObjects 
Fusion HTML access interface. If you prefer the flexibility of creating frames yourself, refer to Creating 
Custom HTML Framesets and Frames.

Links within a frame can display a page, or display information in the same frame or a different frame. 
Frames can also reduce the amount of refreshing your visitor’s browser must do. To learn how you can 
take advantage of these frame features using AutoFrames, see Working with AutoFrames.

Within a frame, you can influence how variations in browser fonts affect your design using the Rows and 
Columns option on the Frame properties tab. These options work within a frame the same way they do 
within a Layout. For more information about selecting a table structure, see Preserving Your Design 
Intentions and Optimizing Nested Tables Output.

Note: Although Netscape Navigator and Microsoft Internet Explorer support frames, not all browsers do. 
If you use frames, you might want to consider creating an alternate site for visitors with browsers that do 
not support frames. 



Adding an AutoFrame
Since NetObjects Fusion applies AutoFrames to the current MasterBorder—and all pages that use that 
MasterBorder—you might want to start by selecting or creating a designated “framed” MasterBorder that 
you can selectively apply to the appropriate pages in your site. See Creating a New MasterBorder if you 
need help creating a new MasterBorder. If you want to apply different framesets to different pages, you’ll 
need one MasterBorder for each frameset.

Arrange the content and design of the MasterBorder as you want it to look, and apply that MasterBorder 
to the first page you want to turn into a frameset. As you develop this MasterBorder, follow these 
guidelines:

l Objects in frames can’t straddle frame boundaries, so check the corners of your page before you add 
AutoFrames. For example, if you have a banner across the top of the page that overlaps the left and 
top borders, resize it or move it before you turn on AutoFrames for either border.

l Frames have internal margins, so add a little extra room to margins you’re going to set as frames, so 
you don’t get scroll bars when you don’t need them.

l By default, frames are borderless. To add borders, see Generating HTML Frame Borders.

To set a MasterBorder margin as an AutoFrame:

1. In Page view, click an empty space inside one of the border areas, or in the grey area outside the 
page.

The MasterBorder Properties palette displays the General tab.

2. Select the AutoFrames tab.

3. Click the button for each margin you want to set as a frame—Left, Right, Top, or Bottom.

NetObjects Fusion indicates a frame is applied by adding a label—Left, Right, Top, or Bottom—to the new
frame.

If you select more than one border to set as a frame, your selection sequence makes a difference. 
Multiple frames overlap each other in the order in which you select them. You can change the overlap 
sequence by deselecting AutoFrame areas and then reselecting them in a different sequence.

If an object overlaps the frame border when you apply AutoFrames, you see a message asking if you 
want to modify the margins.

l If you click OK, the selected margin enlarges to include the overlapping object.

l If you click Cancel, the creation of AutoFrames is canceled so you can manually adjust the margins. 
You can then apply AutoFrames again.



Generating HTML Frame Borders
Frames have borders by default, and you must leave Generate HTML frame borders checked if you want 
visitors to be able to resize the frame.

You can easily set frames to be borderless in the site visitor’s browser. To do so, clear Generate HTML 
frame borders on the AutoFrames tab of the MasterBorders Properties palette. NetObjects Fusion turns 
off the borders for all frames in that MasterBorder.

Note: To combine frames with borders and frames without borders on the same page, you must script the
frames. See Creating Custom HTML Framesets and Frames.



Setting Frame Properties
The Frame tab in the MasterBorder Properties palette contains visual and functional properties that you 
can set for each frame individually. To view and set the properties of a frame, select the frame, click the 
Frame tab in the MasterBorder Properties palette, and follow the appropriate procedure.

You can also assign actions to frames, just like other page objects. See Building Dynamic Pages.



Adding Scroll Bars to Frames
With the User scrollable option on the Frame tab you can specify whether the site visitor’s browser 
displays scroll bars around a specific frame.

1. In Page view, click the frame and select the Frame tab.

2. Select a User Scrollable option:

l Yes: The browser always displays vertical and horizontal scroll bars in the frame, whether
needed or not.

l No: The browser never displays scroll bars, even if needed to display all objects in the 
frame. If the page content is larger than the frame itself, site visitors won’t be able to see 
the entire page.

l Auto: The browser displays scroll bars if the size of the page content requires them. Auto 
is the default setting.

Note: Due to the nature of HTML, links to anchors on a frame will not work if User Scrollable is set to No.



Making Frames Resizable
If you want a site visitor to be able to drag the frame border, making the frame larger or smaller, you can 
set the User Resizable Frame option.

1. In Page view, click the frame and select the Frame tab.

2. Select User Resizable Frame if you want site visitors to be able to resize the frame.

Note: HTML frame borders must be visible so the site visitor can drag them to specify a new 
size. If User Resizable Frame is not available, return to the AutoFrames tab and check the 
Generate HTML frame borders option.



Setting the Frame Background
You can set the frame’s background to the current SiteStyle background, a solid color, or a picture.

1. In Page view, click the frame and select the Frame tab.

2. In the Background section of the Frame properties tab, set the background options:

l To use the background color of the current SiteStyle, select SiteStyle Background.

l To set the frame background to a different color, select Solid Color. If the solid color 
shown is not the one you want, click the Color button, select a color from the Color 
Picker, and then click OK. The selected color fills the frame background.

l To use a picture in the frame background, select Picture. The Picture File Open dialog 
appears. Navigate to and select either an image asset already included in the site, or a 
new image file located elsewhere. If the picture is smaller than the frame, it is 
automatically tiled to fill the frame.



Laying Out the Page 
You have three options for designing pages and laying out your content:

l You can design your pages by positioning content with pixel-level precision. The position-based 
approach uses Layouts and Layout Regions as content containers and preserves your position-based 
layout by generating pages consisting of either HTML or CSS code.

l You can lay out pages using a text-based approach. With text-based design you can preserve the flow 
of content by embedding objects in text boxes or table cells. Text-based page layout generates lean 
and efficient HTML code that responds effectively to variations in browser and font size. If your page 
design is based on rows of content—as in a spreadsheet or other tabular arrangement—you can lay 
out all or part of your page in tables. Each table cell functions as a text box, into which you can embed 
any kind of object.

l You can include hand-coded HTML pages in your NetObjects Fusion site. In the HTML-based 
approach, you incorporate external HTML pages as part of your site by referencing them as objects on 
a page, or the page itself. NetObjects Fusion can manage the assets required by the original page. See
Referencing and Editing External HTML.

No matter which approach you take, you don’t have to worry about differences among browsers. 
NetObjects Fusion publishes your site using Everywhere HTML—generated HTML that displays correctly 
in both Microsoft Internet Explorer and Netscape Navigator.



Using Layouts
The Layout is the default container that makes up the body of the page. It is surrounded on all four sides 
by the MasterBorder. When you publish a page, a single HTML file containing all the objects and 
properties of the MasterBorder and the Layout is created. The dimensions of the published page are 
determined by the combined size of the Layout and the MasterBorder. 

When you create a new page, NetObjects Fusion automatically assigns it a default Layout. You can also 
create multiple Layouts, which are an effective way to prototype page designs and toggle between sets of
content. When you preview or publish your site, NetObjects Fusion publishes each page according to the 
currently selected Layout.



Controlling Layout Appearance
You can control various characteristics of the Layout’s appearance in Page view.

l You can show or hide the MasterBorder by selecting it from the View menu. NetObjects Fusion 
publishes each page with its MasterBorder, whether it is visible or not in Page view. See Modifying and 
Creating MasterBorders.

l You can show or hide Page view’s visual aids: page labels, object icons and outlines, and rulers and 
guides. You can toggle these on or off by selecting the option you want to hide or show from the View 
menu. Hiding or showing the Layout’s visual aids does not have an impact on the published site.

l You can change the Layout margins by dragging the Layout handles. See Changing Layout Size.



Creating and Selecting Layouts
Each page has a default Layout, defined by the Blank Site template. Each Layout is attached to a single 
page, unlike MasterBorders, which can be applied to any page in the site. There’s no connection between
Layouts on separate pages. 

By default, the new Layout is named PagenameLayout, based on the current name of the page. For 
example, when you first add a new page, its page name is Untitled; until you rename that page, the 
default Layout is named UntitledLayout.

You can add multiple Layouts to a page, each with its own properties, design, and content. For example, 
you might use several Layouts so you can prototype or publish several versions of the same page. You 
could also create separate Layouts for different versions of your site, such as English, French, media, and
text-only. When you publish the site, NetObjects Fusion publishes each page using the Layout currently 
selected for that page.

The name of the currently selected Layout appears in the Layout drop-down list in the lower-left corner of 
Page view.

To create a new Layout for a page:

1. Go to the page in Page view.

2. Select Add from the Layout drop-down list.

A new, blank Layout appears. Any content on the previous Layout is stored with that Layout.

3. Change the Layout name as needed. See Renaming a Layout.

4. Add objects to the Layout, and modify the Layout’s properties—such as size, background, or 
HTML output options—as needed.

To display a different Layout for a page, select it from the Layout drop-down list.



Renaming a Layout
Each Layout you add to a page is given the name of PagenameLayout. NetObjects Fusion does not 
require Layout names to be unique, but you might find it easier to keep track of multiple Layouts if they 
have meaningful names.

To rename a Layout:

1. If the Layout currently displayed in Page view is not the one you want to rename, select the 
correct Layout from the Layout drop-down list at the bottom left of the NetObjects Fusion window.

2. Click the Layout, or select it from the Object Tree. 

The General tab of the Layout Properties palette appears.

3. Enter a new Layout name in the Name field of the General tab. Use letters and numbers only; 
Layout names cannot have spaces, hyphens, underscores, or other special characters, and they 
cannot begin with a number.

4. Press Enter or click elsewhere on the page.

The name of the Layout changes and the Layout drop-down list is updated.

You can also use the Object Tree window to change the name of the Layout. See Locating and Renaming
Objects.



Changing Layout Size
There are four ways to change the size of a Layout. You can:

l Set its Width and Height properties to specific values on the Layout Properties palette.

l Show Rulers and Guides and drag the Layout handles into place at the width and height you want.

l Automatically limit the size of the Layout to be no larger than the size required by the objects it 
contains.

Regardless of the method you choose, there are a few guidelines for controlling Layout dimensions:

l The minimum allowable size of a Layout is controlled by two things: the location and size of any objects
placed on the page, and the location and size of any objects in the MasterBorder. You can’t make a 
Layout smaller than the space required by its current contents in their current locations. You also can’t 
make a Layout smaller than the space required by the size and location of its MasterBorder contents.

l The unit of measurement for Layout dimensions is set on the Page tab of the Preferences dialog. See 
Setting Preferences.



Setting a Specific Layout Size
1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Set specific Layout dimensions by entering a number in the Width and Height fields.

If the number you want is lower than the minimum allowable size, NetObjects Fusion displays a 
message and offers to set the Layout size to the minimum allowable size.

Note: Page Width and Height are display-only fields that calculate the total dimensions of the 
page by adding the MasterBorder to the Layout. A standard page size is 600 pixels in width; any 
size over that might force site visitors to scroll their browsers left or right to see the entire page.



Sizing a Layout by Dragging
1. In Page view, if rulers are not visible, choose Rulers & Guides from the View menu.

2. Click the Layout width handle in the top ruler bar and drag it to the Layout width you want.

NetObjects Fusion displays a tip that reports in pixels the distance of the handle from the top left 
corner of the page. It also adjusts the MasterBorder handle as needed to maintain the bottom 
border height.

3. Click the Layout height handle in the left ruler bar and drag it to the Layout height you want.

NetObjects Fusion displays a tip that reports in pixels the distance of the handle from the top left 
corner of the page. It also adjusts the MasterBorder handle as needed to maintain the bottom 
border height.

The Layout and MasterBorder maintain a complete rectangle. If you change the width of the Layout, the 
widths of the top and bottom borders expand or shrink as needed. If you change the height of the Layout, 
the heights of the left and right borders change as needed.



Shrinking the Layout Automatically
u In Page view, from the Object menu, select Size Layout to Objects.

The Layout height and width are reduced to the minimum size required by the MasterBorders and
the current size and placement of objects on the page.

Note: You can significantly reduce the size of the HTML file NetObjects Fusion generates for your page if 
you shrink the Layout. Your pages can also benefit from shrinking the size of the MasterBorder: see 
Resizing a MasterBorder.



Adding Objects to the Layout
The Layout is the default container for the page, and can contain any object. To add objects to a Layout, 
you can:

l Select the appropriate tool and create the object directly within the Layout.

l Paste the object into the Layout from the Clipboard.

l Drag and drop any object that you can place with a tool.

For information on adding a specific type of object to the Layout, see the appropriate section for that 
object.



Setting the Layout's HTML Output Method
You can specify an HTML output method that determines what type of HTML code NetObjects Fusion 
produces for the current Layout. This Layout-specific HTML method overrides the method used to publish 
the site. The site publishing method is assigned in the Publish Setup dialog; see Setting the Site  ’  s HTML   
Output.

See Selecting HTML Output for descriptions of the HTML output options and their effects.

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. In the HTML output section of the General tab, select the HTML output method you want from the 
Use drop-down list.

l Publish Setting generates the Layout using the output method specified for the entire 
site, as assigned in the Publish Setup dialog. This is the default output method for a 
Layout.

l Nested Tables uses nested table tagging and other features of the 3.2 HTML 
specification. This is the default choice for the Publish Setting that controls the HTML 
output for the whole site.

l Regular Tables uses basic HTML table tagging to deliver your design and content for this
Layout only.

l CSS and Layers uses Cascading Style Sheet Positioning code, layers, and scripts to 
position and publish the content of this Layout only.



Setting the Table Formatting Preference for Layouts
If you are using Nested Tables HTML output for this Layout, you can set the table formatting preference 
NetObjects Fusion protects when it publishes the site. This setting determines whether the horizontal or 
vertical relationship between objects on this Layout is more important.

To set the table formatting for the current Layout:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. In the HTML output section of the General tab, select:

l Columns to preserve the vertical relationship between the Layout’s objects. This is the 
default.

l Rows to preserve the horizontal relationship between the Layout’s objects.

See Preserving Your Design Intentions for information on selecting the table formatting 
preference.

3. To preview the impact of your selection on the current size and placement of your Layout’s 
objects, press and hold the Show button.

NetObjects Fusion hides any grid lines, guide lines, and object borders in the Layout and displays
solid grey lines that show where it is dividing the Layout into rows and columns.



Defining the Layout as a Form
To make a page collect data and function as an HTML form, you can use the Form Area tool to place 
multiple forms on a single Layout or MasterBorder, or you can set the Layout itself to function as a single 
form. See Creating a Form for information on creating multiple forms on a page.

To set the Layout to function as a single form:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Select Layout is a form.

Note: You cannot set the Layout to function as a form if it contains one or more Form Areas. If the
Layout is a form option is selected, you cannot place another Form Area on the page.

3. To assign the form processing settings to the Layout, click Settings and enter your settings in the 
Form Settings dialog.

See Designing and Implementing Forms for information on creating forms and determining form 
processing settings.



Adding HTML and Scripts to a Layout
You can also add custom scripts or HTML code to a Layout. When NetObjects Fusion publishes the site, 
it can include your custom scripts or code in three places:

l Between the page’s <HEAD> and </HEAD> tags

l Inside the page’s <BODY> tag

l At the beginning of the page’s body section, before the rest of the page content

To add HTML code or scripts to a Layout:

1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Click the HTML button.

The Page HTML dialog appears.

3. Enter your HTML or scripts in the text box of the appropriate tab, then click OK.

See Working with HTML Directly for a full explanation of custom scripting.



Setting Layout Background Properties
You can control the appearance of each Layout by setting its background properties. You can assign a 
background color, place an image in the background, or attach a background sound that plays when a 
visitor views the page.



Setting the Layout Background Color
1. In Page view, click the Layout, or select it from the Object Tree.

The General tab of the Layout Properties palette appears.

2. Select the Background tab.

3. Select a Background Color option:

SiteStyle sets this Layout background to the default background color specified by the current 
SiteStyle, which you selected in Style view.

Solid Color sets this Layout background to a solid color of your choice. The current color 
appears in the sample box. To select a different color, click Color, select a color from the Color 
Picker, and click OK.

Picture specifies the image file that displays as the background of the Layout. The current 
selection, if there is one, displays in the sample box. To select a new or different image, click 
Browse. In the Picture File Open dialog, select the image file you want to use for the background. 
If the picture is smaller than the Layout, the browser automatically tiles the image as needed. For 
more information on using the Picture File Open dialog, see Using Image Assets.



Adding or Changing a Layout Background Sound
You can assign a sound to play when a site visitor views the page. You can use sound files in .au, .aiff,
.midi, or .wav formats. The sound can play once, or continuously.

1. In Page view, on the Background tab of the Layout Properties palette, select Sound.

l If a sound file is already selected, its name appears in the sample box. To select a 
different sound file, click Browse.

The Background Sound dialog appears.

l If there is no previous sound file selection, the Background Sound dialog appears.

2. Click Browse to find and select a sound file from your hard disk, CD-ROM, or LAN.

3. To make the sound repeat while the page is open, select Continuous Loop.

4. Click OK.

The selected sound plays when you preview the page.

Note: Site visitors must have a sound board, speakers, and a browser that supports background 
sounds installed on their computers to hear background sound. To preview and test sounds, your 
system must also be appropriately configured. Some sound formats also require support from the 
Web server. For more information about using sound files on various platforms, see Inserting a 
Sound File.



Changing the MasterBorder Selection
Although the MasterBorder is not a property of the Layout, each Layout also records the MasterBorder 
currently applied to it. If you switch between Layouts on the same page, each Layout displays the 
MasterBorder that was last applied to it.

You cannot change the MasterBorder from the Layout Properties palette; you can only change 
MasterBorders on the MasterBorder Properties palette. See Changing MasterBorders.



Making Layouts Dynamic
You can make Layouts dynamic by assigning actions to them. For example, you can make a Layout’s 
background change colors when the site visitor’s mouse pointer passes over it, or make an alert box 
display when the site visitor clicks in the Layout. You can also make a Layout the target of an action 
assigned to another object.

See Building Dynamic Pages for information about making pages and objects dynamic, and the 
procedures for adding actions to Layouts and objects.



Using Layout Regions
A Layout Region is a container that you use to group objects in a defined area on the page. Layout 
Regions are independent page segments that you can place, size, and control independently from the 
rest of the Layout.

There are four key aspects to using Layout Regions:

l If your page design includes multiple objects, you can group those objects within a Layout Region. 
When you move a Layout Region on the page, all its embedded objects move with it and maintain their 
positions relative to each other and the Layout Region. This makes it easier to design, manipulate, and 
manage multiple objects or multiple groups of objects on a page.

You can also send cascading action messages to the Layout Region, and it will pass the message to all
the objects embedded within it. This makes it easier to create and manage groups of objects with 
similar or related actions, and to use actions efficiently. See Building Dynamic Pages for information on 
adding and cascading actions.

l You can embed a Layout Region within a text box. This gives you position-based placement of the 
objects within the Layout Region, while the rest of the page is arranged in a text-based layout. The 
embedded Layout Region can be aligned within the text box, just like any other embedded object.

This combines precise positioning of key content with the efficient HTML output of a text-based layout
—taking advantage of both alternatives. See Embedding Objects in a Text Box.

l You can assign to a Layout Region a different HTML output method from that used for its parent 
Layout. For example, you can overlap objects within a Layout Region set for CSS and Layers output, 
while the rest of your page or site is formatted using Nested Tables. Site visitors with advanced 
browsers get the overlapped effect, without making the rest of your page or site incompatible with older 
browser versions.

See Selecting HTML Output for an explanation of these HTML output methods. See Setting the Layout 
Region  ’  s HTML Output   for information on assigning an HTML output method to a Layout Region.

l You can designate a Layout Region as a form and embed form objects within it. You can create multiple
forms on a single page by placing each form in its own Layout Region. See Defining the Layout Region
as a Form.



Creating Layout Regions

1.  In Page view, select the Layout Region tool from the Standard toolbar.
2. Draw the Layout Region at the place you want it on the Layout. Nudge or drag it into position as 
needed. To resize the Layout Region, select it, then drag its object handles as needed.
3. Embed objects in the Layout Region.
A Layout Region is an object; you can manipulate it or set its properties like other objects. You can:

l Set background properties such as background color or transparency. See Setting Layout Region 
Background Properties.

l Align, distribute, arrange, and size Layout Regions in relation to other objects on the page. See 
Aligning and Distributing Objects.

l Add HTML scripts to a Layout Region. See Accessing an Object  ’  s HTML  .

If you move the Layout Region, all objects embedded inside move with it and maintain their positions 
within the Layout Region. You can group objects within a Layout Region to reposition groups of objects on
the page.



Adding Objects to a Layout Region
Like a Layout, a Layout Region can contain any object: text, pictures, media, or even other Layout 
Regions. To add objects to a Layout Region, you can either:

l Select the appropriate tool and create the object directly within the Layout Region borders.

l Drag objects into the Layout Region from elsewhere on the page:

– To make the Layout Region expand as needed to contain the object, drag the top left corner of the 
object into the Layout Region.

– When you place or create objects in a Layout Region, the Layout Region border changes to a thick 
outline, indicating the object is contained in the Layout Region.

– When the pointer changes into the embedded object symbol, you can drop the object. 

You cannot paste an object inside a Layout Region. Once you place objects in a Layout Region, you can 
replace, move, or modify them as needed, just as if they were on the Layout.



Displaying the Layout Region Grid and Guides
To make it easier to place objects precisely in the Layout Region, you can display an alignment grid that is
independent from the grid displayed within the Layout. The Layout Region grid always displays in pixels. 
You can set it to any scale; the default is 50 percent of the grid for the page. See Setting Preferences for 
information on setting the page grid.

To display and modify the Layout Region grid:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. Select LocalGrid.

3. Set the width and height of the local grid.



Setting the Layout Region's HTML Output
You can specify what type of HTML code NetObjects Fusion produces for the current Layout Region. The 
HTML output setting overrides the method NetObjects Fusion uses to publish the parent container for the 
Layout Region.

For example, if the Layout Region is placed on a page’s Layout, you can set its HTML output method to 
override the method used for that Layout, which, in turn, can be set to override the site’s publishing 
method. If you embed Layout Region inside another Layout Region, the embedded Layout Region can 
have an HTML output setting that overrides the HTML output produced for the parent Layout Region.

See Selecting HTML Output for descriptions of the HTML output options and their effects.

To specify the HTML output method that NetObjects Fusion uses to produce this Layout Region:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. In the HTML output section of the General tab, select the HTML output method you want from the 
Use drop-down list:

l Parent Setting generates the Layout Region using the output method specified for the 
parent container in which the Layout Region is embedded. 

l Nested Tables uses nested table tagging and other features of the 3.2 HTML 
specification. Nested Tables is the default choice for the Publish Setting that controls the 
HTML output for the whole site.

l Regular Tables uses basic HTML table tagging to deliver your design and content for this
Layout Region only.

l CSS and Layers uses Cascading Style Sheet Positioning code, layers, and scripts to 
position and publish the content of this Layout Region only.

See Selecting HTML Output for more information on these HTML output choices. See Setting the Site  ’  s   
HTML Output for information on setting the Publish Setting property.



Setting the Table Formatting Preference for Layout Regions
If you use Nested Tables as the HTML output method for this Layout Region, you can set the table 
formatting preference NetObjects Fusion protects when it publishes the site. This setting determines 
whether the horizontal or vertical relationship between objects in this Layout Region is more important.

To set the table formatting for the current Layout Region:

1. In Page view, select the Layout Region. 

The General tab of the Layout Region Properties palette appears.

2. In the HTML output section of the General tab, select:

l Columns to preserve the vertical relationship between the Layout Region’s objects. This 
is the default.

l Rows to preserve the horizontal relationship between the Layout Region’s objects.

See Preserving Your Design Intentions for information on selecting the table formatting preference.



Defining the Layout Region as a Form
You can define a Layout Region as a form in two ways:

l You can create a new form area and set its container to be a Layout Region. See Creating a Form.

l You can set any existing Layout Region to function as a form area.

Using either method, you can place multiple Layout Regions on the same page, and have each Layout 
Region contain its own form objects and function as an independent form. To publish forms that are 
compatible with the broadest range of browser versions, use Regular Tables as the HTML output method 
for Layout Regions you define as forms.

To define an existing Layout Region as a form:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. Set the HTML output option to Regular Tables in the Use drop-down list.

3. Check the Layout Region is a form option.

4. Click Settings to enter your form processing settings for this Layout Region in the Form Settings 
dialog. See Designing and Implementing Forms for information on creating forms and determining
form processing settings.



Setting Layout Region Background Properties
You can control the appearance of each Layout Region by setting the background color or placing an 
image in the background:

1. In Page view, select the Layout Region.

The General tab of the Layout Region Properties palette appears.

2. Select the Background tab.

3. Select a Background Color option:

l Transparent makes this Layout Region transparent, so the background color or image 
assigned to the Layout underneath shows through.

l Solid Color sets this Layout Region background to a solid color. The current color 
appears in the sample box. To select a different color, click Color, select a color from the 
Color Picker, and click OK.

l Picture specifies the image file that displays as the background of the Layout Region. 
The current selection, if there is one, displays in the sample box. To select a new or 
different image, click Browse to display the Picture File Open dialog, and select the image
file you want for the background. If the picture is smaller than the Layout Region, the 
browser automatically tiles the image as needed. For more information on using the 
Picture File Open dialog, see Using Image Assets.



Making Layout Regions Dynamic
You can make Layout Regions dynamic by assigning actions to them. For example, you can make a 
Layout Region’s background change colors when the site visitor’s mouse pointer passes over it, or make 
a Layout Region “fly in” to its proper location when the page finishes loading in the visitor’s browser.

You can also make a Layout the target of an action assigned to another object.

See Building Dynamic Pages for a discussion of making pages and objects dynamic, and the procedures 
for adding actions to Layout Regions and other objects.



Using Text Boxes
The text box not only serves the basic purpose of holding the words and sentences of your text: it also 
works as a container for other kinds of objects. You can type or paste text into a text box—and you can 
also embed pictures, sound objects, tables, and any other object into that text box. When you do so, you 
are using the text box as a layout container for your page’s content.

When you use a text box as a layout container, you do not have pixel-level control over embedded 
objects. For example, you do not insert a picture object in a text box, and then drag it to the location you 
want. Instead, you embed the object at a selected point in the text and then adjust its placement using 
HTML alignment, positioning, and text-wrapping choices.

The resulting pages that NetObjects Fusion publishes, however, have extremely lean HTML code and 
load relatively quickly in the site visitor’s browser.

Additional text box functions not directly related to your use of the text box as a page layout method—
such as creating and applying styles, formatting text, and inserting custom HTML tags—are discussed in 
Designing with Text.



Sizing a Text Box
When you create or select a text box, you can control four aspects of its size: the width and internal 
margins, the minimum height, and the scaling of the text box to the full width of the Layout or the browser 
window.

To size a text box:

1. In Page view, either select an existing text box or draw a new text box using the Text tool from the
Standard toolbar.

The Text Properties palette appears.

2. Select the Text Box tab if it’s not already shown.

3. To set the margins inside the text box, enter a Text Inset value.

4. To set the width of the text box, select it and drag its object handles to stretch or shrink the text 
box as needed. The text box is always the width you set for it, unless you size it to the layout, as 
described in Scaling a Text Box to the Layout.



Setting the Text Box Minimum Height
You can set the minimum height of a text box, so no matter how much or how little you put into it, the text 
box will always be at least the specified height. This also means the text box never shrinks to a smaller 
size than specified; that is, it doesn’t adjust its height based on the size of the browser display font.

For example, text displayed on a Macintosh is smaller than text displayed on Windows 95 or Windows NT.
When a locked text box is viewed in a Macintosh-based browser, the text takes up less room—but 
because the text box has a locked-in minimum size, the browser has to leave blank space at the bottom 
of the text box.

The maximum height of the text box—as displayed in the site visitor’s browser—is determined by the 
amount of content within it, and by the browser font size used to display any text it contains.

To set the minimum height for a text box:

1. In Page view, select an existing text box, or create a new text box using the Text tool from the 
Standard toolbar.

2. Select the Text Box tab on the Text Properties palette.

3. Select Lock height on the Text Box tab. 

4. Select the text box and drag its object handles to the minimum height you always want the text 
box to require.



Scaling a Text Box to the Layout

To use a text box as the only layout container on the page:

1. In Page view, select an existing text box, or create a new text box using the Text tool from the 
Standard toolbar.

2. Embed all Layout objects in the text box or place them in the MasterBorder.

Note: Layout objects left outside the text box will be overlapped by the text box when you size it 
to the Layout. Unless you want this overlap—and use CSS and Layers HTML output to support it
—you must clear the Size to Layout option, resize the text box, and embed, move, or remove the 
objects. Then you can reselect the Size to Layout option.

3. Select the text box.

The Text Properties palette appears.

4. Select the Text Box tab if it’s not already shown.

5. Select Size to Layout.

The text box expands to fill the Layout.



Scaling Text Box Contents to the Browser Window
To make your text-based layout as flexible as possible, you can also configure NetObjects Fusion to 
format the content of a text box so it maximizes itself within the site visitor’s browser window.

To scale a text box’s content to the browser window:

1. In Page view, click any visible MasterBorder, or select the MasterBorder from the Object Tree.

The General tab of the MasterBorder Properties palette appears.

2. Using the MasterBorder name drop-down list, select the ZeroMargins Master Border.

This MasterBorder is provided by default with NetObjects Fusion; if it has been deleted, you must 
create a new MasterBorder of your own name with no margins. See Creating a New 
MasterBorder.

3. Select an existing text box, or create a new text box using the Text tool from the Standard toolbar.

4. Embed all objects on the Layout into the text box.

5. On the Text Box tab of the Text Properties palette, select both Size to Layout and Contents wrap 
to browser width.

When you publish this page, NetObjects Fusion generates HTML that makes the contents of the 
text box adjust to the size of the browser window.



Embedding Objects in a Text Box
There are three ways to embed objects into a text box. You can:

l Drag-and-drop existing objects into the text box from elsewhere on the page.

l Create new objects using any object creation tool except the Text tool by drawing the new object inside 
the text box. The Text tool defaults to an insertion point inside a text box. To embed a text box within a 
text box, you must drag-and-drop it.

l Insert new objects at the current insertion point, either by pasting or using the Insert Object command 
from the Text menu.

No matter which embedding method you use, the insertion point appears within the text as a grey vertical 
bar.

When you embed an object, NetObjects Fusion positions the object in a default location within the text 
box, according to its type:

l Pictures are placed inline at the insertion point.

l Text, tables, sound, video, and other objects are placed one line below the insertion point, flush left.

You can then use the options on the object’s Align tab to arrange that object within the text box. If your 
object is not inline on the text line, NetObjects Fusion displays an insertion marker to show the insertion 
point.

You can move an embedded object by dragging its insertion point into place. When you select the object, 



the insertion point is displayed, and you can manipulate its location as needed. For example, to place the 
embedded object on the top line of the text box, place or move its insertion point before the first character 
of text.



Embedding Existing Objects with Drag and Drop
1. In Page view, select the Text tool from the Standard toolbar and create a text box.

2. Select an object elsewhere on the page and drag it into the text box.

The text box boundary indicates the object will be embedded.

3. Position the drag-and-drop insertion point at the place in the text where you want to insert the 
object.

4. Drop the object.

5. Position the object within the text box where you want it. See Aligning Objects in a Text Box.



Creating New Embedded Objects
1. In Page view, select the Text tool from the Standard toolbar and create a text box.

2. Select the tool for the object you want to create and embed.

Note: Because the Text tool defaults to edit mode when you select it and click within a text box, 
you can’t draw a text box inside another text box. If you want to embed a text box within a text 
box, you have to either insert the text box using the Object menu, or create it outside the text box 
and then drag it into place.

3. Position the starting point of the object at the position in the text where you want to insert the 
object, then draw its outline.

The Open file dialog appropriate for that type of object appears.

4. Select the object source file that you want to embed and click OK.

5. Position the object within the text box where you want it. See Aligning Objects in a Text Box.



Inserting Objects into Text Boxes
1. In Page view, select the Text tool from the Standard toolbar and create a text box.

2. To insert a new object, click the insertion point at the position in the text where you want to insert 
the object.

3. From the Text menu, select Insert, then select the type of object you want to insert.

The Open file dialog appropriate for that type of object appears.

4. Select the object source file you want to embed, and click OK.

NetObjects Fusion embeds that object.

5. Position the object within the text box where you want it. See Aligning Objects in a Text Box.

You can also use this method to embed an object by pasting:

6. Copy or cut the object from another page or location.

7. Right-click the insertion point at the position in the text box where you want to insert the object.

8. Select Paste from the shortcut menu.

NetObjects Fusion inserts the object.

9. Position the object within the text box where you want it. See Aligning Objects in a Text Box.



Aligning Objects in a Text Box
Once you embed an object in a text box, you can position it as needed using the options on the Align tab 
of the Properties palette for the object. The options shown for each type of object reflect the alignment 
attributes supported by HTML.

For example, in HTML coding you can create a horizontal or vertical margin around an image: on the 
Align tab of the Picture Properties palette, you can set a horizontal or vertical space around a picture 
object.

Depending on the type of object you selected, NetObjects Fusion displays some combination of the 
following alignment options. Each option’s icon shows:

l Vertical alignment of the object to the text line: top, middle, or bottom.

l Horizontal alignment of the object to the text box, without text wrapping: left, center, or right.

l Horizontal alignment of the object to the text box, with text wrapping: left align plus text wrap, and right 
align plus text wrap. The name refers to the placement of the object, not the location of the text wrap. If 
you want the object to be embedded at the top left of the container, move the pointer to the absolute 
beginning of the text in the text box.

l Blank space around the object, in horizontal, vertical, or both dimensions.



Aligning Embedded Objects
1. In a text box in Page view, select an embedded object.

The General tab of the object’s Properties palette appears.

2. Select the Align tab of the palette. The figure below shows the Align tab for a picture object.

3. Select a vertical alignment option as appropriate for the object type.

4. Select a horizontal alignment option that is either wrapped or not wrapped, as appropriate for the 
object type.

5. Enter a spacing value for the object, if appropriate.



Defining the Text Box as a Form
You can set any text box that contains form objects to function as an HTML form, If you have form objects
in a text box that is not defined as a form, the red exclamation point error signal appears in the corner of 
the form objects.

To define a text box as a form:

1. In Page view, select the text box. 

The General tab of the text box Properties palette appears.

2. Select Text box is a form.

3. Click Settings to enter your form processing settings for this text box in the Form Settings dialog.

See Designing and Implementing Forms for information on creating forms and determining form 
processing settings.



Making Text Boxes Dynamic
You can make text boxes dynamic by adding actions to them. For example, you can make a text box 
display a transition effect such as Wipe or Peek when the site visitor’s mouse pointer passes over it, or 
make the text box “fly in” to its proper location when the page finishes loading in the visitor’s browser. 
You can also make a text box the target of an action assigned to another object.

See Building Dynamic Pages for a discussion on making pages and objects dynamic, and the procedures
for adding actions to text boxes.

You can also add actions to a text link contained within a text box. See Assigning an Action to a Text Link.



Using Tables for Page Layout
If your page design or page content is tabular, you can use a NetObjects Fusion table to control the layout
of the entire page. Each cell within the table is a text box, with all the attributes and controls of a text box 
outside the table. You can embed any objects within the cell, arrange them using each object’s alignment 
properties, and wrap text around other objects.

To use a table for your page layout: add a table object, size it by hand to fill the Layout, and add content 
as needed. See Laying Out the Page    for detailed information on creating and modifying tables.



Using External HTML for Page Layout
You can also lay out your page using hand-coded HTML. You can incorporate external HTML pages as 
part of your site by referencing them as objects on a page, or the page itself. NetObjects Fusion makes 
no changes to the original HTML, but it will manage the assets required by the original page if told to do 
so. See Referencing HTML from Page View for information on incorporating external HTML pages.



Selecting Layout Method
There’s no single “best way” to lay out your pages; your circumstances will determine which method 
works best for selected pages. The pros and cons of each method are highlighted in the following topics:

l Text box considerations

l Layout considerations

l Layout region considerations



Text Box Considerations
If efficient, lean HTML pages are more critical to your site visitors than precise placement of your content, 
use a text box for your page layout.

Text Box Advantages
l NetObjects Fusion generates extremely efficient HTML code for your site. HTML files are much smaller,

which means they load faster, and your site visitors experience a more responsive site.

l Text within the text box flows around other embedded objects automatically, so you don’t have to 
create multiple text boxes to achieve a text-wrap effect.

l If the text box is the size of the Layout and you have chosen the ZeroMargins MasterBorder, you can 
set the text box to resize itself to the size of the browser window. When your site visitor views the page,
it rewraps itself as necessary to fit within and fill the browser window.

l You can use any of NetObjects Fusion’s HTML output types: nested tables, regular tables, or CSS and 
Layers.

l You can present tabular or columnar data in a NetObjects Fusion table, each cell of which consists of a 
text box.

Text Box Limitations
l You give up pixel-level control of the layout and design of your page, and use alignment choices to 

control the placement of objects.



Layout Considerations
If precise placement of your content is more critical to your site visitors than efficient, lean pages—or if 
you have individual pages that you want to publish using a specific HTML output method, different from 
the rest of the site—then use the Layout as the container for your page layout.

Layout Advantages
l You have pixel-level control of the layout and design of your page.

l You can drag-and-drop objects into their proper locations with ease.

l You can specify the HTML output type for any individual Layout; this lets you isolate any advanced 
content—which can exclude site visitors who are using lower-version browsers—from the rest of your 
site.

l Layouts support the column or row priority for page formatting; this means your pages will adjust more 
predictably to your site visitor’s font and display configuration.

Layout Limitations
l Position-based pages require more HTML code to achieve pixel-level placement of content, so your 

HTML files will be larger.

l Text cannot flow around other objects unless they are embedded in a text box. If you want to create the
text wrap effect you have to create multiple text boxes.

l You can size the Layout as you see fit, but you cannot set the Layout to wrap to the width of your site 
visitor’s browser. If the browser window is wider than your page, the page’s background will fill in; if the
window is smaller than your page width, your site visitor has to scroll right or left.



Layout Region Considerations
In some respects, Layout Regions represent a “best of both worlds” option for laying out your page. Like 
Layouts, Layout Regions offer pixel-precise placement and a choice of HTML output methods—but they 
can be embedded in text boxes. So, if you need precise placement or specific output for some content, 
but want NetObjects Fusion to generate efficient, lean pages, you can use text boxes as your main layout 
container, and embed Layout Regions for selected content.

Layout Region Advantages
l You have pixel-level control of the layout and design of content within the Layout Region.

l You can embed the Layout Region within a text box, which combines the benefits of both containers.

l You can specify the HTML output type for any individual Layout Region, so you can isolate advanced 
content that can exclude site visitors who are using lower-version browsers.

l Layout Regions support the column or row priority for page formatting; this means that selected 
sections of your page, when contained in a Layout Region, can adjust more predictably to your site 
visitor’s font and display configuration.

Layout Region Limitations
l NetObjects Fusion has to generate much more HTML code to achieve pixel-level placement of content.

Your page files are significantly larger, and download more slowly to site visitors.

l Text cannot flow around other objects unless they are embedded in a text box. If you want to create the
text wrap effect, you have to create multiple text boxes within the Layout Region.

l You can size the Layout Region, as you see fit, but you cannot maximize it to the full Layout size, nor 
can you set the Layout Region to wrap to the width of your site visitor’s browser.



Design Priorities and Method Choices
Use the table to determine which combination of layout methods and HTML output methods best supports
your site design priorities.
If your priority is... Suggested page 

layout method
Suggested HTML
output method

Lean, efficient HTML and fast 
browser load time

Text box or page-sized table Nested Tables

Precise placement control for 
objects

Layout and/or Layout 
Region(s)

Nested Tables

Maximizing usability for site visitors 
with older browsers

Text box sized to Layout Regular Tables

Absolute control over minimum text 
box height 

Text box with size locked Nested Tables

Precise placement control for 
selected content, but lean HTML 
otherwise

Text box for page with 
embedded Layout Region for 
selected content

Nested Tables

Wrapping text around images and 
other objects

Text box and/or table Nested Tables

Overlapping selected objects Text box for page; overlapped 
objects in Layout Region 
embedded in the text box

Nested Tables for 
site; CSS and Layers
for Layout Region 
containing 
overlapped objects

Wrapping page to varying browser 
sizes

Text box sized to Layout with 
content wrapped to browser

Nested Tables

Drag-and-drop placement of objects
while designing the page

Layout and/or Layout Region Nested Tables

Horizontal or row-based content 
flow such as spreadsheets or other 
tabular data

Table sized to page Nested Tables

Delivering objects with actions or 
other DHTML effects only to 
advanced browsers

Text box and/or table CSS and Layers

Delivering objects with actions or 
other DHTML effects to greatest 
number of browser versions

Text box for page; objects with 
actions in Layout Region 
embedded in the text box

Nested Tables for 
site; Regular Tables 
for Layout Region 
containing objects 
with actions

Using cascading actions Text box for page; embedded 
Layout Regions containing 
objects with actions, grouped 
for cascading messages

Nested Tables





Designing with Text 
When you want to add text to a NetObjects Fusion page, you create a text box, then add, edit, and format
the text within the box. You can also place objects in a text box and wrap text around the objects. Any 
object you can place on a page you can also add to a text box, including sounds, videos, plugins and 
Java applets, as well as pictures and lines.

Using a text box as a container can help reduce the size of your HTML code. See Laying Out the Page.



Working with Text Boxes
In NetObjects Fusion, a text box is a container into which you can add text and embed other types of 
objects. How you select a text box determines what you can do with it.

To select a text box for text editing:

u Using the Selection tool, double-click in the text box.

To select a text box as an object:

u Using the Selection tool, click inside the text box.



Working with a Text Box as a Text Editor
When a text box is a text editor, the handles around the text box are hollow, and NetObjects Fusion 
displays the Format tab, as well as the Text Box and Actions tabs, on the Text Properties palette.

When a text box is a text editor, you can:

l Add, edit, and format text.

l Add, edit, and format paragraphs, including creating simple and multi-level bulleted and numbered lists.

l Change the appearance of text by selecting font, font size, and font style and assigning a color to the 
text.

l Create text styles so you can replicate and update paragraph formatting easily.

l Insert HTML tags. See Inserting HTML in a Text Box.

l Import an HTML page.

l Link text to images or other text. See Creating Links and Anchors.



Working With a Text Box as an Object
When the text box is selected as an object, the handles are solid and NetObjects Fusion only displays the
Text Box and Actions tabs on the Text Properties palette.

When the text box is an object, you can:

l Cut, copy, and move the text box.

l Place objects in the text box.
l Delete the text box and all its contents.



Adding Text
You add text to a page in one of three ways:

l Use the Text tool

l Drag and drop a text file

l Paste text from the Clipboard



Using the Text Tool

1.  In Page view, select the Text tool from the Standard toolbar, then draw a box on the 
page.

The text box appears on the page in text edit mode and the Format tab of the Text Properties 
palette appears.

2. Type or paste text in the text box.

Text wraps to the width of the text box.



Dragging and Dropping a Text File
u In Windows Explorer, locate the text file, select it, then drag and drop it onto the page.

The text appears on the page in a text box. The text box is a text editor and the Format tab of the Text 
Properties palette appears.



Pasting Text from the Clipboard
1. Cut or copy the text from its original source, such as a word processing file.

2. In Page view, click where you want to place the text on the page.

3. From the Edit menu, choose Paste.

The text appears on the page in a text box. The text box is a text editor and the Format tab of the 
Text Properties palette appears.



Setting Text Box Properties
1. In Page view double-click in the text box, then click the Text Box tab.

2. Select None to eliminate text box background color, or click Color and select a background color 
from the Color Picker. See Choosing Colors.

3. If you added a background color to the text box, specify the number of units you want to inset the 
text within the text box.

Note: Insetting text from the text box boundaries creates a new table in HTML.

4. Select Lock height to keep the text box from contracting to fit with the text. This is the 
recommended setting. Locking the height of a text box helps preserve object location when 
browser-related font changes occur.

5. Select Size to Layout to make the text box the page’s Layout. See Using Text Boxes.

6. Select Text box is a form and click Settings to make the text box a form. See Designing and 
Implementing Forms.



Applying Text Styles
Text styles are predefined sets of font and paragraph formats. Text styles are a convenient way to specify,
replicate, and update paragraph formatting.

1. In Page view, if the text box in which you want to apply Text styles is not a text editor, choose the 
Selection tool and double-click in the text box.

2. Click anywhere in the paragraph you want to format. 

Select multiple consecutive paragraphs if you want to apply the style to multiple paragraphs.

3. In the Paragraph section on the Text Properties palette, select the appropriate text style from the 
Style drop-down list.



Formatting Text and Paragraphs
Text normally assumes the font assigned to it by a browser, but NetObjects Fusion lets you assign unique 
fonts to your text. If the specified font is installed on the site visitor’s system, HTML 3.x-compatible 
browsers display it. If the font is not installed, the browser checks a substitution table before using its 
default font. You can find the substitution table in NetObjects System\fontmap.txt, and edit it with any 
text editor.

The Text Properties palette contains the options you can use for formatting selected characters and whole
paragraphs when you want specific formatting for one-time use. For repeated formatting of paragraphs, 
use a text style as explained in Applying Text Styles.

Note: You can format selected characters only in text boxes or table cells. On a stacked page, you can 
format selected characters in formatted text fields, but in simple text fields, all characters have the same 
format. For more information on data fields, see Data Publishing.

To format text properties, in Page view, select the Text tool, then double-click in the text box in which you 
want to format text or paragraphs to put the text box in text edit mode.



Formatting Text 
1. In Page view, select the text you want to format.

2. Select a font from the Font drop-down list on the Text Properties palette.

3. Click a font style button to assign characteristics—bold, italic, underline, and strikethrough—to the
text.

Click a font effects button to superscript or subscript the text.

4. Select the size you want to assign to the font from the Size drop-down list.

5. To assign a color other than the SiteStyle color to the text, click Color and select a color from the 
Color Picker. See Choosing Colors.



Formatting Paragraphs
Using the Text Properties palette, you can select left, right, or centered paragraph alignment, indent a 
whole paragraph, or create a simple bulleted or numbered list. See Creating Multi-Leveled Numbered and
Bulleted Lists.

Note: Due to limitations in HTML standards, you cannot insert a Tab character in a text box—for example,
to indent the first line of a paragraph. You can only indent a whole paragraph. While you are editing a 
paragraph, Tab and Shift + Tab are keyboard shortcuts for indenting and unindenting the paragraph.

To format a paragraph:

1. In Page view, click in the paragraph you want to format.

2. In the Paragraph section of the Text Properties palette, click the appropriate alignment button to 
align the paragraph.

3. To indent the paragraph, click one of the indent buttons.

4. To use a color other than the SiteStyle color for the paragraph, click Color and select a color from 
the Color Picker.

5. To create a simple numbered or bulleted list, select an option from the Bullet drop-down list.

6. To start a numbered list with a value other than 1 or A, click Start Value, enter a number in the 
Start value field in the Start Value of Numbered List dialog, then click OK.



Creating Multi-Leveled Numbered and Bulleted Lists
You can create a bulleted or numbered list with multiple levels. For example, you can create a bulleted list
that contains subordinate bullets.

l This is an example of a level 1 bullet.

– This is an example of a level 2 bullet.

You can also create a numbered list that has subordinate paragraphs within the list:

1. This is an example of the first level in a multi-level numbered list.

a. This is an example of the second level in a multi-level numbered list.

2. This an example of the first level in a multi-level numbered list.

To create a multi-leveled numbered or bulleted list:

1. In Page view, double-click in the text box, then type the text you want to include in the list. Make 
each item in the list a separate paragraph.

2. Click in the first paragraph of the list, then select a list type from the Bullet drop-down list. If you 
select a numbered list and want to start the list with a value other than 1 or A, click Start Value 
and enter a number in the Start Value of Numbered List dialog. Then click OK.

3. If you want this paragraph to be indented, click the right indent arrow.

4. Select the paragraph or paragraphs you want to make subordinate to the one you selected in the 
previous step.

5. Use the right indent arrow to indent the subordinate paragraph so it is to the right of the superior 
paragraph. Then select a list type from the Bullet drop-down list.

6. Select the next paragraph you want to be a superior paragraph. Indent it to the same level as the 
paragraph you formatted in step 2.

The paragraph adapts the list style you selected in step 2 to the current paragraph. If you 
selected a numbered list style, the paragraph is numbered sequentially. For example, if you 
selected a roman numeral list style starting at 1 in step 2, the current paragraph is numbered II.



Creating and Modifying Text Styles
You can create your own text styles and add them to the Styles list or modify the default text styles 
included with NetObjects Fusion.

Text styles can be based on other text styles. For example, if you create text styles for headings, you 
could specify the formatting for the H1 style, then create an H2 text style that is based on H1. You would 
only have to specify formatting that differs from H1; for example, the font size or style.



Creating a Text Style
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Click New.

The New Style dialog appears.

3. Enter a name for the new text style and if you like, select a text style on which to base this new 
style from the Based on drop-down list.

4. From the Following Paragraph drop-down list, select the text style you want to appear 
automatically after the style you are creating. Leave it blank if you want the following paragraph to
be the same style as the one you are creating.

5. Click Paragraph to modify paragraph settings.

The Paragraph dialog appears. Set the options you want:

l Specify the number of units you want to indent the paragraph in the Indent Level section.

l If you are creating a text style for a list, either select a bullet type or a numbered list 
option from the Bullet list.

l To start a numbered list with a value other than 1 or A, click Start Value and enter a 
number in the Start value field in the Start Value of Numbered List dialog. Then click OK.

l Specify how you want the paragraph to be aligned by selecting an option in the Alignment
section.

Click OK in the Paragraph dialog.

6. In the New Style dialog, click Font to select another font or modify the size, style, effect, or color 
of the font. If you don’t want to modify the font, skip to step 8.

The Font - [style name] dialog appears.

l Select the font, font style, and size you want to specify for the text style. The font size 
numbers represent size relative to your site visitor’s default browser font size.

l In the Effects section, click the check box for the effect or effects you want to specify for 
the style.

l To assign a color other than the SiteStyle color to the text, click Color, select a color from 
the Color Picker, and click OK.

Click OK in the Font dialog.

The changes appear in the Preview and Description sections of the New Style - [style name] 
dialog.

7. In the New Style dialog, click OK.

The new style is added to the Styles list in the Text Styles dialog.

8. Click Close.



Modifying Styles
1. In Page view, from the Text menu, choose Edit Text Styles.

The Text Styles dialog appears.

2. Select the style you want to modify, then click Change.

The Change Style - [format name] dialog appears.

3. In the Change Style dialog, you can change any of the options assigned to the paragraph.

For information on this dialog, see Creating a Text Style.

4. When you are finished, click OK in the Change Style dialog.

5. In the Text Styles dialog, click Close.

NetObjects Fusion updates any paragraph to which you applied the style with the new 
description.



Modifying Styles by Example
You can also modify a text style by formatting a paragraph then reapplying the style.

1. In Page view, select a paragraph that is in the style you want to modify, so the style name is 
selected in the Style list on the Text Properties palette.

2. Select the text and use the Properties palette to change it to the font, size, style, color, and 
alignment you want.

3. Select the style again from the Style list.

The Reapply Style dialog appears, showing the name of the selected style.

4. Select Redefine the style using the selection as an example and click OK.

Note: If you select Reapply the formatting of the style to the paragraph, you lose all your changes and the
paragraph returns to its original settings for that style.

The selected style now has the changed format, and all paragraphs with that style are updated.



Inserting Symbols
You can insert special symbols, such as an em dash, copyright symbol, registered trademark symbol, and
so on.

1. In Page view, if necessary, double-click inside a text box to put it in text edit mode.

2. Click where you want to insert the symbol.

3. Select Insert Symbol from the Text menu.

4. Select the symbol you want to insert from the Insert Symbol dialog, then click Insert.

The symbol appears in the text.



Wrapping Text around Objects
You can wrap text around objects by embedding the object in a text box.

1.  In Page view, select the Text tool from the Standard toolbar and draw a box on the 
page.

2. Select the appropriate tool from the Standard toolbar and embed the object in a text box.
See Embedding Objects in a Text Box.

The Picture Properties palette appears.

3. Click Align.

The Align tab appears.

4. Set the wrap options you want.

l In the Alignment section, select the appropriate wrap option. If you select Left wrap, the 
text wraps around the right side of the object; if you select Right wrap, the text wraps 
around the left side of the object.

l In the Space around object section, specify the amount of space you want to leave 
between the image and the text.

5. Enter the text.

The text wraps around the object according to your specifications.



Setting Paragraphs to Clear Wrapped Objects
You can force the paragraph that follows a wrapped paragraph to clear the wrapped object.

1.  In Page view, select the Text tool from the Standard toolbar and draw a box on the page.
2. Select the appropriate tool from the Standard toolbar and embed the object in a text box. Specify 
how you want the text to wrap around the object using the Align tab on the Picture Properties palette.
3. Enter the text and press Enter.

To embed another object, continue to step 4. Otherwise, skip to step 5.

4. If you want, embed another object and specify how you want the text to wrap around it. Enter the 
text, and then press Enter.

5. In the Paragraph section of the Format tab of the Text Properties tab, do one of the following:

l Select the Left check box to restart the text at the first left margin that is clear of a picture.

l Select the Right check box to restart the text at the first right margin that is clear of a 
picture.

l Select both check boxes to restart the text when both the left and right margins are clear 
of a picture.



Creating and Editing Fields
NetObjects Fusion provides a list of fields you can include on your pages, such as the date and time the 
site was created or last modified, the site name and author, and so on. You can also define your own 
fields to include on your pages.



Inserting a NetObjects Fusion Defined Field
1. In Page view, double-click in the text box, then put the pointer where you want to insert the field.

2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select the type of field you want to insert from the Type drop-down list.

If you select Date & Time, select a date format by clicking Date Format. Then select a format from
the list displayed in the Date Format dialog. Click OK.

4. Click OK in the Insert Field dialog.



Creating a User-Defined Variable
A user-defined variable is text or a phrase that is subject to change. For example, you might refer to a 
product in development that has only a code name. The name appears on many pages in your site. By 
creating a user-defined variable, you can insert the product name as a field. When the product name 
changes, you can edit the field as described in Editing a Variable. Then NetObjects Fusion automatically 
updates all the instances of the name in your site.

1. In Page view, double-click in the text box where you want to insert a user-defined variable.

2. From the Text menu, choose Insert Field.

The Insert Field dialog appears.

3. Select User defined Variable from the Type drop-down list.

4. Click New.

The New Variable dialog appears.

5. Type a name and value for the field and click OK.

The field appears highlighted in the Field list of the Insert Field dialog. 

6. Click OK.



Formatting a Date & Time Field
1. In Page view, click the Date & Time field.

2. From the Text menu, choose Edit Field.

The Edit Field dialog appears.

3. Click Date Format on the Edit Field dialog, then select a new format from the Select format list. 
Click OK in the Date Format dialog.

4. Click OK in the Edit Field dialog.



Checking Spelling
You can check the spelling of English language words using the spelling checker that is included with 
NetObjects Fusion. You can add words to a personal dictionary so they will no longer be flagged as 
misspelled. Your personal dictionary is a simple text file, so you can use any text editor to add or delete 
words.

The spelling checker checks one page at a time.

1. In Page view, choose the text you want to check.

l To check all text boxes and tables on the page, select nothing.

l To check a particular block of text or an individual word, select it.

2. From the Edit menu, choose Spell Check.

If NetObjects Fusion does not recognize the word, it displays the word in the Change To field of 
the Spelling dialog.

3. Choose to correct the selected word, ignore it, or add it to your dictionary. Click:

l Ignore to skip this instance of the word.

l Ignore All to skip all instances on this page.

l Change to replace this instance.

l Change All to replace all instances on this page.

l Add to put the word in your personal dictionary.

l Suggest to see alternate spellings for the word in the Change to field. You can replace a 
misspelled word with a suggestion by double-clicking the suggestion.

l Options to choose U.S. or UK English, and to choose a location for your personal 
dictionary.

l Close to cancel the spelling check.



Finding Text
1. In Page view, choose Find from the Edit menu.

2. In the Find what field on the Find dialog, type the word, letters, or phrase you want to find and 
select any options you want to use to narrow your search.

3. Click Find Next.



Replacing Text
1. In Page view, from the Edit menu, choose Replace.

2. In the Find what field on the Replace dialog, type the text you want to replace.

3. In the Replace with field on the Replace dialog, type the replacement text.

4. Select any options you want to use to narrow your search.

5. Click Find Next to find the next instance of the text you want to replace, then click Replace to 
replace it, or click Replace All to replace all instances of the found text with the replacement text.



Counting Words, Lines, and Paragraphs
u To get a word count for the current page, in Page view, choose Word Count from the Edit menu.

u To get a word count for a section of text, highlight the text, then choose Word Count from the Edit 
menu.

The Page Word Count dialog appears displaying a list of word, line, paragraph and character counts. If 
your text box includes embedded objects, the line count is incremented for each embedded object.



Adding Tables
When you want to add a table to a page, place the table, define its appearance, then add text in table 
cells, which are text boxes. You can embed objects in table cells as you would in text boxes.



Working with Tables
Presenting information in tabular form is often an effective way to convey complex concepts and ideas. 
NetObjects Fusion makes it easy to add tables to a site.

Table cells are text boxes in which you can add text and embed objects. In table cells you can:

l Add text by typing or pasting it.

l Format text using text styles or by selecting individual paragraphs and words and specifying paragraph 
alignment, font, font size, and font style and effect.

l Embed objects in a table cell. See Embedding Objects in a Text Box.

l Wrap text around objects. See Wrapping Text around Objects.

l Create a form. See Designing and Implementing Forms.

The following is an example of a table with text and embedded objects.



Adding a Table
When you add a table to a page, you place it, specify the number of rows and columns, and define its 
appearance.

1.  In Page view, choose the Table tool from the Standard toolbar, then draw a box where 
you want the table to appear on the page.

The Table dialog appears.

2. Select the number of columns and rows you want, then click OK.

The table appears on the page and NetObjects Fusion displays the Table Properties palette.

3. In the Cell section of the General tab, define the appearance of the table. Specify:

l The size of the border surrounding the table.

l The padding: the amount of space you want to leave between the contents of a table cell 
and the cell boundaries.

l The distance between cells.

4. To modify the cell’s background color, click the Background tab, then click Color, select a color 
from the Color Picker, and click OK.



Selecting a Table
u In Page view, select the Selection tool from the Standard toolbar, then click the table.

Solid handles appear around the table. With the table selected you can:

l Move the table on the page.

l Delete the table.

l Insert a row at the bottom of the table or delete the last row.

l Add a rightmost column to the table or delete the rightmost column.

l Resize columns and rows.



Selecting a Table Cell
u In Page view, select the Selection tool from the Standard toolbar, then double-click the table cell.

Cross-hatching appears around the selected cell and dotted lines appear around the text box.

With the table cell selected, you can:

l Add and format text.

l Specify text box properties.

l Insert objects.

l Wrap text around objects.

l Insert a row beneath the currently selected cell or delete the selected row.

l Insert a column to the right of the currently selected cell or delete the selected column.



Selecting a Text Box in a Cell
1. In Page view, select the table cell.

2. Click the boundary of the text box.

Solid handles appear around the text box. With the text box selected you can:

l Delete its contents.

l Specify text box properties.



Making a Table Cell a Form
1. In Page view, double-click in the table cell.

The Text Properties palette appears.

2. On the Text Box tab, select the Text box is a form option.

See Designing and Implementing Forms.



Adding Text and Objects to a Table Cell
1. In Page view, select the cell.

2. Type or paste text in the cell and format the text.

The Text Properties palette appears. Text automatically wraps to fit the column size of the cell; the
cell expands vertically to accommodate the text. See Formatting Text and Paragraphs.

3. Embed objects and align them in the cell.

For example, center a picture using options on its Align tab. See Embedding Objects in a Text 
Box.



Modifying a Table
You can modify a table by changing the cell properties, adding and removing rows and columns, and 
resizing rows and columns.



Modifying Cell Properties
1. In Page view, select the table.

The Table Properties palette appears.

2. In the Cell section of the General tab, adjust the border size, padding between the cell boundary 
and cell contents, and spacing between cells.

3. To modify the cell’s background color, select the Background tab, then click Color, select a color 
from the Color Picker, and click OK. 



Modifying a Cell's Text Box Properties
1. In Page view, select the cell.

The Text Properties palette appears. 

2. Click the text box boundary.

Solid handles appear around the text box and the Text Properties palette displays the Text Box 
tab and the Action tab.

3. Modify Text Box properties. See Working with a Text Box as an Object.



Resizing Columns and Rows
1. In Page view, select the table.

2. Point to the column or row you want to resize.

The pointer changes to a horizontal arrow.

3. Click and drag the cell boundary to the new size.



Inserting a Row
1. In Page view, select the item above where you want the row to be inserted.

l To insert a row at the bottom of the table, select the table.

l To insert a row between two existing rows, select a cell in the row you want to be on top 
of the row you’re inserting.

2. From the Object menu, choose Table, Add Row.



Removing a Row
1. In Page view, select where you want to delete the row.

l To remove the last row in a table, select the table.

l To remove a row from between two existing rows, double-click a cell in the row that you 
want to remove.

2. From the Object menu, choose Table, Remove Row.



Inserting a Column 
1. In Page view, select where you want to insert the column.

l To insert a rightmost column to your table, select the table.

l To insert a column between two existing columns, double-click a cell in the column to the 
left of where you want to add the new column.

2. From the Object menu, choose Table, Add Column.



Removing a Column
1. In Page view, select the column you want to remove.

l To remove the rightmost column, select the table.

l To remove a column from between two columns, double-click a cell in the column you 
want to remove.

2. From the Object menu, choose Table, Remove Column.



Placing Pictures
Pictures are essential building blocks for any page design.



Choosing an Image Format
To display a picture, most browsers require that the picture is stored in a Web-standard format. When you
place an image on a page, NetObjects Fusion offers the following standard formats:

l Joint Photographic Experts Group (.jpeg, .jpg) supports 24-bit true color.

l Graphics Interchange Format (.gif) supports 8-bit, 256-color images. NetObjects Fusion also supports 
GIF 89, a format for transparency, interlacing, and animation. If your .gif is interlaced or transparent, 
NetObjects Fusion parses this information.

NetObjects Fusion also supports animated .gif files. An animated .gif file contains multiple images that 
a browser plays in sequence. It adds movement to your pages without requiring browser plugins. You 
use a .gif animation program to create an animated .gif image and place it as you would any .gif.

l Portable Network Graphics (.png) supports any color-depth image. Web browsers require a plugin 
called PNGLive to view the image.

NetObjects Fusion includes sample pictures in the NetObjects Fusion 3.0\Samples\Content\Images 
folder. When you place a picture, NetObjects Fusion offers to convert image files that are not in a Web-
standard format, such as Photoshop, .bmp, and so on, to either .png or .jpg format.

Use the Picture tool to place Flashpix (.fpx) images in a Layout in Windows NT only. Use the Media Plug-
in tool, as described in Inserting Other Types of Files to place an .fpx image in either Windows 95 or 
Windows NT.



Adding Pictures

1.
 In Page view, choose the Picture tool from the Standard toolbar, and draw a box where you want to 

place the picture.

The Picture File Open dialog appears.

2. Select the image file you want from your hard disk, CD-ROM, or LAN.

NetObjects Fusion provides filters so you can view only the type of file you want to place. The 
filters are listed in the File of type drop-down list. You can select:

l Web images, to view all image files that can be viewed using a Web browser, including
.gif, .jpeg, .jpg, and .png.

l All images, to view all files that are image files.

l Unique images, to view image files by a single file type, such as all .gif files or all .jpeg 
files.

You can also drag and drop an image file directly onto a NetObjects Fusion page from your 
desktop or the Windows Explorer.

3. Select the Show thumbnail image option to preview your image before you add it to the page.

A thumbnail preview of the selected picture appears on the right side of the dialog.

4. Click Open to place the image in the box.

If you select a non-standard Web format, you are asked to convert the file.

l If you convert to .gif, NetObjects Fusion reduces the image to 256 colors.

l If you convert to .jpeg, NetObjects Fusion retains the color information of the original file.

l If you choose not to convert, NetObjects Fusion positions the image in HTML using the 
<EMBED> tag. This means only those browsers that have the appropriate plugin installed
can view the image.

5. Choose the appropriate conversion format and click OK.

If you choose an image in Web-standard format, the picture appears where you drew the box. 
The box snaps to fit the placed picture. The Picture Properties palette also appears.

6. Type a description of the picture in the AltTag field.

Note: The alt tag is not linked if the picture is an image map. See Creating an Imagemap.

For information on how to manipulate the picture, see Modifying a Picture. To place additional instances 
of a picture, see Using Image Assets.

You can also place an image by dragging and dropping it from the desktop or the Windows Explorer.

Note: When you use drag-and-drop to place a picture that is not in .gif or .jpeg format, NetObjects 
Fusion positions it in HTML using the <EMBED> tag instead of the <IMAGE> tag.



Modifying a Picture
Once you place a picture you can:

l Resize, crop, tile, or rotate it.

l Add a border around it.

l Change its transparency (.gif files only).

l Move or copy it.

l Add text to it.



Resizing a Picture
1. In Page view, select the picture you want to resize.

The Picture Properties palette appears.

2. Set the picture’s Display property to Stretch.

3. Drag any handle until the picture is the size you want.

To size the picture proportionally, hold down the Ctrl key as you drag.

4. To return the picture to its original size, do either of the following:

l From the Object or shortcut menu, choose Restore Original Size.

l Select Normal in the Picture Properties palette.



Cropping a Picture
You can crop a picture to make only a part of it visible. When you crop a picture, NetObjects Fusion 
creates a new image file that contains just the visible portion of the image. It does not change your 
original image file.

1. In Page view, select the picture you want to crop.

The Picture Properties palette appears.

2. In the Display area on the Picture Properties palette, select Normal.

When Normal is selected, you cannot make a picture larger than its original size.

3. Drag the lower-right handle, reducing the size of the box to crop the picture. To crop 
proportionally, hold down Ctrl as you drag.



Tiling a Picture
You can create multiple instances of the picture within the box by tiling it. When you tile a picture, 
NetObjects Fusion creates a new image file that contains the tiled image. It does not change your original 
image file.

1. In Page view, select the picture you want to tile.

The Picture Properties palette appears.

2. In the Display section of the Picture Properties palette, select Tile.

NetObjects Fusion displays multiple images of the picture in the box. The images are the size of 
the picture as it is in the source file.

3. Drag any handle to display more or fewer tiled images.



Rotating a Picture
After you place a picture, you can rotate it in 90-degree increments. When you rotate a picture, 
NetObjects Fusion creates a new image file that contains the rotated image. It does not change your 
original image file.

1. In Page view, select the picture you want to rotate.

The Picture Properties palette appears.

2. Select the Effects tab.

3. In the Rotate field, select the desired rotation.



Creating a Border Around a Picture
You can add a border of a specified thickness around a picture.

1. In Page view, select the picture for which you want to create a border.

The Picture Properties palette appears.

2. Select the Effects tab.

3. Use the Border field to specify the thickness of the border.



Creating a Transparent GIF
When you place a .gif image on a page, you can select one of its colors and make every pixel of that 
color transparent. Browsers display all pixels in the image except pixels marked transparent. Although 
only part of the image becomes transparent, a .gif with a transparent color is called a transparent .gif. 
You can use transparent .gif files to achieve a natural image shape rather than a rectangular one, or to 
silhouette an image against the page background.

Only pixels of exactly the same color can be transparent. If the image background color is dithered, it 
might contain a mixture of different shades to approximate a color. An image without dithering in the 
background works best.

Note: Transparency only works with .gif files. You cannot set a transparency for a .jpeg or other image 
file format.

To create a transparent .gif:
1. In Page view, select the picture for which you want to create a transparent .gif.

The Picture Properties palette appears.

2. Select the Effects tab.

3. Click the Transparency dropper, then click the color in the picture that you want to make 
transparent.

The Use Color check box is selected, and NetObjects Fusion displays the color you selected in 
the box next to it.

4. To make a transparent color opaque, clear the Use Color check box.



Moving or Copying Pictures
You can move or copy pictures from layout to layout in Page view using the Cut, Copy, and Paste 
commands on the Edit menu, or by using the shortcut menu. You can also copy a picture by holding down
Ctrl while you drag.

To move or copy a picture onto a different layout:

1. In Page view, select the picture you want to move or copy.

2. From the Edit menu, choose Cut or Copy.

3. Locate the target layout.

The target layout can be on another page or it can be a different layout on the same page.

4. From the Edit menu, choose Paste.

NetObjects Fusion pastes the picture into the new layout.

5. Reposition the picture, as necessary.

Note: To specify the position of an object before you paste it, cut or copy the object, click the page, and 
then paste the object. The upper-left corner of the pasted object appears at the point where you clicked 
the page.



Adding Text to a Picture
You can add text to a picture and format its font, size, and alignment. The text you add becomes part of a 
new image file when you publish the page containing the picture. Your original file is unchanged.

1. In Page view, select the picture to which you want to add text.

The Picture Properties palette appears.

2. Select the Effects tab.

3. In the Text in element section of the Effects tab, select Enable, and click Settings.

The Text in Element Settings dialog appears.

4. Replace the highlighted text with the text you want to add. Press Enter to type additional lines of 
text.

5. Click Set for the Font to open the Font dialog.

6. Select the font, its style and size, and then click OK.

7. Click Set for the colors in the Text in Element Settings dialog to open the Color Picker.

8. Select the color you want to apply to the text.

See Choosing Colors.

9. In the Text in Element Settings dialog, select the Relative Alignment, Horizontal Position, and 
Vertical Position for the text.

The Relative Alignment left-aligns, centers, or right-aligns two or more lines of text. It has no 
effect on single lines of text.

The Horizontal Position and Vertical Position settings place the text block within the picture box.

For example, if you set the Relative Alignment to Left, the Horizontal Position to Center, and the 
Vertical Position to Bottom, NetObjects Fusion left-aligns the block of text and places it in the 
bottom center of the box.

10.In the Orientation area, move the slider to rotate the text.

Select Right angles to limit the text rotation to 90-degree increments.

11.Click Close to apply the text settings to the picture’s text. 



Using Image Assets
By treating image files as assets, NetObjects Fusion provides you with a convenient way to replace or 
update multiple instances of an image. Using Image Assets can also reduce the number of image files 
included in your site. Instead of adding multiple copies of an image file in several locations, you add the 
image asset once and then select from the list of existing image assets when you want to place another 
instance of the picture.

When you export a template, NetObjects Fusion copies your image file assets from wherever they are 
located on your hard disk to an Assets folder within your template folder.

Whenever you place a picture on the page, you add a file asset. You can also add image file assets in 
Assets view. See Adding File Assets.

To place an image asset:

1.  In Page view, choose the Picture tool from the Standard toolbar and draw a box to 
specify where you want to place the picture on the page.

The Picture File Open dialog appears with the Folder tab on top.

2. Click the Image Assets tab to see a list of current assets.

3. Select the Show thumbnail image option to preview the picture before adding it to the page.

4. Select the asset you want to place and click Open.

NetObjects Fusion places the image in its box and opens the Picture Properties palette. You can replace 
all instances of this picture in your site using a single command in Assets view, as described in Replacing 
File Assets.



Editing a Picture
In Page view or Asset view, you can open a picture in the editor you have set up for the image’s file type. 
For information on how to set up this feature, see Editing Objects and Assets.

1. In Page view, select the picture and, from the Object menu, choose Open Object.

NetObjects Fusion opens the picture in the editor you specified for the file type. Edit and save the 
picture according to the editor’s features.

2. To see the changes in Page view, right-click the picture and choose Restore Original Size from 
the shortcut menu.



Drawing Shapes and Lines
In addition to pictures, shapes and lines are essential building blocks for any page design. You can draw 
rectangles, rounded rectangles, ellipses, and polygons, as well as HTML horizontal rules, lines, or 
SiteStyle lines. You can select colors for a shape’s fill and border, add text to shapes, select a color for 
lines, or place a line picture from the SiteStyle you use for your site.



Drawing Shapes

To draw an ellipse, rectangle, rounded rectangle, or polygon:

1. In Page view, select the Draw tool on the Standard toolbar, and select the shape you want to add 
from the flyout.

2. Draw the shape on the page.

l  To draw a polygon, click to set the start point, click to set each subsequent point, and
double-click to complete the shape.

l  When you draw a rounded rectangle, NetObjects Fusion supplies one extra handle inside 
the object. Use this handle to edit the degree of curve on the corners.

The Properties palette for the shape you selected appears.

3. Type an alt tag in the AltTag field.

See Adding and Modifying Alt Tags.

4. In the Line width box, set the shape outline thickness.

To make the outline invisible, set it to zero.

5. In the Color section of the Properties palette, click the Color button for Fill.

6. In the Color Picker, choose the color you want to use for the shape fill color and click OK.

See Choosing Colors.

7. Click the Color button for Line, select the color you want to assign to the shape border in the 
Color Picker, and click OK.

8. To adjust the shape or size of the drawing, drag its handles.

l To change the shape proportionally, drag a handle while holding down Ctrl.

l To vary the curve of a rounded rectangle, select it, place the pointer over the inside 
corner handle until it changes to a four-headed arrow, then drag toward the inside or 
outside until you have the desired curve.

l To edit the lines of a polygon, select it, place the pointer over any handle until you see the
four-headed arrow, then drag the handle to adjust the shape.

l To create hotspots, see Creating an Imagemap.

When you publish a page with shapes, NetObjects Fusion generates each shape as a .gif file.



Adding Text to a Shape
You can add text to a shape and format its font, size, and alignment. The text you add becomes part of a 
new image file when the page containing the shape is published. Because the text is part of the image, 
your site visitor’s browser can display it even if the font you chose is not installed.

To add text to a shape:

1. In Page view, select the shape to which you want to add text.

The shape’s Properties palette appears.

2. On the General tab, under Text in element, select Enable and click Settings.

The Text in Element Settings dialog appears

3. Replace the highlighted text with the text you want to add.

4. Click the Set button for fonts to open the Font dialog.

5. Select the font, its style and size, and click OK.

6. In the Text in Element Settings box, click the Set button for colors.

7. In the Color Picker, select the color you want to apply to the text, and click OK.

See Choosing Colors.

8. In the Text in Element Settings dialog, select the Relative Alignment, Horizontal Position, and 
Vertical Position for the text.

The Relative Alignment left-aligns, centers, or right-aligns two or more lines of text. It has no 
effect on single lines of text.

The Horizontal Position and Vertical Position settings place the text block within the shape’s 
rectangular frame.

For example, if you set the Relative Alignment to Left, the Horizontal Position to Center, and the 
Vertical Position to Bottom, NetObjects Fusion left-aligns the block of text and places it in the 
bottom center of the frame.

9. In the Orientation section, move the slider to rotate the text.

Select Right angles to limit the text rotation to 90-degree increments.

10.Click Close to apply the text settings to the text.



Adding HTML Horizontal Rules
HTML rules are horizontal only and can appear to have beveled edges when displayed by a browser. 
When you add an HTML rule, NetObjects Fusion positions it using an <HR> tag in the HTML for your 
page. When you embed an HTML rule in a text box, you can set its width as a percentage of the text box 
width.

To draw an HTML horizontal rule:

1.  In Page view, select the Line tool on the Standard toolbar, and choose the HR Rule tool 
from the flyout.

2. Draw the horizontal rule on the page.
The HR Rule Properties palette appears.

3. In the Thickness box, set the thickness of the rule.

4. Select Shaded to create a bevel effect.

The standard HR rule is shaded and 2-pixels thick.

5. Click the HTML button to open the Object HTML dialog.

In the bottom of this dialog, you can see the HTML code for the rule and its pixel length. In the top
of the dialog, you can write JavaScript for the line, or your own HTML code. See Working with 
HTML Directly.



Adding a SiteStyle Line
Use SiteStyle lines to embellish your page or divide it into sections. The line is a part of the current 
SiteStyle. See Using SiteStyles.

To place a SiteStyle line:

1.  In Page view, select the Line tool on the Standard toolbar, and choose the SiteStyle Line tool
from the flyout.

2. Draw a box starting where you want to position the upper-left corner of the line.
The SiteStyle line appears.

You can drag the line to reposition it, and add HTML and Actions to it. When you change SiteStyles, 
NetObjects Fusion automatically updates the line with the line picture for the new SiteStyle.

In your published site, a SiteStyle line is a .gif file.



Drawing Lines and Arrows
You can draw a line on your page and specify its attributes, such as width, color, and the style of the head
and tail. An arrow is simply a line that uses the Arrow or Point head/tail style.

1.  In Page view, select the Line tool on the Standard toolbar, and choose the Draw tool from the
flyout.

2. Drag from one point to another to set the position, length, and orientation of the line.
The point where you start dragging is the head of the line. The point where you finish is the tail of 
the line, regardless of the direction you drag.

To constrain the line to vertical or horizontal, hold down the Shift key while dragging.

The Line Properties palette appears.

3. In the Line width box, set the width of the line.

4. In the Color section, click the Color button for the line, head, and tail, choose a color, and click 
OK. To set all three to the same color—the Line setting—select All parts use one color.

See Choosing Colors.

5. In the Style section, select a style for the head and tail from the appropriate drop-down list.

If you want the head and tail to share the same style, select the style from one of the drop-down 
lists, then select Head/Tail same style.

Select Outline so the head and tail have the line color for their outlines, regardless of their fill 
colors.

6. Type an alt tag in the AltTag field.

See Adding and Modifying Alt Tags.

When you publish a page with drawn lines, NetObjects Fusion generates each one as a .gif file.



Editing Lines and Arrows
By dragging, you can change the length and width of a line or change the shape and size of the line’s 
head and tail.

1. In Page view, select the line.

Selection handles appear.

2. Place the pointer over a selection handle—the pointer changes to a crosshair—and do any of the 
following:

l To make the line longer or shorter, drag an end handle.

l To make the line thicker or thinner, drag a side handle.

l To change the shape of the end, drag one of its handles.

3. In the Style section, select a style from the Head or Tail drop-down lists to change the head or tail 
style.



Using SiteStyles
SiteStyles are sets of thematic elements you can apply to your site. Some style elements are graphic and 
others affect the text colors on your pages. In Style view, you use SiteStyles to create the look and feel of 
your entire site. NetObjects Fusion comes with a gallery of professionally designed SiteStyles. Fifty-five 
SiteStyles are installed with NetObjects Fusion 3.0, and you can find the SiteStyles from all versions of 
NetObjects Fusion in the Extras folder on your installation CD-ROM. You can use these SiteStyles as 
they are, edit them, or create styles using your own artwork to give your site a distinctive look.



What Is a SiteStyle?
A SiteStyle is a collection of graphic and typographic elements that NetObjects Fusion applies to every 
page in your site. Your site’s SiteStyle gives it a consistent look that survives variations introduced by your
site visitor’s browser. When you change the SiteStyle, NetObjects Fusion automatically updates every 
page in your site with the new look.

If you do not find a pre-built style that is appropriate for your site, you can create your own custom 
SiteStyle. Or, if a SiteStyle works for most, but not all, pages in your site, you can customize it for the 
exceptional pages, as described in Setting the Navigation Bar Style. For even more flexibility—for 
example, to use more than one banner image in your site or to use a different image for each button in a 
navigation bar—you can use the Navigation Bar and Banner properties palettes in Page view as 
described in Customizing Banners and Buttons.



Style View

When you click the Style button on the control bar, NetObjects Fusion displays Style view. Style view 
shows:

l A list of available SiteStyles for this site

l Elements of the selected SiteStyle



About Style Elements
NetObjects Fusion SiteStyles consist of two kinds of elements: 

l Images for buttons, banners, data list icons, SiteStyle lines, and page backgrounds. Button styles 
contain images for highlighted and non-highlighted buttons. The highlighted button image appears 
when a visitor is on the page represented by that button.

l Text attributes for banner and button text, and colors for normal text and regular and visited text links. 
The text on the navigation buttons and banners appears in the font style, size, color, alignment, and 
orientation assigned to the element in Style view.

Each NetObjects Fusion SiteStyle is composed of nine style elements:

l Background: Color or image used as a background of the page

l Banner: Image containing the banner text

l Primary Navigation Bar: Images for highlighted and non-highlighted navigation buttons

l Secondary Navigation Bar: A second set of images for highlighted and non-highlighted navigation 
buttons

l Data List Icons: Bullets next to items when you use a data object to create a data list

l Normal Text Color: Color of text on the page

l Regular Link Color: Color of linked text on the page

l Visited Link Color: Color of linked text already explored by visitor

l SiteStyle Line: Image for lines drawn with SiteStyle Line tool



Applying SiteStyles
By default, navigation banners and buttons obtain their images and text attributes from the SiteStyle 
assigned to the site. When you apply a SiteStyle, NetObjects Fusion automatically applies style elements 
throughout your site. For example, it replaces all the buttons in your navigation bars with images from the 
style you specified, while maintaining the relevant links.

To apply a SiteStyle:

1. In Style view, select a SiteStyle from the style list.

The elements of the selected style appear.

2. Click the Set Style button on the control bar or choose Set Style from the Style menu.

NetObjects Fusion applies the style to your site. The more pages in your site, the longer this 
takes. When complete, a message confirms that the style was applied and the name above the 
style list changes to the one you selected.

3. Click OK to acknowledge the message.

The next time you go to Page view, you see the new style elements and new font colors on each page.

You can also select a different style from the list and then navigate to another view. When a message 
asks if you want to set the currently selected style, click Yes to set the new style.



Editing SiteStyles
You can edit any element of an existing style to customize it. For instance, you might like every element of
a style except the banner. You can change just the banner image of a SiteStyle. The image for every 
banner in your site changes to the new image.

To customize SiteStyle elements for some, but not all, pages, you do not edit the SiteStyle, you customize
it just for those pages. See Customizing Banners and Buttons.

Note: When you edit a SiteStyle, every site that uses the SiteStyle is affected. Your Styles folder stores 
only one copy of a SiteStyle. When you change it, the change appears in all sites that use that SiteStyle. 
If the style you want to change is used in other sites and you don’t want them to be affected, create a new
style from the original style’s graphic elements and customize the new style. See Creating a SiteStyle. 
Backups of all your style folders are located in the \Extras folder on your NetObjects Fusion CD-ROM.



Editing a Style Background
1. In Style view, select the style you want to change and double-click anywhere in the background.

The Background Style dialog appears.

2. Select a background option.

l Select None to use the default background color set in the browser’s preferences.

l Select Color if you want a solid-color background such as white, the default. To choose a 
different color, click the Color button and select from the Color Picker. See Choosing 
Colors.

l Select Picture to use an image file as a background. Browsers tile the image across the 
page. Click Browse to choose an image file from your hard disk, CD-ROM, or LAN. See 
Adding Pictures.

3. Click OK.



Editing a Style Banner
1. In Style view, select the style you want to change and double-click the banner.

The Banner dialog appears.

2. To change the banner’s image, click Browse to choose an image file from your hard disk, CD-
ROM, or LAN. For information on choosing images, see Adding Pictures.

3. To change the appearance of text, click Text Settings and set text options as described in Editing 
Text Settings for Buttons and Banners.

4. Click OK.



Editing Text Settings for Buttons and Banners
With SiteStyles, you can choose any font on your system for banner and button text. NetObjects Fusion 
dynamically generates image files for these banners and buttons using the font you specified for each 
element. This means that on buttons and banners, your site visitors see the fonts you select regardless of
their browser or the fonts installed on their systems.

To set how text appears on navigation buttons and banners:

1. In Style view, from the Banner, Primary Button, or Secondary Button dialog, click the Text Settings
button.

The Text Settings dialog appears.

l Select the left, center, or right Relative Alignment icon to align multiple lines of text in 
relation to each other.

This option applies only if you used Custom Names to specify a banner or button label of 
more than one line of text. See Using Custom Page Names and Extensions.

l To change the font, click the Set button next to the Font field.

The Font dialog appears. Select the font, its style and size, and script style. The Script 
drop-down list shows the available language scripts for the specified font. Choose the 
appropriate script for the language you are using.

l Change the font color by clicking the Set button next to the Color field and choosing from 
the Color Picker as described in Choosing Colors.

l In Horizontal Position, select Left, Center, or Right. In Vertical Position, select Top, 
Center, or Bottom.

Horizontal Position and Vertical Position specify where text appears on the button, while 
Relative Alignment specifies how lines of text appear in relation to each other.

l In the Orientation section, drag the slider to set the rotation angle of the text. Zero 
degrees represents no rotation.

l Select Right angles to limit the text to right angles only; clear it to permit rotation to any 
angle.

2. When you finish adjusting the text, click OK.

After you close the banner or button dialog, the banner or button text appears with its new options
in Site view.



Editing a Navigation Bar
Each SiteStyle includes a primary navigation bar and a secondary navigation bar. The two navigation bars
differ only in the style of the button images. You can set the navigation bars in your site to display either 
style of navigation bar. For example, top-level pages can display the primary button set while lower-level 
pages display the secondary set. For more information, see Using Navigation Bars.

Each navigation bar contains two button images: regular and highlighted. Highlighted buttons are used in 
button navigation bars to show which page a visitor is currently viewing. You can turn highlighting on and 
off in the Navigation Bar Properties palette in Page view, as described in Setting the Navigation Bar Style.
Highlighting is turned on by default.

Note: If you are using AutoFrames, highlighting can affect how the browser refreshes your page. See 
AutoFrames and Browser Refresh.

To edit a navigation bar:

1. In Style view, select the style you want to change and double-click the Primary or Secondary 
Navigation Bar.

The Primary or Secondary Button dialog appears, depending on which navigation bar you are 
editing.

2. To select a different button image:

l Choose a regular button image by clicking the first Browse button and choosing an image
file from your hard disk, CD-ROM, or LAN.

l Choose a highlighted button image by clicking the second Browse button and choosing 
an image file from your hard disk, CD-ROM, or LAN.

For information on choosing images, see Adding Pictures.

3. To set different text options:

l Choose options for regular button text by clicking the first Text Settings button.

l Choose options for highlighted button text by clicking the second Text Settings button.

The Text Settings dialog appears, where you can set text options as described in Editing Text 
Settings for Buttons and Banners.

4. When finished, click OK in the Text Settings dialog and then click OK in the Primary Button dialog.



Editing a Data List Icon
Data list icons appear when you use the Data List tool to create a data list in Page view. For information 
on working with data lists and data objects, see Data Publishing.

To edit a data list icon:

1. In Style view, select the style you want to change and double-click a Data List icon.

The Picture File Open dialog appears.

For information on choosing images, see Adding Pictures.

2. Select an image file from your hard disk, CD-ROM, or LAN.

3. Click Open.



Editing the SiteStyle Line
A variety of horizontal page-wide images can serve as lines to separate pages into sections. A number of 
line picture images are included in NetObjects Fusion styles. You insert line pictures in Page view using 
the SiteStyle Line tool, as described in Adding a SiteStyle Line.

To edit a SiteStyle line element:

1. In Site view, select the style you want to change and double-click the SiteStyle Line.

The Picture File Open dialog appears.

2. Select an image file from your hard disk, CD-ROM, or LAN.

For information on choosing images, see Adding Pictures.

3. Click Open.



Editing Text Colors
You can set the colors for normal text, links, and visited links with NetObjects Fusion. These colors apply 
only to text created with the Text tool in Page view and text navigation bars. They do not apply to text on 
buttons, banners, or other images. To edit the default font, font size, and other font attributes, set the 
browser font, as described in Setting Preferences.

The normal text color is automatically applied to all text you add to text boxes in Page view. You can 
override the default color by formatting text in Page view.

The regular link color is applied to all text you link; the visited link color appears after your site visitor 
follows the link. You do not see this color in Page view. Link colors show site visitors where links are 
located, and browsers keep track of which links have been followed. Set a regular link color that is 
different from the color you plan to use for ordinary text. By assigning visited links a different color than 
that of the regular links, you let site visitors know at a glance that they have visited the link. If color 
consistency is more important than this detail, assign identical colors to regular and visited links.

To edit a text color:

1. In Style view, select the style you want to change and double-click the text label you want to 
change.

l Double-click the words Normal Text Color to change the default color for text in the site.

l Double-click the words Regular Link Color to change the color for links in the site.

l Double-click the words Visited Link Color to change the color for visited links in the site.

The Color Picker appears. See Choosing Colors.

2. Select a color and click OK.



Creating a SiteStyle
You can create original styles to give your site a unique look. Simply collect or create image files for your 
banner, buttons, line, icon, and background, and select them in Style view. When you create a new 
SiteStyle, each element is saved into its own subfolder in the style’s folder inside the NetObjects Fusion 
3.0\Styles folder. See Styles Folder Structure.

When you create your own SiteStyle, keep these points in mind:

l When you use an animated .gif for a style image, only the first frame of the animation displays on the 
image.

l Text labels for buttons and banners are placed on top of images. If you want the label to appear below 
the image, leave space above or below the image when you create it in your image editing application.

l If you plan to use your SiteStyle on a page with a background color or image, and you want the 
background to show through your image, use your image editing application to set transparency in your
image.

You can check the NetObjects Web site at www.netobjects.com for more guidelines on creating 
SiteStyles.

To create your own SiteStyle:

1. Create or collect images for your banner, buttons, lines, icons, and background.

Use an image creation application to create the images. To be included in a published site they 
must be in .gif or .jpeg format. If you use an image in .bmp, .pcx, .pct, .png, or .psd format, a 
message asks you if you want to convert the image to .gif or .jpg format. If you choose to 
convert, NetObjects Fusion converts a copy of the image for you.

2. In Style view, on the control bar, click the New button, or choose New Style from the Style menu.

The New Style dialog appears.

3. Enter a name for your new SiteStyle and click OK.

NetObjects Fusion displays rectangular placeholders to indicate where you click to define the 
graphic images. It also displays the default text colors.

4. Define each style element by double-clicking it as described in Editing SiteStyles.

As you define each element, its image appears in Style view.

5. Click Set Style to apply the new style to your site.

Your custom SiteStyle images and settings are applied to your site. NetObjects Fusion creates a 
new folder in the Styles folder to contain your style elements. See Styles Folder Structure.



Managing SiteStyles
You can add new styles to the list of available styles, such as those you obtain from your colleagues or 
those you create on your own. You can also remove styles from the list and synchronize the list with the 
style folders currently in your Styles folder. SiteStyles are stored in folders labeled with the style name. 
Because NetObjects Fusion stores a list of SiteStyles with each site file, you must add new styles you 
obtain to your site’s style list before you can use them.

If you create a new site from a template, your new site contains the same style list as the site from which 
the template was made. If you import a template into your current site, style names that were in the 
template’s style list are added to your site’s style list. Templates created in NetObjects Fusion 3.0 also 
include the style folder for the template’s style. Templates created in earlier versions of NetObjects Fusion
do not include the style and you must manually copy the style to your Styles folder to use it. For more 
information on transferring SiteStyles, see Chapter 10, “Upgrading From a Previous Version of 
NetObjects Fusion,” in Getting Started.



Adding a SiteStyle
You can add a style from any NetObjects Fusion style folder on your hard drive, CD-ROM, or LAN. The 
Add Style to List command on the Style menu makes a complete copy of the added style’s folder in the 
Styles folder in your NetObjects Fusion 3.0 folder. For information about these folders, see Styles 
Folder Structure.

Note: When you add a style, it appears in the list of styles for the current site only. If you want that style to
appear in the style list of every new site you create, see Changing an Existing Template.

To add a SiteStyle to the style list:

1. In Style view, from the Style menu, choose Add Style to List.

The Open dialog appears.

2. Navigate to the style folder of the style you want to import and select its .ssf file.

3. Click Open.

NetObjects Fusion adds the style name to the style list.



Adding All Available SiteStyles
To synchronize your style list with the styles in your Styles folder:

u In Style view, from the Style menu, choose Update Styles List.

NetObjects Fusion updates the Style list of the active site to match the current contents of the Styles 
folder. This process also removes styles from the style list that are not included in the Styles folder.



Removing SiteStyles
You can remove a style from the list of styles in the current site. You cannot remove the currently applied 
style.

When you remove a SiteStyle, its name is removed from the current site only. Its style folder and the 
associated image files are not deleted, and it is not removed from any other sites.

To remove a style from the list:

1. In Style view, select the style you want to remove.

2. From the Style menu, choose Remove Style from List.

3. Click Yes in the warning dialog.

The style disappears from the style list of the open site. It remains in the NetObjects Fusion 3.0\
Styles folder.



Styles Folder Structure
Each SiteStyle stores the images it uses in a special folder structure in the NetObjects Fusion 3.0\Styles
folder.

NetObjects Fusion uses this folder structure to organize and label SiteStyle elements so you can easily 
locate parts of a style. When you assign an image to a SiteStyle element in Style view, NetObjects Fusion
automatically copies the file to the appropriate folder within the Styles folder. You can give a style element
any name you want, but NetObjects Fusion style images generally have the name of the style and 
element, such as BasicButton.gif, or BasicLine.gif.
When you select a new image for a style element, NetObjects Fusion automatically copies it into the 
appropriate folder for the SiteStyle. If you’re editing an existing SiteStyle, the new image file replaces the 
one previously assigned to that element in Style view. It copies the new image to the folder, but doesn’t 
overwrite the old image file unless the new and old files have identical names.

For example, suppose you want to modify the SiteStyle BlackBook to change the color of the highlighted 
button from black to red. First you must use an image editing application to open the file 
BlackBookButtonOn.gif and change the button’s color. You can give the new image file any name you 
like. Then, in Style view, you edit the highlighted button of the Primary Navigation Bar and choose the 
image file you edited. The image file you select is copied to the Primary Buttons Highlighted folder in 
the NetObjects Fusion 3.0\Styles\BlackBook folder. If the new image file has the same name as the 
original file, the original is overwritten. Thereafter, every site created or opened on your machine that uses
BlackBook uses this file for all highlighted primary buttons.

This applies to all style elements that can be based on images: Background, Banner, Primary Navigation 
Bar, Secondary Navigation Bar, SiteStyle Line, and Data List Icon. This also occurs when you replace the 
image for a single instance of a button or banner as described in Customizing Banners and Buttons.



Creating Navigation Bars and Banners
NetObjects Fusion includes tools you can use to create banners and navigation bars that help site visitors
understand and navigate the structure of your site. A new blank site includes a navigation bar and banner 
in the MasterBorder. You can create your own banners and navigation bars and place them in any 
MasterBorder or Layout area. You save time using banners and navigation bars because NetObjects 
Fusion automatically places page names on the banner and navigation bar pictures, and automatically 
links buttons to pages in your site.

New banners and navigation bars you create use picture elements of the currently selected SiteStyle. 
However, you can customize the banners and buttons after you create them by assigning other styles or 
labels or by replacing their pictures with your own pictures.



Working with Banners and Navigation Bars
NetObjects Fusion makes it easy to create different kinds of navigation tools to aid site visitors, including 
banners that show the page names and button and text navigation bars that link to pages in your site.

You can easily place banners and navigation bars anywhere on the page, including MasterBorders, 
Layouts, and inside text boxes, table cells, and Layout Regions. Banner titles and button names are 
determined by the page names in Site view or the settings in the Custom Names dialog. Buttons are 
linked according to your site’s structure. Whenever you change your site’s structure in Site view or 
change the name of a page, NetObjects Fusion automatically updates the buttons and banners.

When you preview or publish your site, NetObjects Fusion creates a new .gif image file with the picture 
and text for each button and banner. It gives the text the font style, size, and color you assigned to the 
element in Style view. It combines this text with the image file for that element of the SiteStyle to ensure 
that the font style you choose appears despite differences in the browsers used by your site visitors.

In each new site you create, NetObjects Fusion places a banner in the top margin, a button navigation bar
in the left margin, and a text navigation bar in the bottom margin. If you do not want the default banner 
and navigation bars to appear in every new site you create, edit the Blank Site template to remove them, 
as described in Changing an Existing Template. The only way you can permanently remove banners and 
navigation bars from your newly created sites is to edit the Blank Site template.



Using Navigation Bars
Navigation bars are rows or columns of buttons or text that are automatically linked to other pages in your
site. NetObjects Fusion provides two types of navigation bars: button navigation bars and text navigation 
bars. Text navigation bars provide navigation for visitors whose browsers do not display navigation 
pictures. Use the Navigation Bar tool to add navigation bars to MasterBorders or page layouts.

By default, button names are the same as the page name unless you specify a custom name, as 
described in Using Custom Page Names and Extensions. You can also split the button text into two lines 
by customizing the button name.

The style for buttons is determined by the SiteStyle you set in Style view, described in Using SiteStyles. 
The SiteStyle button picture is automatically applied to buttons throughout your site. You can change the 
button style for an individual navigation bar or even an individual button without changing the overall 
SiteStyle.

You create navigation bars using the default settings, but you can customize the way they look. You can 
choose buttons or text for navigation, include borders around the navigation bar, modify the spacing within
the navigation bar, and change the background color.

You can assign an action to any navigation bar using the Actions tab of the Navigation Bar Properties 
palette. For example, you might want a navigation bar to fly in from the top when the site visitor opens the
page. To make the navigation bar do this, you assign it an action that executes when the page is loaded. 
For information on creating actions and assigning them to objects, see Building Dynamic Pages.



Adding Button Navigation Bars
You can add a horizontal or vertical button navigation bar to a page.

1. In Page view, go to the page on which you want to place the navigation bar.

2.  Select the Navigation Bar tool from the Standard toolbar. 
3. Drag a box in the MasterBorder or Layout area where you want to place the navigation bar.

l Drag in a horizontal direction to create a horizontal navigation bar.

l Drag in a vertical direction to create a vertical navigation bar.

A new button navigation bar appears, and the Properties palette displays settings for the 
navigation bar. The bar contains buttons linked to the pages indicated by the setting in the Display
field of the Navigation Bar Properties palette.



Setting the Display Options
You set the display level to specify the relationship between the current page and the pages represented 
by the navigation bar. You also use it to change the navigation bar orientation. Illustrations in the Nav Bar 
Display dialog help you visualize the relationship of pages in the site’s structure. You can add as many 
navigation bars as you need and set each one to a different display level.

If a navigation bar appears in a MasterBorder assigned to pages at several different levels of the site, the 
display level you select might not make sense at all levels. To make sure your site visitors have access to 
all levels of your site, you can create new MasterBorders and place navigation bars with different display 
level settings in them.

To set the display options:

1. In Page view, select the navigation bar.

The General tab appears on the Navigation Bar Properties palette.

2. In the Display section of the General tab, click the Options button.

The Nav Bar Display dialog appears.

3. In the Show section, set the navigation option for this bar:

l First Level generates buttons linked to the children of your Home page.

l Parent Level includes links to all pages in the level above the current page in the site’s 
structure.

l Current Level links the buttons to this page and all other pages on the same level with the
same parent page.

l Child Level generates links to the children of the current page.

Open Site view or the Site Navigation window if you are unsure about which level of the site you 
want to link.

4. To include your Home page as a link in this button bar, select Include Home Page.

By default, Include Home Page is selected to provide quick access to the hub of your site.

5. To change the orientation of the bar, select Horizontal or Vertical in the Display section.



Setting the Navigation Bar Type
On the Properties palette for navigation bars, you can choose whether the selected navigation bar 
displays text or picture buttons. Text navigation bars provide navigation for visitors whose browsers 
cannot display picture buttons.

Primary and secondary navigation bars offer different sets of button pictures. Other than the pictures 
displayed, primary and secondary navigation bars function the same way. Because secondary button 
pictures are typically different in size, shape, or color, you can use a secondary navigation bar to visually 
distinguish links to different parts of your site. For example, to help your site visitor understand your site’s 
structure, you might use the secondary navigation bar for the lower levels of your site. To see the 
difference between primary and secondary navigation bars, go to Style view.

To set the navigation bar type:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Button Type section of the General tab, select the button type.

l To apply the primary button style for the current SiteStyle, select Primary Buttons.

l To apply the secondary button style, select Secondary Buttons.

l For a text navigation bar, select Text.

Text navigation bars use the SiteStyle’s linked text color and the Normal text style. For 
information on editing text styles, see Creating and Modifying Text Styles. To set the link 
color, see Editing Text Colors.



Setting the Button Spacing
You can set the pixel size of a button navigation bar’s border, as well as the spacing between buttons. By 
default, the spacing between buttons is zero pixels, but you can increase this to let a background show 
through or to add visual breaks around buttons. The border and spacing are measured in pixels 
regardless of the measurement you set in Preferences.

To set button spacing:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Display (in pixels) section of the General tab, set display options.

l To increase or decrease the navigation bar border, enter a new number in the Border 
field.

l To increase or decrease the spacing between buttons, enter a new number in the 
Spacing field.



Setting the Navigation Bar Style
By default, new navigation bars take on the style of the currently applied SiteStyle, but you can set 
individual navigation bars to any available SiteStyle. If a SiteStyle works for most, but not all, pages in 
your site, use a different SiteStyle for the exceptional pages.

You can also choose whether the button for the current page will be highlighted or not. Use button 
highlighting to show site visitors which page they are on. The highlighted button picture is different from 
the regular button, so a glance at the buttons quickly indicates the current page. If you are using 
AutoFrames, be aware that highlighting can affect the way the browser refreshes your page. See 
AutoFrames and Browser Refresh.

To set a button style:

1. In Page view, select the navigation bar.

The General tab appears on the Properties palette.

2. In the Button Style section of the General tab, select Other, and choose a different style from the 
drop-down list.

3. To turn off highlighting, clear the Use Highlighting checkbox.



Setting the Navigation Bar Background
You can set a background color for a text or button navigation bar. A background color can visually unify a
navigation bar if buttons are widely spaced; it can also help site visitors distinguish the navigation bar 
from the background of the page.

To set navigation bar background:

1. In Page view, select the navigation bar, then click the Background tab of the Properties palette.

2. In the Background Color section, set a background color.

l To use a background color, click the Color button, select a color from the Color Picker, 
then click OK. See Choosing Colors.

l To use no background color, select None. 

The background color appears around buttons in a navigation bar or behind text in a text 
navigation bar.



Using Banners
Banners are picture title bars that display the name of the page, helping site visitors understand where 
they are in your site. You use the Banner tool to add new banners.

Banners are just like pictures, except they contain text to identify the page. By default, banner text is the 
page name, but you can specify a custom name or no name for the banner, as described in Using 
Custom Page Names and Extensions. You can also split the banner text into two lines by customizing the 
banner name. The style of a banner is determined by the SiteStyle you choose in Style view.

You can assign an action to any banner using the Actions tab of the Banner Properties palette. For 
example, you can make a banner “grow” into existence when the site visitor goes to the page by 
assigning this action to it: On Page Loaded do Transition with the transition type set to Iris. For 
information on assigning actions to objects, see Building Dynamic Pages.



Adding a Banner 
1. In Page view, go to the page on which you want to place the banner.

2.  Choose the Banner tool from the Standard toolbar. 
3. Drag a box in the MasterBorder or Layout area where you want to place the banner.

l Drag in a horizontal direction to create a horizontal banner.

l Drag in a vertical direction to create a vertical banner.

A new horizontal or vertical banner appears in the current SiteStyle and contains the page name 
or the text specified in the Custom Name dialog. The Banner Properties palette displays options 
for the banner.

4. To change the banner orientation, select Horizontal or Vertical in the Display section of the 
General tab.



Setting the Banner Style and Orientation
By default, new banners take on the style of the currently applied style, but you can set individual banners
to any available style. If you change the style of a banner in a MasterBorder, it changes on every page 
using that MasterBorder.

1. In Page view, select the banner.

The General tab of the Banner Properties palette appears.

2. In the Style section of the General tab, select Other, and choose a different style from the drop-
down list.



Customizing Banners and Buttons
You might want to take advantage of the automatic page linking of a navigation bar, but still want to 
design the entire button—including special text effects not available in NetObjects Fusion—in an image 
editing application. Or, you might want to replace a banner on just one page with a picture that is not 
included in SiteStyles, without affecting all the other pages that use the same MasterBorder.

If necessary, you can substitute navigation pictures with other images for special pages. The customized 
picture appears only when you assign the SiteStyle that was selected when you chose the picture. The 
advantage to using customization instead of simply placing your own images as pictures is that 
NetObjects Fusion manages page links for you.



Changing the Image for One Banner
You can change the picture for a selected banner in Page view. When you assign a new picture to a 
banner, NetObjects Fusion does not display the page or custom banner name. If you want text to appear 
on the banner, you must include the text in your banner graphic. If you change a banner in a 
MasterBorder, the change does not affect the banner on all the other pages that use that MasterBorder. 
You do not change the SiteStyle when you customize a banner picture.

To change the picture for one banner:

1. In Page view, navigate to the page containing the banner you want to change.

2. Select the banner.

The General tab appears on the Banner Properties palette.

3. Double-click the banner, or click Custom Image on the General tab.

The Picture File Open dialog appears.

4. Select the image you want to use for the selected banner.

l To use an image that is not already an asset in your site, click the Folder tab, navigate to 
the appropriate folder, and select the image.

l To use an image that is already an asset in your site, click the Image Assets tab and 
select the image from the name column.

For more information on choosing images, see Adding Pictures.

The selected banner displays the new picture. The picture does not include the text style 
attributes or name that NetObjects Fusion usually assigns to the banner. Note that the banner 
picture changes for the current page only. The original image for the banner is unchanged. If you 
change the style assigned to the site, the banner no longer displays the custom picture.

For information about changing the banner back to its original SiteStyle, see Removing Banner or Button 
Image Customization.



Changing the Picture for One Button
You can change the picture on each individual button in a navigation bar in Page view. When you assign 
a new picture to a button, NetObjects Fusion does not display the page or custom name on the button. If 
you want text to appear on the button, you must include the text in your button picture. You do not change
the current SiteStyle when you customize a button picture.

Changing a button picture affects every instance of the button for that page, even if the button is on 
different MasterBorders and on different pages. For example, if you change the picture for a regular 
button named “Download” in a primary navigation bar, every instance of the regular Download button in all
primary navigation bars in your site will change. However, the highlighted button for Download will not 
change, nor will the Download buttons in secondary navigation bars. The Download page itself, which 
contains the highlighted button picture for the Download button, remains unchanged. To change both the 
regular and highlighted button you must customize both.

To change the picture for one button:

1. In Page view, navigate to the page containing the navigation button you want to change.

2. Double-click the button to select it.

A wide border surrounds the button to show it is selected.

The General tab appears in the Navigation Button Properties palette.

3. Double-click the selected button, or click Custom Image on the General tab.

The Picture File Open dialog appears.

4. Select the image you want to use for the selected button.

l To use an image that is not already an asset in your site, click the Folders tab, navigate to
the appropriate folder, and select the image.

l To use an image that is already an asset in your site, click the Image Assets tab and 
select the image from the name column.

For more information on choosing images, see Adding Pictures.

The selected button displays the new picture. The picture does not include the text style attributes
or name that NetObjects Fusion usually assigns to the button. The original picture for the button is
unchanged. If you change the style assigned to the site, the button no longer displays the custom 
picture.

For information about changing the button back to its original SiteStyle, see Removing Banner or Button 
Image Customization.



Removing Banner or Button Image Customization
If you change a banner or button picture, and want to revert back to using the selected SiteStyle, you can 
remove the customization.

1. In Page view, click the banner or double-click the button to select it.

The General tab appears in the Properties palette. 

2. Select Remove Customization.



Creating Links and Anchors
In addition to navigation bars and banners, NetObjects Fusion makes it easy to create any kind of 
navigation aid you might want using links. You can link page objects to any other point on the Web, 
including points within your site. For example, you can make any text, image, draw object, or area of an 
image into a navigation aid by adding a link. You can also create anchors—markers at a specific location 
on a page—to aid navigation in long pages.

NetObjects Fusion offers several types of links. You use internal links to link to pages within the site. 
Smart links are based on the site’s structure. NetObjects Fusion manages both internal and smart links 
for you, updating them as you change your site structure and page names. Use external links to link to 
other sites on your intranet or on the Internet. File links let you link to a file.



Working with Links
You can use the linking techniques described in this chapter to manually link objects such as text, 
pictures, and drawn shapes, both within your site and outside it. As you organize your site, you’re likely to 
create multiple links to the same location. You can update these links efficiently in Assets view, as 
described in Managing Links.

You can use NetObjects Fusion’s HTML access button to insert your own HTML and JavaScript code 
before, inside, and after links. For more information on adding HTML, see Working with HTML Directly. 
You can also use a link to trigger an action instead of jumping to a new page by using the Blank link, as 
described in Assigning an Action to a Text Link.

The properties palette for all linkable objects contains a Link button in the lower left corner. The Link 
button opens the Link dialog, where you specify the destination of a link. There are four types of links; 
each with its own tab in the Link dialog:

l Internal link, which links to a page or anchor inside the site.

l Smart link, which links to a relative position in the site, such as previous page or next page. Sometimes
these are called structural links. The Blank link, which you can use to trigger an action without going to 
a new page, is also a smart link.

l External link, which links to a page in another site via a URL, using a protocol such as ftp, mailto, http, 
JavaScript, or other method.

l File link, which links to a file that will be published with the rest of the site.

If Object Icons is checked in the View menu, NetObjects Fusion displays the Link or Anchor icon 
wherever you create a link or an anchor.

In Page view, you can follow an existing link to its target page or anchor:

l Right-click a linked object and select Follow Link from the shortcut menu, or select the object and from 
the Go menu, choose Follow Link.

l To follow a text link, click in the text so it includes the blinking insertion point, then right-click the linked 
text and select Follow Link from the shortcut menu.

l To follow a button link, double-click the button, then right-click the button and select Follow Link from 
the shortcut menu.

To edit a link, select the linked text or object, click the Link button on the properties palette, then change 
the link in the Link dialog.

To remove a link, select it, click Link on the Properties palette, and click Unlink in the Link dialog.

If your page includes AutoFrames, you might want the target of a link to appear in a specific frame. For 
more information, see Targeting Links in AutoFrames.



Creating an Internal Link
Internal links lead to pages or anchors within your site. If you move the page to a different place in your 
site’s structure or change the page’s name, NetObjects Fusion automatically updates the link. Assets view
lists the internal links in your site so you can track them.

You can either link to a page name or to the current page when you make a link to an anchor. When you 
link to an anchor and the link is later present on another page, the ability to link to the current page is 
useful. Linking to an anchor on the current page ensures intelligent treatment of anchors by the browser.

For example, suppose your layout contains a very long text box. At the top and bottom of the text box you 
place anchors, and in the MasterBorder, you link the words To Top to the top anchor and the words To 
Bottom to the bottom anchor. In the Link dialog, instead of choosing the current page name in the Page 
Name section, you choose the Current Page option. Then you decide to copy that text box to another 
page with the same MasterBorder and replace its content with different subject matter. Because you used
the Current Page option, the To Top and To Bottom links still work, jumping to locations on the current 
page instead of the page where you made the links. When you copy an anchor link from one page to 
another, or when an anchor link is in a MasterBorder or AutoFrame, you can make sure the link always 
points to an anchor on the current page by using the Current Page option in the Link dialog.

If you want an anchor link to always lead to a specific page, select a page name and then select an 
anchor.

To create an internal link:

1. In Page view, select an object to link.

l If you are linking text, select the text you want the browser to display as linked.

l If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.

l If you are linking to a page, select Page Name and choose a page name.

l If you are linking to an anchor and want the link to always link to a specific page, select 
Page Name and the name of a page.

l If you are linking to an anchor and want to always link to an anchor on the browser’s 
current page, select Current Page.

The Anchor section lists all the anchors on the page selected in the Page section. To learn how to
create and link to an anchor, see Adding an Anchor.

3. If you are linking to an anchor, choose the name of the anchor from the Select Anchor drop-down 
list.

The Select Frame Target field appears only when the current page contains an AutoFrame. For 
more information about link targets, see Targeting Links in AutoFrames. The Actions button 
appears only if you are linking text. For information on adding an Action to a text link, see 
Assigning an Action to a Text Link.

4. If the current page contains an AutoFrame, select the name of a frame from the Select Frame 
Target drop-down list.

The destination page for the link appears only in the frame you select.

5. Click Link.

NetObjects Fusion creates the link. When your site visitor clicks the linked item, the browser 
displays the destination page or the selected anchor.



Adding an Anchor
An anchor marks a specific location on a page. Anchors are useful on long pages so site visitors can go 
directly to a particular part of the page, instead of scrolling and searching for information.

You can place an anchor anywhere in a text object or table, or on a picture or drawn shape. You can link 
to an anchor from anywhere; for more information, see Creating an Internal Link. When a site visitor clicks
the link, the browser displays the page containing the anchor, beginning at the location of the anchor.

To add an anchor:

1. In Page view, click to place the insertion point within a line of text, or select an image or drawn 
shape.

Make sure you place the insertion point within the text, rather than selecting text. If you select 
text, the Anchor button is not accessible.

2. In the Properties palette for the selected object, click the Anchor button.

The Add Anchor dialog appears. The Anchors on Page section shows existing anchors on the 
selected page.

3. Type a name for the anchor in the Name field. The name cannot contain spaces. Choose an 
appropriate name because you reference this anchor by name later, and the name appears in the
browser when the pointer passes over it.

4. Click OK.

If Object Icons is checked in the View menu, the Anchor icon appears at the anchor location on 
the page.

To edit an anchor, click the Anchor icon and change its name in the Change Anchor dialog.

To delete an anchor, click the Anchor icon and click Remove in the Change Anchor dialog.



Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the structure, rather than its name. 
These links automatically adjust when you change your site structure. For example, if your smart link 
leads to the parent of the current page, and you later move the current page to a different parent, 
NetObjects Fusion updates the link to point to the new parent. Sometimes a smart link is called a 
structural link.

To create a smart link:

1. In Page view, select an object to link.

l If you are linking text, select the text you want the browser to display as linked.

l If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the Smart Link tab.

The Select Frame Target control appears only when the current page contains an AutoFrame. For
more information about link targets, see Targeting Links in AutoFrames.

4. Select the type of link you want.

l Home links to your Home page.

l Up links to the parent of the current page.

l Next Stacked Page links to the next page in a stack.

l Previous Stacked Page links to the previous page in a stack.

l Next Page links to the sibling to the right of this page in your site structure.

l Previous Page links the sibling to the left of the current page in your site structure.

l First Child Page links to the first page below the current page.

l Blank creates an empty link on the page. You can use the Blank link to assign an action 
or to create a custom <HREF> tag. If you want a link to trigger an action, but you don’t 
want it to lead to another page, use the Blank link. For more information on adding 
actions, see Assigning an Action to a Text Link.

5. Click Link.

For information about stacked pages, see Data Publishing. For information about link targets, see 
Targeting Links in AutoFrames.



Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages and items in other sites 
on the Web. A valid URL can include the protocol, host name or DNS, path name, and sometimes a file 
name, such as http://www.netobjects.com/products/fusion.html. Each external link you create 
becomes an asset of the site that you can easily update in Assets view.

To create an external link:

1. In Page view, select an object to link.

l If you are linking text, select the text you want the browser to display as linked.

l If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the External Link tab.

The Select Frame Target control appears only when the current page contains an AutoFrame. For
more information about link targets, see Targeting Links in AutoFrames.

The External Link tab shows a list of external links you previously entered in the current site.

4. Select a protocol from the URL drop-down list.

If you’re creating a link that does not require a protocol, select the existing protocol and press 
Delete. If you want to use a protocol that is not in the drop-down list, simply type it.

5. Either enter a new URL or, if you already created a link asset for this URL, select it from the list.

When the site visitor clicks the selected object, this link target is displayed.

If you select a link target from the list of assets, its URL and name appear in the URL and Asset 
Name fields. You can modify the name and URL.

6. If you’re creating a new external link asset, enter a name for this link target in the Asset Name 
field.

This name is for your reference. It appears in the list of links in Assets view so you can quickly 
identify and sort link destinations. It is not added to the HTML generated when your site is 
published.

7. Click Link.



Creating a File Link
You use file links to link to a file. The file referred to by the file link becomes an asset of the site and is 
uploaded to the server when the site is published. You might use a file link to link to a file that your site 
visitors want to download.

1. In Page view, select an object to link.

l If you are linking text, select the text you want the browser to display as linked.

l If you are linking a picture or other object, click to select it.

2. In the Properties palette for that object, click Link.

The Link dialog appears.

3. Select the File Link tab.

The Select Frame Target control appears only when the current page contains an AutoFrame. For
more information about link targets, see Targeting Links in AutoFrames.

The File Link tab shows the path to the file and the name that appears in Assets view.

4. Click Browse and select a file in the Open dialog.

5. If necessary, enter or edit the Asset Name.

This name is for your reference. It appears in the list of links in Assets view so you can quickly 
identify and sort link destinations. It is not added to the HTML generated when your site is 
published.

6. Click Link.



Adding HTML to a Link
You can add your own HTML or JavaScript to a link to extend its capabilities. For example, you might 
want to add HTML that directs the browser to open the link in a new window, or JavaScript that displays a 
dialog. The steps below show you how to add HTML that directs the browser to open the link in a new 
window.

1. In Page view, select the object you want to link.

l If you are linking text, select the text you want the browser to display as linked.

l If you are linking a picture or other object, click to select it.

2. On the Properties palette for that object, click Link.

The Link dialog appears.

3. Select a link in one of the link tabs.

4. Click the HTML button on the Link dialog.

The Object HTML dialog appears. For detailed information on this dialog, see Accessing an 
Object’s HTML.

5. Click the Inside Tag tab to indicate where you want to enter HTML or JavaScript. 

6. Enter target=NewWindow.

As you type, the bottom panel of the dialog displays your code as it will appear in the HTML 
NetObjects Fusion generates.

7. Click OK in the Object HTML dialog.

8. Click Link in the Link dialog. 

When you preview or publish the site, the link opens in a new browser window.



Creating an Imagemap
An imagemap contains several links in a single picture. You create an imagemap by drawing hotspots on 
a picture. You can link as many hotspots as you like in a single image, but the hotspots cannot overlap or 
extend beyond the edge of the picture. Because the imagemaps you create with the following procedure 
do not require a CGI script running on the server, they are called client-side imagemaps. Server-side 
imagemaps require setup on a Web server to run properly.

To create a client-side imagemap:

1. In Page view, select a picture.

2.  Press the Hotspot tool in the Standard toolbar, and select the appropriate tool to create 
a rectangular, circular, or polygon hotspot.

3. Draw a hotspot on the image.
If you are using the Polygon Hotspot tool, you must click to establish each vertex of the polygon, 
then double-click to complete the hotspot shape.

The Link dialog appears.

4. In the Link dialog, select the type of link by clicking a tab.

5. Select a destination for the link or type a URL. For more information about creating links, refer to 
one of the following sections.

l For information about internal links, see Creating an Internal Link.

l For information about smart links, see Creating a Smart Link.

l For information about external links, see Creating an External Link.

l For information about file links, see Creating a File Link.

l For information about custom links, see Assigning an Action to a Text Link.

6. Create more hotspots, if you like, using the same tools and the Link dialog.

Once a picture has imagemaps, you can move it anywhere on the page and even copy and paste it 
elsewhere in the site.



Editing an ImageMap
To edit an existing hotspot, select it. The General tab appears in the Properties palette.

l To edit the link, click Link. The Link dialog appears, displaying the tab for the type of link. Change the 
link destination or click Unlink to remove the link.

l To make the hotspot an anchor, click Anchor and type a name in the Add Anchor dialog.

l To add HTML to an anchor, click HTML and follow the procedure for adding HTML to a link as 
described in Adding HTML to a Link.

l To assign an action to a hotspot, click its Actions tab on the Properties palette and follow the procedure 
described in Adding Actions to Objects.

l To resize a hotspot, select it and drag its handles.

l To create an alt tag for the hotspot, type in the AltTag field. The alt tag appears when the browser does 
not display the image.



Placing Media
Media such as sound and video give a site impact. The tools in NetObjects Fusion make it easy to add 
various media files to your pages.

NetObjects Fusion contains sample sound, video, and other media files that you can add to your pages. 
These files are available in the NetObjects Fusion 3.0\Samples folder.



Media Tools
The Media flyout contains five tools for placing different types of media on your pages. 

Each tool and the types of files it helps you insert are discussed in topics that follow.



Inserting Shockwave Files
With Shockwave from Macromedia™, you can create multimedia, graphics, and audio that downloads 
quickly over a network. NetObjects Fusion supports various Shockwave file formats, including: 

l Shockwave for Director 4.0 and 5.0 (.dcr)
l Director (.dir)
l Protected Director (.dxr)
l Flash (.swf) and Splash (.spl)
To view these files, site visitors must install the Shockwave plugin for their browser and platform. These 
plugins are available from the Macromedia Web site at www.macromedia.com.

You cannot directly add a Shockwave Audio (.swa) file to a page. Instead, embed it in a Director movie by
passing it as a parameter to the movie, and add the movie to your page. Then in Assets view, add the 
Shockwave audio file as a file asset.

The NetObjects Fusion 3.0\Samples\Content\Shockwave Movies folder contains some ready-to-use 
Shockwave files. Any Shockwave files you embed appear inline on the page itself. When you insert a 
Shockwave or Director file, Page view displays the Macromedia Shockwave placeholder.

To get WYSIWYG height and width parameters for Macromedia Director movies, you must have the 
Macromedia Director ActiveX control (version 6.0.1 or later) or the Macromedia Director Netscape plugin 
(version 6.0.1 or later) installed on your system. If you have an earlier version of the ActiveX control 
installed, you must update it for this feature to work. To obtain the ActiveX control, create a site with 
NetObjects Fusion that contains a Director movie, then preview the site with Microsoft Internet Explorer. 
The ActiveX control is automatically downloaded and installed. If you don’t have Internet Explorer, you 
can download the current Macromedia Director plugin at www.macromedia.com/shockwave/download.

To insert a Shockwave file:

1.  In Page view, select the Shockwave tool from the Media flyout on the Advanced toolbar.
2. Draw a box to indicate the file’s location.

The WYSIWYG feature in NetObjects sizes the Shockwave box so it is the appropriate size for 
the stage, which is the space in which the animation appears. If this doesn’t happen, you might 
not have the right browser plugin or ActiveX control installed.

The Open dialog appears.

3. Select a Shockwave file from your hard disk, CD-ROM, or LAN.

4. Click Open.

The Macromedia Shockwave placeholder appears on your page, and the Shockwave Director 
Properties palette appears. The Properties title changes depending on which type of file you 
selected. The name of the file you selected appears in the File field on the General tab.

5. To provide text for the browser to display if it cannot play the Shockwave file, enter a description 
in the AltTag field.

6. Click the HTML button to insert HTML tags and scripts. For information about HTML in NetObjects
Fusion, see Working with HTML Directly.

7. Select the Controls tab.

The options on the Controls tab vary depending on the type of Macromedia file you selected. To 
set the options on the Controls tab, see the appropriate procedure.



Setting the Properties for Shockwave Director
u In Page view, after adding a Shockwave Director file, on the Controls tab of the Properties palette, click

the option you want, enter the parameter, and click the check mark.

If you have worked with Director files, you should be familiar with these options. For detailed 
information on the Controls tab options, see the Shockwave or Director user guide.



Setting the Properties for Shockwave Flash or Splash
1. In Page view, after adding a Shockwave Flash file, select the Controls tab on the Properties 

palette.

The Controls options for the Flash or Splash file appear.

2. To control the display when using anti-aliasing, select a Quality option.

l AutoLow sets the default to normal quality. The host computer uses high quality if it has 
the capacity.

l AutoHigh starts the movie in high quality. The host computer uses low quality if it cannot 
display the movie in high quality.

l High anti-aliases the movie on any computer.

l Low uses a normal quality so the movie displays quickly. 

3. To determine how the movie fits in the frame, select the Scale option.

l ShowAll displays the movie within the frame but maintains the image proportions.

l NoBorder fits the movie within the frame so it fills the frame but maintains the ratio of the 
animation. Some edges of the animation might be trimmed.

l ExactFit displays the movie exactly within the frame.

4. To specify the movie’s alignment within the frame, select an Alignment option, such as Left, Right,
or Top.

5. To play the movie automatically when the site visitor opens the page, select Auto Start.

6. To replay the movie when it ends, select Loop.



Inserting a QuickTime Movie
QuickTime, developed by Apple Computer, is a multimedia software architecture used to create and 
deliver graphics, sound, video, text, music, and 3D media. You can use the QuickTime tool to place 
QuickTime movies.

To view QuickTime movies, site visitors must have the QuickTime plugin installed in their browsers. For 
more information on QuickTime, visit Apple Computer’s site at www.quicktime.apple.com.

To insert a QuickTime movie:

1.  In Page view, select the QuickTime tool from the Media flyout on the Advanced toolbar.
2. Draw a box where you want to locate the QuickTime movie.

An Open dialog appears.

3. Select the QuickTime file from your hard disk, CD-ROM, or LAN.

QuickTime media has a .mov extension.

4. Click Open.

The QuickTime placeholder appears on the page, and the QuickTime Properties palette appears.

The name of the file you selected appears in the File field on the General tab. To select a different
movie file, click the Browse button.

5. To provide text for the browser to display when it cannot play a movie, enter a description in the 
AltTag field.

6. In the Display section, select the option you want:

l To play the movie in your site, select Play Inline.

l To open a new browser window in which to play the movie, select Play in new browser 
window.

By default, NetObjects Fusion represents the movie on the page with the QuickTime icon. If you 
want to use a different icon, you can click the Browse button and select another image file to 
represent the movie. The name of the image file appears in the Launch from picture field.

7. Click the HTML button to insert HTML tags and scripts. For information about HTML in NetObjects
Fusion, see Working with HTML Directly.

8. On the Controls tab, set the sound volume for the movie. You can enter a number from 0 to 256.

9. In the Display options section, select the options you want:

l If you don’t want to show the movie but want to use it only as background sound, select 
Hide all.

l To display a control bar that the site visitor can use to start or stop the movie, select 
Controller. This option is not available when Hide all is selected.

l To automatically start playing the movie when the page loads, select Auto start.

l To replay the movie when it comes to the end, select Loop. You can replay the movie 
from the end to the beginning by selecting Back and forth.

10.To store the movie in the cache on the site visitor’s system, select Keep movie in user’s cache. If 
the visitor leaves the page and comes back, the movie doesn’t have to be downloaded again 
because it is already in the system cache.

You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.



Inserting a Video File
You can add video, such as an animation or a movie, to a site. For example, if you are creating a site for a
video rental store, you might include video clips from the latest releases on the site. Site visitors could 
preview the video clips before they rent or buy the movie.

The latest browsers often have video players built in; however, other browsers might require a helper 
application or plugin. For example, Netscape Navigator includes Live Video. To ensure that site visitors 
can view the video, you should provide a link to a site from which site visitors can download a plugin that 
can play the video files.

Using NetObjects Fusion, you can display video files two ways on a page:

l Use a placeholder icon to represent the video file. When site visitors click the icon, a separate browser 
window opens and plays the video.

l Play the video on the page when the page is displayed.

You set how video is displayed on the Video Properties palette.

NetObjects Fusion supports these popular video file formats:

l Moving Pictures Experts Group (.mpg, .mpeg,.mpe, .mpv), supported by Windows and the Macintosh 
with browser plugins

l Microsoft Audio Video Interleaved (.avi), supported by Windows 

l Vivo Active Producer (.viv), supported by Windows and the Macintosh with browser plugins

l Rapid Prototyping Module (.rpm)

To insert a video file:

1.  In Page view, select the Video tool from the Media flyout on the Advanced toolbar.
2. Click where you want to position the video placeholder. 

A box with handles appears on the page, and the Open dialog appears.

3. Select a video file from your hard disk, CD-ROM, or LAN.

4. Click Open.

The video icon appears on the page, and the Video Properties palette appears. The selected file 
name appears in the File field on the General tab.

5. To provide text that the browser displays if it cannot display the video, enter the text in the AltTag 
field.

6. In the Display section, select the display option for this video:

l To display the first frame of the video inside the browser window, click Inline. The image 
is the placeholder for the movie. The site visitor can start the movie by clicking the image.

l To select a different NetObjects Fusion image to represent the video on the page, select 
Icon, then click the image you want.

l To use another image file you previously created, such as a .gif or .jpeg file, to represent 
the video, select File. Click Browse and choose the image file to use.

7. Click the HTML button to insert HTML tags and scripts. For information about HTML in NetObjects
Fusion, see Working with HTML Directly.

You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.



Inserting a Sound File
Sounds are either digital or synthesized audio files that a browser with a built-in player or helper 
application can play. To play sounds, a system must have a sound card and speakers.

On any system, the visitor’s browser must be capable of playing sounds, either through a built-in player or
helper application. Typically, site visitors must download and install these applications, but most popular 
browsers have sound file players built in. For example, Live Audio technology is built into Netscape 
Navigator. Visitors can also download helper applications from sound technology developers and install 
them in their browsers. Some sound formats also require support from the Web server.

NetObjects Fusion supports the following popular audio file formats:

l Windows Wave (.wav) format sound files that play on Windows and Macintosh. For Macintosh, site 
visitors must have Netscape 3.x or later.

l Audio Interchange File Format (.aiff) with browser plugins can play on Windows 95 and Macintosh.

l Musical Instrument Digital Interface (.midi, .mid) can play on almost all types of operating systems.

l .AU, the most common sound format found on the Web, is used in Java applets and can play on Sun 
Microsystems and NeXT systems.

l RealAudio™ (.ra, .ram) can play streaming audio on all systems, requires RealAudio Web server-
resident software, and sometimes includes video. Site visitors must install the RealAudio player 
browser plugin.

l Rich Music Format (.rmf) is a sound file format that enhances the use of music and sound in interactive
environments, such as the Web.

You can also add any of these formats as a background sound that plays when a visitor views your page. 
For more information, see Setting Layout Background Properties.

Because an audio file has no visual object, NetObjects Fusion represents the audio file with a graphic, 
usually an icon or an inline player control bar the browser recognizes. When a site visitor clicks the icon or
the play button on the inline player control bar, the browser either plays the sound file or opens a helper 
application to play it.

To insert a sound file:

1.  In Page view, select the Sound tool from the Media flyout on the Advanced toolbar.
2. Draw a box on the page to indicate the location of the sound file.

The Open dialog appears.

3. Select a sound file from your hard disk, CD-ROM, or LAN.

4. Click Open.

The default sound icon appears on the page, and the Sound Properties palette appears. The 
name of the file you selected appears in the File field on the General tab. You can use the Browse
button to select a different sound file.

5. To provide text that the browser displays if it cannot play the sound, type a description in the 
AltTag field.

6. In the Display section, set the display options for this sound:

l To use the audio player for your browser, select Inline. If site visitors have Headspace 
Beatnik installed on their system, the browser will use that player to play the sound.

l To change the sound icon, select Icon and click one of the three images. The selected 
image represents a link to the sound on the page.

l To use another image file as an icon linking to the sound, select File, click Browse, and 
select an image file.



7. Click the HTML button to insert HTML tags and scripts. For information about HTML in NetObjects
Fusion, see Working with HTML Directly.

You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.



Inserting Other Types of Files
Although NetObjects Fusion supports a wide variety of media files, you might have other formats, such as
Adobe Acrobat PDF files, that you want to include on your site. You can place other files on your site, 
including an Adobe Acrobat, VRML, RealSpace FlashPix files, and Headspace Beatnik files.

When a site visitor clicks the document’s icon, the file displays it in the visitor’s browser or downloads to 
the visitor’s system. When you insert a file using the Plug-in tool, site visitors need the appropriate plugin 
for their browser and platform to use the file.

To insert a file using the Plug-in tool:

1.  In Page view, select the Plug-in tool from the Media flyout on the Advanced toolbar.
2. Draw a box where you want to place the plugin.

The Open dialog appears. 

3. Select a file from your hard disk, CD-ROM, or LAN.

To display the various file types that NetObjects supports, use the Files of type drop-down list.

To insert a plugin that is not explicitly supported by NetObjects Fusion, choose All Files in the 
Files of type drop-down list, then select the plug-in file.

4. Click Open.

The plug-in placeholder image appears on your page, and the Plug-In Properties palette appears.
The name of the file you selected appears in the File field on the General tab.

5. To provide text for the browser to display if it cannot display the file, enter a description in the 
AltTag field.

6. In the Display section, select the option you want:

l To display the file on your site, select Play inline.

l To open a new browser window in which to display the file, select Play in new browser 
window. NetObjects Fusion launches the file when the site visitor clicks the plug-in icon. 
By default, the Plugin.gif icon represents the file on your page. If you want to use a 
different image, you can click the Browse button and select another image file.

7. Click the HTML button to insert HTML tags and scripts. For information about HTML in NetObjects
Fusion, see Working with HTML Directly.

8. Select the Advanced tab.

The Advanced options appear.

9. Set the parameters. Because you can add different parameters for different files, see the 
associated user guide.

l To edit parameters that appear in the Parameters section, double-click the parameter. 
Enter the value in the Add Plug-In Parameter dialog.

l To add a parameter, click the plus (+) button and enter the parameter name and value in 
the Add Plug-In Parameter dialog.

l To remove a parameter, select it and click the minus (–) button.

l To change the order of the parameters, click the Up or Down arrow buttons. The selected 
parameter moves up or down in the parameters list.

You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.





Replacing a Media File
Sites are constantly changing and evolving. As you build your site or after using it for some time, you 
might want to change a media file that you used in a specific location. You can replace one file with 
another.

To replace a media file with a new file:

1. In Page view or Assets view, double-click the media placeholder on your page.

The Open dialog appears.

2. Select the new file and click Open.



Editing a Media File's Properties
When you place a media file on your page, you can set the properties for that file in the Properties palette.
The properties determine how the media file looks and works on your page. After previewing a page or 
from site visitors’ feedback, you might want to change the properties for a particular file.

To edit a media file’s properties:

1. In Page view, click the media file’s placeholder.

The Properties palette for that file appears.

2. Change the options you want.

3. Save the site.



Adding Java and ActiveX
You can make your site more interesting and interactive by adding special applications, such as Java 
applets or ActiveX controls. The tools in NetObjects Fusion make it easy to insert a Java applet, Java 
servlet, or ActiveX control and set its properties. To choose appropriate properties settings, you should be 
familiar with Java or ActiveX before you add these types of application files to your site.



Inserting a Java Applet or Servlet
Java applets and servlets are an efficient way to add sound and animation, such as scrolling messages 
and color cycling buttons, to a page. Java applets and servlets are platform-independent applications with
compact file sizes. Usually, Java applets and servlets run on the client platform, which means site visitors 
download and run them from a Web browser. Most browsers are Java-compatible, so site visitors don’t 
need special plugins to run a Java application.

When you embed a Java applet or servlet file on a page, NetObjects Fusion displays the file’s parameters
on the Java Properties palette if the file conforms to certain standards. If the Java applets and servlets 
meet the appropriate standards, you can edit their parameters without leaving NetObjects Fusion.

Visit the NetObjects Fusion site (www.netobjects.com) to learn the details of using Java applets and 
servlets, and the standards that NetObjects Fusion uses to display the applet or servlet’s parameters.

To insert a Java applet or servlet:

1.  In Page view, select the Java tool from the Advanced toolbar.
2. Draw a box to indicate the position of the Java applet or servlet.

The Open dialog appears.

3. Select the appropriate Java file from your hard disk, CD-ROM, or LAN.

The extension for a Java file is .class. A sample Java applet is available in the NetObjects 
Fusion 3.0\Samples\Content\Java Applets folder.

4. Click Open.

The Java placeholder image appears on the page, and the Java Properties palette appears. The 
name of the file you selected appears in the Class field on the General tab.

5. Select Applet or Servlet depending on the type of file you are inserting.

6. To provide text for the browser to display if it cannot display the file, enter a description in the 
AltTag field.

7. Set the parameters.

This guide assumes you are familiar with Java and know how to set these parameters. In some 
cases, Java developers do provide documentation that explains the parameters.

l To edit parameters that appear in the Parameters section on the General tab, double-click
the parameter. Enter a value in the Enter Value dialog.

For servlets, you can specify that the value is an initialization value for the parameter by 
checking the Value is an initialization option in the Enter Value dialog.

l To learn more about each parameter, check the Parameter info section on the General 
tab.

l To remove a parameter, select it and click the minus (–) button.

l To add a parameter, click the plus (+) button and enter a name and value in the Enter 
Value dialog.

Typically, you can add more instances of a parameter than already exists. For example, if
text1 and text2 already exist, an applet will probably recognize a text3 parameter you 
create. If you add a parameter the applet doesn’t recognize, the parameter is ignored.

l To change the order of the parameters, click the Up or Down arrow buttons. The selected 
parameter moves up or down in the parameters’ list.

8. To provide text that the browser displays if it cannot launch the applet or servlet, enter the text in 



the AltTag field.

9. If your applet or servlet uses more than one .class file and you need to add others, click the List 
button, then click Add in the Java Applet Files dialog.

10.Select another .class file from the Java Applet Files dialog, and click Open. Click OK to add the 
selected file.

To delete a .class file from the Class list, click the List button and select the appropriate applet in 
the Java Applet Files dialog. Click Delete, then click OK.

You can drag a Java .class file from a folder onto your page. The Java placeholder appears on the page, 
and you can set the Java properties for that file.

Note: After you place a Java object, you cannot change the applet or servlet it embeds. If you want to 
replace one object with another, you must delete the original Java object.



Inserting an ActiveX Control
ActiveX controls are small applications designed with a specific purpose, such as playing an animation. 
Microsoft Internet Explorer 3.x or later supports ActiveX controls with which you can add custom 
capabilities such as audio and movie players, calendars, custom buttons, and forms to your pages. You 
can view documents such as Microsoft Office files in Internet Explorer without launching the associated 
program. Site visitors must use Internet Explorer 3.x or later to view content created with ActiveX controls.
To view the content in Netscape Navigator, site visitors must install special plugins.

If you use an ActiveX control that references an external file, such as a .pdf file, you must type in the 
relative path of the file as it will be in the final published Web site. First you must add the file as an asset 
of the site and set it to always publish; see Adding File Assets. Then you can determine the file’s relative 
path in the final Web site by looking at the publish directory structure listed in Publish view.

Because ActiveX requires that you install Microsoft ActiveX controls on your system, you can get ActiveX 
controls from the Microsoft site. You can also check at www.netobjects.com and www.microsoft.com 
for links to archives of free, ready-to-use ActiveX controls.

To insert an ActiveX control:

1.  In Page view, select the ActiveX Control tool from the Advanced toolbar.
2. Draw a box to indicate the position of the ActiveX control.

The Insert ActiveX Control dialog appears, listing the ActiveX controls currently installed on your 
system. The bottom section shows the selected ActiveX control, which has an .ocx extension.

3. To display the file name of the control in the Codebase field of the ActiveX Properties palette, 
select Set Codebase.

4. Select the control you want and click OK.

The ActiveX placeholder appears on your page, and the ActiveX Control Properties palette 
appears.

The General tab displays the options for the selected control. If you selected Set Codebase, the 
path name and file name of the ActiveX Control appear in the Codebase field.

Because the options vary depending on which ActiveX control is selected, this guide does not 
describe all the options. Step 6 explains how to change them.

5. To provide text that the browser displays if it cannot launch the ActiveX control, enter the text in 
the AltTag field.

6. To change an option, select it, then edit the text field at the top.

l To accept any text you enter, click the check mark. 

l To cancel the change, click the X.

l To change the native property page for the ActiveX control, click the Properties button. 
You can change the control’s settings using the native property page instead of in the 
NetObjects Fusion properties.

l To insert HTML tags and scripts, click the HTML button. For information about HTML in 
NetObjects Fusion, see Working with HTML Directly.



Designing and Implementing Forms
You can add forms to your site to collect information from site visitors, for example, to survey potential 
customers, conduct credit-card transactions, have customers register products, or otherwise process 
information visitors submit.

Using forms, visitors can type in text fields, and select options in check boxes, radio buttons, and combo 
boxes. You can use NetObjects Fusion’s Form Handler component to have responses posted in an email 
or copied to a text file on your Web server. Or, you can assign a Common Gateway Interface (CGI) script 
to further process responses, for example, by summarizing them on a confirmation page.

You can also use JavaScripts or Visual Basic routines with forms, for example to do client-side processing
before sending data to the server. For information on attaching script to forms, see Working with HTML 
Directly.

Note: Don’t publish pages containing forms using the CSS and Layers HTML output option; if you do, the 
forms won’t display properly.



Creating a Form
With NetObjects Fusion, you can create one or more forms on a page. Devote an entire Layout area to a 
detailed survey, or create one or more forms in a Layout Region, table, or text box. One form might log 
product registrations, for example, while another emails customer comments to a product manager. You 
can also add a form to the MasterBorder to appear on each of several pages.

1.  In Page view, select the Form Area tool from the Standard toolbar, and draw a rectangle
in the Layout area or MasterBorder.

The Create Form dialog appears.

2. Select a type of form.

l Create position-based form: Use this option to create a form in a Layout Region that 
you can resize and drag anywhere on the page. When you add form objects, text boxes, 
and other objects to the region, you can freely position and align them, just as you do 
objects in a Layout area.

l Create text-based form: Use this option to create a form in a text box. Text you type and
form objects you add appear sequentially inline, just as when you type. This is a good 
choice for forms that have a lot of text, where objects appear inline, or that have a simple 
layout, like a row of check boxes or single column of fields.

A text box form usually generates less HTML when you publish than a Layout Region 
form.

l Create form in a table: This option creates a table where you can line up form objects by
inserting them in table cells. Each cell acts like a text box, where you type and add 
objects just as you add other objects to a table.

l Define Layout as a form: Use this option to fill your entire Layout area with a form. You 
can’t use this option if there’s a form in the page’s MasterBorder. You’ll also notice it’s not 
available in the Create Forms dialog when you use the Form Area tool in a MasterBorder.

3. Click OK.

4. Add fields, check boxes, and other objects to your form, along with images and other content, as 
described in Adding Objects to a Form.

You can also turn an existing Layout or object into a form. Click the Layout area, Layout Region, text box, 
or table, and select the form option on the Properties palette; for example, Text box is a form.



Adding Objects to a Form
You can add any standard form objects to a form, including single- and multiple-line text fields, check 
boxes, radio buttons, scrolling lists, and drop-down lists.

You add objects to a form using the Form toolbar. This toolbar appears when you first create the form, or 
you can open the toolbar from the View menu by choosing Toolbars, Form Tools.

Arrange and align the fields, check boxes, and other objects in a form, just as you would objects in a 
Layout area, table, or text box. You must place form objects inside a form to make them work as part of 
the form.

To minimize the amount of HTML generated by a Layout Region form, align its objects by selecting them 
and using the Multi-Object Palette.

Browsers display form objects differently, so test your form on all the browsers and platforms you plan to 
support.



Naming Form Objects
When you add objects to a form, you provide a name or argument for each object that’s passed to the 
Form Handler component or CGI script processing responses. These names can then be used to output 
or otherwise process the text typed in each field or the state of each check box, radio button, or combo 
box.

If you’re using the Form Handler to output responses, you must name each form object with a sequential 
number, beginning with 1, and continuing with 2, 3, and so on. Don’t use text characters or punctuation, 
as in 1-RadioButton.

In addition to names, you might also provide a value to be sent when a site visitor selects a check box, 
radio button, or item in a combo box. For example, a check box named Yellow with a value of Yes might 
be sent to a CGI script as Yellow=Yes, depending on the script.

Actions you add with NetObjects Fusion can also use form object values to manipulate a site visitor’s 
response. For information on using actions with values, see Scripting JavaScript Expressions.

Note: Avoid associating an action with an object that’s inside a form. Problems with some browsers can 
keep the form from displaying. You can, however, use an action with an object that’s outside the form.

If you’re using a CGI script, you might need to coordinate the names and values you enter with those 
used in the script. Also, each CGI script has its own naming conventions, but in general, names can’t 
include spaces or punctuation. Check with your Web administrator or ISP for more information.



Adding a Single-Line Text Field
A single-line text field can accommodate just a few words, such as a name or phone number. 

After creating the form:

1.  In Page view, select the Forms Edit Field tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Edit Field Properties palette, define the field’s size, content, and name passed to 
the script processing the form.

l Name. Type the argument for this field that’s passed to the CGI script processing the 
form. Ask your Web administrator or ISP if you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the object’s order in the output 
text. For example, a field with the name 2, where a visitor has typed St. Louis, might 
appear as 2=St. Louis.

l Text. Type text to appear in the field by default. This text is submitted as the response if 
the site visitor doesn’t replace it.

l Password field. Select this option if the field is for sensitive information like a password or
credit card number. Characters site visitors type are submitted to the script, but 
depending on the browser, visitors see asterisks, bullets, or nothing at all as they type.

l Visible length. Enter a number defining the text field’s width in characters.

l Max length. Enter a number defining how many characters can be entered in the field. 
When typing exceeds the field’s width, text scrolls up to this number of characters.

4. To label the field, use the Text tool on the Standard toolbar to insert text next to it.



Adding a Multiple-Line Text Field
To provide a place for long comments or descriptions, you can add a multiple-line text field. Site visitors 
can type as much as they want, and text scrolls as necessary.

After creating the form:

1.  In Page view, select the Forms Multi-Line tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Multi-Line Properties palette, define the field’s height, content, and name passed to
the script processing the form.

l Name. Type the argument for this field that’s passed to the CGI script processing the 
form. Ask your Web administrator or ISP if you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the object’s order in the output 
text. For example, a field with the name 4 that a visitor has typed in might appear as 
4=Your Web site is really great.

l Text. Type text to appear in the field by default. This text is submitted as the response if 
the site visitor doesn’t replace it.

l Visible length. Enter a number defining the text field’s width in characters.

l Visible height. Enter a number defining the field’s height in lines, up to 16. When typing 
exceeds this height, the text scrolls.

4. To label the field, use the Text tool to insert text next to it.



Adding Radio Buttons
Use radio buttons when you want site visitors to choose one option from a group. Clicking one radio 
button deselects all others in its group.

After creating the form:

1.  In Page view, select the Radio Button tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Radio Button Properties palette, define the button and group names passed to the 
script processing the form.

l Group name. Type the argument for this group of buttons that’s passed to the CGI script 
processing the form. Ask your Web administrator or ISP if you’re not sure what’s required 
here.

If you’re using the Form Handler, use a number indicating the button’s order in the output 
text.

l Value sent. Type the argument passed for the button if the site visitor selects it.

If you’re using the Form Handler, and a visitor selects a button named Large in a group 
named 4, the output text might appear as 4=Large. 

l Default. Choose either Selected or Not selected to set the button’s initial status, which is 
returned as the response if the site visitor doesn’t change it. Remember that only one 
radio button in a group can be selected at a time.

4. To label each radio button, use the Text tool to insert text next to it.



Adding Check Boxes
You can provide check boxes for making one or more selections from a group of options, or to turn a 
single option on or off. Unlike radio buttons, any number of boxes in a group can be selected at the same 
time, or site visitors can leave them all unselected.

After creating the form:

1.  In Page view, select the Forms Checkbox tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Checkbox Properties palette, define the name for this box that’s passed to the 
script processing the form.

l Name. Type the argument for this box that’s passed to the script processing the form. Ask
your Web administrator or ISP if you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the box’s order in the output 
text.

l Value. Type the argument passed for the box if the site visitor checks it.

If you’re using the Form Handler, and a visitor checks a button named 6 that has the 
value Email, the output text might appear as 6=Email.

l Default. Select either Checked or Unchecked to set the box’s initial status, which is 
returned as the response if the site visitor doesn’t change it.

4. To label each check box, use the Text tool to insert text next to it.



Adding a Combo Box
If a long list of check boxes or radio buttons takes up too much space in your form, you can list options in 
a combo box, instead. Use a scrolling list if you want site visitors to be able to select more than one 
option, which is a space-saving alternative to a group of check boxes. Or use a drop-down list for 
selecting only one option, which is an alternative to radio buttons.

After creating the form:

1.  In Page view, select the Forms Combo Box tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Combo Box Properties palette, define the type of list, its options, and names that 
are passed to the script processing the form.

l Name. Type the argument for this combo box that’s passed to the script processing the 
form. Ask your Web administrator or ISP if you’re not sure what’s required here.

If you’re using the Form Handler, use a number indicating the combo box’s order in the 
output text.

l Type. Select whether you want a drop-down list that displays one item at a time, or a list 
box that can display several items in a scrolling list.

l Visible Height. For a list box, enter a number defining the list’s height, in lines.

l Allow Multiple Selections. For a list box, select this option if you want site visitors to be 
able to select more than one item in the list.

4. For each item in the list, click the plus (+) button and, in the Enter Values dialog, type a name and
the value passed to the script for the item.

l Name. Type the name passed for this item, which is also the name that appears in the 
list.

l Value. Type the value passed if the item is selected.

l Selected by Default. Check this option if you want this item initially selected. Unless 
you’re creating a list box and you select Allow Multiple Selections, only one item in the list
can be selected.

5. To give the list a label, use the Text tool to insert text next to it.



Adding Submit, Reset, and Custom Buttons
After adding objects for collecting data from site visitors, you need to add a Submit button to send the 
data to your Web server. You can also supply a Reset button so visitors can clear the form if they want to 
enter responses from scratch. And you can add a custom button that runs a script on the visitor’s browser,
for example, to calculate shipping for a purchase or to validate that the right information is entered in a 
field.

Note: If you’re using the Form Handler component to send form responses in an email or to a text file, 
create your Submit button as described in Submitting Data to a Text File.

After creating the form:

1.  In Page view, select the Forms Button tool from the Form toolbar.
2. Draw a rectangle on the form.
3. On the Forms Button Properties palette, choose the type of button you want to create and give it 
a label.

l Name. Use the name your CGI script references.

l Text. If you want a different text label, select Text and type the label in the field.

l Image. To use a picture as a label, select Image, click Browse, and choose an image file 
from the Open dialog.

l Type. Choose the type of button you want to create from this drop-down list.

Choosing Submit creates a button that sends the site visitor’s responses to the Form 
Handler or CGI script on the Web server. Choosing Reset creates a button that reverts to 
the form’s initial settings. And choosing Button creates a custom button that runs the 
script you add using the HTML button.

l HTML. Click here to open the Object HTML dialog and add a script that runs on site 
visitors’ browsers when they click the button you’re creating. Do this for a custom button 
to define what it does.

For more information, see Accessing an Object’s HTML.



Submitting Responses as Plain Text
You can have responses submitted as plain text in an email or to a file on the Web server using the 
NetObjects Fusion Form Handler component. When you use the Form Handler, you don’t have to provide 
your own CGI script.

Note: Using the Form Handler component might require configuration of your Web server, which some 
administrators or ISPs might not support. To find out what’s required, see the usage note at 
www.netobjects.com/support.



Submitting Data to a Text File
To use the Form Handler component to copy site visitors’ responses to a text file on your server, use the 
component’s tool to create the form’s Submit button.

After creating the form:

1.  In Page view, select the Form Handler tool from the Component toolbar, and draw a 
rectangle on the form for the Submit button.

2. On the Form Handler Properties palette, identify the type of server, and rename the Submit button
if you want.

Click each row in the palette and enter information as follows:

l Button Name. Type another name for the button’s label, or use the one that’s there.

l Publish to. From the drop-down list, choose the type of Web server you’re publishing to: 
Windows, Mac, or UNIX.

l Success URL. Double-click this row and, in the Link dialog, select the page to display 
when a site visitor accurately completes the form. Click the Link button when you’re done.

l Error URL. Double-click this row and, in the Link dialog, select the page to display when 
the submission fails, for example, if the site visitor doesn’t fill in a required field.

l Output File. Type a name for the file you want responses copied to. Don’t specify a path.

l Required Fields. For each field, choose whether a response is required (True) or not 
(False) for a submission to be successful. If you mark a field True, and a site visitor 
doesn’t fill it in, they see the error URL when they submit the form.

Note: If any object in your form isn’t listed in the Form Handler Properties palette, you might have
named it incorrectly. For information, see Naming Form Objects.

3. If you’re publishing to a UNIX server, enter the following. You might need to consult your Web 
administrator or ISP for this information.

l Perl Path for UNIX. Type the path to the Perl application on the server. Note that Perl 5 is 
required on the server.

l CGI Bin Directory. Type the path to the directory on the Web server where CGI scripts 
should be copied.

l Storage Directory. Type the path to the directory on the Web server where you want 
NetObjects Fusion to put the Output file.



Submitting Data in an Email
You can also use the NetObjects Fusion Form Handler component to copy site visitors’ responses into an 
email to any address you specify.

1.  In Page view, select the Form Handler tool from the Component toolbar, and draw a 
rectangle on the form for the Submit button.

2. Enter the email address, and relabel the button if you want.
l Button Name. To change the button’s label, click in the Button Name row and type a 

name in the Form Handler text field.

l Publish to. Click this option and choose Email from the drop-down list.

l Email. Click this option and type the email address to which responses will be sent.

l Required Fields. For each field, choose whether a response is required (True) or not 
(False) for a submission to be successful. If you mark a field True, and a site visitor 
doesn’t fill it in, they see the error URL when they submit the form.

Note: If any object in your form isn’t listed in the Form Handler Properties palette, you might have
named it incorrectly. See Naming Form Objects.



Processing Data with a CGI Script
To process form responses other than by outputting text, use a CGI script. A CGI script is a program that 
controls a program on your Web server. Using a CGI script, you can format responses for a particular 
application, summarize them on a page that’s returned to the site visitor, or do practically anything else 
with the data. For more information about the benefits of CGI scripts, talk to your Web administrator or 
ISP.

Note: Not all Web administrators let you install CGI scripts on their servers. Some provide standard CGI 
scripts for you to use, and a few don’t support CGI at all. For information on CGI support for your Web 
server, consult your server administrator or ISP.

1. In Page view, click anywhere in the form except on a form object.

2. On the form’s Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For other forms, look on the 
General tab.

The Form Settings dialog appears.

3. In the top half of the dialog, specify the CGI script.

l Form Name. Type an arbitrary name for the form. This is required by some browsers.

l Action. If the CGI script is already on the server, enter its URL here; for example:

http://www.host.com/myaccount/fusionproject/assets/cgi-bin/mtscript.cgi
Note: Normally, NetObjects Fusion publishes CGI scripts to the cgi-bin folder on the Web server. 
If your server’s configuration requires publishing scripts somewhere else, you must use the 
Advanced Settings dialog to specify that location in the CGI script field. See Creating Aliased 
Folders and Setting the CGI-Bin Directory.

If the CGI script isn’t already on the Web server but needs to be published along with your site’s 
assets, click Browse and select the script file to be published from the Open dialog. This file appears 
in the Action field.

When visitors click Submit, their Web server executes the CGI script at this URL.

Note: If the URL isn’t to your server’s cgi-bin folder, you also have to customize your site’s 
published directory structure by renaming cgi-bin appropriately. See Customizing Your Directory 
Structure.

l Method. Select the method for sending form data to the Web server.

Select Post, which is the preferred method, to send data as a standard stream of 
name=value pairs, separated by an ampersand (&).

Select Get to send data using environment variables. Use Get with care, as some Web 
servers truncate data sent via this method.

l Encoding Type. If your Web server requires data to be encoded in a particular format, 
such as MIME or BinHex, type the format here.

4. Click OK.



Adding Hidden Fields
If a CGI script is processing your form, you probably need to use hidden fields to pass additional 
information to it, such as which fields must be filled out to display the success page or where to return 
data once it’s been processed; for example, to your email address. Site visitors don’t see these fields, but 
their values are submitted to the script along with form responses.

Note: If you’re not sure what hidden fields a CGI script requires, ask the script author, or your Web 
administrator or ISP.

1. In Page view, click anywhere in the form except on a form object.

2. On the Properties palette, click the Settings button.

For a text box form, look for the Settings button on the Text Box tab. For other forms, look on the 
General tab.

The Form Settings dialog appears.

3. Add names and values for each hidden field in the bottom of the dialog.

l To add a field, click the plus (+) button, then enter a name and value for the field in the 
Enter Value dialog.

l To remove a field, select it and click the minus (–) button.

l To reorder fields in the list and define their order in the submitted data, select a field and 
click the up or down arrow.

4. Click OK.

Note: If you’re using the Form Handler component to process a form, don’t enter hidden fields yourself. 
The Form Handler enters the fields it needs for you.



Using NetObjects Fusion Components
NetObjects Fusion Components are pre-built mini-applications that add sophisticated interactivity to your 
site with no custom programming or scripting required on your part. For example, you can use the Site 
Mapper component to add a button that site visitors can click to display a full navigational map of the site.

NetObjects Fusion includes nine pre-built components and one tool for adding new components. You 
place components on your pages using the tools on the Component toolbar.

Some NetObjects Fusion Components require set up on the server side. You can find information about 
server-side setup in usage notes at www.netobjects.com/support.
If you are a software developer and want to create your own NetObjects Fusion components, sometimes 
called NFXes, you can use the NetObjects Component Development Kit (CDK), available for free from 
NetObjects. You can download the CDK from the NetObjects site at www.netobjects.com.



Adding DynaButtons
DynaButtons are Java buttons that link to another page on your site, other sites, or a specific file. You can
place DynaButtons anywhere on your pages and assign up to 20 buttons to a DynaButton bar. In addition,
you can assign up to 20 sub-buttons to each DynaButton. You can create sub-buttons for navigating from 
a main page to pages at a lower level.

When you publish the site, each button appears in the browser in the primary button style selected for the 
site and displays the name of the page to which it is linked. You cannot assign custom images to 
DynaButtons. The buttons style is determined by your SiteStyle. To use custom images for buttons, use 
the Picture Rollover tool.

Because a DynaButton is an active link, the button appears active when a site visitor moves the mouse 
pointer over the DynaButton or clicks the button. The site visitor can click the DynaButton to go to the 
appropriate link.

Note: Because of the security features in some browsers, NetObjects Fusion cannot display DynaButtons
in Preview. To see how your DynaButtons work, you must publish the site locally or remotely and browse 
it via http: protocol. 



To add DynaButtons and set properties:

1.  In Page view, select the DynaButtons tool from the Component toolbar.
2. Draw a box on the page to indicate the DynaButtons’ location.

A button placeholder labeled DynaButtons appears on the page, along with the DynaButtons 
Properties palette.

3. Select the buttons’ orientation—vertical or horizontal—from the drop-down list.

4. Double-click the Number of Buttons row, specify how many buttons you want, and click the check 
mark.

5. Double-click the number row, such as Button 1.

The Link dialog appears. You can link this button to another page, file, smart link, or external link. 
For information about adding links, see Working with Links.

6. Create the link for the button and click Link.

The details of the link appear in the right column of the button row.

You can add an action to an object using the Actions tab. For information about adding actions, see 
Building Dynamic Pages.



Adding Sub-Buttons
If a DynaButton contains sub-buttons, the sub-buttons appear when a site visitor clicks the DynaButton. 
The sub-button shows information about the link associated with the button. For example, if the sub-
button is linked to an external link, the sub-button displays the asset name for the external link.

To add sub-buttons and set the properties:

1. In Page view, create a DynaButton as described in Adding DynaButtons.

2. Double-click a Use Sub-Buttons row, and Yes appears in the right column.

NetObjects Fusion adds a Number Sub-Buttons row under the Use Sub-Buttons row.

3. To specify the number of sub-buttons, select the Number Sub-Buttons row, enter the number of 
buttons, and click the check mark.

The limit is 20 sub-buttons. The appropriate number of sub-button rows appear, numbered in 
sequential order.

4. To define the link for each sub-button, double-click the appropriate sub-button row, such as Sub-
Button 1,2. The first number, in this case the 1, identifies the button for which the sub-button was 
created, and the second number is number of the current sub-button.

The Link dialog appears. For information about adding links, see Working with Links.

5. Create the link for the sub-button and click Link.

6. Repeat steps 3 through 5 to create and define each sub-button.



Using Ticker Tape
Often, you want to announce a special promotion or event on your site. You can use the Ticker Tape 
component to add a scrolling message to a page and set the colors and speed that are used to display 
the message.

To add a Ticker Tape display and set its properties:

1.  In Page view, select the Ticker Tape tool from the Component toolbar.
2. Draw a rectangle to indicate the location of the Ticker Tape display. Make the rectangle the size 
you want for the message background.

The Ticker Tape placeholder appears on the page, and the Ticker Tape Properties palette 
appears.

3. To display multiple messages in the Ticker Tape display, double-click the Number of Messages 
row, specify the number, and click the check mark.

You can specify up to 50 messages. A new Text for Message and URL for Message row appears 
for each message you specified.

4. Double-click the Text for Message row, and type the message in the Ticker Tape text entry field. 
Click the check mark.

5. Double-click the URL for Message row.

The Link dialog appears. For information about creating links, see Working with Links.

6. Create the link for this message and click Link.

7. Repeat steps 4 through 6 for each message in the Ticker Tape display.

8. Click the Speed row, and specify the scrolling speed (1 to 50) of the message.

Specify a higher number to make the message scroll faster; a lower number to make the 
message scroll slower.

9. To set the frame, background, and LED colors, click the appropriate row, then select the color you
want from the drop-down list.

l Frame Color determines the border color of the Ticker Tape display. The default is grey.

l Background Color determines the background color of the Ticker Tape display. The 
default is black.

l LED Color determines the color of the message text. The default is green.

You can add an action to an object using the Actions tab. For information about adding actions, see 
Building Dynamic Pages.



Adding a Site Map Button
Site Mapper is a Java navigation applet that site visitors can use to create an interactive map of a site. If 
your site is large, Site Mapper simplifies navigation by providing a detailed view of the site’s levels. Using 
the site map, visitors can jump directly from page to page without using the page navigation controls. You 
cannot place Site Mapper inside a frame.

 The Site Map button provides three ways for visitors to view the site:
l By structure, similar to the Site view in NetObjects Fusion

l In an outline view

l By searching for certain words

Note: Because of the security features in some browsers, you cannot click a page in the Site Mapper to 
display the page in Preview. You must publish the site before you can display a page from the Site 
Mapper.

To add a Site Map button and set its properties:

1. In Page view, display the page of your site where you want to include the Site Mapper 
component.

2.  Select the Site Mapper tool from the Component toolbar.
3. Draw a box on the page to indicate the location of the Site Map button.

The Site Map button appears on the page, and the Site Mapper Properties palette appears.

4. To change the image displayed for the Site Map button, double-click the Image row, then select 
the image file you want from the Picture File Open dialog. For information about placing an 
image, see Adding Pictures.

The selected image appears on the page.

You can add an action to a NetObjects Fusion object using the Actions tab. For information about adding 
actions, see Building Dynamic Pages.



Adding a Message Board
You can create a Message Board on your site by adding the NetObjects Fusion Message Board 
component to a page. The Message Board component is also called the BBS or BBS component.

 When site visitors click the Message Board button, the browser opens a new browser 
window displaying the Message Board. Visitors can use this message board to read messages organized 
by thread, subject, author, or time; expand or collapse the view; post new messages; and reply to 
messages.
You can have only one Message Board per site. For the Message Board to run properly, your Web server 
must be able to run CGI scripts, and the site visitor’s browser must support the Netscape JavaScript 
standard. Before you can view the Message Board, you must complete the server-side setup described in
usage notes available at www.netobjects.com/support.
Note: You cannot view your Message Board in Preview because the Message Board uses CGI.

Some components, such as the Message Board and Form Handler, generate files when they are used by 
the client. When you publish your site, NetObjects Fusion attempts to set up the proper file and directory 
permissions using the CHMOD command. Some servers do not allow this permission change. The 
Message Board will not work if it cannot write to certain files and directories. This situation is more 
common with UNIX servers. You can contact your Internet service provider to find out if CHMOD is 
implemented on the server.

To add a Message Board and set its properties:

1.  In Page view, select the Message Board tool from the Component toolbar.
2. Draw a box on the page to indicate where you want to place the Message Board.

The Message Board button appears on the page, and the Message Board Properties palette 
appears.

3. To specify where Message Board files are stored, double-click the Subdirectory row, type the new
location in the Message Board field, and click the check mark.

The default is BBS. NetObjects Fusion creates the directory in your site’s base directory, which is 
the directory where you want to publish the site.

4. To specify the title that appears in the title bar of the Message Board window, double-click the 
Page Title row, type the title, and click the check mark.

The Page Title cannot include a single quote.

5. To select the operating system platform on which the server is running, click the Publish to row, 
then select the platform from the drop-down list.

This option determines if the Perl5 CGI script or NT CGI binaries are uploaded to the server.

Note: If you are publishing your site to a Macintosh Web server, Message Board Macintosh CGI 
requires a Webstar 2.0 Web server, running on a PowerPC computer with Mac Perl5 installed.

6. If you are publishing to a UNIX server, Perl5 must be installed on the server. Click the PerlPath for
UNIX row, then type the path name to the Perl 5 interpreter.

The path name is relative to the base publishing directory. You can obtain the path name from 
your Internet service provider. Or, if you want to get the Perl5 path yourself, you can type which 
perl or which perl5 at the UNIX command-line prompt.

7. To specify the CGI-bin directory where the BBS CGIs are to reside, double-click the CGI-bin 
Directory row, type the path name for the directory, and click the check mark.

You can obtain the path from your Internet service provider. 



You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.



Adding Pictures That Roll Over
You can use the Picture Rollover component to create JavaScript rollovers for any image on your site. 
Because this component uses JavaScript, the colors of your images are not compromised in any image.

To view a rollover picture, site visitors must use Netscape Navigator 3.x or 4.x or Microsoft Internet 
Explorer 3.x or 4.x. You can also create rollovers for any image by using NetObjects Fusion actions; 
however, this only works in Netscape Navigator 4.x or Microsoft Internet Explorer 4.x.

Note: Because of the security features in some browsers, NetObjects Fusion cannot display a rollover 
picture in Preview. You must publish the site locally or remotely to see how this component works.

To add pictures that roll over:

1.  In Page view, select the Rollover Picture tool from the Component toolbar.
2. Draw a box on the page where you want to locate the pictures.

A picture placeholder appears on your page, and the Picture Rollover Properties palette appears.

3. To specify the first image to display, double-click the Initial image row, select the image from the 
Picture File Open dialog, and click Open.

The Picture Rollover Properties dialog changes and displays two new rows—Mouse over image 
and Mouse out image.

4. To specify the image to display when the mouse pointer moves over the image, double-click the 
Mouse over image row, select the image from the Picture File Open dialog, and click Open.

5. To specify which image to display when the site visitor moves the mouse pointer off the picture, 
double-click the Mouse out image row, select the image from the Picture File Open dialog, and 
click Open.

6. To link the image to a specific URL, double-click the Link URL row.

The Link dialog appears. Because the entire image is treated as one object, you can link it to 
another page, file, smart link, or external link, such as another site. For information about adding 
links, see Working with Links.

7. Create the link for the image and click Link.

The details of the link appear in the right column of the button row.



Adding Time Based Pictures
You can use the Time Based Picture component to display different pictures at the same location on your 
page at different times. You select the image to display and specify the hour at which to display it. The 
browser automatically displays the picture at the specified time. The picture remains on the page until it is 
time for the next picture to be displayed.

NetObjects Fusion supports the most popular graphics formats used on the Web, including .gif and .jpeg.
For information about these formats, see Adding Pictures.

Note: Because of the security features in certain browsers, NetObjects Fusion cannot display the Time 
Based Picture component in Preview. You must publish the site to see how this component works.

To add time based pictures and set the properties:

1.  In Page view, select the Time Based Picture tool from the Component toolbar.
2. Draw a box on the page where you want to locate the picture.

A picture placeholder appears on your page, and the Time Based Picture Properties palette 
appears.

3. Double-click the Number of Images row and specify the number of images you want to rotate.

You can use up to 24 images. NetObjects Fusions adds an Image, Start Time for Image, and URL
for Image row for each image.

4. To select an image, double-click the Image row, select the image from the Picture File Open 
dialog, and click Open.

For information about adding an image to your site, see Adding Pictures.

5. Double-click the URL for Image row, then select the type of link.

For information about creating links, see Working with Links.

6. Specify the link information and click Link.

7. Double-click the Start Time for Image row and select a starting time from the drop-down list.

The start time determines when the image is displayed on your site. You can select one-hour 
increments from 12 a.m. to 12 p.m. The image is displayed until the next image’s starting time.

8. Repeat steps 4 through 7 for each image you add.



Loading Pictures onto Your Site
Use the NetObjects Picture Loader Component to load an image from a site other than your own. You can
use this to place advertising banners if the banners are located on a server other than your Web server.

To load a picture from an external source:

1.  In Page view, select the Picture Loader tool from the Component toolbar.
2. Draw a box on the page to indicate where you want to place the picture.

A picture placeholder appears on your page, and the Picture Loader Properties palette appears.

3. Double-click the Image URL row and type the URL where the picture is located.

Type the complete URL. For example: 
http://www.netobjects.com/announcements/assets/images/homepagemainart.gif.

4. Click the check mark.



Adding Rotating Pictures
You can use the NetObjects Fusion Rotating Picture component to display different pictures in succession
in the same place on the page. For example, you could rotate among several images that advertise new 
products or current sale items.

To add a rotating picture, you specify the image to display and the number of seconds to pause before 
displaying the next picture in the sequence. You can also assign a link to each picture.

NetObjects Fusion supports the most popular graphics formats used on the Web, including .gif and .jpeg.
For more information about these formats, see Choosing an Image Format. Note that if you want to use 
animated .gif files, you can create an animated .gif file outside NetObjects Fusion in several popular 
image-editing applications. After creating the animated .gif file, use the Picture tool to place the file.

Note: Because of the security features in certain browsers, NetObjects Fusion cannot display a rotating 
picture in Preview. You must publish the site locally or remotely to view rotating pictures.

To add pictures that rotate and set their properties:

1.  In Page view, select the Rotating Picture tool from the Component toolbar.
2. Draw a box on the page to indicate where you want to place the picture.

A rotating picture placeholder appears on the page, and the Rotating Picture Properties palette 
appears.

3. To set the number of seconds each picture is displayed before moving to the next one, double-
click the Pause Time (Seconds) row, specify the number of seconds, and click the check mark.

4. To set how many different images to display in the rotating picture, double-click the Number of 
Images row, specify the number of images, and click the check mark.

You can display up to 50 images for your rotating pictures. An Image row and URL for Image row 
for each image you specified appears.

5. Double-click an Image row, select an image file from the Picture File Open dialog, and click Open.

For information about placing images, see Adding Pictures.

6. To create a link for this image, double-click the image’s URL for Image row, then select the type of
link. For information about creating links, see Working with Links.

7. Specify the appropriate information for the link and click Link.

8. Repeat steps 5 through 7 for each image.

You can add an action to an object using the Actions tab. For more information about adding actions, see 
Building Dynamic Pages.



Adding Other NetObjects Fusion Components
NetObjects Fusion components extend a site’s functionality. Many third-party developers create 
components that make external database connectivity, electronic commerce, and dynamic data publishing
possible.

Dynamic data publishing, for example, refreshes data each time a visitor goes to the site. You can publish
data dynamically on your site by adding a third-party component, such as:

l Allaire Cold Fusion and Fusion2Fusion components, available at www.allaire.com
l Selective Server from Fundere, available at www.fundere.com
l Lotus Domino and NetObjects Fusion Connector, available at www.lotus.com
For information about static data publishing, see Static and Dynamic Data Publishing.

Other third-party developers, such as Coolmaps, provide many useful components. You can purchase 
components from Coolmaps to create special rollover buttons, add pull-down menus of links, or put a 
vicinity map on your page. Visit the Coolmaps site at www.coolmaps.com for information.

Because the number of NetObjects Fusion components is constantly growing, the NetObjects Web site at
www.netobjects.com is a valuable resource for learning:

l When new components become available

l The many ways to enhance your site with NetObjects Fusion components

l How to develop your own NetObjects Fusion components using the CDK

You can add a component to your site by:

l Dragging the component file (.nfx extension) and any associated files and folders into the Components
folder in the NetObjects Fusion folder.

l Using the NetObjects Fusion Components tool from the Component toolbar.

To add a new or third-party NetObjects Fusion component:

1.  In Page view, select the NetObjects Fusion Components tool from the Component 
toolbar.

2. Draw a box on the page where you want to place the component.
The Installed Components dialog appears and displays a list of installed NetObjects Fusion 
Components.

3. Click Add.

The Install Components dialog appears.

4. Select the component to add and click Open.

Components have the extension .nfx or .class. You cannot add components that come with 
NetObjects Fusion, such as DynaButtons or the Message Board. Any other components appear 
in the list in the Installed Components dialog.

5. To add the component to your page, select the component in the Installed Components dialog 
and click OK.

The new component appears on your page, and the component’s properties palette appears.

6. Specify the properties for the component.

Because each component has different properties, check the information included with the 
component for help.





Referencing and Editing External HTML
In addition to content you create and maintain in Page view, your site might also include pages that 
require special, hand-coded HTML. Instead of importing and converting this HTML, you can reference 
HTML files externally and place them anywhere in your site. NetObjects Fusion doesn’t parse the HTML 
when it publishes your site, ensuring that your HTML is kept pure.

You can edit referenced files externally using any HTML editor, such as Allaire HomeSite 3.0, which is 
included with NetObjects Fusion. Plus, you can manage external assets in Assets view, and apply a 
consistent look to the published pages by assigning a MasterBorder.

Note: You can reference files located on a hard disk, CD-ROM, or LAN, but not from a remote Web 
server. Also, <A HREF> links in the original HTML files should point to other HTML files, and anchors 
within those files, using relative rather than absolute path names. See Managing Referenced Assets.



Referencing HTML from Site View
You can reference an entire site or section of a site from Site view. For example, you might reference an 
existing site you want to manage with NetObjects Fusion now and import later. Or, reference files you 
prefer to maintain in their native code, such as files containing the HTML tags <ROWSPAN> or 
<COLSPAN>.

Note: For links to work between the HTML files you reference, use relative path names in the original <A 
HREF> tags, keep all HTML files in the same directory, and publish files using the same directory 
structure as the original site. See Managing Referenced Assets.

When you reference HTML from Site view, NetObjects Fusion publishes the <HEAD> content from the 
original files, along with <HEAD> content it generates.

1. In Site view, select the page to be the parent of the pages you reference.

2. From the File menu, choose Reference HTML, or right-click the page icon and select Reference 
HTML from the shortcut menu.

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the top-level HTML file you want to reference, and click Open to return to the Reference 
HTML dialog.

5. Choose which files to reference, and assign a MasterBorder.

l Assign MasterBorder. Choose a MasterBorder from this drop-down list. Each HTML file 
you reference occupies the Layout area of a page, while the MasterBorder gives pages 
the consistent look of your site. To display external content with its original look, choose 
ZeroMargins.

Note: If any external HTML you’re referencing contains frames, you must choose the 
ZeroMargins MasterBorder.

l Limit number of pages to. You can select this option to enter a number of files to 
reference. NetObjects Fusion begins with the Home page you select and stops 
referencing when it reaches the end of the site or the number of pages entered here.

l Down to structural level. Select this option to enter how many levels of your site structure 
to reference. NetObjects Fusion references as many pages as possible at a higher level 
before going to a lower level.

l Do not manage or move assets. If you select this option, NetObjects Fusion doesn’t copy 
external assets into Assets view. Do this if you prefer that path names in the published 
HTML not be edited from your native code. However, you then have to manage images 
and other assets yourself. See Publishing Unmanaged Assets.

l Domain Name. Enter the domain name of the site containing the HTML files you’re 
referencing. Be sure to include the entire name, as in www.netobjects.com.

6. Click OK.

Preview your site to see the referenced pages.

You can rename referenced pages in Site view, just like you do other pages. To keep track of what part of 
your site is externally referenced, you might want to use the View tab on the Properties palette to assign a
different color background to the icons of referenced pages.



Referencing HTML from Page View
You can reference an external HTML file as the Layout area of a page from Page view, and incorporate 
the file’s <HEAD> content—for example, to include existing <META> tag keywords or JavaScript 
definitions.

1. Create a page in Site view.

2. In Page view, from the File menu, choose Reference HTML.

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the external file you want to reference, and click Open to return to the Reference HTML 
dialog.

5. Choose whether to import the referenced file’s <HEAD> content and manage external assets.

l Import <HEAD>. Select this option to publish the external HTML file’s <HEAD> content. 
Choose Append to Current <HEAD> to add external <HEAD> content to what NetObjects
Fusion generates, or choose Replace Current <HEAD> to publish only the external file’s 
<HEAD> content.

Caution: Don’t select Replace Current <HEAD> if the page contains actions or is being published 
using the CSS and Layers HTML output option. NetObjects Fusion generates <HEAD> content these 
options require.

l Do not manage or move assets. If you select this option, NetObjects Fusion doesn’t copy 
any external assets into Assets view. Do this if you prefer that path names in the 
published HTML not be edited from your native code. However, you then have to manage
images and other assets yourself. See Publishing Unmanaged Assets.

6. Click OK.

In Page view, the referenced HTML fills the Layout area:



Referencing HTML as an Object
You can reference an external file as an individual object on a page. Reference an ad banner, for 
example, an applet created by a Java generator such as Lotus Bean machine, or any other object 
requiring special code.

You can even put several external files on a page. For example, you might construct a front page for a 
company newsletter that includes a slot for each of several externally maintained story leads; and add 
pictures, actions, or media created with NetObjects Fusion.

As when you reference HTML as a Layout area, you can incorporate each file’s <HEAD> tags and script 
definitions to include existing <META> tag and script definitions.

To reference HTML as an object:

1.  In Page view, select the External HTML tool from the Advanced toolbar.
2. Draw a box where you want the referenced content to appear.

Put the box in the Layout area to publish the content on one page, or in the MasterBorder to 
publish it in the border of several pages.

The Reference HTML dialog appears.

3. Click Browse.

The Open dialog appears.

4. Select the external file you want to reference, and click Open to return to the Reference HTML 
dialog.

5. Choose whether to import the referenced file’s <HEAD> content and manage external assets.

l Import <HEAD>. Select this to publish the external HTML file’s <HEAD> content. Choose 
Append to Current <HEAD> to add external <HEAD> content to what NetObjects Fusion 
generates and what you import from other external objects on the page. Or choose 
Replace Current <HEAD> to publish only this external file’s <HEAD> content.

Caution: Don’t select Replace Current <HEAD> if the page contains actions or is being published 
using the CSS and Layers HTML output option. NetObjects Fusion generates <HEAD> content these 
options require.

l Do not manage or move assets. If you select this, NetObjects Fusion doesn’t copy any 
external assets into Assets view. Do this if you prefer that path names in the published 
HTML not be edited from your native code. However, you then have to manage images 
and other assets yourself. See Publishing Unmanaged Assets.

Preview the page to see the object. If necessary, go back and adjust the box’s position in Page view to 
get the actual spacing you want. As with other objects, you can drag a referenced object around the page,
drag it inside other objects, or even layer it.



Toggling Referenced Layouts and Objects
You can convert a referenced layout into an object, for example, to add other objects to the Layout area. 
Or conversely, size a referenced object to fill the Layout area. Use the Lock to Layout option on the 
External HTML Properties palette.

1. In Page view, click in the referenced Layout area or object you want to resize.

2. Click the General tab on the External HTML Properties palette.

3. Select or clear Size to Layout.

Clearing this option adds resize handles to a referenced Layout area, so you can resize it, move 
it, and add other objects to the Layout area. Selecting the option removes resize handles from an 
object, which snaps to fill the Layout.

Note: Avoid locking a referenced object to a Layout if there are other objects in the Layout area. 
You might get unexpected results in some browsers.



Managing Referenced Assets
When you reference an external HTML file, NetObjects Fusion lists the HTML file in Assets view. Unless 
you choose otherwise, it imports into Assets view pictures, applets, media, and most other external assets
the file references.

You can move external assets around in your directory structure in Publish view while maintaining paths. 
When you publish, NetObjects Fusion edits paths to the assets so they can be found. For example, 
depending on your original and published directory structures, NetObjects Fusion might change the 
original HTML’s <IMG SRC="Images/Logo.gif"> to <IMG SRC="../Index/Logo.gif"> in the published 
HTML.

However, NetObjects Fusion doesn’t edit paths to other HTML files, or to <TARGET=> anchors within a 
file. For these links to be maintained, the path names in the original files must work as-is when you 
publish. The original <A HREF> tags must use relative rather than absolute path names; that is, use <A 
HREF=".Index.html"> rather than <A HREF="HTTP://www.your_original_domain.com/Index.html">. And 
you must position external HTML files in your NetObjects Fusion directory structure so these original 
paths work. See Customizing Your Directory Structure.

In particular, NetObjects Fusion manages external assets referenced by these tags:

l <IMG SRC=>

l <A HREF=> to non-HTML assets, such as sound files

l <BODY BACKGROUND=>

l <EMBED SRC=>

l <BGSOUND SRC=>

l <SCRIPT SRC=>

l <INPUT SRC=>

l <APPLET CODE=>

Although NetObjects Fusion manages external applets that are assets of referenced HTML, it doesn’t 
manage classes referenced by the applets. See Publishing Unmanaged Assets for information on getting 
these classes and other unmanaged assets to the Preview folder or Web server.

Note: Once an external asset is imported into Assets view, you can use it anywhere throughout your site. 
Deleting referenced HTML from your site removes its assets from Assets view unless they’re in use 
elsewhere.



Publishing Native HTML
When you preview or publish referenced HTML, NetObjects Fusion copies the HTML from the original 
files to .html files it creates in the Preview or Publish folder. If it’s managing external assets or including 
MasterBorders, NetObjects Fusion also adds its own code to the published HTML. Of course it never 
modifies your original files.

If you don’t want NetObjects Fusion to add HTML to the original code when it publishes, you can choose 
these options in the Reference HTML dialog.

l When you reference from Site view, choose the ZeroMargins MasterBorder. NetObjects Fusion doesn’t 
add MasterBorder information to the published HTML or impose a table structure.

l When you reference from Page view, you can choose Replace Current <HEAD> from the Import 
<HEAD> drop-down list. NetObjects Fusion publishes the original <HEAD> as-is, without adding HTML
of its own.

Don’t do this if you’re using actions on the page or publishing using the CSS and Layers HTML output 
option.

l In either case, check Do not manage or move assets. NetObjects Fusion doesn’t copy external assets 
into Assets view, so it doesn’t edit path names in the published HTML. However, you have to publish 
images and other assets yourself. See Publishing Unmanaged Assets.

l Be sure Lock to Layout is selected on the External HTML Properties palette.



Publishing Unmanaged Assets 
If you choose not to manage assets when you reference external HTML files, you have to get external 
pictures, media files, applets, and other assets to the Web server yourself.

You can upload the files to the server with an FTP utility. Or, copy assets manually into Assets view, and 
they are published when you publish the rest of the site.

1. In Assets view, from the Assets menu, choose New File Asset.

The New File Asset dialog appears.

2. Click Browse in the dialog to open an external asset you want to publish, and type a name for the 
asset.

For more information on this dialog, see Adding File Assets.

3. Select Always publish file in the dialog.

This causes NetObjects Fusion to publish the file, even though it’s not listed as being in use.

4. In Publish view, position the asset in your directory structure so when it’s published, it can be 
found by any HTML referencing it.

Because NetObjects Fusion doesn’t edit paths to unmanaged assets in the published HTML, you 
must position assets so the original paths will work. See Customizing Your Directory Structure.



Editing Referenced HTML
To update referenced HTML, edit the original files using any HTML editor, such as Allaire HomeSite 3.0, 
which is included with NetObjects Fusion. To add or modify assets, do so in the original site folder, as 
well. When you preview or publish the site, NetObjects Fusion copies the original HTML to your site’s 
Preview folder or Web server. If it’s managing assets, it copies asset files you add or modify, too.

1. In Page view, select the referenced Layout area or object, and click the Edit HTML File button on 
the External HTML Properties palette. Or, just double-click the referenced page or object.

Your default HTML editor opens. You choose this editor using the Preferences command on the 
Edit menu.

2. Edit the HTML.

3. Save your changes and close the file.



Data Publishing
NetObjects Fusion makes it easy to publish information such as employee directories, product and 
service catalogs, and event schedules. You can enter, manage, and store this information as records 
either in your NetObjects Fusion site, or in an external application such as a database or spreadsheet.

To publish the data, you specify its source and create a layout for the pages that will display it. NetObjects
Fusion uses your Layout to create a separate page for each record, and can automatically provide your 
site visitor with buttons to navigate between them.



Static and Dynamic Data Publishing
NetObjects Fusion supports two kinds of data publishing: static and dynamic.

l Static data publishing takes any kind of data—text, pictures, multimedia files, and so on—from a 
database or spreadsheet. NetObjects Fusion publishes the data on your site, where it remains 
unchanged—static—until the source data is changed and the site is re-published. Static data 
publishing, which is the focus of this chapter, uses data objects that can derive their data from internal 
or external sources.

l Dynamic data publishing makes it possible to refresh the data each time a visitor goes to the site. 
When the browser requests the data, it is assembled on the spot; it does not depend on re-publishing 
the site.

Dynamic data publishing requires third-party components such as:

– Allaire’s Cold Fusion and Fusion2Fusion components (www.allaire.com)

– Selective Server from Fundere (www.fundere.com)

– Lotus Domino and NetObjects Fusion Connector (www.lotus.com)

For information on additional third-party components, see Adding Other NetObjects Fusion 
Components, or visit the NetObjects Fusion Web site at www.netobjects.com.



Storing Data with NetObjects Fusion
Using the data publishing capabilities of NetObjects Fusion, you can store text and pictures in a database 
internal to your site, or import data from external sources such as Microsoft Excel, Access, and ODBC 
databases. In both cases, NetObjects Fusion publishes your data in standard HTML pages. This makes it 
easy to add listings, such as product and service catalogs, employee directories, and event schedules to 
your site.

Data publishing in NetObjects Fusion uses the following objects:

l data objects

A data object is a collection of data fields, the definition of what data will be published. Creating a data 
object is the essential first step in adding internal or external data to your site. The data object becomes
an asset of your site. When you store records internally, you must specify the data fields you want to 
store. When you store records from external data, NetObjects Fusion includes all fields available in the 
source.

l data fields

Defined in the data object, data fields appear in the stacked pages and are the containers for the data 
in your site. You can arrange and label the data fields, and this arrangement appears in all stacked 
pages.

l data lists

The data list appears on the parent page of the stacked pages that contain the actual data. The data 
list functions as a table of contents for the internal or external data in your site. You select the fields you
want to display as column headers in the list. The field data from either the internal or external source 
populates the data list when you publish.

l stacked pages

Each record in your database appears on a separate stacked page below the page containing the data 
list. Stacked pages are not siblings of each other, but instead are iterations of the same page, 
containing the fields defined in your data object.

For example, you could publish a backpack catalog on your site, with a record for each backpack. Each 
row in the data list lets the site visitor navigate to the stacked page that describes the corresponding 
backpack with a description, photo, and price.

To create your backpack catalog, your first step is to create a backpack data object. You can define a data
object once and use it in different filtered data lists. For example, you can create one data list of all the 
backpacks in your database. With the same data object, you can create additional data lists of internal 
frame backpacks, external frame backpacks, frameless backpacks, and so on.

If you create a data object from an external source—for example, from a Microsoft Access database—and
then update or change the external source, you must use Assets view to update the data in your site. For 
example, suppose your backpack data object references 50 records originally and the external database 
is increased with 25 new records. After you update your site, the data object references 75 records, the 
backpack data list contains 75 rows, and there are 75 stacked pages.



After you create a data list on a page, NetObjects Fusion generates a stacked page as its child. When 
you create the Layout of the first stacked page, the remaining stacked pages automatically inherit the 
same Layout. The following illustration shows how the data list page and its child stacked pages appear in
Site view.



Publishing Data
In general, when you work with data publishing, you follow this three-step process:

1. Create a data object.

2. Create a data list.

3. Create a set of stacked pages.

When you create a data list, NetObjects Fusion automatically creates the first of your stacked pages, 
where you create the Layout to be used for all the pages in the stack.

When you design a stacked page, you create or identify the field data you want to display on the page.

l If you are storing data internally, you enter the field data on the stacked page itself.

l If you are using an external source, the field data is drawn from the external database, spreadsheet, or 
ASCII text file.

When you use the Data List tool in Page view, you can perform all three tasks within the Data Publishing 
dialog.



Creating a Data Object
You can create two types of data objects:

l Internal data objects: These objects reference simple text, formatted text, and picture data fields stored 
within your site.

l External data objects: These objects import simple text fields from a data field created in a program 
other than NetObjects Fusion. External data sources include external databases, spreadsheets, and 
ASCII text files.

Use external data if your database is maintained by others who do not have NetObjects Fusion, if you 
have large quantities of data, or if the data is frequently updated.

Note: Importing external data takes a single table from a database or a single worksheet from a 
program such as Microsoft Excel; it does not import the entire database.

The two data tools appear on the Advanced Tools toolbar.

Use the New External Data Source tool to create a data object for external data; use the Data List tool to 
create a data object for internal data. The currently selected tool appears on the toolbar.



Creating a Data Object for Internal Data
Internal data is records and fields stored within your site. You enter internal data directly into a stacked 
page by typing text or numbers and by placing pictures.

You can create a data object in Page view or in Assets view. If you create a data object in Page view, you 
can immediately create stacked pages to contain the data. If you create a data object in Assets view, you 
must return to Page view to create a data list and stacked pages.

To create a new internal data object:

1. Do either of the following:

l  In Page view, select the Data List tool from the Advanced toolbar, and draw a 
rectangle on the page. The Data Publishing dialog appears. Click the New button to 
display the Data Object dialog.

l In Assets view, click the Data Objects tab and then click the New button on the control bar. The 
Data Object dialog appears.
2. Select Internal and enter a name for the data object and comments about it.

NetObjects Fusion uses the data object name to identify your data object when it lists all data 
objects in the Data Publishing dialog and in Assets view.

3. Click the plus (+) button to add a field. Fields define the kind of data you can enter.

The Data Field dialog appears.

4. Type the field name, select the data type for the field, and click OK.

Internal data fields can store formatted text, plain text, and image files:

l Simple text fields: All characters in these fields share the same formatting characteristics. 
Simple text fields cannot contain paragraph breaks or line breaks and cannot exceed 255
characters. You can sort on simple text fields.

l Formatted text fields: Characters in these fields can be formatted individually. Formatted 
text fields can contain paragraph breaks and line breaks and can exceed 255 characters. 
You cannot sort on formatted text fields.

l Image file fields: These fields can contain an image in one of these formats: .bmp, .gif 
(animated, embedded, interlaced),.jpg, .jpeg, .pct, .pcx, .pict, .png, .psd, .tga, or .tif. 
You can sort on image file fields.

Note: Take special care as you define fields. Once you click OK in the Data Field dialog, you 
cannot delete the field from the data object.

5. Repeat steps 3 and 4 to add fields.

6. When you are done, click OK in the Data Object dialog.

The data object is now an asset of your site, and you can continue as follows:

l If you’re working in Page view, the Data Publishing dialog is still open. You can select fields and format 
the data list as described in Creating a Data List, and lay out your stacked pages as described in 
Creating Stacked Pages.

l If you’re in Assets view, take these additional steps:
a. Switch to Page view.



b.  Select the Data List tool from the Advanced toolbar, and draw a rectangle on 
the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.
You can now select fields and format the data list as described in Creating a Data List, and lay out
your stacked pages as described in Creating Stacked Pages.



Changing an Internal Data Field Name
1. Switch to Assets view.

2. Click the Data Objects tab.

3. Double-click the data object name.

The Data Object dialog appears.

4. Double-click the name of the object you want to rename.

The Data Field dialog appears.

5. Type a new name in the Name field and click OK.

You can also change a Simple text field to an Image field and vice versa, but you cannot change the type 
of a Formatted text field.



Creating a Data Object for External Data
External data exists in local desktop databases or in ODBC data sources. To make this data available to 
your site, you must choose an appropriate driver. NetObjects Fusion uses two types of drivers to access 
external data:

l Indexed Sequential Access Method (ISAM) drivers: These draw data from desktop databases, such as 
Microsoft Access, Paradox®, dBASE®, Microsoft FoxPro®, Microsoft Excel, or delimited text files.

l Open Data Base Connectivity (ODBC) drivers: These draw data from Structured Query Language 
(SQL) data sources, such as Oracle and Sybase data files.

A data source is either of the following:

l an ISAM driver plus a source data file

l an ODBC data source, which is an ODBC driver bound to a database

If your system includes both types of drivers for your application, use the ISAM driver, which is faster. In 
addition, selecting an ISAM driver takes fewer steps.

NetObjects Fusion automatically imports all the fields available in the external database file. By default, it 
imports all external fields as simple text or formatted text. To import pictures referenced in an external 
file’s field as image file paths, change that field’s type to Image.

Note: NetObjects Fusion components that support dynamic data publishing are available. Visit 
www.netobjects.com for information.



Creating an External Data Object from a Desktop Database
This topic describes how you draw data from desktop databases such as Microsoft Access, Paradox, 
dBASE, Microsoft Pro, Microsoft Excel, or from delimited text files. Your system must include an ISAM 
driver appropriate for your source. ISAM drivers are automatically installed with most desktop databases.

To create an external data object from a desktop database:

1. Do any of the following:

l  In Page view, select the New External Data Source tool from the Advanced toolbar, 
and draw a rectangle on the page.

l  In Page view, select the Data List tool from the Advanced toolbar, and draw a rectangle 
on the page. The Data Publishing dialog appears. Click the New button. The Data Object dialog appears. 
Select External and then click the Source button.
l In Assets view, click the Data Objects tab, and then click New on the control bar. The Data Object
dialog appears. Select External and then click the Source button.

The Data Source Type dialog appears.

2. Select the data file type from the drop-down list.

NetObjects Fusion always lists Access 3.0. Additional data types are available if ISAM drivers are 
installed. ISAM drivers are automatically installed when you install Microsoft FoxPro, Microsoft 
Visual FoxPro¨, Paradox, Microsoft Excel, or dBASE.

Note: If the data is in Microsoft Excel 97 workbook format, use an ODBC driver. See Creating an 
External Data Object from a SQL Data Source.

3. Click the Browse button, locate the database, and open it.

If the file is a multiple-file database or a spreadsheet with multiple tabs, the Select dialog appears.

4. Select the file or tab you want to use and click OK.

NetObjects Fusion creates the data object and makes it an asset of your site. The data object 
contains all fields in the external source, and takes the name of the selected file or tab. All fields 
are Simple text fields, regardless of their type in the source.

The data object is now an asset of your site, and you can continue as follows:

l If you’re working in Page view, the Data Publishing dialog is still open. You can select fields and format 
the data list as described in Creating a Data List, and lay out your stacked pages as described in 
Creating Stacked Pages.

l If you’re in Assets view, take these additional steps:
a. Switch to Page view.

b.  Select the Data List tool from the Advanced toolbar, and draw a rectangle on 
the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.
You can now select fields and format the data list as described in Creating a Data List, and lay out
your stacked pages as described in Creating Stacked Pages.



Creating an External Data Object from a SQL Data Source
This topic describes how you use an Open Data Base Connectivity (ODBC) driver to draw data from a 
Structured Query Language (SQL) data source, such as an Oracle data file.

Before you can choose an ODBC data source, you must specifically create the data source by binding 
your data file to a driver. You can do this in the Windows ODBC Data Source Administrator, found in the 
Control Panel as 32bit ODBC, or from within NetObjects Fusion, as described in this topic.

If you use MS Office or MS Office Professional for Windows 95, you might already have a set of ODBC 
drivers installed. If you do not use those products, you must obtain the drivers elsewhere. Contact 
Microsoft for information.

To create a data object from a SQL data source:

1. Create an external data object by doing any of the following:

l  In Page view, select the New External Data Source tool from the Advanced toolbar, 
and draw a rectangle on the page.

l  In Page view, select the Data List tool from the Advanced toolbar, and draw a rectangle 
on the page. The Data Publishing dialog appears. Click the New button. The Data Object dialog appears. 
Select External and then click the Source button.
l In Assets view, click the Data Objects tab, and then click New on the control bar. The Data Object
dialog appears. Select External and then click the Source button.

The Data Source Type dialog appears.

2. Click ODBC and then the Select button.

The Select Data Source dialog appears. It displays all the ODBC data sources stored on your 
computer. You can select an existing data source, or you can create a new data source.

To select an existing data source:

u To select an ODBC source on your system, you can use the File Data Source tab or the Machine Data 
Source tab.

l File Data Source: Select from the list of data sources and click OK.

l Machine Data Source: Select from the Data Source Name list and click OK. Depending on the data 
source type you choose, the Select Workbook or Select Database dialog appears. Follow these 
steps:

- Select a file in the dialog and click OK.

- If the source refers to a multiple-file database or a spreadsheet with multiple tabs,
the Select dialog appears. Select the file or tab and click OK.

NetObjects Fusion creates the data object, gives it the name of the selected file or tab, 
and imports its fields as simple text fields.

The data object is now an asset of your site, and you can continue as follows:

l If you’re working in Page view, the Data Publishing dialog is still open. You can select fields and format 
the data list as described in Creating a Data List, and lay out your stacked pages as described in 
Creating Stacked Pages.

l If you’re in Assets view, take these additional steps:
a. Switch to Page view.



b.  Select the Data List tool from the Advanced toolbar, and draw a rectangle on 
the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.
You can now select fields and format the data list as described in Creating a Data List, and lay out
your stacked pages as described in Creating Stacked Pages.

To create a new data source:

u Click New in the Select Data Source dialog.

The Windows Add Data Source wizard takes over. Follow the steps in the wizard, or refer to the online 
Help for information.

Once the data object becomes an asset of your site, you can continue as follows:

l If you’re working in Page view, the Data Publishing dialog is still open. You can select fields and format 
the data list as described in Creating a Data List, and lay out your stacked pages as described in 
Creating Stacked Pages.

l If you’re in Assets view, take these additional steps:
a. Switch to Page view.

b.  Select the Data List tool from the Advanced toolbar, and draw a rectangle on 
the page. The Data Publishing dialog appears.

c. Select the newly created data object from the drop-down list.
You can now select fields and format the data list as described in Creating a Data List, and lay out
your stacked pages as described in Creating Stacked Pages.



Importing Images from an External Data Source
NetObjects Fusion can import images referenced in an external data source. A field in the external data 
source must provide paths for the location of each image.

1. In your database application, such as Microsoft Excel or Access, create a simple text field. In 
each record enter the full path to each image—for example c:\my documents\images\photo.gif.
You can reference only .gif and .jpg files.

2. In NetObjects Fusion, create an external data object as described in Creating an External Data 
Object from a Desktop Database or Creating an External Data Object from a SQL Data Source. 
Link it to the table that contains your image field.

3. Switch to Assets view and click the Data Objects button.

4. Open the data object for editing by double-clicking it.

5. In the Data Objects dialog that appears, double-click the name of the field that contains your 
images.

6. In the Data Field dialog that appears, select the Image File option.

7. Close both dialogs and switch to Page view.

l If you have not created the data list and stacked pages, see Creating a Data Object for 
External Data.

l If you have created the data list and placed the image field on your stacked pages 
manually or by selecting the Display All Fields option in the Data Publishing dialog when 
you created the data list, go to a stacked page, delete the placed image field, then place 
it again using the Data Field tool as described in Adding Stacked Pages for Internal Data.

Each image from the external data file appears on the appropriate stacked page. 



Creating a Data List 
Once you create a data object, you can create a data list on any page. You create a data list and one or 
more stacked pages at the same time. NetObjects Fusion automatically includes linked data list icons in 
the first column in the data list. The data list thus acts as a table of contents—each row contains data for, 
and is linked to, a single stacked page.

To create a data list:

1. In Page view, display the page on which you want to place the data list.

2.  Select the Data List tool from the Advanced toolbar.
3. Draw a rectangle in the page body.

The Data Publishing dialog appears. Select the data object you want to use for this data list.

The Fields list displays the fields in the selected data object.

4. Choose a field to sort the list. You can sort on simple text fields or image file fields.

The records are sorted in ascending order.

5. To filter the data, click Set next to Filter.

By default, all available records in the data list and on stacked pages appear. A filter selects a 
subset of the available records to display. You can create selection criteria that isolate exactly the 
records you want to appear in your data list.

The Query dialog appears.

6. Enter your selection criteria and click OK.

If you do not use all three lines, choose “end” from the drop-down list at the end of the last line 
you use.

You return to the Data Publishing dialog.

7. In the Data List area, enter a name for the data list.

8. In the Fields list, select fields to include in the data list by clicking the check boxes to the left of 
the fields.

As a shortcut, you can click the Add All button, which marks all fields for display. Typically, 
however, you display only a subset of fields in the data list and display all fields on stacked pages.

9. To link a field to its stacked page, select the field in the Data Publishing dialog and click the 
Link/Unlink button.

A data list automatically includes at the left of each row a navigation button that links to the 
record’s stacked page. When you link a field, your site visitor can click either the button or the 
linked field to jump to the record’s stacked page.

10.To change the order in which fields appear left to right in the data list, click a field and then click 
the up and down arrow buttons.

Continue to select fields and press the up and down arrow buttons until the list is in the order you 
want.

11.Set the following options for creating stacked pages:

l Display all fields: Places all fields available in the data object in a simple Layout when 
NetObjects Fusion creates the first stacked page. This shortcut can save you the effort of 
placing fields individually as described in Designing the Stacked Page Layout.

l Add navigation buttons: Places relative navigation buttons in a simple Layout when 



NetObjects Fusion creates the first stacked page. This shortcut can save you the effort of 
creating these buttons as described in Adding Navigation Buttons for Stacked Pages.

12.Click OK.

The data list placeholder appears. Its column heads are the names of the fields you selected for 
display, and a data list button appears at the left of the first row.

This is enough information for you to use the Properties palette to specify the appearance of your 
data list.

NetObjects Fusion populates the data list only when you preview or publish the page. Data never 
appears in the data list in Page view.

13.Click the data list to see the General tab on the Data List Properties palette.

Adjust the settings to change the bullet type, background color, border size, and spacing of data. 
You can also mouse over the column heading borders and drag them to set column width.

When you are satisfied with the appearance of the data list, create a Layout for your stacked 
pages as described in Designing the Stacked Page Layout.



Deleting a Data Object
1. If you created stacked pages for the data object, you must delete the stacked pages and any data

lists before you can delete the data object.

Switch to Site view and select the stacked pages.

2. Press Delete, and click OK in the warning message that appears.

3. Switch to Assets view.

4. Click the Data Objects tab.

5. Select the data object and press Delete.

You see a warning that the deletion cannot be undone.

6. To continue with the deletion, click OK.



Creating Stacked Pages
Stacked pages correspond to records in a database. When you store information internally in NetObjects 
Fusion, each stacked page lets you enter data for one record. If you are drawing information from an 
external data file, each stacked page automatically displays information from a record.

Note: You can add or delete stacked pages for internal data as described in Adding Stacked Pages for 
Internal Data. To add or delete records for external data, you must make the changes in your external 
database or spreadsheet application and then republish your site.



Designing the Stacked Page Layout
The stacked page Layout determines the appearance of all the stacked pages. Data fields and non-data 
objects (text, pictures, or other assets) added to the stacked page Layout are repeated across all the 
stacked pages. In addition, Layout changes made to any stacked page are automatically applied to all 
pages in the stack.

Unless you selected the Display All Fields option when you created your data list, your stacked page 
Layout is blank. You can add text and graphic objects to this page, just like any other page. The key items
to be added, however, are the data fields you defined in the data object.

To design stacked pages:

1. Switch to Site view, or use the Site Navigation window in Page view to navigate to the first 
stacked page.

If you are working with external data, the stacked page navigation button bar indicates this is “1 
of” as many records as were imported from the external source. If you are working with an 
internal data object, the stacked page navigation button bar indicates this is “0 of 0” because you 
have not created any records yet.

2.  In Page view, select the Data Field tool from the Advanced toolbar, and draw a rectangle in 
the body of the stacked page.

The Data Field dialog appears, so you can choose which field you want to display in the area you 
drew. The fields available are those in the data object you selected in the Data Publishing dialog 
when you created the stacked pages.

3. Select a field and click OK.

l If you are using external data, NetObjects Fusion displays simple text field data from the 
first record in the data file. To import images, see Importing Images from an External Data
Source.

l If you are using internal data and selected an image file field, the field area is marked with
an X. Double-click the X to open the Picture File Open dialog. Select the file, and then 
click OK.

l If you are using internal data and selected a simple or formatted internal text field, 
NetObjects Fusion displays a blank field. See Adding Stacked Pages for Internal Data to 
learn how to enter text in these fields.

4. Place additional data fields, until you have as many as you want. Add text blocks to label your 
fields, lines, and other graphics until you are satisfied with your Layout.

5.  If you are using external data, your stacked pages are already created. You can 
use the Next and Previous buttons on the control bar to scroll though all pages in the stack.

6. If you are using internal data, add records as described in Adding Stacked Pages for Internal 
Data. You cannot enter data until you add a record to contain it.



Adding Navigation Buttons for Stacked Pages
Next and Previous buttons simplify navigation between stacked pages. You can automatically add 
navigation buttons when creating your data list as described in Creating a Data List, or you can create 
custom navigation aids by drawing or importing buttons, as described here.

To add navigation buttons for stacked pages:

1. In Page view, on one of the stacked pages, add an object to serve as a button.

You can place text, draw a button using the Draw tool, or import an image using the Picture tool. If
you installed the Extras folder, you’ll find it contains pictures specially designed for page 
navigation buttons.

2. Select the object.

3. Click Link in the object’s Properties palette.

4. In the Link dialog, click the Smart Link tab.

5. Select Next Stacked Page or Previous Stacked Page, and then click Link.



Adding Stacked Pages for Internal Data
To add a new record to internal data, you create a new stacked page. Each new stacked page has the 
same layout of data fields and non-data objects as all the others in the stack.

You can create as many new stacked pages as you want. For each new stacked page, NetObjects Fusion
adds a row to the data list on the data list page. You can delete stacked pages for internal data whenever 
you want.

Note: You cannot add or delete stacked pages associated with an external data object. To add or delete 
records when data is stored externally, you must update your external database or spreadsheet 
application and re-publish your site.

To add internal data stacked pages:

u  In Page view, on the first stacked page, click the Add button on the control bar.

A stacked page with blank data fields appears. The counter on the navigation bar indicates the new 
total of records in the stack.



Deleting Stacked Pages
To delete the current stacked page:

u  In Page view, click the Delete button on the control bar.



Adding Text and Images for Stacked Pages
When a stacked page displays data from an internal data object, you can enter text and add pictures in 
fields on the stacked page. You cannot edit text on stacked pages that reference external data.

To enter text in a text field:

u Double-click the field. Or press Tab or Shift + Tab to move the selection from field to field. To edit a 
selected field, press Enter.

A dotted outline with hollow handles highlights the field, and an insertion point appears inside. Type the 
text you want, then click outside the field to deselect it.

To add an image in an image file field:

u Double-click the field and select the image you want in the dialog that appears.

When you add data to the stacked pages, the data list can display it. Preview the data list page to see 
how it will look in your browser.



Building Dynamic Pages
Thanks to continuing advances in HTML specifications and browser development, you can now make 
pages dynamic—enlivening objects with movement and function, and using interaction to help deliver 
your site’s message and content.

Using NetObjects Fusion you can add animations, actions, messages, and behaviors to any object on the
page, or to the page itself. There’s no programming required: NetObjects Fusion provides all the 
ingredients for a wide range of actions, presented in a standard selection dialog.

If you prefer, you can script your own actions in NetObjects Fusion, using JavaScript or VBScript. 
Experienced programmers can customize the built-in menu of actions.

When you publish your site, NetObjects Fusion generates dynamic pages in Everywhere HTML—a 
combination of CSS positioning code, JavaScript, and browser-specific HTML code such as Netscape’s 
<LAYER> tag. Everywhere HTML makes dynamic pages work properly in both Microsoft Internet Explorer
4.0 and Netscape Communicator 4.0, with no further configuration or adjustment.



The Basics of Dynamic Pages
Dynamic pages contain one or more objects that have actions. These actions can include:

l Animations that make the object move on, off, and around the screen, bounce off other objects, grow or
shrink, or change places.

l Direct manipulation of the object by the site visitor, typically by dragging or moving it with the mouse.

l Indirect manipulation of the object by the browser using JavaScript “collision detection” to prevent two 
objects from occupying the same space at the same time.

l Changes to the object’s properties, such as its color, location, visible/invisible condition, or some other 
state.

l Responses attached to form objects that cause other actions in response to the site visitor’s selection 
or entry.

The action mechanism is message-based; each action is triggered by a specific message, and it sends a 
specific message in response to that trigger.

Because of their capability for animation or interaction, pages with dynamic objects are considered to be 
coded in dynamic HTML (DHTML). DHTML is not a new HTML standard of specific tags and attributes; 
it’s a general term to describe pages that use JavaScript or other supported scripting languages operating
within the browser to provide animation and interactivity.

The templates provided with NetObjects Fusion include an example of a page written in DHTML that has 
objects on it with pre-built actions. See Expanding Your Site.

Note: For reliable performance, actions should be viewed in Internet Explorer 4 or Netscape Navigator 4. 
The HTML tags that make actions possible are not always supported in earlier versions.



Objects, Actions, and Messages
At their most basic level, actions are composed of a trigger event, an action message, and one or more 
message targets. 

l A trigger event causes an action to start. Trigger events are expressed as:

– Messages about site visitor actions, such as a mouse click or mouse-over

– Messages about conditions such as the page loading or a particular state of the server

– Messages sent from or by other objects

l An action message is the information that gets passed from the source object to the target object. An 
action message can be a statement or a conditional expression.

l A target is any object that receives the message and acts upon it.



Triggering Actions
There are a variety of ways that you can define the triggering event for an action. You can:

l Set the state of the browser as a triggering event, so actions are triggered when the page loads, or 
when the browser leaves the page. You might, for example, define one set of actions to occur when the
page loads, and have another set of actions triggered to “reset” the objects or the page to their original 
state when the browser exits.

l Set actions to respond to various forms of onscreen interaction, including clicking, hovering over, or 
dragging objects on the page. For example, images are frequently used as buttons to launch actions 
when the site visitor clicks them.

l Define custom messages and then use them as the triggering event for other actions. This lets you link 
actions together that do not require onscreen interaction or changes to object states.

l Use completion messages from one action to trigger another action. For example, you can have one 
image fly in to your page from top right; its completion triggers the fly-in of the second image from the 
bottom left.

l Send cascading messages to grouped or collected objects, so one message gets sent to multiple 
related objects.



An Active Objects Example
Suppose you are creating a site for a non-profit organization that is having its annual fund-raising drive. 
You want to provide a Click for Status button that displays a thermometer, indicating the progress of the 
fund-raising efforts. You can do this using a simple action that makes an image appear when you click on 
a button object. The example works like this:

1. When a site visitor clicks the object, the browser sends a Mouse Down message to the button 
object itself—that’s how the button “knows” it has been clicked.

2. When the button object receives the Mouse Down message, it triggers the object to send a 
message called Object Show to its target—an image that is currently on the page, but hidden.

3. When the hidden object receives the Object Show message, it triggers the action attached to the 
hidden object, which changes the image object’s visible property to “true.”

In this example:

l The button object has an action whose trigger event is defined as a mouse click on that object:

When Mouse Down, send message Object Show to target Hidden_Object
l The hidden object has an initial setting

Don’t show when the page loads

and an action:

When Object Show (is received), send message Set Visible Property On to target 
Hidden_Object (myself).

The built-in behavior for Set Visible Property On is to display the specified object when the ObjectShow 
message is received.



The Dynamic Page-Building Process
To add dynamic content and actions to your pages, you follow this basic process:

1. Design the activity and effects for each page. Determine the sequence of actions, the possible 
groupings and arrangement of objects, and the most effective use of cascading actions.

Then, compare all the dynamic pages within your site to identify duplication, eliminate conflicts or 
clashes, and keep a “big picture” view of the site as a whole.

2. On each page with dynamic content, select the objects and assign the appropriate actions, 
targets, messages, and parameters.

3. Script custom parameters or custom actions as needed.

4. Preview or publish, then test your results in both 4.0 browsers.

The specifics for each step are described in the remainder of this chapter.



Adding Actions to Objects
1. In Page view, select the object to which you are adding an action.

The object’s default Properties palette appears.

2. Select the Actions tab.

The Actions tab displays the Object ID for the current object.

3. By default, Object initially visible in browser is selected. If you want this object to be hidden when 
the page is loaded, clear the check box.

4.  To add a new action, click the plus (+) button in the lower left corner.

The Set Action dialog appears.

Use this dialog to configure the action by specifying its trigger, target, message, and parameters.

5. To override the default action name, enter a descriptive name for the action in the Name field.

6. Specify the triggering event for this action in the When field. See Specifying a Trigger Event.

7. Specify the target for this action in the Target field. The default target is always the object itself. 
See Specifying an Action Target.

8. Specify the message you want this action to send to the target object in the Message field. See 
Specifying an Action Message.

9. Specify the appropriate parameter for this message in the Parameter field. See Specifying an 
Action Parameter Value.

10.If your target object is a text box, Layout Region, or Layout, you can send this message to all 
objects contained within the target object. To do so, select Cascade Action. See Creating 
Cascading Actions.

11.When you finish configuring your action, click OK.

The new action appears in the list box of the Action tab of the object’s Properties palette.

12.Repeat steps 3 through 11 to assign additional actions to this object.

13.Preview or publish the site locally and view the results in your browser. To ensure the best 
experience for your site visitors, test your dynamic pages in both Microsoft Internet Explorer 4 and
Netscape Navigator 4.



Specifying a Trigger Event
The first component of an action is its trigger event or condition: when the trigger event occurs, or the 
trigger condition is met, the action begins. The trigger event is defined by its subject and its condition: an 
action’s trigger might occur when the page is loaded or when a transition is started.

Your choices for trigger events and conditions vary, depending on the type of object to which you’re 
adding the action. For example, if you are adding an action to a picture object, there are five potential 
mouse-driven trigger events to choose from: clicked, down, up, over, and out.

Keep in mind that the trigger event is itself expressed as a message: in a literal sense, the action is kicked
off when the object receives the message that the trigger event occurred. The picture object in the 
example below won’t “know” that the mouse was clicked until it receives a message to that effect from the
browser.

This is what happens when you chain actions together in a sequence—you use a message from one 
action to trigger the next action.

Use the When message menus in the Set Action dialog to select the triggering message that kicks off this 
action.

1.  In the Set Action dialog, open the When menu.

A list of the event subjects that you can use to define the trigger event appears.

Mouse-driven events, for example, can be triggered when the site visitor clicks the mouse or 
moves the mouse pointer over the object. Object-driven events can be triggered when the object 
is hidden, shown, generates an error, or is loaded on the page. Page-driven events can be 
triggered when the page finishes loading in the browser, or when the site visitor leaves the page.

2. Point to the trigger category, then click the event or condition you want. To select a custom 
message, point to Custom and select from the list displayed. See Creating Custom Messages.

The name of the trigger event appears in the When field.

3. Continue setting the action target, message, and parameters as needed.



Specifying an Action Target
The target of an action is the recipient of the action’s message. An action can target any one of the other 
objects or containers on the current page. If you target a container, like a text box or a Layout Region, you
can also cascade the action so the container passes it along to all the objects embedded within it. See 
Creating Cascading Actions.

For example, you might add a “Fly Out to Top Right” action to one picture object and target it at another 
picture object. When the site visitor clicks the first object, the second object receives the action message, 
which triggers it to fly off the page.

NetObjects Fusion’s default setting is for an object’s actions to target itself. Unless you target another 
object, the action acts on or impacts the object to which it is attached.

If you add an action to an object in a MasterBorder or an AutoFrame, and it targets an object in the 
Layout, make sure the target object is always available in all Layouts to which the MasterBorder or 
AutoFrame is applied. MasterBorders and AutoFrames are often applied to several pages; if you add an 
action to an object in the MasterBorder and the target is in the Layout, the target might not always be 
available. For example, if you add an action in a MasterBorder on a page named Staff Photos, and the 
target is an object named CEOPicture in the Layout, the action will not work while site visitors are on the 
page named Phone Numbers if CEOPicture is not also in the Layout for Phone Numbers.

Use the Target field’s Object Tree to select the target for an action:

1.  In the Set Action dialog, click the Target Browse button.

The Object Tree shows the hierarchy of all the objects on the current page. 

The Object Tree shows the page’s containers—MasterBorder, Layouts, Layout Regions, and text 
boxes—with their objects listed below. You can expand or contract the Object Tree by clicking the 
plus or minus sign for each level.

2. Select the object you want to designate as the target for this action and click OK.

The name of the object is displayed in the Target field.

3. Continue setting the action message and parameters as needed.



Specifying an Action Message
The action message is the heart of the action—it defines what the action really does, what effect it has, 
and what conditions or behaviors it establishes. An action message is essentially an instruction to the 
target object, telling it to behave in a certain way: it might, for example, carry instructions for the target 
object to Fly In from Top Right when triggered.

Your choices for action messages vary, depending on the type of object you are targeting. For example, if 
you target an action at the Layout, there are three potential dialogs that you can display: alert, confirm, 
and prompt.

Keep in mind that the action message is itself a trigger that kicks off the action when it is received by the 
targeted object. The picture object in the example above won’t “know” to fly off the screen until it receives 
the instruction to do so, which triggers the flying action within the object.

Use the Message menu button to select the action message.

1.  In the Set Action dialog, open the Message menu.
2. Point to a Message option, then click the condition you want. To select a custom message, point 
to Custom and select from the list. See Creating Custom Messages.

The name of the selected action message appears in the Message field.

3. Continue setting the action parameter values, if appropriate to the message you selected.



Specifying an Action Parameter Value
Some actions require or accept additional parameters that control some aspect of their activity. In some 
cases, you can select from a list of predefined parameter values. In others, you can enter a value of your 
choice. The parameter value you set is sent to the object as part of the Action Message.

The range of choices is determined by the type of Action Message you assigned to this action. For 
example, the Fly message accepts directional parameters, with choices like In from Top or Out to Top 
Left. The Alert message, on the other hand, accepts a text string that it displays within the alert box.

Use the Parameters menu button to select the parameter values.

1.  In the Set Action dialog, open the Parameters field menu.

NetObjects Fusion displays the list of predefined parameter values, if any are defined for the 
selected action message.

2. Set the value for this action message’s parameter by:

l Selecting a predefined value from the list.

l Selecting the Values option to set custom values. See Customizing Parameter Values.

l Selecting the Expression option to create a JavaScript expression that generates or 
otherwise controls the value of the parameter. See Scripting JavaScript Expressions.

Once you select or set the parameter value, the name of the value appears in the Parameter field.

3. If you want this action to cascade within the hierarchy of the target object, select Cascade 
message. See Creating Cascading Actions.

4. Click OK to complete this action and return to the Action tab of the selected object.



Customizing Parameter Values
When you select a predefined value from the Parameters list, you are only setting the value of the most 
important parameter for this action. For example, in the case of the action Fly, the most important 
parameter—the one available from the menu list—will define “where from, and where to?” The default 
value for this parameter in this instance is In from Top.

However, the Fly message has other parameters as well, such as speed, duration, and action repeat. All 
these parameters have default values; you can also set new values.

1. Select Values from the Parameter drop-down list in the Set Action dialog.

The Parameter Values dialog appears, listing all the parameters predefined for this message and 
their default values.

2. Select a parameter whose value you want to change.

The value for that parameter appears in the edit field at the top of the dialog.

3. Set the parameter value:

l If the potential value choices for this parameter are predefined, the edit field might offer a 
means to select your choice—such as a drop-down list, the Color Picker, a Picture File 
Open dialog, or a Link dialog. Select the parameter value you want from the available list 
or dialog.

l If the parameter accepts any values, enter one in the edit field.

4. Repeat steps 2 and 3 for other parameter values you want to set.

5. Click OK after you set all parameter values.

The Set Action dialog appears.



Creating Cascading Actions
If you target an action at a container object, such as a Layout or a Layout Region, you can instruct the 
target to forward that action’s message to every object contained within it. When the site visitor or browser
triggers the action, the message cascades down the target object’s hierarchy.

In effect, the target object forwards the message in turn to each object contained within itself. For 
example, if you send a cascaded action to a Layout, the Layout forwards the action’s message to each 
object on the page.

Be aware that messages your actions send to either the Layout or the MasterBorder will apply to the 
entire page, not just the Layout or MasterBorder. For example, if you make a button which, when clicked, 
sends a Hide Object message to all objects on the Layout, it actually sends the message to all items on 
the page, making everything invisible. If you want a cascading message to affect only a group of objects, 
put all the objects in a Layout Region container and send the message to the Layout Region instead of 
the Layout.

Cascading actions are particularly valuable when you want to apply actions to a changing collection of 
multiple objects. For example, assume you are preparing a site for your company. In the marketing 
information part of your site, you want to display a map showing the 10 locations of your company offices.
The way you designed it, each office location includes a button that superimposes a text object on the 
page. That text object contains a profile of that location’s activities. When a site visitor clicks a location, 
you want to hide any currently visible profile and display the one linked to the selected location.

Cascading messages make this manageable:

l Without cascading messages, you’d have to include 10 actions with each location button: 9 actions to 
hide other location profiles (Hide Profile1, Hide Profile2, and so forth) and 1 action to display that 
location’s profile object.

l Using cascading actions, each location button sends one Hide all profiles message to the Layout. That 
message is then forwarded by the Layout to each object within that Layout; in effect, the message 
cascades down the Layout’s object tree. In this case, Hide all profiles is a custom message that is not 
provided with NetObjects Fusion: see Creating Custom Messages.

Note that the Layout doesn’t command its objects to hide. It simply passes along the Hide all profiles 
message, and any object that understands that message—because it has an action of its own that is 
triggered by a Hide all profiles message—acts on it.

The selected location button then sends one Show message to its corresponding location profile, and 
that profile object displays itself.

The net result: you assign 20 actions, not 100, and when a new office location opens in Quebec, all you 
add is one location button, one profile object, and two actions—instead of having to add the hide Quebec 
profile message to all other office locations.



Configuring Cascading Actions
1. In Page view, create the objects that you want to act upon, and embed them in the container of 

your choice.

2. Add the object that will trigger the action.

The default Properties palette for the trigger object appears.

3.  Select the Actions tab and click the Add Action button to add a new Action, and name the 
action if appropriate.

4. In the Target Object Tree, select the container—Layout, MasterBorder, Layout Region, or text box
—in which you embedded the objects in step 1. This is the container you want to target for the cascaded 
action.
5. Select the Cascade action option.
6. Complete the action configuration as needed, and click OK.
7. Preview or publish the site locally and test the cascading effect.



Assigning an Action to a Text Link
1. In Page view, select text you want to link.

2. On the Format tab of the Properties palette, click Link.

The Link dialog appears.

3. Select a link in one of the four link tabs.

If you want the link to launch the action, but you don’t want the link to display a new page in the 
browser, choose the Blank link on the Smart Link tab.

4. Click the Actions button.

The Actions dialog appears.

5. Click the Add Action button and add an action as described in Adding Actions to Objects.

6. Click OK in the Actions dialog.

7. Click Link in the Link dialog.



Customizing Actions
The actions, messages, and values described in Adding Actions to Objects are predefined by and 
provided with NetObjects Fusion. They represent samples of the typical actions you will use to make your 
pages dynamic. However, you might also want to:

l Create custom messages to support specific combinations of actions.

l Script custom actions using JavaScript or VBScript to produce exactly the results you want.

l Script JavaScript expressions to create effects or perform functions.



Creating Custom Messages
You can create custom messages and use them as trigger or action messages. Any custom message that
you define and use will typically be used twice: once as the action Message, sent when triggered by some
other event, and once as the When message, to trigger another event.

For example, in the office locations example described in Creating Cascading Actions, the custom 
message Hide all profiles works like this:

1. When the site visitor clicks an office location, the custom message Hide all profiles is sent as a 
cascading action message to the Layout.

2. The Layout receives the custom message, but it doesn’t have any actions triggered by this 
message. The Layout cascades the message down to its embedded objects.

3. The custom message Hide all profiles is received by each object contained in the layout. Each 
profile object has an Object Hide action that is triggered by the message Hide all profiles. As a 
result, each profile object hides itself when it receives the custom message.

To create a custom message:

1. In the Set Action dialog, from the When or Message option menus, select Custom, Edit.

The Custom Messages list box appears.

2.  Click the plus (+) button.

The Add Message dialog appears.

3. Enter the message exactly as you want it to be used in other actions, and click OK.

The message is added to the Custom Message list box. The next time you select Custom from 
the When or Message option menus, NetObjects Fusion displays your custom message as one of
the choices.



Deleting a Custom Message
1. In the Set Action dialog, select Custom, Edit from the When or Message option menus.

The Custom Messages list box appears.

2. Select the message you want to delete, then click the minus (-) button.

The custom message disappears from the Custom Messages list box.

3. Click OK.



Scripting Custom Actions
The action events and messages you can choose from the Set Action dialog are defined by NetObjects 
Fusion in the default JavaScript Beans file: \NetObjects Fusion 3.0\NetObjects System\
NetObjects Fusion.jsb. You can also use the Set Action dialog to script your own actions for any object. 
You can define these actions in any valid scripting language: JavaScript, JScript, VBScript, or CGI.

To add a scripted action to an object:

1. In Page view, select the object.

The object’s default Properties palette appears.

2. Select the Actions tab.

The Action tab displays the Object ID for the current object.

3. By default, the Object initially visible in browser option is checked. If you want this object to be 
hidden when the page is loaded, clear the check box.

4.  Click the plus (+) button in the lower left corner to add an action.

The Set Action dialog appears.

5. Check the Scripted action option in the bottom left corner.

NetObjects Fusion modifies the Set Action dialog to display the Action scripting text box.

6. Use the Action text entry field to enter your scripted action. NetObjects Fusion gives you three 
methods for building a custom script: 

l You can enter script or paste any valid JavaScript, JScript, or CGI coding directly into the 
text entry field. NetObjects Fusion does not validate or otherwise check the code you 
enter.

l You can insert a predefined script from another file.

l You can insert any action you have already defined for this object.

Use all three methods as needed to create a scripted action.



Inserting a Script in a Scripted Action
1. In the Set Action dialog, click the Scripted action option, and then click Insert Script to display a 

File Open dialog.

2. Use the dialog to navigate to and select the source file for your script. Change the Files of type 
setting to All Files (*.*) if necessary.

3. Click OK to insert the contents of the selected file.

NetObjects Fusion inserts the script from the selected file.

This is particularly helpful if you are sharing scripts with other developers, or if you are 
implementing a script that someone else developed.



Inserting an Existing Action
1. In the Set Action dialog, click the Scripted action option, and then click Insert Action.

The list of the Actions assigned to the current object appears.

2. Select the Action you want to insert, and click OK.

NetObjects Fusion inserts a call to the selected action, in the form $Actionn where n is the 
number of the action as it was created, and places the statement in the text box. Actions are 
numbered when you create them.

3. Insert other scripts or actions, as needed.

4. Click OK when you finish scripting the action.

NetObjects Fusion adds the scripted action to the Action list box.



Scripting JavaScript Expressions
You can script your own JavaScript expressions to use as parameter values for any action. These 
JavaScript expressions can return individual values for specific parameters. They can return objects with 
multiple values. They can obtain values from form objects and forward them as message parameters.

You can enter JavaScript expressions directly, or you can assemble an expression out of existing actions 
for that object. For example, you could define an expression that tests for a particular server condition—
such as time of day—and then launches specific actions that you defined using the Set Actions dialog 
based on that condition.

For more information about JavaScript and scripting expressions, consult the resources at 
www.developer.com/directories/pages/dir.javascript.html.
To script an expression for the value of a message parameter:

1. In Page view, select the object and add any actions that you want to use as components of the 
scripted expression. See Adding Actions to Objects for specific steps.

2. In the Action list box, select the action whose parameter value you want to set to the expression, 
and click OK.

3. In the Set Action dialog, set the other values of the action as appropriate.

4. Select Expression from the Parameter drop-down list. 

The JavaScript Expression edit dialog appears.

5. Enter in the text field the JavaScript expression you want to use to determine the value of this 
parameter.

6. If you want to build your expression around or with existing actions, click the Insert Action button.

NetObjects Fusion displays a list of actions you already defined for this object. Select the action 
you want to insert and click OK.

Note: Expressions must be written in valid JavaScript. NetObjects Fusion does not perform any 
error- or syntax-checking of your expression.

7. When the expression is completed, click OK.

The parameter is set to the value generated by the expression, and the Set Action dialog 
appears.

8. Repeat steps 1 through 4 for other parameter values you want to set to expressions.



Modifying Existing Actions
1. In Page view, select the object that has the action you want to modify.

The default tab of the object’s Properties palette appears.

2. Select the Actions tab. The actions you added to this object are listed.

3. To change the sequence of actions for this object:
a. Select an action that’s out of sequence.

b. Press the up or down arrows in the bottom right corner to move the selected action.

c. Repeat as needed.

Actions are launched by their trigger events, or messages. If two or more actions share the same 
trigger action, they are run in the order in which they appear.

4. To suppress an action so NetObjects Fusion does not include it when the site is published, clear 
that action’s check box on the Actions tab. A suppressed action can, however, be inserted in a 
scripted action.

5. To change the properties of an action—the name, trigger, target, message, parameters, or 
cascade setting—double-click the action you want to modify.

The Set Action dialog appears with the current action configuration shown. You can change any of
these settings as needed.



Customizing Action Choices
The Set Action dialog is dynamically built when NetObjects Fusion starts up, based on the contents of the 
NetObjects Fusion.jsb file located in the \NetObjects Fusion 3.0\NetObjects System folder. The 
NetObjects Fusion.jsb file, in turn, is based on the JavaScript Beans specification.

If you are experienced in JavaScript programming, you can edit this file to:

l Add, delete, or modify the choices available from the Set Action dialog.

l Change the default or potential values of parameters.

l Replace or supplement the .jsb file with your own files.



Working with HTML Directly
In addition to adding content, links, and Dynamic Actions™ to your site using NetObjects Fusion’s tools, 
you can work directly with the code to insert HTML and script yourself. For example, you can add 
<META> tags to index your site for search engines, power content with JavaScript or Visual Basic 
routines, center pages throughout your site, or do whatever else you can when coding raw HTML. You 
can’t edit the HTML NetObjects Fusion generates, but you can add your own code virtually anywhere.

Before working with HTML directly, you should be familiar with HTML tags and page structure. There are 
many books and Web sites to learn from. If you’re not familiar with HTML, you can still complete the tasks
in Examples of Adding Page HTMLand Examples of Object HTML.

You can also code custom frames and framesets, insert code within link tags, and add your own actions. 
See Creating Custom HTML Framesets and Frames, Adding HTML to a Link, and Customizing Actions.

Note: NetObjects Fusion doesn’t verify HTML you add, so be sure to use valid syntax, enclosing scripts 
within <SCRIPT> and </SCRIPT> tags, and so on. Also, assets referenced in your HTML aren’t managed
in Assets view. If you move the HTML or its assets in your directory structure, edit paths in the HTML 
accordingly.



Accessing the Page's HTML
You can add HTML or script to the <HEAD> or <BODY> of the HTML NetObjects Fusion generates. First, 
select the area of the page you want to access—the Layout area to access the current page’s HTML, or a
MasterBorder or AutoFrame to access the HTML of several pages.

Note: If your site uses frames, access Master HTML to add code to the frameset NetObjects Fusion 
generates, and access Frame HTML to customize that frame.

Then use the Page HTML dialog to add code between the <HEAD> tags, inside the <BODY> tag, or at 
the beginning of the <BODY>.

1. In Page view, click in the Layout area, MasterBorder, or an AutoFrame.

To select a ZeroMargins MasterBorder, click outside the page. See Modifying a MasterBorder.

2. Click the HTML button on the Properties palette.

Click the Frame tab to locate the button for accessing AutoFrame HTML and adding code to a 
frame’s contents.

To access frameset HTML, select the MasterBorder or AutoFrame; then click the HTML button on 
the General tab, or right-click in the Layout, MasterBorder, or AutoFrame, and select Layout 
HTML, Master HTML, or Frame HTML from the shortcut menu.

The Page HTML dialog appears.

3. Click a tab to indicate where in the HTML you want to add tags or script.

l Between Head Tags. Adds code to the <HEAD> content, inserting it just before the 
</HEAD> tag.

l Inside Body Tag. Adds code inside the <BODY> tag, as in <BODY attribute=value>, 
where attribute=value is your code.

l Beginning of Body. Adds code just below the <BODY> tag.

4. Enter your code in the white area of the dialog.

Your typing, shown in blue, appears in the dialog’s grey area, where you can preview its location 
in the HTML NetObjects Fusion generates.

You can click the Insert button to insert contents of an HTML, script, or other text file. Click the 
Field button to insert a field. For information on fields, see Managing Variables.

5. Click OK.

Preview the site to test your code, and view the source from your browser to see the resulting HTML.

To edit your code, open the Page HTML dialog again, click the tab containing the code, and make your 
changes.

Note: If you convert an AutoFrame back to a MasterBorder, code added to the frame’s content HTML is 
deleted.



Examples of Adding Page HTML
Centering a page’s contents

Indexing pages for search engines

Auto forwarding from a transition page



Centering a Page's Contents
NetObjects Fusion generates fixed-width pages by default. As a result, content doesn’t widen or narrow 
when site visitors resize their browsers. If your pages are narrow, you can center them to avoid an 
imbalance of white space by adding the <CENTER> tag at the beginning of each page’s <BODY>.

1. In Page view, click in the Layout area of the page you want to center, in a MasterBorder to center 
a set of pages, or in an AutoFrame to center just the contents of the frame.

2. Click the Frame tab locate the HTML button for an AutoFrame.

The Page HTML dialog appears.

3. Click the Beginning of Body tab and type <CENTER>.

4. Click OK.

Preview the site and resize your browser to test the centered pages.

You can’t use NetObjects Fusion to add a <\CENTER> tag at the end of the page’s <BODY>, which is 
considered standard HTML syntax. Although this breach of protocol might be noted by an HTML code-
checking program, it doesn’t cause problems in your site.

For information on scaling page content, see Changing Layout Size.



Indexing Pages for Search Engines
To give your content the best chance of being found and ranked by search engines like AltaVista, you can
add <META> tag descriptions and keywords to your pages’ <HEAD> content. Site visitors don’t see this 
information, but search engines require it to index your site.

Note: Search engines index frameset files, so if your site uses frames, be sure to access MasterBorder 
HTML so your tags are added to the frameset file. 

1. In Page view, click in the Layout area of the page you want indexed, or in the MasterBorder or 
AutoFrame to index a set of pages.

2. Click the HTML button on the General tab of the Properties palette, or right-click and select 
Layout HTML or Master HTML from the shortcut menu.

The Page HTML dialog appears.

3. Click the Between Head Tags tab and enter <META> tags that describe your content. For 
example, type:

<META NAME="DESCRIPTION" CONTENT="Large selection of valuable, high quality antiques 
and collectibles for any budget.">

where the content is a one-sentence description containing the most important keywords site 
visitors might search for. Then type:

<META NAME="KEYWORDS" CONTENT="antiques, quality antiques, valuable antiques, low-
cost antiques, collectibles, jewelry, furniture, novelties">

where the content lists all important keywords.

4. Click OK.

5. Register your site with search engines.

You must do this separately with each search engine for it to find your site. Visit AltaVista, Excite, 
Lycos®, Yahoo®, and so on, for information.

To see the resulting HTML, you must publish the site locally or on your Web server and view the source in
your browser. To test the tags you added, publish on your Web server and search for keywords using the 
various search engines—be patient, as it can take days or weeks for indexers to find your site.

Search engines continually evolve how they use <META> tags and other content to index and rank 
pages, and many of them make this information available at their sites. Check there to find out about 
other techniques.



Auto-Forwarding from a Transition Page
You can create a transition page that appears for a few seconds, for example, to display a product logo, 
and then forwards site visitors automatically to another page. You do this by inserting a <META> tag in 
the page’s <HEAD>.

1. In Page view, click in the Layout area of the transition page, and click the HTML button on the 
Layout Properties palette.

The Page HTML dialog appears.

2. Click the Between Head Tags tab and type:

<META HTTP-EQUIV="REFRESH" CONTENT="seconds; 
URL=http://server.domain.com/page.htm">
where seconds is the number of seconds you want the transition page to appear, and 
http://server.domain.com/page.htm is the URL of the page you want to link to.

3. Click OK.

Preview the site to test the transition, and view the HTML source in your browser to see your code.



Accessing an Object's HTML
You can add HTML or script to pictures, media, a text box, or any other object, to modify or control that 
object. You can enclose the object in HTML tags, or add HTML or script inside the object’s tag.

You can add code before and after a text box’s HTML as described here. For information on inserting 
code inside the contents of a text box, see Inserting HTML in a Text Box.

1. In Page view, select the object you want to add code to, and click the HTML button on the 
Properties palette.

You can also click HTML on the Object menu, or right-click the object and select Object HTML 
from the shortcut menu.

The Object HTML dialog appears.

2. Click the tab to indicate where you want to insert HTML or script.

l Before Tag. Adds code just before the object’s tag, as in your_code <IMG SRC=>, if the 
object is a picture.

l Inside Tag. Adds code inside the object’s tag, as in <BODY SRC=”Image.gif” attribute>, 
where attribute is your code.

l After Tag. Adds code just after the object’s tag; for example, to insert a closing HTML tag 
for any opening tag inserted before the object.

3. Enter your code in the white area of the dialog.

Your typing, shown in blue, appears in the dialog’s grey area, where you can preview its location 
in the object’s HTML.

You can click the Insert button to insert contents of an HTML, script, or other text file. Click the 
Field button to insert a field. For more information on fields, see Managing Variables.

4. Click OK.

Preview the site to test your code, and view the source from your browser to see the resulting HTML.

To edit your code, open the Object HTML dialog again, click the tab where you entered code, and make 
your changes.



Examples of Object HTML
Displaying a message on mouse click

Linking to a new window



Displaying a Message on Mouse Click
You can display a message when site visitors click an image or text link. One way to do this is by creating 
a Blank link and inserting an onClick JavaScript in the link’s opening <A HREF> tag.

1. In Page view, select the image or exact text site visitors are to click, and click the Link button on 
the Properties palette.

The Link dialog appears.

2. Click the Smart Link tab and select a Blank link.

See Creating a Smart Link.

3. Click the HTML button in the Link dialog.

The Object HTML dialog appears.

4. Click the Inside Tag tab and type:

onClick="alert('your message')"
where your message is the text of your message.

5. Click OK in the Object HTML dialog, then click Link in the Link dialog.

Preview the page and click the image or text to see the message. View the HTML source in your browser 
to see the resulting HTML.

Another way to add this JavaScript to a picture or text link is to create a custom link. In the Link dialog, 
click the External Link tab, choose javascript from the URL drop-down list, and type the onClick script in 
the URL field. See Linking to a New Window for another example of creating a link this way.



Linking to a New Window
You can have a link open a page in a new browser window rather than in the current window, for example,
so site visitors can keep the current page around while exploring a new part of your site. To do this, define
a window.open JavaScript in a page’s <HEAD>, and call the function from the link using the Link dialog.

1. In Page view, select the image or exact text to be the link, and click the Link button on the 
Properties palette.

The Link dialog appears.

2. In the Link dialog, click the External Link tab and create a custom link.

URL. Choose javascript from this drop-down list. In the field, type openMe().
Asset Name. In this field, type NewWindow, which identifies the link in Assets view.

3. Click the Link button to close the dialog.

4. On the same page, click in the Layout area or MasterBorder depending on where the link is, and 
click the HTML button on the Properties palette.

The Page HTML dialog appears.

5. Click the Between Heads tab and type:

<SCRIPT LANGUAGE="javascript">
function openMe() 
{
window.open("http://server.domain.com/filename.htm", "newwindow")
}
</SCRIPT>
where http://server.domain.com/filename.htm is the URL of the page you’re linking to.

6. Click OK.

Preview the page to test the link, and view the HTML source in your browser to see the resulting HTML.



Inserting HTML in a Text Box
You can insert HTML or script inside the contents of a text box at the insertion point; for example, to add 
text attributes or comments to the HTML.

1. In Page view, double-click in the text box to get an insertion point.

2. From the Text menu, select Insert HTML.

The Insert HTML dialog appears.

3. Enter your HTML or script.

4. Click OK. 

Preview the page to test your code, and view the source from your browser to see the resulting HTML.



Coding Your Own Objects
You can create an object, such as a Java applet or a table you want to code yourself, by entering HTML 
or script in an empty text box.

1. In Page view, draw a text box where you want the object to go.

The box marks the object’s position when you publish, but it can grow vertically or horizontally 
depending on the object. To approximate the published size in your Layout area, select Lock Size 
on the object’s Properties palette.

2. From the Text menu, select Insert HTML.

The Insert HTML dialog appears.

3. Enter the HTML or script.

4. Click OK. 

Preview the page to test your code, and view the source from your browser to see the resulting HTML. If 
necessary, go back and adjust the box’s position in Page view to get the actual spacing you want.



Creating Custom HTML Framesets and Frames
This topic describes how to use the Page HTML dialog to create custom HTML frames entirely from 
scripts.

Understanding the differences between custom HTML frames and AutoFrames can help you choose 
which to use. It’s easier to create frames using AutoFrames, and you can customize them with custom 
HTML or scripts.

You can also create the frameset page in another HTML editor, such as Allaire’s HomeSite, and then 
reference the frameset page as an External HTML page. This way, NetObjects Fusion manages the 
frameset page as an asset, and you can create the frameset’s content pages as regular pages in 
NetObjects Fusion. See Referencing and Editing External HTML for information about referencing 
external pages.

Although these tools help you create framed pages to meet most of your needs, on some occasions you 
may want to create custom frames using NetObjects Fusion’s HTML access feature.



Understanding Frames
Frames are an HTML mechanism you can use to subdivide a page Layout so it displays in the browser 
window as multiple independent areas. Each frame displays its own content, made up of a separate page 
or resource that can include links, form objects, regions, or any text, graphic, or media objects.

A special type of page—called a frameset—establishes the combination of frames and frame properties 
that make up the complete Layout. The frameset sets the number of frames, defines their size and 
placement, and specifies the pages or resources that make up their original or default content.

Within a frameset, each frame has the characteristics of an individual page. Site visitors viewing a 
frameset can drag frame borders and scroll frame contents to display information. A link in a frame can 
display new information in any frame within the frameset, or load an entirely different page that replaces 
the frameset. You can target links to specify what happens within each frame when a site visitor clicks 
linked items.

In addition to the AutoFrames function, NetObjects Fusion provides HTML access capabilities necessary 
to create frames directly in HTML. If you know the HTML used to create frames, you can create custom 
frames in NetObjects Fusion just as you create frames in an HTML editor.

This chapter describes how to script a simple frameset. For information on other uses of NetObjects 
Fusion’s HTML access feature, see Working with HTML Directly.

Note: You must know HTML frame coding to script frames in NetObjects Fusion. If you need background 
information, see the resources at www.newbie.net/frames/.



The Frame Scripting Process
To script frames in NetObjects Fusion, follow this process:

1. Determine how and where you want to use frames in your site, as described in Planning Your Use
of Frames.

2. Create a frameset page and define the appearance and function of the frames within it. See 
Defining a Frameset.

3. Add non-frame content for site visitors using older browsers that don’t support frames. See 
Adding Content for Frameless Browsers.

4. Create the content pages that will be displayed in the frames. See Creating Frame Content.

5. Define links and determine frame targeting. See Scripting and Targeting Links.



Planning Your Use of Frames
Begin your frame scripting efforts by planning the appearance and use of frames.

l Determine which pages within your site you want to display in frames. If you want the entire site 
framed, for example, then you create your frameset on the site’s Home page. If you only want certain 
sections—such as technical publications or references—displayed in frames, then you can create your 
frameset as the top page of that section, and arrange the content pages as child pages beneath it.

l If you apply frames only to a section of your site, decide how you want site visitors to navigate in and 
out of the framed section:

– You can link to the frameset from other pages in the site with the normal methods, using either 
navigation bars or specific object links.

– To link from the frameset back to the non-framed parts of the site, you must include a properly 
targeted link on one or more of the content pages of the frameset. If you don’t create an exit link, you
might leave your site visitor with no way to navigate out of your frameset.

l Plan in which frame your links will display retrieved results. You might want to define default link targets
for certain content pages, and specific target frames for selected links.



Defining a Frameset
1. In Site view, create and name a new page at the location where you want the frameset.

2. Go to the page in Page view and select the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button.

The Between Head Tags tab of the Page HTML dialog appears.

4. In the text field of the tab, enter the HTML code that defines the page as a frameset and defines 
the size, names, and configuration of the frames it contains.

5. You can include other HTML frame attributes as needed. For example, to set a frame to have 
zero margins enter this HTML between the frameset tags:

<frame name=”menu” src=”../html/menu.html” scrolling=”no” marginwidth=0 
marginheight=0>

6. Click OK, and your frameset is established.



Frameset Paths and File Names
The src attribute of a <FRAME> tag identifies the URL of the source file that first displays in that frame. 
This can be a relative path, like the one shown above, or an absolute URL.

If the source file for your frame is an internal page, you must make sure the src attribute exactly matches 
the file name that NetObjects Fusion assigns when it creates the page. For example, if your source page 
name has spaces or special characters, NetObjects Fusion converts those special characters and spaces
to underscores when it generates the page. When you script your frame to use that page as its source, 
you must also use an underscore in the source file name so the frame can find the file.

You also have to define the relative path to the source file correctly. NetObjects Fusion determines the 
relative path to an internal page at the time you are prepared to publish the site. The directory structure 
you select before you preview or publish your site defines the relative paths between the files.

NetObjects Fusion offers three predefined site structures, and you can also customize the structure 
yourself. Customizing Your Directory Structure describes these choices in detail.



Relative Path Scenarios
If you use one of NetObjects Fusion’s directory structure choices, consider these relative path scenarios 
when you define your frameset.

For these examples, page.html stands for any content page, section_name refers to any site section, 
and index.html represents your Home page. Your own file names may be different.

l If you publish with a Flat directory structure, NetObjects Fusion puts all content files, including the 
Home page, in the same directory. Relative paths in a flat structure are always expressed as 
./page.html or ./index.html.

l If you publish with By Asset Type directory structure, NetObjects Fusion puts the Home page in the top 
directory, and all content pages in the /html subdirectory below it. Other types of assets have their own 
subdirectories. Relative paths in an asset type structure are expressed as follows:

– If the frameset is the Home page for your site, the relative path to your content pages is 
./HTML/page.html.

– If the frameset is not your Home page, the relative path to your content pages is ./page.html.
– If the frameset is not your Home page, but you want to use the Home page as a source file for one of

your frames, the relative path to the Home page is ../index.html.
l If you publish with By Site Section directory structure, NetObjects Fusion puts the Home page in the 

top directory, creates a subdirectory named for each major section of the site, and puts the content 
pages into subdirectories for each section. Relative paths in a site section structure can be expressed 
as follows:

– If the frameset is the Home page for your site, the relative path to your content pages is 
../section_name/page.html.

– If the frameset is in the same section as its content pages, the relative path to the content pages is
./page.html.

– If the frameset is in a different section than its content pages, the relative path to the content pages is
../section_name/page.html.

– If the frameset is not your Home page, but you want to use the Home page as a source file for one of
your frames, the relative path to the Home page is ../index.html.



Creating Frame Content 
After you define your frameset, you add or refine the content pages or resources for each frame. You can 
use all NetObjects Fusion tools that you would normally use for page and content development, but 
consider these issues:

l The frames created by your frameset constrain the size of your content pages. For example, if you set 
frames to be unscrollable and then create a content page that’s too big for the frame, your site visitor 
won’t be able to see the entire page. Keep track of your frame dimensions and reset your Layout size 
to match.

l Arrange the hierarchy of your site to support your framed content. For example, if you want the 
frameset to be the sole access point for the pages in the frames, organize the content pages as 
children of your frameset page. This simplifies managing NetObjects Fusion’s automatic navigation 
links.

l Links within scripted frames have special targeting requirements, which are discussed in Scripting and 
Targeting Links.



Scripting and Targeting Links
Targeting is the technique of specifying which frame a link is supposed to use to display its retrieved 
content. When a site visitor clicks a link within a scripted frame, the retrieved content can appear in one of
three targeted locations:

l The frame that contains the link itself. This is the default browser behavior, but it’s not usually the 
targeting behavior that you want.

l A default target frame that you define for a particular frame content page. If you set a default target for 
the page in left_frame, for example, all links on that page retrieve their content into the target frame, 
unless you define a different, specific target for individual links.

l A specific target defined only for that link. This target can be:

– Any other frame in the current frameset.

– A full browser window with no frames. This replaces the frameset with the retrieved content displayed
in the full browser window.

– A new, additional browser window, also known as a browser instance. This leaves the original 
browser window open and the original frameset intact.

Note: If you do not specify any default or specific targets, links within your frames follow the default 
browser behavior: the retrieved content displays in the same frame as the link, overwriting the page 
containing the original link.



Scripting a Default Target Frame
You can set the default target frame for any content page, whether it’s the original content for that frame 
(the page entered as the value of src in the <FRAME> tag) or simply another content page. If, for 
example, you create a frame intended to provide site navigation, then you set its default target to be the 
body or main frame, so all links display their content in the proper frame.

To script a default target frame:

1. In Page view, open the content page to be targeted.

2. Click the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button.

The Between Head Tags tab of the Page HTML dialog appears.

4. In the text field on that tab, enter: 

<base target="framename">
using the actual name of your target frame.

5. Click OK.

6. Add or select several objects in the Layout of this page and link them to appropriate pages or 
resources.

7. Preview or publish your site and view the frameset page. Then test the default links. All retrieved 
resources should be displayed in the targeted frame.



Scripting Targeted Links
You can also define a specific target frame for each individual link. As noted previously, these targets can 
be another frame in the current frameset, a full browser window with no frames, or an additional browser 
instance.

1. In Page view, select an object or text to link.

2. In the Properties palette for that object, click Link.

The Link dialog appears. 

3. Select the tab for the type of link you want and select the page, resource, or anchor you are 
linking to.

4. Click the HTML button to display the Object HTML dialog.

5. Select the Inside Tag tab and enter the following HTML:

< target="framename">
using the actual name of your target frame. For example, you might use the following HTML for a 
link to a secondary menu page.

6. Click OK and the Link dialog appears. Click Link to complete the link.



Adding Content for Frameless Browsers
Some site visitors may have browsers that don’t support frames, so you should include unframed content 
to give them some information when they access your site. Site visitors using browsers that do support 
frames do not see this content.

To define this alternate content for frameless browsers, you can use the HTML 
<NOFRAMES></NOFRAMES> tag to add text, pictures, and links to the frameset that you created by 
modifying the layout HTML and the contents of your frameset page:

1. In Page view, open the frameset page.

2. Click the Layout.

The General tab of the Layout Properties palette appears.

3. Click the HTML button to display the Between Head Tags tab of the Page HTML dialog.

4. Select the Beginning of Body tab. In the text field of this tab, enter:

<noframes>
...your message to frameless site visitors, using any valid HTML tagging
</noframes>

5. Click OK to close the dialog.

A site visitor with a browser that supports frames sees the framed site as you designed it. A site visitor 
with an older, frameless browser sees the <NOFRAMES> message.



Working with AutoFrames
When you use AutoFrames, you use the MasterBorder to create an HTML frameset—a multi-paned page 
that lets you deliver multiple content pages in one browser window. When you preview or publish the site, 
NetObjects Fusion converts all pages that use that framed MasterBorder into content pages for the 
frameset. The process of using AutoFrames to create a frameset is described in Using AutoFrames.

These topics expand your use of AutoFrames to exercise greater control over framed pages. They explain
how NetObjects Fusion generates HTML pages that contain AutoFrames, and describe how to add HTML
or scripts to individual frames or the main frameset, so you can customize AutoFrame pages.

For example, you can:

l Target links in your AutoFrames to specify where they display results.

l Include content within the <NOFRAMES> HTML tag, so site visitors using frameless browsers—older 
browser versions that don’t support frames—see some content or message.

l Add <META> tags and information to any frameset or frame content pages.

The combination of AutoFrames and custom scripting will probably meet your needs for frame-based 
pages. To create your frames completely from scratch, see Creating Custom HTML Framesets and 
Frames.



Targeting Links in AutoFrames
Before you customize AutoFrames, you should understand these basics about HTML frame targeting:

l HTML frames divide the browser window into multiple areas. When a site visitor clicks a link that’s 
placed within a frame—including the main or body frame—the browser has to know where to display 
the results.

l The frame that displays the retrieved content is considered the target of the link; when you specify 
which frame is to display the results of a link, you are targeting that frame.

l In HTML, you can set a default target for a frame that targets all its links to a specific frame, or you can 
define targets for individual links. You can also do both; an individual link target overrides any default 
target set for that page.

When NetObjects Fusion generates AutoFrame pages, it inserts a <base target=”_parent”> statement into
the HTML of each frame. This defines the frameset as the default target for any links within each frame. 
You can override this default by defining an individual link to target a specific frame.

You cannot reset the default target in AutoFrames, however; if your page design requires that you set a 
specific default target, you have to script the frames yourself. See Scripting a Default Target Frame.

When NetObjects Fusion generates the AutoFrames, it names the frames Left, Right, Header, Footer, and
Body. The read-only Frame name field on the Frame tab of the MasterBorder Properties palette displays 
the name of the currently selected frame in grey text.

If the framed MasterBorder contains a dynamic element such as a banner, highlighted navigation buttons,
or a smart link, NetObjects Fusion names the source page for that frame one of the following:

l Left_PageName.htm
l Right_PageName.htm
l Bottom_PageName.htm
l Top_PageName.htm
where PageName is the name of the page that forms the frameset.

The dynamic element, by definition, changes from page to page, so NetObjects Fusion has to create 
separate pages for each MasterBorder.

If the MasterBorder does not contain any dynamic elements, NetObjects Fusion names the source page 
for that frame one of the following:

l Left_MasterBorderName.htm
l Right_MasterBorderName.htm
l Bottom_MasterBorderName.htm
l Top_MasterBorderName.htm
This source page is then used by all the frameset pages that share that MasterBorder.



Targeting Specific Links 
When you add a link to an object located in an AutoFrame frameset, you can target the retrieved results 
to display in one of three places:

l In a different frame on the same page within the same frameset. Use this to target content to display in 
any frame other than the body frame.

l In the full browser window with no frames. This removes the current frameset and displays the retrieved
content in the full browser window.

l In a new, additional browser window opened just for that purpose. This window is also known as a new 
browser instance. This leaves the original browser window open and the original frameset intact.

When you create AutoFrames, you must also consider whether the browser refreshes all or part of the 
entire frameset when a site visitor clicks a link. Although this is not a linking issue, it has an impact on 
visitors to your site. For more information, see AutoFrames and Browser Refresh.



Targeting a Link to Internal Pages 
1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. If you’re linking to an internal page, select the page to be linked from the Page Name list. To 
target a specific anchor on that page, select it from the Select Anchor drop-down list.

If you’re linking to an anchor location on the current page, select Current Page and choose an 
anchor from the Select Anchor drop-down list.

4. Choose the target frame in which you want to display the linked information from the Select 
Frame Target drop-down list.

5. Click Link to close the dialog and create the link.

6. Preview or publish locally and test your targeted links.

See Working with HTML Directly for information on scripting techniques and requirements.



Targeting a Smart Link to Internal Pages 
1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog is displayed.

3. Select the Smart Link tab.

4. Select the Smart Link you want from the Link Types list.

5. Select the targeted AutoFrame from the Select Frame Target drop-down list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.



Targeting a Link to External Pages 
1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the External Link tab.

4. If you are linking to a new external resource:
a. Select the correct protocol for this resource from the URL drop-down list. http:// is the 

default for HTML pages.

b. Enter the complete URL for the linked resource in the second URL field.

c. Enter a name for the external resource in the Asset Name field.

If you are linking to an existing external resource, select its name from the list of link assets.

5. Select the targeted AutoFrame from the Select Frame Target drop-down list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.



Targeting a File Link
1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the File Link tab.

4. If you are linking to a new file resource:
a. Enter the complete URL for the linked resource in the URL field, or click Browse to open a

file dialog and find the resource.

b. Enter a name for the external file in the Asset Name field.

If you are linking to an existing file resource, select its name from the list of file assets in the 
dialog.

5. Select the targeted AutoFrame from the Select Frame Target drop-down list.

6. Click Link to close the dialog and create the link.

7. Preview or publish locally and test your targeted links.



Targeting the Full Browser Window
To display the retrieved resource in the full browser window—regardless of the type of link you use—you 
can script the necessary targeting HTML yourself.

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

NetObjects Fusion displays the Internal Link tab of the Link dialog.

3. Select the tab for the type of link you want—Internal, Smart Link, External, or File.

4. Select or enter the page or resource that you are linking to the selected object.

5. Make sure Select Frame Target drop-down list is set to (none).

6. Click the HTML button.

The Before Tag tab of the Page HTML dialog appears.

7. Select the Inside Tag tab. In the text field, enter:

target="_top"
This inserts your target statement inside the link tag that NetObjects Fusion creates for your 
object. The value “_top” is an HTML default that displays the retrieved resource in the full 
browser window.

8. Click OK to close the Page HTML dialog.

9. Click Link to create the targeted link.

10.Preview or publish locally and test your targeted links.

See Working with HTML Directly for information on scripting techniques and requirements.



Targeting a New Browser Window
To display a linked resource in a new browser window, you can script the necessary targeting HTML.

1. In Page view, select the object or text that you want to link.

The object’s Properties palette appears.

2. Click the Link button.

The Internal Link tab of the Link dialog appears.

3. Select the tab for the type of link you want—Internal, Smart Link, External, or File.

4. Select or enter the page or resource that you are linking to your selected object.

5. Make sure the Select Frame Target is set to (none).

6. Click the HTML button.

The Before Tag tab of the Page HTML dialog appears.

7. Select the Inside Tag tab. In the text field, enter:

target="_blank"
This inserts your target statement inside the link tag that NetObjects Fusion creates for your 
object. The value “_blank” is an HTML default that displays the retrieved resource in a new 
browser window.

8. Click OK to close the Page HTML dialog.

9. Click Link to create the targeted link.

10.Preview or publish locally and test your targeted links.

See Working with HTML Directly for information on scripting techniques and requirements.



AutoFrames and Browser Refresh
When a site visitor clicks an untargeted link in a frame that you created with AutoFrames, the browser 
either refreshes the content of the body frame only, or it refreshes the entire page. Although this doesn’t 
affect the appearance of the page, for performance reasons you don’t want the browser to refresh the 
entire page unnecessarily.

The HTML code that NetObjects Fusion generates for your AutoFrame pages controls this according to 
the factors listed below. In all cases this is based on untargeted links—links that depend on the default 
target of the frame. Use this information to plan your use of AutoFrames:

l The browser refreshes the entire window if any one of the framed MasterBorders contains a dynamic 
object, such as a banner, highlighted navigation buttons, or a smart link. The dynamic object, by 
definition, changes from page to page, so the browser has to load the new page.

l The browser exits the frameset and displays the retrieved resource in the full browser window if the link
retrieves a page with a different MasterBorder, or an external HTML page.

If neither of these conditions exist, the browser refreshes the body frame only.



Adding Content for Frameless Browsers
Some site visitors might have browsers that don’t support frames, so you should include unframed 
content. Site visitors using browsers that support frames do not see this content.

To define alternate content for frameless browsers, you can use the HTML 
<NOFRAMES></NOFRAMES> tag to add text, pictures, and links to the frameset that you created with 
AutoFrames.

1. In Page view, click a border of the frameset page.

The General tab of the MasterBorder Properties palette appears.

2. Click the HTML button. 

The Between Head Tags tab of the Page HTML dialog appears.

3. Select the Beginning of Body tab. In the text field of this tab, enter:

<noframes>
...your message to frameless site visitors, using any valid HTML tagging
</noframes>

4. Click OK to close the dialog.

A site visitor with a browser that supports frames sees the framed site as you designed it. A site visitor 
with an older, frameless browser sees the <NOFRAMES> message.



Adding Other Scripts to AutoFrames
You can use the Page HTML dialog to add custom HTML or scripts to any frame in the frameset, or to the 
frameset itself.

1. In Page view, click a border of the frameset page.

The General tab of the MasterBorder Properties palette appears.

2. Click the HTML button.

The Between Head Tags tab of the Page HTML dialog appears.

3. Select the tab that places your HTML or scripting in the proper location. In the text field of this tab,
enter the HTML or script for the current frame.

4. Click OK to close the dialog

To add HTML or scripts to an individual frame:

1. In Page view, click the frame to which you want to add HTML or script.

The General tab of the MasterBorder Properties palette appears.

2. Select the Frame tab and click the HTML button.

The Between Head Tags tab of the Page HTML dialog appears.

3. Select the tab that places your HTML or scripting in the proper location. In the text field of this tab,
enter the HTML or script for the current frame.

4. Click OK to close the dialog.

For example, you may want to help search engines categorize your site by adding a set of keywords to 
the frameset using the <META> HTML tag. See Indexing Pages for Search Engines for an example of 
<META> tag scripting.



Managing Assets
NetObjects Fusion can manage all the files, links, data objects, and variables used in your site. In Assets 
view, you can navigate to the pages on which these assets appear, delete unused assets, and verify the 
location of assets that are in use. Because NetObjects Fusion uses aliases for files and external links, you
can globally replace an item that appears on several pages—such as a picture, an applet, or an external 
link—by replacing it once in Assets view. If you insert a variable in text boxes on different pages, you can 
edit the value of the variable in Assets view, and NetObjects Fusion updates all instances of the variable 
throughout your site automatically.



Working in Assets View
When you switch to Assets view, choose which kind of asset to view by clicking one of the four tabs below
the control bar. You can sort a list by clicking a column heading, and you can change the width of any 
column by dragging the column divider to the left or right.

Depending on the selected asset type, Assets view lists:
Files Links Data Objects Variables
Name Name Name Name

Type Link To Contents

In Use Type

Location Target

Size Verify Status

Date

Verify Status

Managing File Assets
When you click the Files tab, a list of the files associated with your site appears, including external files 
and those generated by NetObjects Fusion.

File types include:

l images

l audio 

l video

l applets/plugins

l Java scripts

l HTML

In Assets view you can add new assets and edit the names of assets. You can go directly to the page 
containing a selected asset. You can replace assets, delete selected assets, or delete all unused assets 
in a single action. You can verify the locations of assets in your site, and you can open an asset file for 
editing in the application that created it.

The File dialog displays an asset’s name, location, and the pages on which it is used. To display the File 
dialog, double-click the asset’s name in the Assets Files view.

Note: Image files that you place on stacked pages to populate an internal data object are not listed in 
Assets view. You can manage such files directly on the stacked pages. For information about data objects
and stacked pages, see Data Publishing.



Adding File Assets
1. In Assets view, from the Assets menu choose New File Asset, or click New on the control bar.

The File dialog appears.

2. In the Location field of the File dialog, type the path and file name of the asset you want to add, or
click Browse and select a file.

3. If you want, edit the asset name and click OK. See Editing Asset Names and Locations.

4. To force publication of the file, even if it is not in use, you can select Always publish file.

If the new asset is an image file, its name appears on the Image Assets tab of the Picture File Open 
dialog.

When you add an asset in this manner, it is available for use in your site, but it is not yet actually in use. 
For information about placing image assets, see Using Image Assets.



Editing Asset Names and Locations
Giving custom names to assets can make them easier to manage. For example, if you have an image file 
of an arrow that indicates the next page in the site, you could name this asset “Next Page” and place it on
several pages. If you later decide to change the image to a pointing finger, you need only edit the file 
asset so Next Page uses the pointing finger image file. NetObjects Fusion automatically changes the 
image on all the pages that include the Next Page image asset.

To edit an asset’s name:

1. In Assets view, double-click the name in the Files list to display the File dialog.

2. Type a new name into the name in the Name field and click OK.

You can also edit the location directly in the File dialog. For example, you could enter a URL instead of a 
file path to point to a dynamic image on a server. Such images, however, are represented by an X in Page
view, because the asset is not accessible.



Displaying Pages Containing File Assets
1. In Assets view, double-click a file asset to open the File dialog.

2. Select the page you want to see from the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.



Replacing File Assets
You can change all occurrences of one asset file to another file. To replace an asset throughout the site:

1. In Assets File view, double-click the name of the asset you want to replace.

2. In the Location field of the File dialog, type the location of the replacement asset file, or click 
Browse and select the file from the dialog that is displayed.

3. If the asset is a picture, the Picture File Open dialog appears.

Select a new file from the Folders tab or an existing asset from the Image Assets tab and click 
Open.

4. Click OK in the File dialog to change all occurrences of this asset.

Note: If the asset is an image and the replacement image is not the same size as the original, 
you must go through the site and resize the new images accordingly.



Deleting File Assets
To delete a file asset that is not in use:

u In Assets view, select the file you want to delete, and choose Delete File Asset from the Edit menu or 
press Delete. Click Yes to confirm the deletion.

If the asset is in use, you must first delete all occurrences of the file throughout the site. To delete a file 
asset that is in use:

1. In Assets view, double-click the asset you want to delete.

2. In the File dialog, select a page containing the asset and click Go To.

NetObjects Fusion switches to Page view, displaying the page that contains the asset you want to
delete.

3. In Page view, select and delete the asset.

4. Repeat steps 1 to 3 until the object is deleted from all pages.

5. Return to Assets view and select the file you want to delete.

6. Choose Delete File Asset from the Edit menu or press Delete. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the New File Asset command to recreate the file 
asset.



Deleting All Unused File Assets
1. In Assets view, from the Assets menu choose Delete All Unused File Assets.

2. Click Yes to confirm the deletion.

NetObjects Fusion removes all file assets for which the In Use indicator is not Yes.

Note: You cannot undo this operation. You must use the New File Asset command to recreate file
assets.



Verifying File Assets
To determine whether all file assets are in their expected directories:

1. In Assets view, from the Assets menu choose Verify All File Assets.

NetObjects Fusion verifies and reports the path status of all files.

l When a file’s path information is correct, NetObjects Fusion lists the date and time found 
in the Verify Status column.

l When a file’s path information is incorrect and the file or folder cannot be found, 
NetObjects Fusion displays this dialog:

2. Resolve the paths of any lost files or folders.

l To specify a new path, click Browse and locate the file or folder.

l To skip the lost item and continue verification, click Skip. NetObjects Fusion gives this file 
Not Found status and goes on to verify subsequent files or folders.

l To stop the verification process, click Cancel. The verification status of the current file or 
subsequent files is not updated.

3. When verification is complete, click OK in the confirmation dialog.



Opening File Assets
You can open a file asset in the application with which it is associated. For example, you can open a .gif 
or .jpeg file in your paint program directly from NetObjects Fusion. To open a file asset:

1. In Assets view, select the asset.

2. From the Assets menu choose Open Asset.

For information on file types and applications, see Editing Objects and Assets.



Managing Links
When you click the Links tab, a list of all the links used in your site appears, including external links, user-
defined internal links, and smart (structural) links.

For information on links, see Creating Links and Anchors.

Links between entries in a data list and their associated stacked pages do not appear in Assets view. You 
can manage such links directly on the data list pages. For complete information about data lists, see 
Creating a Data List.



Updating an External Link
1. In Assets Links view, double-click the external link you want to update.

The Links dialog appears.

2. Change the name in the Name field if desired.

3. Update the URL in the Link To field and click OK.



Displaying the Page Containing a Link
1. Double-click the link in Assets Links view. The Links dialog appears.

2. Select the page you want to see in the list of pages.

3. Click the Go To button.

The page you selected appears in Page view.



Adding a Link
1. In Assets Links view, from the Assets menu choose New Link, or click the New button on the 

control bar.

The Links dialog appears.

2. Enter a name and destination for your link and click OK.



Deleting a Link
1. In Assets Links view, select the link you want to delete

2. From the Edit menu choose Delete Link, or press Delete.

3. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the Add Link command to recreate the link.



Verifying Links
To determine whether all link destinations can be located:

1. In Assets Links view, from the Assets menu choose Verify All Links.

NetObjects Fusion displays a progress bar as it verifies and reports the status of link destinations.
It accesses the Internet to verify external link references.

l When a link’s destination is found, the date and time of validation appear in the Verify 
Status column.

l If a link’s destination is not found, the problem is described in the Verify Status column.

When verification is complete, the progress bar disappears.

2. Resolve the destinations of any broken links by double-clicking the link and editing it as described
in the previous section.

Link verification takes place in the background, so you can switch to another view and continue working 
while the links are being verified.

To verify links through a proxy server:

l Open the Windows 95 Control Panel and double-click the Internet icon. In the Internet Properties 
dialog, click the Advanced tab, and configure your proxy settings.

Note: NetObjects Fusion might not be able to verify destinations that are on the other side of a firewall. 
Also, after verification any mailto links display “Unsupported URL Type” because NetObjects Fusion 
cannot verify whether an email address is valid.



Managing Data Objects
Data objects are collections of fields of data. You can use a data object to publish data without using CGI 
scripts or database programming. For information about data objects, including how to create them in 
Assets view, see Data Publishing.

When you click the Data Objects tab, NetObjects Fusion displays a list of all the data objects used in your
site.

You can edit the name and field names of an internal data object and add new fields. See Changing an 
Internal Data Field Name.

For an external data object, you can change Simple fields to Image fields and vice versa, but you cannot 
edit field names or add new fields, because these items depend on data in the external data file.



Managing Variables
Text variables make it easy to update text that appears throughout your site. User-defined variables are 
displayed in Assets Variables view so you can edit, create, or delete them. NetObjects Fusion also 
provides standard variables, such as the date and time the site was created or last modified, but these 
are not displayed in Assets Variables view.



Adding a Variable
1. In Assets Variables view, from the Assets menu choose New User Defined Variable, or click New 

in the control bar.

The New Variable dialog appears.

2. Enter a name and value for your variable and click OK.



Editing a Variable
1. Double-click the variable in Assets Variables view.

The Edit Variable dialog appears.

2. Edit the name and value of the variable and click OK.

If you edit the value of the variable, NetObjects Fusion updates all text blocks containing that 
variable with the new value.



Deleting a Variable
1. In Assets Variables view, select the variable you want to delete.

2. From the Edit menu, choose Delete User Defined Variable, or press Delete.

3. Click Yes to confirm the deletion.

Note: You cannot undo this operation. You must use the New Variable command to recreate the 
variable. Do not delete a variable that is in use. If you do, it will be replaced with Undefined User 
variable: variable name in the text where it was used.



Publishing Your Site
When you complete your site design and development, you’re ready to publish the results as a collection 
of HTML pages and associated assets. Publishing is similar to previewing your site, with one major 
difference:

l When you preview your site, NetObjects Fusion automatically generates and stores your site in the 
Sitename\Preview folder and creates absolute paths to your site’s assets.

l When you publish, you can control the location of your published site, directing NetObjects Fusion to 
store your site on a local disk or a remote server.

Note: Sites published with NetObjects Fusion work with any Web server, on any operating platform. No 
special Web-server extensions are required. If your site contains server-side components—including 
NetObjects Fusion Message Board or Form Handler components, CGI scripts, or third-party components 
such as Allaire Fusion2Fusion—it will require additional server setup.



The Publishing Process
When you publish your site, NetObjects Fusion generates HTML pages and associated assets from the 
information in the Sitename.nod file, which contains your site structure, page design, content, links, and 
assets. If you are publishing to a remote server, NetObjects Fusion opens an FTP session and connects 
to the remote server. Then the HTML pages and assets of your site are stored in the location of your 
choice, using the file and directory structure you specify.

To publish your site the first time:

1. Define your site’s publishing settings in the Setup Publish dialog by:
a. Defining the file and directory structure.

b. Selecting the HTML output method.

c. Defining a server profile for each location where you want to publish your site.

These publishing settings are saved in your Sitename.nod file for future use.

2. Customize your site’s directory structure, if needed, by:
a. Re-arranging and renaming site folders.

b. Creating custom folders.

c. Changing the publishing properties for folders, pages, and assets.

Your customized directory structure is saved in your Sitename.nod file for future use. The file and
directory structure you use does not change the appearance, design, or content your site visitor 
sees; it only controls the way the pages and assets are stored on the server.

3. Publish your site to the selected server location.

Once you successfully publish, you can re-publish at any time by clicking the Publish button on the control
bar. You can also modify these settings at any time, and then re-publish.



Using Publish View
When you click Publish on the control bar, Publish view opens. Publish view looks similar to the Microsoft 
Windows Explorer or the Windows NT File Manager.

You must be in Publish view to publish your site.

The Directory pane on the left displays the file and directory structure of your site as it will be published on
your server. You can delete, rearrange, or rename folders shown in the Directory pane, and you can 
create new subfolders at any level. Components and their related assets have a black lock image on their
icons, signifying that they cannot be renamed or rearranged.

The Contents pane on the right displays the contents of the folder currently selected in the Directory 
pane. For each folder, page, or asset, the Contents pane displays its name, type, attributes, and the last 
date each page or asset file was published locally and remotely. You can sort the content files and folders 
by clicking a column heading, and you can resize the columns by dragging the column heading border to 
the left or right. The icons displayed for different file types are set in the File Types Registry of the 
Windows 95 options.

Click a folder’s plus sign to expand the display to show the subfolders beneath it. Click a folder’s minus 
sign to collapse the display and hide the subfolders beneath it. You can also resize the Directory and 
Contents panes by dragging the divider bar in either direction.



Configuring Publish Setup
Before you can publish, you should configure three publishing settings: the directory structure, the type of 
HTML output, and the server locations where you want to store the published results.



Setting the Directory Structure
When you publish your site, you control the directory structure NetObjects Fusion uses to arrange your 
files and assets on the server. Setting the directory structure does not change the site structure that the 
site visitor sees, nor does it affect the relationships or links between pages and assets. It simply defines 
how your pages and assets are stored on the server, and what URL is required to access them.

For example, some servers require a one-level structure, with all pages, images, and other assets in the 
same directory; others let you set up your own directories.

NetObjects Fusion supports three types of server directory structures:

l Flat directories for servers that require all resources and assets to be in a single directory. Many 
commercial Internet Service Providers (ISPs) require this kind of structure.

l By Asset Type arranges your site contents into folders according to their asset type. This is the 
structure generated by earlier versions of NetObjects Fusion. For example, if your site contains a 
typical mix of text and media, a structure set By Asset Type arranges your contents into the structure 
shown below.

l By Site Section arranges your site contents into a directory structure that looks like your site in Site 
view:

– Your Home page and its assets are stored in the site’s root directory.

– Each first-level page is stored in its own folder with its assets.

– Any child page is stored with its assets in a subfolder beneath the folder that contains its parent 
page.

For example, a structure set By Site Section would have this directory structure on the server.

This setting creates the most efficient file structure, allowing your server to load your pages as quickly 
as possible in your site visitor’s browser. It is the default directory structure setting in NetObjects 
Fusion. It also provides the most effective directory structure for search engines, which may only index 
one page per folder.

Note: If you apply the By Section directory structure, shared assets are stored in the deepest 
folder common to all pages that use that asset. This makes the shared access to those assets as 
efficient as possible.

To set the Directory Structure property for this site:

1. In Publish view, click the Setup button on the control bar, or choose Publish Setup from the 
Publish menu.

The Directory Structure tab of the Publish Setup dialog appears.

2. Select the server arrangement you want from the Directory Structure drop-down list.

For each option, NetObjects Fusion displays a short description of that option’s effect.

3. If you customized your directory structure and want to reset your arrangement to the default 
directory structure, click the Clear All Customizations button.

NetObjects Fusion removes any custom folders and changes all customized asset names back to
their original, auto-generated names. See Customizing Your Directory Structure.

4. Click OK to apply the selected directory structure type.

The directory structure is revised and displayed in Publish view.



Note: If you apply the By Section directory structure, shared assets are stored in the deepest 
folder common to all pages that use that asset. This makes the shared access to those assets as 
efficient as possible.



Setting the Site's HTML Output 
The wide range of browser versions and capabilities makes it difficult to know exactly what kind of HTML 
tags and functions will display effectively to site visitors. Advances in HTML coding and browser abilities 
have also made it possible to create pages using less code and more efficient downloads—if your site 
visitor’s browser can support it.

To address these concerns and take advantage of these improvements, NetObjects Fusion can generate 
any of three types of HTML output when publishing your site See Optimizing Nested Tables Output for 
information on these publishing methods.

l Nested Tables uses nested table tagging and other features of the 3.2 HTML specification. This is 
NetObjects Fusion’s default output because it produces the most predictable and consistent results 
onscreen, regardless of the type, version, or configuration of the site visitor’s system or browser fonts. 
Both Microsoft Internet Explorer 2.x and above and Netscape Navigator 2.x and above correctly display
pages published in Nested Tables format.

l Regular Tables uses basic HTML table tagging to deliver your design and content. Both Microsoft 
Internet Explorer 2.x and above and Netscape Navigator 2.x and above correctly display pages 
published in Regular Tables format, although site visitors’ results might vary according to their system 
and browser font settings.

Note: If you select either form of table-based output, be sure your pages do not have overlapping
objects, or your published results will not be what you expected. See Interpreting the Warning 
Icon.

l CSS and Layers uses Cascading Style Sheet Positioning code, layers, and scripts to position and 
publish your layout and content. Both Microsoft Internet Explorer 4.x and Netscape Communicator 4.x 
correctly display pages published in CSS and Layers format, although the site visitors’ results might 
vary according to their system and browser font settings.

On the HTML Output tab of the Publish Configure dialog you designate which type of HTML output 
NetObjects Fusion generates. This setting determines the site preference for HTML output. You can 
override this site preference for individual Layouts and Layout Regions, so NetObjects Fusion generates 
their HTML using a different method. See Setting the Layout’s HTML Output Method and Setting the 
Layout Region’s HTML Output.

To set the publishing method for your site:

1. In Publish view, click the Setup button on the control bar, or choose Publish Setup from the 
Publish menu.

The Publish Setup dialog appears.

2. Select the HTML Output tab.

3. Select the publishing method you want to use from the Output Type drop-down list.

When you select an option, NetObjects Fusion displays a short description of that option’s effect. 
The selected output method becomes the default for all the pages in the site, unless overridden in
a specific Layout or Layout Region.

4. In the Options section of the dialog:

l To include comments in the HTML file created for each page, select the Generate HTML 
comments option. The comments identify the beginning and ending of each page’s head 
and body, as well as objects.



l If you are working with special character sets, such as Japanese or Chinese, and are 
familiar with their related coding issues and tradeoffs, you can prevent NetObjects Fusion
from converting high ASCII characters to their HTML equivalents. To do so, select Skip 
High ASCII character set conversion.

The default is to leave ASCII character set conversion turned on; this is the correct setting
for most sites.

l Use the Quote Type drop-down list to select one of the three types of quotation marks 
you can use in your site’s text objects.

Curly Quotes is the default setting. The site visitor’s browser font settings control the 
appearance of these quotes in the browser.

5. Click OK to set the selected HTML output type and formatting options.



Defining Server Profiles
The last task in configuring your publishing settings is to define the local or remote server locations where
you want to store the completed site. You configure these locations by modifying or creating server 
profiles, which are stored with the rest of your publishing specifications in the Sitename.nod file.

Each server profile has a name and a set of properties that define the local path name or the remote host 
connection settings that NetObjects Fusion uses to publish your site to that location and server. You can 
select a server profile or set its properties any time before you publish the site.

NetObjects Fusion includes two default server profiles:

l My Computer, which defaults to a local setting with the target directory of Sitename\My Computer.
l Remote Publish Server, which defaults to a blank remote server profile that you must fill out before 

publishing.

You can modify these default profiles, create your own, or delete unneeded profiles.



Defining a Server Profile for Local Publishing
1. In Publish view, click the Setup button on the control bar.

The Publish Setup dialog appears.

2. Select the Server Locations tab.

3. To modify an existing local server profile, select the profile from the list and click Edit. Continue 
with step 5.

4. To create a new server profile, click Add.

NetObjects Fusion displays the New Location dialog with the Server Name field blank and the 
Local publish setting selected by default.

Enter a name for this profile in the Server Name field.

5. Fill in the Directory field using one of these methods:

l Enter the drive and directory path you want to use. This path can point to an existing 
directory or create a new directory.

l Click Browse to display the Select Destination file dialog, then select the local directory 
you want to use and click Open. To create a new directory, browse to and select the 
directory immediately above the location you want, then click Open. Enter the name of 
the new directory at the end of the path in the Directory field.

To prevent your published site files from getting mixed in with other files, enter or select a new or 
empty directory. Also, make sure the local drive has sufficient space for your published site files.

6. To set the file name for the Home page of your site, use the Rename the home page drop-down 
list. You can select:

l Index, which is the default page name automatically recognized by most current servers. 
This is the default.

l Current Page Name, which is set by the value of the Name property for the Home page.

l Home

l Default, which literally uses the name default, as in default.html.
7. Set the default file name extension applied to each page in your site by either:

l Selecting .htm, .html, or .shtml from the drop-down list.

l Entering an extension of your choice.

For local publishing, be sure to use a page extension that your browser recognizes, or it might not
display the page properly. If you defined a file name extension for an individual page in the 
Custom Names dialog, that extension overrides the site default for that page.

8. To convert all spaces and most non-alphanumeric characters in asset file names to underscore 
characters (_), select Replace spaces and other special characters with underscores. NetObjects 
Fusion does not replace periods (.) or hyphens (-), because all servers understand those 
characters.

9. Click OK to complete the configuration of the local server profile.



Defining a Server Profile for Remote Publishing
The information needed to connect to a remote server is specific to your server. Contact your ISP or 
server administrator for the precise information to enter in these fields. For guidance on the questions you
need to ask, see the Remote Server Access Checklist.

To define a remote server profile:

1. In Publish view, click Setup on the control bar. 

The Publish Setup dialog appears.

2. Select the Server Locations tab.

3. To modify an existing remote server profile, select the profile from the list and click Edit. Continue 
with step 5.

4. To create a new remote server profile, click Add.

NetObjects Fusion displays the New Location dialog with the Server Name field blank and the 
Local publish setting selected by default.

Enter a name for this profile in the Server Name field.

5. In the Location Properties dialog, select Remote.

6. In the Remote Host field, enter the name or IP number used to connect to the remote server. This 
can be your site’s domain name, the name of an intranet server, or the name of your ISP’s server.

7. To specify a CGI FTP port number or custom port number, or establish aliases or virtual 
directories for some of your site content, click Advanced to display the Advanced Settings dialog. 
See Creating Aliased Folders and Setting the CGI-Bin Directory.

8. Enter the Base Directory for your site that defines where on the server your content will be stored:

l If your site’s Home page should be stored in the root directory of the user ID or server 
account that you use for loading your site, leave this field blank.

l If you want your site’s Home page to be stored in a different directory than the root 
directory, enter the relative path to it here.

For more information on the base directory setting, see the Remote Server Access Checklist.

9. In the Name field, enter the user ID needed to log on to the remote server so you can transfer 
files to it.

10.In the Password field, enter the password that authorizes this ID to access the server. To 
effectively publish your site, you need server permissions that let you add files and create 
directories, so you can transfer scripts and other executable resources to a directory on the 
server that lets them run.

11.Select the Remember Password option unless you want to be prompted for your password every 
time you publish remotely to this server.

12.To set the file name for the Home page of your site, use the Rename the home page drop-down 
list. You can select:

l Index, which is the default page name automatically recognized by most current servers. 
This is the default.

l Current Page Name, which is set by the value of the Name property for the Home page.



l Home

l Default, which literally uses the name default, as in default.html.
Your server administrator can tell you whether to use Home or Default instead of Index. If you use
Current Page Name, your site visitors must include the exact file name as part of the URL to 
reach your site.

13.Set the default file name extension applied to each page in your site by either:

l Selecting .htm, .html, or .shtml from the drop-down list.

l Entering an extension of your choice directly in the extension field.

Your server administrator can tell you which extension is the default for your server.

Note: If you define a file name extension for an individual page in the Custom Names dialog, that 
extension overrides the site default for that page.

14.To convert all spaces and most non-alphanumeric characters in asset file names to underscore 
characters (_), select Replace file name spaces with underscores.

Your site might be hosted on a UNIX server that cannot handle spaces in file names, so it’s 
recommended that you select this option. NetObjects Fusion does not replace periods (.) or 
hyphens (-), because all servers understand those characters.

15.Click OK to complete the configuration of the remote server profile.



Creating Aliased Folders and Setting the CGI-Bin Directory
Sometimes you need to store certain assets of your site in a location separate from the rest of your site. 
For example:

l You can link to programs such as CGI scripts or other executables that have to be placed in a specific 
CGI directory so they run properly.

l You can place an order form or other pages in a secure location that requires authorized access, 
without restricting access to the rest of your site.

l You can link to images or other assets that are maintained or controlled by others, and stored in a 
protected location.

To do this, you create alias folders, using a process in which you define two locations: the actual physical 
location where you want to FTP the pages or assets, and the URL or logical address that you want 
NetObjects Fusion to use when referring to that object. On some servers, this is referred to as creating 
virtual folders.

Once the site is published, you or your server administrator must configure the server to look in the FTP 
location for assets that are described as being in the URL location.

For example, your site might include several stock images from your company’s marketing department, 
such as the company logo and other approved artwork. When you create your site, you use copies of the 
artwork that you stored on a local disk. When you publish and upload your site to the company server, 
however, you want to use the “official” images that have been approved and maintained by the marketing 
department.

Check with your server administrator to see if your site contents or remote server configuration requires a 
CGI directory or other aliases.

To specify the CGI-BIN directory:

1. In Publish view, click Setup.

2. Select the Server Locations tab, select a remote server, and click Edit.

3. Click the Advanced button.

4. Enter the ftp path where CGI scripts are stored in the CGI field. This establishes an alias to the 
executable directory on the server where CGI scripts are kept.

You can also use the Advanced Settings dialog to define a specific server port or permissions setting—
even if you are not defining aliases or virtual folders. Depending on your Web server configuration, you 
might need to set specific permissions so your Web server software can access your published files. This 
section describes how to set a different permission string to override the default permissions normally set 
by NetObjects Fusion. If you simply want to define a specific server port or permissions setting for this 
server profile, proceed to step 10.

To create other aliased folders:

1. In Publish view, arrange the directory structure for your site the way you want it to appear on your 
server.

2. Isolate the pages or assets you want to store in an aliased location into one branch of the 
directory structure, under a common parent folder. If necessary, create a custom folder for each 
set of aliased content.

If your site requires more than one alias—such as one alias for secure pages and another alias 
for protected assets—you can create more than one custom folder. See Creating Aliased Folders 
and Setting the CGI-Bin Directory.

3. Drag pages and assets into the appropriate custom folder(s) as needed.

4. Click Setup on the control bar. 



The Publish Setup dialog appears.

5. Select the Server Locations tab.

6. Select the remote server profile that you want to change, and click Edit. 

The Location Properties dialog appears.

7. Enter remote server profile information, if needed.

8. Position the Locations Properties dialog so you have a clear view of the Directory pane of Publish
view. Refer to the directory structure to make sure you type the URL correctly.

9. Click the Advanced button.

The Advanced Settings dialog appears.

10.To specify a port or permissions setting to access this server, enter the port number or 
permissions flag in the fields shown.

11.To add a new alias, click the Add button. To edit an existing alias, select it from the list, then click 
the Edit button.

The New Alias dialog appears.

12.Enter the relative path from your site’s root folder to the custom folder containing the aliased 
pages and assets as the URL Path. Refer to the directory panel as needed to enter the path 
exactly as it appears, including the use of uppercase and lowercase names and spaces.

For example, if you create a custom folder called companypix and placed it under your /assets 
folder, then the URL Path would be /assets/companypix.

13.Enter the FTP path that you want to use to actually store that folder and its contents. This FTP 
location must be on the same server as the rest of the site because your server profile only logs 
on to one server at a time.

14.Click OK. 

The Location Properties dialog appears.

15.If you need to add additional aliases, return to step 11.

When you publish your site, NetObjects Fusion keeps all links and references to your aliased content 
pointing toward the URL path, but actually stores the pages and assets in the FTP location you specified.

Note: The server must be configured to support this alias. This is a system administrator task outside 
NetObjects Fusion’s responsibility, so you or your server administrator must define the alias on the server.



Customizing Your Directory Structure
Although NetObjects Fusion offers three directory structures, you might need to customize your site’s 
directory structure further. You can do this in Publish view by renaming, rearranging, or deleting site 
folders, creating custom folders, or changing the publishing properties for folders, pages, and assets.

NetObjects Fusion’s database keeps track of all your name, path, and structure changes, and updates the
site’s links and auto-generated objects as appropriate. When you re-publish the site in the future, 
NetObjects Fusion remembers your changes and keeps them in place.

Note: Customizing your site structure does not change the appearance, design, or content that your site 
visitor sees; it only controls how the pages and assets are stored on the server, and the URL necessary to
access the site’s interior information.



Creating a Custom Folder
1. In either pane of Publish view, right-click the folder, page, or asset where you want to add a 

custom folder, and select Add Folder from the shortcut menu.

NetObjects Fusion adds a custom subfolder named \New Folder below the selected folder or file,
and opens the folder’s name field.

2. Edit the existing folder name, or enter a new name. Press Enter or select another object to record
your changes.

3. Drag other folders or files into the custom folder as needed.



Renaming Folders and Files
1. In either pane of Publish view, right-click the object and select Rename from the shortcut menu.

The object’s name field opens.

2. Edit the existing object name, or enter a new name. Press Enter or select another object to record
your changes.

You can rename auto-generated folders and files; NetObjects Fusion remembers the new names the next
time you generate your site. Any folder or file that you rename is considered customized. If you name a 
customized folder with a name used by an auto-generated folder, it is still treated as a customized folder.

Aliased folders are also considered customized folders; NetObjects Fusion displays them in the directory 
structure, even if they are empty, and tracks their name and location in the event you change them. See 
Creating Aliased Folders and Setting the CGI-Bin Directory.

By definition, read-only assets, such as script files used by NetObjects Fusion components, can’t be 
changed. NetObjects Fusion ignores attempts to move or rename read-only files.



Deleting Folders
1. In either pane of Publish view, click the folder you want to delete, and make sure it is empty. You 

cannot delete a folder until it is empty, and you also cannot delete pages or assets in Publish 
view.

2. Right-click the folder and select Delete Folder from the shortcut menu.

NetObjects Fusion deletes the folder.

After you delete a customized folder, the next time you publish the site, NetObjects Fusion recreates any 
auto-generated assets that it needs.



Rearranging the Directory Structure
u In either pane of Publish view, click the folder, page, or asset and drag it to its new location.

NetObjects Fusion moves the object and updates all references to it.

If you move pages, NetObjects Fusion remembers their new locations, but might continue to auto-
generate folders needed to contain that page’s assets. Components and their related assets have a black
lock image on their icons, signifying that they cannot be renamed or rearranged.



Viewing and Setting Publication Properties
In addition to their other properties, your site’s folders, pages, and assets have publishing properties that 
indicate or control the way they are included in your published site.

Three of these publication properties are indicators of the publishing status for that folder, page, or asset:

l Folders, pages, and assets that were renamed or moved from their default location have a customized 
publication property. Customized assets display a C in the Attributes column of the Contents pane, and 
a check in the Customized option of the publication Properties dialog.

l Some folders, pages, and assets are marked read-only:

– Assets created by NetObjects Fusion components, such as Site Mapper or Message Board.

– Dependent Java .class files that were added to the site’s assets. When you add a Java object and 
preview or publish your site, NetObjects Fusion analyzes the object’s .class file to see if it calls for 
other .class files; if so, those dependent .class files are added as read-only assets.

Read-only assets display an R in the Attributes column of the Contents pane, and a check in the Read-
only option of the publication Properties dialog.

l Pages and assets have two published date properties that display the latest publication date in both the
Last Remote Publish and Last Local Publish columns of the Contents pane.

– The publish dates for pages are always displayed in red, because NetObjects Fusion always 
publishes all pages of your site, except those individually marked Don’t publish.

– If an asset was never published locally or remotely, it displays Never Published in red in the 
appropriate column, and has a check in the Needs Publishing option of the publication Properties 
dialog.

– If an asset was changed since the last time it was published, it displays the Last Published date in 
red, and has a check in the Needs Publishing option of the Publication properties dialog. If you select
Publish changed assets only when you publish this site, the assets with red dates are re-published to
the server.



Suppressing a Page or Asset from the Published Site
You can also suppress publishing for a selected page or asset by setting its Don’t publish property. If you 
set this property, NetObjects Fusion:

l Overrides any Needs Publishing or Publish changed assets setting for this page or asset.

l Displays a diagonal red slash mark through the page or file icon in Publish view and adds a D to its 
attribute column.

l Publishes the site without that page or asset.

To suppress publishing for a page or asset:

1. In the Contents pane of Publish view, right-click the page or asset and select Properties from the 
shortcut menu.

The Publication properties dialog appears.

2. Select Don’t Publish, then click OK.

NetObjects Fusion displays a red slash through the page or asset icon and suppresses it from the
site when published.

To re-enable publishing for a suppressed page or asset, repeat step 1, then clear Don’t Publish and click 
OK.



Publishing Your Site
When your publishing configuration settings are complete, you are ready to publish your site:

1. In Publish view, click the Publish button on the control bar.

The Publish dialog appears.

2. Use the Location drop-down list to select a server profile.

3. To confirm or change the server profile properties—such as the directory name for local 
publishing, or the target directory for remote publishing:
a. Click Edit.

The Locations Properties dialog is displayed.
b. Make necessary changes to the server profile.

See Defining a Server Profile for Local Publishing or Defining a Server Profile for Remote
Publishing.

c. Click OK to close the Locations Properties dialog.

4. To publish only the assets that changed since the last time you published, select Publish changed
assets only.

NetObjects Fusion determines which assets have changed since the last time the site was 
published, then generates and transfers only those assets. This does not impact your site’s 
pages, which are always regenerated and reloaded when you publish your site.

Note: NetObjects Fusion does not query the server to see if it has all the unchanged assets 
needed by the site. If you publish changed assets only, be sure you publish to the same location 
you did previously, so unchanged assets are still available.

5. Click OK to publish your site.

l If you publish your site locally, NetObjects Fusion creates the local directories if needed, 
and stores the formatted site as directed.

l If you publish your site remotely, NetObjects Fusion generates a temporary copy of the 
site, connects to the remote server using the settings in the server profile, and uses its 
internal FTP program to transfer the site files and directories to the remote server.

If you specify in Publish Setup a folder that doesn’t exist yet on the server, NetObjects 
Fusion alerts you that the target directory doesn’t exist, and asks for confirmation that you
want it to be created.

6. While NetObjects Fusion is transferring the published site to the server, you can select a different 
view and continue working. You cannot open a different site, however.

7. When the transfer is complete and your site is in place, access it with your browser and examine 
your results. You can now make changes to your site file (Sitename.nod), and re-publish the site 
or its changed assets as needed.



Additional Publishing Guidelines
l Sites published with NetObjects Fusion work with any Web server, on any operating platform. No 

special Web server extensions are required.

l When you re-publish your site, NetObjects Fusion overwrites existing files as needed. It does not, 
however remove old files or obsolete assets from your local or remote directories; you have to perform 
these housekeeping duties yourself.

l NetObjects does not publish through firewalls or to proxy servers. See Publishing with Firewalls or 
Proxy Servers for the steps necessary to publish your site to a protected server.

l If NetObjects Fusion has difficulty storing your site on a remote server:

– Make sure your system is online and has a valid connection to your network or the Internet.

– Make sure the server is not down or offline.

– Make sure your server profile settings are correct. Test the remote host, account name, and 
password settings displayed in the Location Properties dialog by using them to log onto the server 
using a separate FTP or telnet application.

– Make sure your account has the appropriate permissions, and that there is sufficient storage space 
for your site on the server.

l If you define publishing configuration settings for a site, and then export that site as a template, those 
settings travel with the template. If you are sharing a template with colleagues who can use the same 
publishing settings, you can save time by configuring the publishing settings in advance, exporting 
them with a template, and then distributing the template.

l If your site has been published and revised several times, your publish location might contain files that 
are not needed in the current or final version of the site. Delete unused assets and clean out obsolete 
files from your published site folders before publishing a new version of a site. See Managing Assets.



Publishing with Firewalls or Proxy Servers
If your remote server is behind a firewall or stored on a proxy server, NetObjects Fusion cannot publish 
directly to the server. If that’s the case, follow these steps:

1. Publish your site to a local folder other than the Sitename\Preview folder of your site. Use 
whatever directory structure and publishing method you would normally. The default setting, My 
Computer, publishes to the folder Sitename\My Computer.

2. Consult with your server administrator for the preferred method of transferring content to the 
remote server. Potential methods include

l Transferring the entire site structure of the locally published site to a holding location on 
an unprotected server, so an authorized administrator can then transfer the site to the 
protected location.

l Using an FTP application such as WS-FTP™ or other means of access authorized by the
server administrator to transfer the entire site structure of the locally published site to the 
protected server.

In either instance, be sure to transfer all files and to duplicate the local folder structure precisely.



Publishing Special Assets
When you publish your site, NetObjects Fusion transfers the entire site to your designated location, 
including special assets you told it to manage. These special assets include things like Java classes, 
images and assets contained on external HTML pages, and CGI scripts. The list of managed assets 
included in your published site is displayed in Assets view.

You can use one of three ways to ensure that these special assets are included in your site’s managed 
assets when you publish:

l Include the assets when you add the object that refers to them. For example:

– If you reference external HTML pages using the External HTML tool, NetObjects Fusion 
automatically analyzes the external pages and includes their assets in the Asset Manager—unless 
you select Do not manage or move assets. If you do not select this option, you have to add assets 
those pages need to the Asset Manager, using one of the two methods below. For information, see 
Adding File Assets.

– If you add Java objects to your pages using the Java tool, NetObjects Fusion analyzes their .class 
files and adds other .class files referenced there. If you listed special assets in the Java Object 
Properties palette, NetObjects Fusion includes them as managed assets. See Inserting a Java 
Applet or Servlet.

l You can add a file link to a special asset, and NetObjects Fusion manages and publishes the asset. 
See Creating a File Link.

l You can explicitly add any special asset to the Asset Manager and select Always publish file to ensure 
that NetObjects Fusion manages and publishes the asset. For information, see Adding File Assets.



Managing Script Assets
NetObjects Fusion does not analyze custom scripts that you add to pages, MasterBorders, or other 
objects. If those scripts reference special assets, they are not automatically included in the site’s 
managed assets. To have NetObjects Fusion manage and publish assets called in custom scripts, you 
must create file links to those assets, or explicitly add them to the Asset Manager. Then right-click the 
asset, choose Properties from the shortcut menu, and select Always publish.



Remote Server Access Checklist
Before you create a remote server profile, answer these questions:

1. Who is your service provider? This is the ISP, organization, or department that is going to store 
your site on its server and provide your site visitors access to it.

The technical support staff of your service provider should be able to provide the answers to the 
rest of these questions. ISPs and other service providers often offer technical support pages on 
their own Web sites that answer these questions.

2. What is the name of your remote host? This is the name of the server where you are going to 
store your site. It might be the same as your domain name, such as www.yourname.com; a 
name assigned by the service provider, such as inbox.isp.com; or a specific IP address, a series
of four numbers separated by periods.

3. What is your base directory? When you log onto your remote host, you automatically begin in 
the home directory for your log-in account. This might not be the right place to put your site, 
however. For a variety of reasons, you might need to store your site in a subdirectory of your 
home directory, or in another directory altogether.

You must know the relative path from your account’s home directory to the base directory where 
your site should be stored. When NetObjects Fusion publishes your site and logs onto your 
service provider, it stores your site’s pages and assets in this base directory. This path statement 
is the value you enter for Base Directory in the Location Properties palette for remote server 
publishing.

However, the host and base directory might not look anything like the URL that your site visitors 
use to access your site. For security and other reasons, service providers frequently name their 
host machines and user directories according to their own needs.

Note: If you have your own domain, such as www.mycompany.com, and are logging in directly 
to the account that owns that domain, you might not need to specify a base directory, because the
home directory of that account might be the same location as the base directory.

4. What is the name and password for your account? You need these so NetObjects Fusion can 
log on to the server and store your site files.

5. What is the preferred name for the default Home page? Your service provider determines 
what file name the server displays by default for each directory on the server. Some servers are 
configured to display by default any file named index; others default to home or default. You 
must match this preferred name in the Location Properties dialog for remote server publishing.

6. What HTML file name extension does your server support? Web page servers typically 
support .html, .htm, or .shtml as file name extensions. Some service providers map one to the 
other so the server recognizes all of them; others require you to use a specific one. You must set 
the Location Properties dialog so NetObjects Fusion publishes files with the correct extension. 
You can also enter a custom extension, if your server supports it.

7. Is a specific port required for upload? The service provider might have designated a specific 
port on the server that it wants you to use to upload files. If so, you must specify this for 
NetObjects Fusion. See Creating Aliased Folders and Setting the CGI-Bin Directory for 
information about setting a custom port address.

8. Does your log-in account have the necessary permissions? Servers use permission 
configurations to control what users are allowed to do while logged on—whether they can delete 
files, for example, or create new directories.

In Publish view, you can specify the server file and directory structure that you want NetObjects 
Fusion to create or use for your site. Your log-in account—which NetObjects Fusion uses to store 
the files—must have the server permissions necessary to create the directory structure you 
defined.



If your service provider does not let user accounts create directories, then you must use the Flat 
directory structure option to publish your site.

9. How much server space do you have? Before you publish, you should publish your site locally 
and check the size of the generated Sitename\Publish folder, including all its sub-folders. 
Confirm that it takes less space than the maximum allowed by your service provider.



Working Around Browser Problems
There are a few circumstances when later versions of browsers don’t properly display or handle actions, 
forms, and other objects you create in NetObjects Fusion.

You can work around many problems by changing the HTML output method used to publish the particular 
page or Layout Region. For more information, see Selecting HTML Output.

Also, see the usage notes at www.netobjects.com/support for the latest information on browser 
problems.



Problems with Actions
If you publish a page using the Nested Tables or Regular Tables HTML output method, the following 
problems can occur.

l If you assign an action to an object, and then put the object in a table, text box, or Layout Region, 
sometimes the object doesn’t display in Netscape Navigator 4.0.

Solution: Removing any action assigned to the table, text box, or region itself might fix the problem. Or, 
you can change the HTML output method to CSS & Layers.

l If you assign the Set Src or Use Image action to an image, the action doesn’t work in Netscape 
Navigator 4.0.

Solution: Change the HTML output method to CSS & Layers.

l If you assign a transition action to an object, the transition doesn’t display properly in Internet Explorer 
4.0 for Windows.

Solution: Either change the HTML output method to CSS & Layers, or use a motion action instead of a 
transition.

If you assigned transition actions to objects placed inside a table or text box, changing the HTML output
method will not fix the problem. Either use a Layout Region instead of the table or text box, or use a 
motion action.

Note that transitions don’t display in Internet Explorer 4.0 for Macintosh, regardless of your output 
method. Use a motion action.



Problems with Forms
l If you assign an action to an object inside a form, the form might not be visible in Netscape Navigator 

4.0.

Solution: Place the object outside the form. For example, create the form in a Layout Region, and place
the object elsewhere in the Layout area.

l If you publish a form in a Layout area or Layout Region using the CSS & Layers HTML output method, 
form elements display piled on one another in the upper left corner of the page.

Solution: Either change the HTML output method to Regular Tables or Nested Tables, or recreate the 
form in a text box or a table.



Problems with Sounds and Shockwave
l In some situations, sound or Shockwave objects published using Nested Tables or Regular Tables as 

the HTML output method can’t be started, stopped, or otherwise controlled in Netscape Navigator 4.0.

Solution: To avoid this problem, change the HTML output method to CSS & Layers.



Select this option to create a new blank site. In the New Blank Site dialog, enter a name and select a location for the new site.    A 
folder containing the new site will be created in the selected folder, by default the NetObjects Fusion User Sites folder. The new site 
will include basic navigational objects such as a banner and navigation bar. (To base a new site on an existing web site, select New 
Site->From Local Import or New Site->From Remote Import from the File menu.)



Welcome to NetObjects Fusion 3.0, the premier tool for building Web sites!    As you’ll soon find out, NetObjects Fusion gives you 
unprecedented power to design, publish and manage professional dynamic sites with amazing speed. If you’ve used NetObjects 
Fusion before, you’ll be excited about the hundreds of improvements, additions and features, those most requested by you!

To find out more about NetObjects Fusion, consult the Getting Started or User Guide, or select Help Topics from the Help menu for 
on-line documentation.



Select this option to create a site based on a NetObjects Fusion template. In the Select a Template File dialog, locate a NetObjects 
Fusion Template (.nft file) to base your new site on. NetObjects Fusion offers excellent page, form and site templates (or AutoSites), 
found in the installed Templates folder. (To base a new site on an existing web site, select New Site->From Local Import or New 
Site->From Remote Import from the File menu.)



Select this option to open an existing NetObjects Fusion site. Click the Browse button to locate a NetObjects Fusion File (.nod) from 
a standard Open dialog.    The most recently used file is selected by default in the field on the right.



This displays the most recently used NetObjects Fusion file.    If the radio button on the left is selected, this site will be opened when 
you click OK. Click the Browse button to locate a NetObjects Fusion File (.nod) from a standard Open dialog. 



Launches a standard Open dialog, where you can locate a NetObjects Fusion File (.nod file) to open.



Rulers and Guides.    When enabled, rulers are displayed on the top and left side of the page area (View menu, Rulers & Guides). 
The ruler measurement is based on user preference (Edit menu, Preferences, Page tab). Click on the top or left ruler strip to create 
a new vertical or horizontal guide. While the guide marker is dragged its position is displayed in a tooltip. To remove a guide, drag 
the guide marker off the ruler strip until the marker is no longer seen. You may add as many horizontal and vertical guides as you 
like.    Use the Layout and MasterBorder handles to resize the Layout or MasterBorder directly from the ruler strip. To enable objects 
to snap to your guides, select Snap to Guides    from the View    menu.



MasterBorder. MasterBorders allow pages and sections of your site to share an overall look and feel. A page is defined by two 
areas, the Layout and MasterBorder. The MasterBorder area can be shared by multiple pages; the Layout area contains the unique 
content of a page. Create a new MasterBorder or change the MasterBorder for the current Layout from the General tab of the 
MasterBorder properties palette. The content of a MasterBorder is shared by all pages assigned to it, though managed objects such 
as Banners or Navigation Bars will change dynamically. You may remove a margin by setting it to zero or select the empty 
ZeroMargins MasterBorder to effectively remove it from the page (MasterBorder properties, General tab). AutoFrames allow you to 
easily add frames to your MasterBorder (AutoFrames tab).    Remember that changes made in a MasterBorder will be made on all 
pages sharing the MasterBorder. You can easily resize the MasterBorder by dragging its margin handles on the horizontal and 
vertical rulers (View menu, Rulers & Guides). To hide MasterBorders from view, uncheck MasterBorder from the View menu. Small 
labels and borders identify the MasterBorder and Layout areas when Page Labels are displayed (View menu, Page Labels).



Layout.    A page is defined by two areas, the Layout and MasterBorder. The Layout area contains the unique content of a page; the 
MasterBorder area can be shared by multiple pages. Change the MasterBorder for the current Layout from the General tab of the 
MasterBorder properties palette (Click in the MasterBorder area, MasterBorder properties, General tab). Select the empty 
ZeroMargins MasterBorder to effectively eliminate the MasterBorder from the page.    Edit properties of the Layout from the Layout 
properties palette. You can easily resize the Layout by dragging its margin handles on the horizontal and vertical rulers (View menu, 
Rulers & Guides). You can add alternate Layouts for the current page from the drop-down list on the lower left of the window (select 
Add… from the list to create an alternate Layout ). To view the Layout without MasterBorders, uncheck MasterBorder from the View 
menu. Small labels and borders identify the MasterBorder and Layout areas when Page Labels are displayed (View menu, Page 
Labels).



Page icon. This icon is a representation of the actual page. Clicking on this icon reveals the Page tab of the Properties palette, 
where you may change the selected page's properties (also see help within the Page Properties palette). Double-click on this page 
icon to edit the page in Page view, or click the right mouse button to view a pop-up menu with applicable commands.    Drag a page 
icon to change its position within the site structure.
Stacked page icon. Page icons with a layered lower edge are representations of stacked pages. Double-click on a stacked page 
icon to edit the stacked page in Page view. 
External HTML file icon. Page icons with diagonal hatching represent referenced or external HTML pages. Double-click on this 
icon to go to the corresponding page in Page view. To edit the external HTML file (with the editor specified in Preferences, General 
tab), double-click on the external HTML layout in Page view.
· To select a Section, hold down the Shift key when clicking on a page icon. All of the page’s children (and their successive 

children) will be selected.    You can make global changes to all selected pages from the Section properties tab.    To preview a 
section, perform a single page preview (Ctrl+Preview).



The Object Tree palette displays a hierarchical view of all objects and containers found on your page. All contents of the page are 
considered objects; the top object, the Page, contains the MasterBorder and Layout (and Frames, if any).    Many objects, such as 
Layout regions, text boxes or tables, can be containers for other objects.    You may select objects directly from this palette.    
Change their arrangement (front-to-back order) by dragging objects up or down the tree (the pointer will become a hand).    Hidden 
objects are displayed with grayed-out icons and can be selected. Hidden objects are objects hidden in Page view (Hide Object on 
the Object menu), not to be confused with actions which dynamically hide or show objects. The name or IDs of objects can be can 
be modified in the Actions tab of a selected object.



Warning
Because of browser incompatibilities and the varied complexity of dynamic pages, actions in some cases can cause viewing 
instabilities in your browser.    Clicking this button will launch the Problem with Actions topic in the Working with Browser Problems 
section of NetObjects Fusion Help.



Warning
Because of browser incompatibilities and the varied complexity of dynamic pages, actions in some cases can cause viewing 
instabilities in your browser.    For more information, please refer to the Problem with Actions topic in the Working with Browser 
Problems section of NetObjects Fusion Help (select Help Topics from the Help menu).



Selection. Use this tool to select any object in Page view or page icon in Site view.



Rectangle. When selected, properties for this Rectangle are displayed in the properties palette. Adjust settings from the properties 
tabs.



Rounded Rectangle. When selected, properties for this Rounded Rectangle are displayed in the properties palette. Adjust settings 
from the properties tabs. To vary the curve of a rounded rectangle, place the pointer over the inside corner handle until it changesto 
a double-sided arrow, then drag toward the inside or outside until you have the desired curve.



HR Rule. When selected, properties for this HR Rule object are displayed in the properties palette. The HR Rule uses the Horizontal
Rule HTML tag <HR>. Adjust settings from the properties tabs.



Ellipse. When selected, properties for this Ellipse are displayed in the properties palette. Adjust settings from the properties tabs.



Text. When selected, properties for this text box are displayed in the Text properties palette. Adjust settings from the properties tabs.
To edit the text within the box, double-click within the text box or press Enter. When in text edit mode format selected text with 
options found on the Format tab. A text box can be a container for pictures or other objects.    Text objects are also found as cells in 
tables, and as text data fields on stacked pages.



Picture. When selected, properties for this Picture are displayed in the properties palette. Adjust settings from the properties tabs. In
some cases, this picture may be a placeholder for a component or other object.    Double-click on the picture to select a new picture 
file for this object.



Polygon. When selected, properties for this Polygon are displayed in the properties palette. Adjust settings from the properties tabs.



Ole Object. Use the Properties palette to modify attributes of this object.



Java Applet or NetObjects Component. When selected, properties for this Java Applet or NetObjects Fusion Component are 
displayed in the properties palette. Adjust settings from the properties tabs.



Data List. When selected, properties for this Data List are displayed in the properties palette. Adjust settings from the properties 
tabs.



Data Field. When selected, properties for this Data Field are displayed in the properties palette. Adjust settings from the properties 
tabs. Data fields are displayed with red bounding boxes.    Data fields are found and can only be placed on a stacked page.



Forms Button. When selected, properties for this Button form object are displayed in the properties palette. Adjust settings from the
properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form Area tool on the 
Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the General tab).



Forms Radio Button. When selected, properties for this Radio Button form object are displayed in the properties palette. Adjust 
settings from the properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form 
Area tool on the Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the 
General tab).



Forms Checkbox. When selected, properties for this Checkbox form object are displayed in the properties palette. Adjust settings 
from the properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form Area tool 
on the Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the General tab).



Forms Edit Field. When selected, properties for this Edit Field form object are displayed in the properties palette. Adjust settings 
from the properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form Area tool 
on the Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the General tab).
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Forms Combo Box. When selected, properties for this Combo Box form object are displayed in the properties palette. Adjust 
settings from the properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form 
Area tool on the Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the 
General tab).



Forms Button. When selected, properties for this Button form object are displayed in the properties palette. Adjust settings from the
properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form Area tool on the 
Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the General tab).



Zoom in. .



Zoom out.



Table. When selected, properties for this Table are displayed in the properties palette. Adjust settings from the properties tabs. A 
Table can be a form area. Each cell is considered a text object, which may contain any other object. Use the shortcut menu or the 
Table commands found on the Object menu to add or remove columns or rows.



Picture. When selected, properties for this Picture are displayed in the properties palette. Adjust settings from the properties tabs. In
some cases, this picture may be a placeholder for a component or other object.    Double-click on the picture to select a new picture 
file for this object.



Rectangle Hotspot. When selected, properties for this Rectangle Hotspot are displayed in the properties palette. Adjust settings on 
the properties tabs to modify this object’s attributes, such as its link target. Hotspots are represented as children of picture objects in
the Object Tree palette.



Polygon Hotspot. When selected, properties for this Polygon Hotspot are displayed in the properties palette. Adjust settings on the 
properties tabs to modify this object’s attributes, such as its link target. Hotspots are represented as children of picture objects in the
Object Tree palette.



Circle Hotspot. When selected, properties for this Circle Hotspot are displayed in the properties palette. Adjust settings on the 
properties tabs to modify this object’s attributes, such as its link target. Hotspots are represented as children of picture objects in the
Object Tree palette.



Background Color Selector. Use the Background Properties palette to modify attributes of this object.



Shockwave. When selected, properties for this Shockwave object are displayed in the properties palette. Adjust settings on the 
properties tabs.



Sound. When selected, properties for this Sound object are displayed in the properties palette. Adjust settings on the properties 
tabs.



Video. When selected, properties for this Video object are displayed in the properties palette. Adjust settings on the properties tabs.



ActiveX Control. When selected, properties for this ActiveX Control are displayed in the properties palette. Use the settings on the 
General tab to modify the ActiveX control’s parameters or click on the Properties button to open the external Properties dialog for 
the selected control.



Forms Multi-Line. When selected, properties for this Multi-Line form object are displayed in the properties palette. Adjust settings 
on the properties tabs. Form objects must be placed within a form to work properly.    Define a form area with the Form Area tool on 
the Standard toolbar, or by selecting the Form option for a Layout, Layout region, Text box or Table (found on the General tab).



Line. When selected, properties for this Draw Line are displayed in the properties palette. Manipulate directly or adjust settings on 
the properties tabs.



NetObjects Component. When selected, properties for this Java Applet or NetObjects Fusion Component are displayed in the 
properties palette. Adjust settings on the properties tabs.



HID_PALETTE_ImageText



Navigation Bar. When selected, properties from this Navigation Bar are displayed in the properties palette. Adjust settings on the 
properties tabs. Navigation Bars are auto-generated objects which automatically update their internal links as a site is modified.    
Button titles are based on page names, or those set in the Custom Names dialog (Edit menu). Click on the Options button on the 
General tab to open the Nav Bar Display dialog, where you can modify navigation and display settings.    Navigation Bars are 
containers for Navigation Buttons, which may be individually customized.    Navigation bar pictures and text are defined in Style view.



Banner. When selected, properties from this Banner are displayed in the properties palette. Adjust settings on the properties tabs. 
Banners are auto-generated objects which automatically update as a site is modified. Banner names are based on page names, or 
those set in the Custom Names dialog (Edit menu). Banner pictures and text are defined in Style view.



Vertical Banner. When selected, properties from this Banner are displayed in the properties palette. Adjust settings on the 
properties tab. Banners are auto-generated objects which automatically update as a site is modified. Banner names are based on 
page names, or those set in the Custom Names dialog (Edit menu). Banner pictures and text are defined in Style view.



Vertical Navigation Bar. When selected, properties from this Navigation Bar are displayed in the properties palette. Adjust settings 
on the properties tabs. Navigation Bars are auto-generated objects which automatically update their internal links as a site is 
modified.    Button titles are based on page names, or those set in the Custom Names dialog (Edit menu). Click on the Options 
button on the General tab to open the Nav Bar Display dialog, where you can modify navigation and display settings.    Navigation 
Bars are containers for Navigation Buttons, which may be individually customized.    Navigation bar pictures and text are defined in 
Style view.



HID_PALETTE_BBSComp



HID_PALETTE_SiteMapperComp



HID_PALETTE_PopMenuComp



HID_PALETTE_FormToolComp



HID_PALETTE_BillBoardComp



HID_PALETTE_ODBC_DBList



HID_PALETTE_ISAM_DBList



HID_PALETTE_TickerTape



HID_PALETTE_ComponentByFileName



Navigation Button. When selected, properties for this Navigation button are displayed in the properties palette. You can select a 
custom image for the button by double-clicking on the button, or from the General tab. This button is contained within a Navigation 
Bar.



QuickTime. When selected, properties for this QuickTime object are displayed in the properties palette. Adjust settings on the 
properties tabs.



SiteStyle Line. When this object is selected, its SiteStyle Line properties are displayed in the properties palette. The SiteStyle is 
based on the current SiteStyle (SiteStyle Lines are defined in Style view). Adjust settings on the property tabs to modify the SiteStyle
Line’s attributes.



Layout Region.    When selected, properties for this Layout Region object are displayed in the properties palette.    A Layout region 
is a layout within a Layout.    It can contain objects, or be a form container (checkbox found on General tab). Layout regions also can
have a separate or Local grid (General tab).    Layout regions are useful for cascading messages with Actions, defining layers when 
using CSS & Layers HTML output, defining multiple forms on a pages, among other cases.



Text Navigation Button. This button is contained within a Text Navigation Bar.    You may format the when selected from the There 
are no modifiable settings for this object on the properties palette..    Select the parent Navigation Bar to adjust settings.



External HTML. When selected, properties for this External HTML object are displayed in the properties palette. Add an external 
HTML file to the layout, and NetObjects Fusion will add the HTML directly, without editing, into the final generated page source, 
within the object dimensions. Various options are presented when an external HTML object is placed which determine how the 
HTML is incorporated. To edit the external HTML file in the selected editor (specified in Preferences, General tab), double-click on 
the object.



HID_PALETTE_Document



Plug-In. When selected, properties for this Plug-In object are displayed in the properties palette. A file of any file type (such as one 
which requires a browser plug-in) may be placed onto a page with the generic plug-in tool.    Adjust settings on the properties tabs.



HID_PALETTE_FormArea



HID_PALETTE_ImageRollover



HID_PALETTE_TimebasePic



HID_PALETTE_PicLoader



HID_PALETTE_RotatingPic



HID_PALETTE_InternalHtml



HID_PALETTE_DBPictureField



HID_PALETTE_DBTextField



HID_PALETTE_MAXSHAPE



To view help on buttons, options or objects, right-click on the item and choose "What's This?" from the pop-up menu.



New Site. Opens the New Site dialog, where you name and select a location for your new web site. You have the option to base 
your site on an AutoSite™ or other NetObjects Fusion template, or from a pre-existing web site, either local or remote, which is 
imported into the NetObjects Fusion format. 



Open Site. Opens the standard Open dialog to let you locate and open an existing NetObjects Fusion site file (.nod). 



Save As. Opens a dialog that lets you choose a new name and/or location for the current site.



Import Section. Opens the Import Section dialog to let you import templates (such as NetObjects' pre-defined Page templates) or 
web sites (local or remote) into the current site (in Site view). 



Export Page. Opens a save dialog that lets you save the current page as an HTML file.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Exit. Closes (and saves) the current site and exits NetObjects Fusion.



Paste Special. Opens a window that lets you paste, link or embed special types of objects from the Windows clipboard. These 
special OLE (Object Linking and Embedding) objects are from other OLE-capable Windows applications, and are placed on the 
clipboard by copying them from the other application.



Delete (object). Lets you delete an object from your site. What gets deleted depends on which view you're in:
Delete Page. Removes a page from the site structure.
Remove Style. Removes the currently selected style when in Style view.



Options. 



Duplicate Layout. Makes a copy of a page’s layout and lists it in the Layout drop-down list.



Aligns all selected objects to the left edge of the left-most object selected. For example, if you select two objects and then align left, 
the object on the right will be repositioned so its left edge is aligned with the left object's left edge.



Center aligns all selected objects to the horizontal center position between all selected objects.



Aligns all selected objects to the right edge of the right-most object selected. For example, if you select two objects and then align 
right, the object on the left will be repositioned so its right edge is aligned with the right object's right edge.



Aligns all selected objects to the top edge of the top-most object selected. For example, if you select two objects and then align top, 
the bottom object will be repositioned so its bottom edge is aligned with top object's top edge.



Center aligns all selected objects to the horizontal center position between all selected objects.



Aligns all selected objects to the top edge of the bottom-most object selected. For example, if you select two objects and then align 
bottom, the top object will be repositioned so its top edge is aligned with bottom object's bottom edge.



Evenly distributes all selected objects horizontally.



Evenly distributes all selected objects vertically.



When this option is selected, all Align and Distribute options are applied to selected objects in relation to the Layout.    For example, 
Align Left with this option selected and all selected objects will be aligned to the Layout’s left-most margin.    Similarly, Distribute will 
distribute objects evenly across the Layout height (if vertically) or width (if horizontally).    This option affects the Align and Distribute 
commands regardless of whether they are invoked from the the Object menu or the Position tab (Multi-Object properties palette).



Size Objects: Both. If more than one object is selected, this command resizes the objects to match the height and width of the last 
object selected. For example, if you select three objects and then choose this item, the first two objects selected are resized 
(equidistant from all outer edges inward) to match the exact size of the third object.



Opens the Object HTML dialog to let you enter or insert HTML or scripts into the page.    The Page HTML dialog is opened from the 
Layout, MasterBorder or Frame properties palette. 



Layout HTML. Opens the Page HTML dialog to let you enter or insert scripts or HTML tags that are added to the HTML source of 
the page.



Help Topics. Opens the NetObjects Fusion Help Contents dialog. Launches your browser to view the table of contents for the 
online Getting Started Manual. This document is in HTML format.



About NetObjects Fusion. Opens the NetObjects Fusion version information box.



Getting Started. Introduces you to the NetObjects Fusion Help system. Links to the online Getting Started Manual and NetObjects 
web site by launching your browser.



Text properties. 



Layout properties. 



Picture properties. 



Site Structure View. Switches you to a graphical view of your site. You can use this view to rename pages, add new pages and 
delete pages from your site. You can also expand and collapse the structure and color code individual pages.
Style Gallery. Lists all the SiteStyles™ that can be applied to your site, along with a preview pane that lets you examine the various
components that make up the style. To edit any style or component, click Components.



Site Outline View. Switches you to a tree view of your site in which you can expand and collapse the structure at any level. You can
also review site management information about each page, such as the names of child pages, page type, status, and comments.
Style Components. Opens a list of elements that make up the current style. You can select and Edit any of these components and 
immediately see the results in the preview pane. To switch back to the site selection list, click Style Gallery. 



To view help on individual buttons, options or objects, right-click on the item and choose "What's This" or "Help" from the pop-up 
menu.



HID_NEWPUBLISHINGSET. 



HID_POPUP_MENU. 



HID_VIEW_AUTOSIZE. 



HID_INDICATOR_DATE. 



HID_INDICATOR_TIME. 



Choose this option if you want a solid color background on this page.



Click this button to go to the next page within this stacked page.



Click this button to add a current page within this stacked page.



Click this button to delete the current page within this stacked page.



HID_SECTION. 



HID_NEW2. 



Settings... Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also allows for choosing
modifiers: text only, greyscale, and low-bandwidth versions.



Stage. Stages your site by writing HTML, assets and other files to your hard disk or a server that has restricted access.



HID_DRAW_SELECTION. 



HID_DRAW_RECT. 



HID_DRAW_ROUNDRECT. 



HID_DRAW_LINE. 



HID_DRAW_ELLIPSE. 



HID_DRAW_TEXT. 



HID_DRAW_PICTURE. 



HID_DRAW_POLYGON. 



HID_DRAW_OLE. 



HID_DRAW_JAVA. 



HID_DRAW_DBLIST. 



HID_DRAW_DBFIELD. 



HID_DRAW_FORMBUTTON. 



HID_DRAW_FORMRADIO. 



HID_DRAW_FORMCHECKBOX. 



HID_DRAW_FORMEDIT. 



HID_DRAW_FORMPSW. 



HID_DRAW_FORMCOMBO. 



HID_DRAW_FORMCLEAR. 



HID_DRAW_ZOOMIN. 



HID_DRAW_ZOOMOUT. 



HID_DRAW_TABLE. 



HID_DRAW_GRAPHIC. 



HID_DRAW_HOTSPOTRECT. 



HID_DRAW_HOTSPOTROUNDRECT. 



HID_DRAW_BACKGROUNDPICKER. 



HID_DRAW_SHOCKWAVE. 



HID_DRAW_SOUND. 



HID_DRAW_VIDEO. 



HID_DRAW_ACTIVEX. 



HID_DRAW_FORMMULTIEDIT. 



HID_CANCEL_EDIT_CNTR. 



HID_VIEW_GRID. 



HID_VIEW_ZOOM_IN. 



HID_VIEW_ZOOM_OUT. 



HID_PAGE_NEWPAGE. 



HID_PAGE_DELETEPAGE. 



HID_OBJECT_LINECOLOR. 



HID_VIEW_DIAGONAL. 



HID_OBJECT_FILLCOLOR. 



HID_VIEW_VERTICAL. 



HID_OBJECT_MOVETOFRONT. 



HID_OBJECT_MOVEFORWARD. 



HID_INDEX. 



HID_VIEW_PAPERCOLOR. 



Click this button to go to the previous page within this stacked page.



HID_NEW_CHILD. 



HID_NEW_SIBLING. 



HID_PREVIEW. 



HID_OPEN_NODE. 



HID_OBJECT_FONT. 



HID_OBJECT_FILLCOLOR2. 



HID_OBJECT_LINECOLOR2. 



HID_OBJECT_FONT2. 



HID_FONT_BOLD. 



HID_FONT_ITALICS. 



HID_FILE_SUMMARYINFO. 



HID_FONT_UNDERLINE. 



HID_FONT_TEXTCOLOR. 



HID_STYLE_LEFT. 



HID_STYLE_CENTER. 



HID_STYLE_RIGHT. 



HID_TEXT_BULLET. 



HID_LAYOUT_FONT. 



HID_LAYOUT_TITLE. 



HID_LAYOUT_PICTURE. 



HID_LAYOUT_COLOR. 



HID_LAYOUT_FIXEDFONT. 



HID_OBJECTDEFINITION. 



HID_NEWPUBLISHSET. 



HID_SETPUBLISHSET. 



HID_PUBLISH_NEWPUBLISHSET. 



HID_AlLIGNOBJECTS. 



HID_ASSIGNLAYOUTS. 



HID_ALIGN_HORIZONTAL. 



HIDM_BROWSER_OPTIONS. 



Indents text within a text box.



Unindents text within a text box.



HID_FILE_DUMPHTML. 



HID_DRAW_SELECT. 



HID_DRAW_POLY. 



HID_LAYOUT. 



HID_DELETE. 



HID_TOP_LEVEL_MENUS. 



HID_OBJECT_COMMENTS2. 



This option allows you to set the start value of a numbered list when the selected text box uses the numbered list (also called 
ordered list) paragraph style.



Help Overview. Explains how to get help with NetObjects Fusion by launching your browser and opening a locally installed HTML 
file.



HID_INDICATOR_ZOOM. 



HID_INDICATOR_POSITION. 



HID_INDICATOR_CUROBJ. 



HID_ERR_LAYOUTTOOSMALL. 



HID_DELETE_ELEMENT .



HID_DELETE_FILE_ASSET .



HID_DELETE_LINK .



HID_DELETE_PAGE .



HID_EDIT_CLEAR_ITEMNAME .



HID_EDIT_CLEAR_STYLE .



HID_GOTO_PAGE .



HID_IMPORT_ITEMNAME .



HID_IMPORT_PAGE .



HID_IMPORT_STYLE .



HID_NEW_DATA_OBJECT .



HID_NEW_FILE_ASSET .



HID_NEW_ITEMNAME .



HID_NEW_LINK .



HID_NEW_PAGE .



HID_NEW_STYLE .



HID_NEXT_TAB .



HID_PREVIOUS_TAB .



Removes link previously associated with the selected text.



HID_NEW_ASSET



HID_DRAW_POPMENU



HID_DEBUG_LINKASSETS



HID_DRAW_VERTBANNER



HID_VERIFY_ASSET



HID_DRAW_COMPONENT



HID_LAYOUT_EXTERNAL



HID_PRINT_TO_FIT



HID_DRAW_NAVBAR



HID_DRAW_FORMTOOL



HID_DRAW_ODBC



HID_DRAW_ISAM



HID_DRAW_BBS



HID_DELETE_ASSET



HID_EDIT_HTML



Click here to close the Spelling dialog and cancel your spell check session.



HID_DRAW_VERTBAR



HID_DRAW_ARROWLINE



HID_FILE_INSTALLCOMPONENT



HID_TEXT_UPDATEFIELD



HID_FLUSH_REDO



HID_DRAW_BANNER



Click this button to delete the currently selected tag from the text.



HID_INDICATOR_EXT



HID_INDICATOR_CAPS



HID_INDICATOR_NUM



HID_INDICATOR_SCRL



HID_INDICATOR_OVR



HID_INDICATOR_REC



HID_INDICATOR_KANA



HID_SEPARATOR



HID_FILE_NEW



HID_FILE_CLOSE



HID_FILE_SAVE_AS



HID_FILE_PAGE_SETUP



HID_FILE_PRINT_DIRECT



HID_FILE_UPDATE



HID_FILE_SAVE_COPY_AS



HID_FILE_SEND_MAIL



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



Most Recently Used (MRU) Sites. Ordered list of the last several sites that you opened. To reopen a saved site, click its name on 
the MRU list.



HID_EDIT_CLEAR_ALL



HID_EDIT_PASTE_LINK



HID_EDIT_REPEAT



HID_WINDOW_NEW



HID_WINDOW_ARRANGE



HID_WINDOW_CASCADE



HID_WINDOW_TILE_HORZ



HID_WINDOW_TILE_VERT



HID_WINDOW_SPLIT



HID_HELP_INDEX



HID_HELP_FINDER



HID_HELP_USING



HID_CONTEXT_HELP



HID_HELP



HID_DEFAULT_HELP



HID_NEXT_PANE



HID_PREV_PANE



HID_FORMAT_FONT



HID_OLE_INSERT_NEW



HID_OLE_EDIT_LINKS



HID_OLE_EDIT_CONVERT



HID_OLE_EDIT_CHANGE_ICON



HID_OLE_EDIT_PROPERTIES



HID_OLE_VERB_FIRST



HID_OLE_VERB_LAST



HID_VIEW_TOOLBAR



HID_VIEW_STATUS_BAR



HID_RECORD_FIRST



HID_RECORD_LAST



HID_RECORD_NEXT



HID_RECORD_PREV



HID_APPLY_NOW



HID_WIZBACK



HID_WIZNEXT



HID_WIZFINISH



Merge Text boxes. Merges all selected text boxes into the first text box selected (you may use the mouse or keyboard to select 
multiple text boxes). The combined text box maintains the same width as the first text box selected.



Assign a MasterBorder to the current page. To add, rename or remove MasterBorders to this list, click on the Add/Edit button on the 
MasterBorder properties palette, General tab. When importing or referencing pages in Site view, select a MasterBorder from this list 
to assign to the imported or referenced pages. In the New MasterBorder dialog, select a MasterBorder from this list to base the new 
one from (to begin with an empty MasterBorder, base the new one on the default ZeroMargins MasterBorder).



Enter or browse to the home page of the local site you want to import (if Import Local Web Site or Reference HTML), or enter the 
URL address of the remote site you want to import (if Import Remote Web Site) .











If checked, hotspots that have been applied to the selected picture are displayed.    This is used for design purposes only, as 
hotspots (image map) are not visible in browsers.





Sets the page background color to match the current SiteStyle (as selected in Style view).



Choose this option if you want a solid color background for this page.



Choose this option if you want a graphic background on this page.



Opens the Color Picker dialog to let you choose a solid color background for this page.



Opens the Picture File Open dialog to let you locate a picture to use for the page background.







Check this box to display the grid.







Displays the path and file name for the current picture. Change the picture by typing in a new path and file name or by clicking the 
Browse button to locate a file.



Displays the link assigned to the selected hotspot. Click the Link button to specify a new link.



Lets you choose the type of template you wish to apply to the site.



Select the next data field to query on. 



Select the next data field to query on. 







Lists all available web browsers. Select the browser from this list that NetObjects Fusion will launch when you click the Preview 
button in the control bar. 





Click this button to add a .class file used by the selected Java Applet.



Lets you remove the selected browser from the list.



Sets the web browser that NetObjects Fusion will launch when you click the Preview button in the control bar. Installed web 
browsers are list here.



















Shows the current fill color for the selected graphic object. To change the color, click the Color button.



Opens the Color Picker dialog to let you change the fill color for the selected graphic object.



Opens a standard file Open dialog to let you locate a file.



Applies underline formatting to the selected text.



Applies strikeout formatting to the selected text.





Lists available point sizes for the selected text. The list also shows the corresponding HTML standard sizes. 





Opens the Link dialog to let you link to another page or location within this site or on the Internet. The link is applied only to the 
selected text. This button is disabled when no text is selected.



Enter the name of your new paragraph style here.







Opens the Color Picker dialog to let you change the background color in the selected text.















Displays the file name represented by the selected object. 



Opens the standard Open dialog to let you locate the selected media file type.



Click one of these buttons to place a supplied icon to represent your page.



Click this option to select from one of the supplied sound or video images. To choose an image, click its button.



Click this option to select a custom picture to represent the sound or video. To locate an image on your disk, click the File button.



Opens the Picture File Open dialog to let you locate an image to represent the media object.



Displays the file name of the picture selected to represent the media object.    Click the Browse button to select a picture file.







Choose a Layout for the current page from this drop-down list. Choose Add… from the drop-down list to create a new page layout 
based on the current page.









Check this option if this name-value pair is to be selected by default.



Makes the field a password control. Any text entry is displayed as asterisks. 





Choose this option if you want to allow the user of the form to make multiple selections from the items in your list box.



Check this option to additionally publish or stage your site as a greyscale site. All images (GIFs and JPEGs) are published or staged
as two-color monochrome.



Check this option to additionally publish or stage your site as a low bandwidth site. All GIFs are reduced to 4-bit color (16 color) and 
all JPEGs are reduced in file size by half (they are resized in your browser to their original dimensions).







Displays the name of the selected data list. If you are creating a new data list, enter a name here (the default is “Untitled”). This 
data list name is for internal reference only. Open the Data Publishing dialog by either double-clicking on the Data List itself or by 
clicking the Define button in the Data List properties palette.





Enter the name for this new data object sourced with internal data. This field is unused by data objects sourced with external data.



Displays the name and type of each data field within this data object. Double-click on a field to edit its name. Click on the add button
(+) below to add data fields to this data object. 



Enter any comments for this object here (for internal purposes only).







Lets you change the name of the currently selected page.





Enter or select a column number to change its settings. Use the drop-down list below to change the type of object contained within 
the specified column. Change settings for multiple columns by selecting columns here and changing their object types below 



Adjust size of the external border for the selected data list, table or navigation bar.



Select a method of comparison from this drop-down list for this relational query



Enter the value to be compared (according to the comparison method) in the specified data field.



Select a logical conjunction (“and” or “or”) to define the relational query. Select “end” to end your query without specifying further 
conditions.





Enter the value to be compared (according to the comparison method) in the specified data field.





Enter the password for your user name.    This is optional.    If you don’t enter your password here, you will be prompted when 
publishing to this server.



Enter your user name for the server you want to publish to.



The location of the selected file is displayed here.























Identifier for the control.





Makes the default state of the control "not selected" or "unchecked."



Choose this option to have the selected radio button be selected by default when the form object is viewed within a browser.



Choose this option to have the selected radio button be unselected by default when the form object is viewed within a browser.



Click the up or down arrows to change the grid block width.



Click the up or down arrows to change the layout height.



Enter or select a column number to change its settings. Use the drop-down list below to change the type of object contained within 
the specified column. Change settings for multiple columns by selecting columns here and changing their object types below 



Adjust size of the external border for the selected data list, table or navigation bar.



Lets you increase or decrease the margin, in points, between the cell contents and container edges. Each click on a spin button 
changes the size by one point. For larger changes, type a new number into the field



Adjust the margin between cells in the table or data list (or between buttons in a navigation bar) and its outside borders..



Choose this option to select a image file to use as a bullet in the selected data list. Click on the browse button to open a standard 
Image File Open dialog.



Check this option to if you do not want to use bullets within the selected data list.



Choose this option to have the navigation buttons automatically link to all pages on the current page’s level of the site structure (as 
found in Site view)







Moves the selected item up one position on the list.











Click the up or down arrows to change the layout width.



Shows the color that will be applied to the selected text box background if you choose the background color option. To change the 
color, click the Color button. 











Lets you change the measurement units used in determining the height and depth of the page as well as the grid size used to 
position objects on the page. Choose from centimeters, inches, points or pixels. Your choice is used in the Grid Size options below 
as well as in the Layout and MasterBorder properties palettes.



Choose this option to use the primary button style as shown in the current style (Style view) for the selected navigation button.



Choose this option to use only text for the selected navigation button.



Choose this option to use the secondary button style as shown in the current style (Style view) for the selected navigation button.











Check this option to additionally publish or stage your site as a text only site. Non-text assets such as images or sound files will not 
be included in the published or staged site.





Displays the current page type (Normal or Stacked).







Shows the color of the background that is applied to the picture container if you select the Use Current Color option.



Area in which you can enter additional comments about the currently selected page.



Opens the Color Picker dialog to let you set the color of individual page icons in Site view.    You can use this feature for various 
purposes, such as indicating site sections.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Opens the Color Picker dialog to let you set the color of the Site view background.



Opens the Color Picker dialog to let you set the color of the Site view background.





Outline View. Provides a drag and drop file tree view of your site in which you can expand and collapse the structure at any level. 
You can review site management information about each page, such as the names of child pages, page type, status, and 
comments.





These options let you control how a graphic is displayed within the selected picture bounding box.



 These options let you apply text to the selected picture or graphic container and choose the color, alignment and font for the applied
text. 



Choose this option if you would prefer a solid color as a background for this style. Click on the Color button to select a new color.



Choose this option if you would prefer a picture as a background for this style. Click on the Browse button to browse for a picture. A 
sample of how the tiled picture will appear as a background style is displayed on the right.



Click this button to open the Color Picker dialog, where you can select a color for the background style. 



Adds the current footer to the Footer list, making it available to all other pages in your site.



Opens the Edit MasterBorder List dialog, when you add, rename or delete MasterBorders. Changes made in the Edit MasterBorder 
List do not change the current page's settings.





Closes the dialog and saves any changes you made.



Displays the URL (internet address) for this external link.





Enter, edit or view the value displayed in this field.



Choose this option to make the control a dropdown type list box, which takes up less space on the form. The user opens the list by 
clicking a button.



You've selected a text buttonface. Enter the text you would displayed on the button, and specify whether it is a Submit or Reset 
button.



Displays the name of the style to be edited.



If checked, places the Banner button (as shown in the Styles view) in the page header.



Lets you choose a new footer for this page.





Lists the ActiveX controls available on your system. Select the ActiveX control to be inserted into the current selection.



Lists the properties available in the selected ActiveX control.







These three icons align text flush left, center and right, in that order. When working in a text box, they affect the current paragraph. 
When working with Text in Element Settings in Page view, or Text Settings in Style view, they affect the relative alignment of multi-
lined text only.





Displays the current background color of the selected data list or table. To change the color, click the Color button.



Enter the name of the remote server you want to publish to.



Check here to have your password stored in memory. If checked, you will not need to enter your password each time you publish.





Check this option to use the current default bullet style (as shown in Style view) in the selected data list.



Lets you switch between vertical and horizontal orientation in Site Structure View.



Check or clear this box to show or hide column headers in the selected data list.



Select a file extension for the generated HTML files of your site. Html is used by UNIX and Macintosh computers and is more 
commonly found on the Web; htm is used by IBM-PC compatibles with its three-character extension limit.    You can set an individual
page’s extension from the Custom Names dialog box (Custom Names from the Edit menu or Page Properties tab).



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Shows the color of the Site view background. To change the color, click the Color button. 











Enter the directory on the remote host to start in.







Displays a list of symbol characters, with descriptions and Shortcut keys (if applicable) which can be inserted into a text box. Use 
Shortcut key combinations outside this dialog, when entering text into a text box. Insert the selected symbol into the text box at the 
insertion point by pressing the Insert button below.



Check this box to use highlighted buttons (as defined by the style) in the navigation bar. The navigation button for the current page 
will use the highlighted style. Note: this option has no effect on navigation bars with text buttons.



Select this option to include the site home page as a navigation button in the navigation bar.



Displays the number of words in the current page.





Displays the number of characters in the current page.



Displays the number of lines in the current page.



Displays the number of words in the current text selection.



Displays the number of lines in the current text selection.



Displays the number of paragraphs in the current text selection.



Displays the number of characters in the current text selection.



Structure View. Provides a drag and drop graphical view of your site. You can use this view to visualize your site’s structure. You 
can also expand and collapse the structure and color code individual pages.





Finds the selected page and opens it in Page view.



Opens a pre-built ActiveX control Properties dialog (if available), where you may edit the ActiveX control's properties. Also use this 
property palette to modify ActiveX properties within NetObjects Fusion (for further information, see help on other options within this 
palette).



Displays the color that will be applied to the selected line or object border. To change the color, click the Color button.



Select a method of comparison from this drop-down list for this relational query



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To change the color, click
the Color button.







Name assigned to the current page. You can change this name at any time.



Enter or select the number of rows for your table here.



Applies italic formatting to the selected text.



Name assigned to the current page layout. You can change this name at any time.





 Opens an alignment dialog to let you position text within the selected picture or graphic object. Applies only if the Text in Element 
checkbox is checked and text appears in the field above the Align button.



Displays the current picture used for the banner in this style. Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Click here to open the standard Font dialog, where you may select fonts and font styles to be applied to the text used in this style 
element.





This displays the current background style color. Click on the Color button to change this color.



Displays the current picture used for the background in this style. Click on the Browse button to modify this selection.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this selection.



Click here to open the Image File Open dialog, where you can select a picture for this style element.







Enter a full or partial name of the page within your site you wish to link the selected object to. 



Searches for pages beginning with the character(s) you’ve entered above. Click on the Find button below to locate all matches.



Searches for pages which contain the character(s) you’ve entered above. Click on the Find button below to locate all matches.



Searches for pages which end with the character(s) you’ve entered above. Click on the Find button below to locate all matches.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Graphical display of the selected level.



Use these options to apply the default color or choose a new color for the selected text.



Use these options to add or remove background color in the selected text box.







Icon representing the audio controls object that is placed on the page when you choose the Inline option.





Opens a standard Windows search dialog to let you locate a picture to place on the selected button.



Displays the file name of the picture that appears on the selected button. If no picture is assigned to the button, this label is blank. 
Click on the Browse button to select a picture file.



Choose this option if the intended data object uses one of the pre-built database drivers listed in the drop-down list to the right. Click
on the Browse button to choose a file that matches the driver type specified in the drop-down list.



Click on this button to add a new field to your data object.



Opens a standard Windows search dialog to let you locate a file.



Type the text that will appear in place of the sound graphic in client browsers that either can't display images or have image display 
turned off.



Click to apply the selected operation. In the Link dialog, removes the currently assigned link.



Removes the currently assigned link.



Turn off or on the autosave feature, which automatically saves your site as you work on it. Unchecking    this option can improve 
overall performance when working with large sites, but if turned off you must manually save your site    (Save Site on the File menu).



Type the text that will appear in place of the image representing the ActiveX control in client browsers that either can't display 
images or have image display features turned off.



Specify the file needed to implement this ActiveX control on the client side, almost always an .OCX files (less commonly.CAB or .INF
files). Note: if the Set Codebase option was checked in the Insert ActiveX dialog the necessary module will be automatically added 
to this field. Also, the module used by a particular ActiveX control is displayed in the Insert ActiveX dialog. See help for the Insert 
ActiveX dialog.



Type the name of a script to run with the ActiveX control. To open the full script editing window, click the HTML button.



Text will be aligned to the bottom of the style element.



Launches a standard Open dialog which lets you locate files.



Opens the Image File Open dialog, where you can select a new image or picture to be used for highlighted buttons in this style.







Opens a Browse dialog to let you choose a new bullet graphic for the selected data list. 



Add a new item to the list.



Moves the selected item down one position on the list.



Remove the selected item to the list.



Opens a standard Windows Font selection dialog to let you choose a new proportional font and font size. You must match these 
settings to the proportional font settings in your browser's preferences.





Click this button to assign a picture to the selected cell. When you select this option, a standard Windows search dialog appears to 
let you locate a picture. Caution: If the cell already contains text and you choose a picture to replace it, the text cannot be retrieved.



Click this button to enable text entry in the selected cell. Caution: If the cell already contains text and you assign a picture to it 
through the Picture type option, the existing cell text cannot be retrieved.



Chooses what type of object, text or picture, will appear in the Column number chosen in the field above. The default type is text.



Text will be aligned to the horizontal center of the style element.



Text will be aligned to the vertical center of the style element.



Enter the location on the remote server where CGI (Common Gateway Interface) scripts are located. 



Edit. Lets you edit the selected style element. You can also edit elements by double-clicking list items. 



Check this box to enable uploading only those file assets which have changed since the last time you've published or staged. If 
you've deleted or changed files on your server, disable this option to re-publish or re-stage your entire site (NetObjects Fusion 
doesn't compare the server's files). This option is enabled by default. 







Check this option to use a transparent GIF to maintain WYSIWYG layout in Netscape Navigator 3.0 (and older versions). The file 
"dot_clear.gif" will be used to display your site in Netscape as it appears within NetObjects Fusion.



Check this box to have NetObjects Fusion automatically place all data fields on the stacked pages associated with this data object 
and list. Go to the stacked pages in Page view to manually adjust the layout of the data fields and stacked pages.



Check this box to automatically add navigation buttons to the stacked pages associated with this data object and list. NetObjects 
Fusion will add Next, previous and up buttons to the set of stacked pages. Go to a stacked page in Page view to manually adjust the
layout and properties of navigation buttons on the stacked pages.











Displays the currently selected solid background color for this page. Only applies if the Solid Color option is selected. To change the 
color, click the Color button.





Lists the pre-built database drivers available for the intended data object. Click on the Browse button to choose a file that matches 
the driver type specified in this list.



Select a data field to be added to the current stacked page from the drop-down list.



Select a method of comparison from this drop-down list to use for this query.



Enter the value to be compared (according to the comparison method) in the specified data field.



Elements. Lists the editable elements that make up the selected style. You can double-click on any item in the element list to edit it.



Clicking this button opens the SQL Data Sources dialog, where you may add and select from a list of external data sources.



Opens the Data Publishing dialog, where you can change the name assigned to this list, show or hide fields assigned to the list, 
assign the Linked Field attribute to fields in the list, change the order in which fields appear, and other options.



Choose from the current set of Data Objects to be included in your data list. Choose the New Button to create a new data object.









Enter the path to the local folder you want to publish your site to. Click the Browse button to locate a folder.



If you make the control a standard list box, this field lets you set the number of lines that are displayed in the box. If there are more 
items in the list than the number you set here, a scroll bar is added



If you make the control a standard list box, these buttons increase or decrease the number of lines displayed in the box. If there are 
more items in the list than the number you set here, a scroll bar is added.



Lets you change the text displayed on the element.



Click the up or down arrows to increase or decrease, in increments of one, the maximum number of characters allowed in the field. 
If the box contains more text than shown in the Max Visible setting, the user can view the additional text by using the arrow keys to 
scroll right or left.



Contains the value that will be returned when the form is submitted and this checkbox or option is selected. All checkboxes and 
radio buttons should have a name and a value assigned to them (otherwise, if the option is selected, and the form is submitted, the 
default string “On” is returned when the form is submitted).



The number of lines that are visible in the field (which determines the onscreen height of the box). If the box contains more lines 
than the Visible Height setting, the user can view the additional text by scrolling up or down using the keyboard .



Click these buttons to increase or decrease the number of lines that are visible in the field (which determines the onscreen height of 
the box). If the box contains more lines than the Visible Height setting, the user can view the additional text by scrolling up or down 
using the keyboard arrow keys.



The number of characters that are visible in the field (which determines the onscreen width of the box). The maximum number of 
characters the box can contain is set in the Max Length control. If the box contains more characters than the Visible Length setting, 
the user can view the additional text by scrolling right or left using the keyboard arrow keys.



Click these buttons to increase or decrease, in increments of one, the number of characters that are visible in the field (which 
determines the onscreen width of the box). The maximum number of characters the box can contain is set in the Max Length 
control. If the box contains more than the Visible Length setting, the user can view the additional text by scrolling right or left using 
the keyboard arrow keys.





Enter the text you would like to be inserted into the published HTML page after the selected object. Click the Insert button to insert a
text or HTML file in this field. Click OK to confirm the insertion, Cancel to exit this dialog without inserting or changing the script.



Sets the maximum number of characters allowed in the field. If the box contains more text than shown in the Max Visible setting, the
user can view the additional text by using the arrow keys to scroll right or left.





The number of characters that are visible in the field (which determines the onscreen width of the box). The maximum number of 
characters the box can contain is set in the Max Length control. If the box contains more characters than the Visible Length setting, 
the user can view the additional text by scrolling right or left using the keyboard arrow keys.











Select an initial data field to perform a Boolean query on. 



The file name and path for the picture is displayed here. To change the picture, click the Browse button.



Enter the number of pixels to offset your background image from the left margin.



This buttons opens the Query dialog, which allows you to set database queries or filters for the data fields listed below (further help 
is available within the Query dialog).



Choose this option to have the navigation buttons automatically link to all pages on the first level of the site structure (as found in 
Site view)





With the Get method, the values of the form variables are sent as part of the URL. This corresponds to the “METHOD=GET” 
attribute of the Form tag in HTML. 



Post is the default method used by forms. The values of the form variables are echoed as text, whereas in the Get method the 
values are sent as part of the URL. This corresponds to the “METHOD=POST” attribute of the Form tag in HTML. 



In this field specify the URL of the CGI script to be used by your site when processing forms. This corresponds to the “Action” 
attribute of the Form tag in HTML. This field is required.





Advanced users may specify a local copy of the CGI script used for processing forms. The Action field below should contain the full 
URL for the CGI script selected above. This file will be FTP’d to the CGI directory indicated in your Remote configuration (Publish or
Stage Settings). Note: if your CGI script is already on your web server, you may leave this field blank.



This field is optional. Advanced users may need to specify a non-standard encoding type when configuring advanced forms. (MIME-
type application/x-www-form-urlencoded is the default encoding type, which encodes the form’s name-value pairs as an URL is 
encoded).



Click this button to open a standard Open File dialog and select a local CGI script.



Opens the Forms Settings dialog, where you configure your form.    View help within the dialog for more information.











Horizontally aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the picture.



Horizontally aligns the selected picture to the left of its bounding box, when the bounding box is sized differently from the picture.



Horizontally aligns the selected picture to the right of its bounding box, when the bounding box is sized differently from the picture.





Opens the Hidden Fields dialog, which lets you add or remove hidden fields (not visible in the browser) from your form.





Select a name for your site’s home page, which can be either the current home page name (as displayed in Site view), Index, 
Default, or Home. 





If this option is checked, headers and footers within this site will be oriented horizontally, i.e. headers will be at the top, footers at the
bottom of each page. The header/footer splitter bars will be horizontal, at the top and bottom of each page. If this option is 
unchecked, headers and footers within this site will be oriented vertically, i.e. headers will be on the left, footers on the right of each 
page. The header/footer splitter bars will be vertical, on the left and right of each page.



Choose this option to display a set of graphical audio or video controls on the page. This interactive object can be used to control 
the sound or video object from the client browser.





Choose this option to have the navigation buttons automatically link to all pages on the parent page’s level of the site structure (as 
found in Site view)



Choose this option to have the navigation buttons automatically link to all pages on the child page level of the site structure (as 
found in Site view)







Launches a standard Open dialog where you can locate HTML or other text files to insert into the edit field (where the cursor is 
currently located). (In the JavaScript Expression dialog, opens the Action dialog, where you insert a call to return an action value.)



Lets you type in an HTML alternate tag for the selected object. This text—generally a short description of the object—appears in 
place of the graphic representing the object in text-only web browsers or browsers in which graphics have been turned off.



Displays the file name of the selected Java applet or Shockwave file.



Text you want displayed in the control.





Lets you view or change the width or height of the current page layout in terms of the selected unit of measurement. You can 
change the layout width or height by typing a new number directly into this field or clicking the spin buttons to change the value.



Displays the currently selected unit of measurement used in determining layout and page size. The Measurement unit preference 
can be changed at any time (Edit menu, Preferences, Page tab).



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Opens the Color Picker dialog to let you choose a background color.



Lets you view or change the height or width of the current page layout in terms of the selected unit of measurement. You can 
change the layout height or width by typing a new number directly into this field or clicking the spin buttons to change the value.



Displays the currently selected unit of measurement used in determining layout and page size. The Measurement unit preference 
can be changed at any time (Edit menu, Preferences, Page tab).





Text will be aligned to the left margin of the style element.







When this option is checked, the selected data list field above will be considered a linked field, which means that the data within that
field is linked to its corresponding page within the set of stacked pages used by the current data list. When the data list is viewed in 
a browser, data displayed in the column for a linked field will be seen as highlighted links to the corresponding data pages (within 
the set of stacked pages). To indicate that a data list field is linked, "(link)" is added to the end of the fieldname on the list above.





Displays the URL (internet address) for this external link.



This list displays all pages which contain this asset.



This is a list where parameters, actions or other items are displayed. Double-click an item to edit or select it. To add or remove a 
parameter or item, click the + or - buttons below the list. To reposition an item on the list, select the item and click the up or down 
arrow buttons.



Select this option if this server location is local. 











Displays the name of the selected asset.





Click this button to create a new data object. The Data Object dialog will open (see help on individual options within the Data Object 
dialog). 





Adds a new button to the header or footer navigation bar. The button picture is set in the Nav. Button properties palette.



Select the logical conjunction (“and” or “or”) to compare data fields. Select “end” to end your query without specifying further 
conditions.









Selects whether the selected page is included in the published site. By default all pages are published. To exclude the selected 
page, select the Don't Publish option. To include an excluded page, select the Publish option. A red dot appears in the upper right of 
each page icon when the Don't Publish option is set.







Displays a list of objects to be selected from.



The name of the selected ActiveX control or NetObjects Component.



Choose this option if the data object will use the Open Database Connectivity (ODBC) standard. Click on the Select button to open a
dialog where Data Sources and ODBC drivers for this data object are chosen.



Click this button to open the Data Source Type dialog, where you specify the location and type of a data object sourced with external
data.



Selects whether the selected page is included in the published site. By default all pages are published. To exclude the selected 
page, select the Don't Publish option. To include an excluded page, select the Publish option. A red dot appears in the upper right of 
each page icon when the Don't Publish option is set.



Enter or modify the name of the selected page here.



Selects whether the selected page is included in the published site. By default all pages are published. To exclude the selected 
page, select the Don't Publish option. To include an excluded page, select the Publish option. A red dot appears in the upper right of 
each page icon when the Don't Publish option is set.









Displays the data type (string, integer) required by the selected parameter.



Describes the required contents of the selected parameter.



Opens the Color Picker dialog to let you choose a color for the selected line or border on the selected graphic object. In the Line 
properties palette, you can only set the color when the Draw option is selected.



Opens a font selection dialog to let you choose a font for the text that appears in the selected picture or graphic object. 



Opens the Link dialog to let you add or change an internet link for the selected picture or graphic object. The link can point to 
another page within your site or to another page or site on the Internet.



Opens the Alignment dialog which lets you choose the position the image "snaps" to if you change the size or shape of the 
container. If, for example, you choose Left and Bottom alignment and then enlarge the picture container, the picture will maintain its 
original size, but snap to the bottom left corner of the enlarged container.



Enter text for the alternate (ALT) attribute of the selected object, which will be added to the Object HTML. This text, generally a short
description, appears in place of the object in browsers when images, java or other features are unsupported or have been disabled.  
The ALT text may appear while an object is loading and in some browsers, as tooltips when the visitor mouses over the picture or 
object.



If this page uses an image for the background, the image file name is displayed here.



To add text to the selected picture, check the Text in Element checkbox, then type the text into this field.



Opens the Color Picker dialog to let you choose a color for the text that appears in the selected picture or graphic object. 











You've selected an image form button. Click on the Browse button to select a picture file. By default, a graphic form button acts as a 
Submit button. 



Makes the button a "reset" control. When the user clicks the button in a client web browser, form contents on the page are cleared.



Makes the button a "submit" control. When the user clicks the button in a client web browser, form contents on the page are sent to 
the site.



Makes the default state of the control "selected" or "checked."





The image file will be converted from its currently file format to a .GIF file, one of the two image file types supported by most 
browsers. Choose JPEG below to convert the image to a .JPG file (called .JPEG on UNIX and Mac), the other image file type 
supported by most browsers.



Choose this option if you want to control the length, width, angle and color of the selected line.



Choose this option to make the selected line a horizontal rule. An <HR tag will be added to the HTML source for this page.



The image file will be converted from its currently file format to a .JPG file (.JPEG on UNIX and Mac), one of the two image file types
supported by most browsers. Choose GIF above to convert the image to a .GIF file, the other image file type supported by most 
browsers.



Choose this option to make the control a standard list box.





Choose this option if you would prefer no background for this style.



Choose this option to apply the line picture style (specified in Style view) to the selected rule.





Choose this option to create an internal data object. Select a name, enter comments and create data fields below (also see help on 
each individual item).











Choose this option to include a data object sourced with external data. Click on the Source button to open the Data Source Type 
dialog to select your external data source type (also see help for that dialog).



The data field will consist of images. If you are creating this data object internally, you may select images by double-clicking on the 
empty data field after it is placed on a stacked data page.





Select this option if this server location is remote. Enter basic settings for this remote server below. Click the Advanced button to 
configure advanced settings such as server port, permissions and aliases.







Select this option to have all spaces and special characters in the names of your assets replaced with underscores when published. 
Only the published file name is changed (not the local file).



Enter the name for a field within this data object. Choose from the options below to determine the type of data field (see help on 
individual options below).



Text will be aligned to the right margin of the style element.





Check this option if you would like to offset your background image the number of pixels specified in the Left and Top fields on the 
right. Since most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small gutter on the top and left 
margins, you may find that text will not align with your background image perfectly. Offsetting your background image will allow you 
compensate for this gutter problem.











This list displays the data fields (of the chosen data object) which will be added to the current data list. The checkboxes to the left of 
each field indicate whether or not this field will be included in the data list. You may reorder their positions within the data list with the
up and down arrow buttons on the lower right (the topmost field will be displayed in the leftmost column, and so forth).



Displays the name of the current site (if creating a new site, enter its name here).





Select an AutoSite or Page template from this list to base your new site on.



Templates. Offers two different types of templates to give you a head start with building your site.
AutoSites are fully structured sites with suggested content and navigation objects. You can open them as new sites or insert them 
into other sites.
Page Templates are pre-built pages with suggested content. You can open them as new sites or insert them into other sites.





Choose the data field on which this data list will be sorted from this drop-down list. This option is available only when a data object is
accessed by the data list.







Select a specific option to view help.



Enter text for the alternate (ALT) attribute of the selected object, which will be added to the Object HTML. This text, generally a short
description, appears in place of the object in browsers when images, java or other features are unsupported or have been disabled.  
The ALT text may appear while an object is loading and in some browsers, as tooltips when the visitor mouses over the picture or 
object.



Enter text into this field.



Style Gallery. Lists the SiteStyles that can be applied to your site and displays the various elements that make up the style. To edit 
a style's element, click the Elements button or double-click the style name.



Lets you apply a solid color background to the selected table.



A transparent background will be used when this option is selected.



Lets you enter the margin, in points, between cell contents and cell container edges.



Adjust the margin between cells in the table or data list (or between buttons in a navigation bar) and its outside borders.











Enter the number of columns for your table here.



Enter the number of columns for your table here.







Enter or select the number of rows for your table here.







Choose this option to reapply the formatting of the chosen style to the active paragraph. The formatting for the entire paragraph or 
text box (not just the current selection) will be replaced with the formatting for the style chosen. Redefining the style, the alternate 
option, not reapplying the style, is the default option.



Choose this option to redefine the chosen style using the current text selection as an example. The formatting of the chosen style 
will be replaced with the formatting of the text selection. This is the default option when reapplying paragraph styles.



Applies bold formatting to the selected text.



Lets you choose a bullet style for the selected paragraph.







Click this button to open the Color Picker dialog and choose a new color for the selected text. The new color appears in the swatch 
next to the button.





Click this button to apply the color shown in the swatch to the selected text. To change the currently defined color, click the Color 
button.





Applies the current SiteStyle text color to the selected text.    The SiteStyle text color is defined in Style view.





Lists available fonts you can apply to the selected text. Browser Proportional is the default font. 



Applies a solid color background to the selected text box. The color that will be applied is shown in the swatch next to the button. To 
change the color, click the Color button.



Choose a style for the selected paragraph. If you choose a style from this list, the style overrides any previously assigned font or 
size settings. You can also choose Add... from the list to add a new style based on any font or size settings you apply.



Inserts the selected symbol above into the text box at the insertion point.





Enter a value which will be used as the start value for the selected paragraph’s bulleted list. Although this field only accepts whole 
numbers, they will correspond to their alphabetical or roman equivalents.





Select this option if you want to add formatted text onto a selected object. Click the Settings button to add or edit the text you want 
to place.    This feature can be used for many purposes, such as adding copyright information directly onto the picture. When text is 
added to pictures, the original files are not altered.











Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the paragraph itself will 
be modified. Redefining the style using the selection as an example is the default choice (see help for each option below).



Displays the paragraph style to be reapplied or redefined. The options below determine whether this style or the paragraph itself will 
be modified. Redefining the style using the selection as an example is the default choice (see help for each option below).





Removes any solid color background in the selected text box. 









Text will be aligned to the top of the style element.



Site view. This is the Site view where you build, organize and manage the structure of your site. You can drag pages and sections 
to new locations in your site, and NetObjects Fusion updates the page links automatically.



















Enter the URL (Internet address) to be linked to the selected object.



Vertically aligns the selected picture to the bottom of its bounding box, when the bounding box is sized differently from the picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the picture.



Vertically aligns the selected picture to the center of its bounding box, when the bounding box is sized differently from the picture.









Displays the number of paragraphs in the current page.





 When this box is checked (its checked by default), a visible border is added to all objects placed on the page. To remove the 
borders, clear the checkbox.



Selects whether the selected page is included in the published site. By default all pages are published. To exclude the selected 
page, select the Don't Publish option. To include an excluded page, select the Publish option. A red dot appears in the upper right of 
each page icon when the Don't Publish option is set.



Enter or modify the site author's name here.    This is added to the generated HTML in the <META> tag. 



This text field displays the module (usually an .OCX file) which the selected ActiveX control uses for implementation.



Checking this option will place the filename listed in the above text field into the Codebase field in the ActiveX properties tab. (also 
see help for the text field above).



HIDC_DOFILE



Enter an HTML tag or tags to be inserted into current cursor position within the selected text box.



HIDC_SOLINK



HIDC_DOIMAGE



HIDC_DOLINK



Enter the number of pixels to move your background image to the left.



Enter the number of pixels to move your background image toward the top.



Enter the number of pixels to move your background image toward the top.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small 
gutter to the top and left edges of their windows. Offsetting your background images will allow you to compensate by moving the 
image to the left and toward the top.



Select the protocol to use to publish your site. Currently FTP (the protocol most often used for uploading files) is the only available 
protocol.



Click here to configure settings for remote staging. Opens the Remote dialog, where settings may be entered or modified.



Enter the text you would like to be inserted into the published HTML page before the selected object. Click the Insert button to insert
a text or HTML file in this field. Click OK to confirm the insertion, Cancel to exit this dialog without inserting or changing the script.



Displays the name used by this name-value pair. Enter a name here if creating a new name-value pair. 



The data field will consist of formatted text, which includes font styles, paragraph and other formatting attributes.



The data field will consist of simple text, without formatting.



Choose this option to go to the page which begins with the characters entered above. A list of all pages which match the search 
characters will be displayed.



Choose this option to go to the page which ends with the characters entered above. A list of all pages which match the search 
characters will be displayed.



Choose this option to go to the page which contains the characters entered above. A list of all pages which match the search 
characters will be displayed.



Select this option to preview the entire site when you click the Preview button.    To preview the selected page or section only when 
this preference is selected, hold down the Ctrl key while clicking the Preview button. 



Select this option to preview the current page or section, and not the entire site, when the Preview button is pressed. To preview the 
entire site when this preference is selected, hold down the Ctrl key while clicking the Preview button.    If the entire site preference is 
selected, you can preview the selected page or section by holding down the Ctrl key while pressing the Preview button. All internal 
links will be disabled when you preview a single page.



Enter the name or partial name of the page you wish to go to. Use the options below to choose whether to search for a page which 
begins with, contains, or ends with the text entered here. A list of all pages which match the search characters will be displayed.



Enter the relevant text in this field.



Folder in which the primary pages of your site will be stored. You can use any local or network path. 



Click here to configure settings for remote publishing. Opens the Remote dialog, where settings may be entered or modified.



Enter the number of pixels to move your background image to the left.



Displays the number of pages in your site.



Enter the text you would like to be inserted into the published HTML page within the tag associated with the selected object. The text
inside the object is placed just before the tag’s closing angle bracket. For example, if you’ve placed the picture “airplane.jpg” on 
your page and added the text ‘lowsrc=”airplane_low.jpg”’, the HTML source will read <IMG SRC=”airplane.jpg” 
lowsrc=”airplane_low.jpg”. Click the Insert button to insert a text or HTML file in this field. Click OK to confirm the insertion, Cancel 
to exit this dialog without inserting the script.



Lets you offset your background image. Most browsers (such as Netscape Navigator or Microsoft Internet Explorer) add a small 
gutter to the top and left edges of their windows. Offsetting your background images will allow you to compensate by moving the 
image to the left and toward the top.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the Page Type for the selected page, either Normal or Stacked Page (data pages used by a data list).



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the current background color. To change the color, click the Color button.



Shows the color of the currently selected page icon. To change the color, click the Color button.



Displays the name of the currently selected proportional font used throughout your site.



Displays the name of the currently selected monospace font in use throughout your site.



Displays the file name represented by the selected object.



Displays the color that will be applied to the selected line or object border. To change the color, click the Color button.



Displays the color that will be applied to the selected line or object border. To change the color, click the Color button.



Shows the current fill color for the selected graphic object. To change the color, click the Color button.



Shows the current fill color for the selected graphic object. To change the color, click the Color button.



Displays the file name of the selected Java applet, Shockwave or other plug-in file.



Displays the name of the current site.



Shows the date and time the current site was created.



Shows the date and time the current site was last changed.



Displays the number of pages in your site.



Displays the current picture used for the banner in this style. Click on the Browse button to select a new picture.



Displays the Font currently selected for this style element.



Displays the current picture used for regular or non-highlighted buttons in this style. Click on the Browse button to modify this 
selection.



Displays the current picture used for highlighted buttons in this style. Click on the Browse button to modify this selection.



Displays the color that will be applied to the selected text if you choose the color option next to the swatch. To change the color, click
the Color button.



Shows the color that will be applied to the selected text box background if you choose the background color option. To change the 
color, click the Color button.



When a style is selected, you can view its elements in the window on the right. Double-clicking a style or clicking the Elements 
button in the secondary control bar will open the Elements view, where you may edit the style's elements.



When an element is selected, you can edit it by double-clicking the list item or clicking the Edit button in the secondary control bar. 
See help for options within each dialog for further information.



Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that are associated 
with your site. You can use the list to manage these files and their associations.
Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or pages on which 
each link appears.
Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based information from 
either internal or external sources You can use the list to remove the data object from your site or edit the data object definition.
Variables. Shows you a list of User defined variables that are used within your site, as well as the page or pages on which each 
variable appears.



Enter or modify the name for this link. This name, used in Assets view, is an internal reference and is not added to HTML generated 
when your site is staged or published.



Choose this option to enable the Snap to Grid feature. All objects placed on a page will snap to the grid. Grid settings are found in 
the View properties tab, in Page view.



HIDC_EDIT1_VALUE



HIDC_ABOUTBOX



HIDC_CUT



HIDC_COPY



Select a tail style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_PASTE



Select a head style to use for the selected line. You may choose a Point, Arrow, Diamond, Circle or Square.



HIDC_UNDO



Check this box to have the line head and tail share the same style.



HIDC_LOOKUP



Check this box to have the line head and tail share the same color.



HIDC_COMMENT_TYPE



Enter or use the spin buttons to adjust the line width value from 1 to 100. 



Standard Cut, Copy, Paste and Undo buttons. Use these to easily cut, copy and paste text or undo actions within this dialog.



Enter or use the spin buttons to adjust the line width value from 1 to 100.



HIDC_FUNC_NAME



HIDC_LIST1



HIDC_LIST2



Displays a list of installed NetObjects Fusion Components. To add a Component to this list, click on the Add… button below.



Check this box to outline the head and tail with the line color.



HIDC_EDITBODY



HIDC_FILESASSETS



HIDC_LISTFOLDERS



Select the type of variable to insert at the cursor position into the text box. Select Date & Time to insert date or time variables (click 
the Date Format… button to choose from many date and time formats), or Site & General to insert site information and other 
variable. These fields will update when you switch from view to view, preview or publish. Select User defined to choose from text 
variables you have created (click the New… button to define a new variable).



Displays the name of the current MasterBorder. You may change this name at any time, which will update throughout your site. To 
create a new MasterBorder, select the New button on the Layout properties palette, select the MasterBorder, and change its name 
and settings from this property palette.



HIDC_LISTASSETS



Displays all available variables for the field type chosen above. If a Date & Time field is selected, click the Date Format… button to 
choose a date and time format. If User defined is chosen, choose from the list of defined variables, or click the New… button to 
define a new one.



The value for the currently selected variable is displayed here. The values are displayed only and are not editable.



HIDC_FILEPATHLABEL



Click on this button to choose a date format for the currently selected Date & Time field. Opens the Date Format dialog, where 
many date and time formats are available.



HIDC_FILEPATH



HIDC_SITE_CUSTOM_ADD



HIDC_SITE_CUSTOM_DELETE



HIDC_EDIT_TAGNAME



HIDC_SITE_CUSTOM_NAME



Opens the New Anchor dialog, which lets you create or remove a page anchor for the selected object. To link the selected object to 
an already defined anchor, click the Link button instead (select a page and anchor from the Internal Link tab).



Select this option to create an internal link to the current page. If desired, select an anchor from the Select Anchor drop-down list 
below to create a link to an anchor on the current page.



Click this icon to include a frame for the left side of the current MasterBorder. The order of frames chosen (displayed in parentheses 
below) will determine whether a frame spans the height of the MasterBorder margin or ends at another frame’s edge.



HIDC_RADIO_CENTER



When this option is selected, a background grid is displayed in Page view. Set the grid width and height below.    The Grid uses the 
unit of measurement set in Preferences. Check the snap to grid/guides box below to have objects snap to the grid when positioned 
near a grid line. When a Layout Region is selected, an alternate Grid is displayed within the Layout Region when the Local Grid 
option is selected. Adjust grid display with the settings below.



When this option is selected, guides are displayed in Page view. By default, one horizontal and vertical guide will appear on your 
screen. Drag to reposition a guide, or hold down Ctrl and drag from a guide to create a new guide. Check the snap to grid/guides 
box below to have positioned objects snap to your guides.



HIDC_SITE_CUSTMO_LIST



Check this box to replace the current layout with an external HTML file.    Locate an external HTML file with the standard Open 
dialog which appears when this option is selected. The selected HTML file will be published in place of the current internal page 
layout. No changes are made to the external HTML file. To edit the external HTML file (with the editor specified in Edit | General 
Preferences), double-click anywhere in the grayed-out page view. You may toggle between the internal layout (which is not lost) and
the selected external HTML file.



Displays the name of the currently selected anchor. If creating a new anchor, enter its name here.



HIDC_USEANCHOR



Click this icon to include a frame for the right side of the current MasterBorder. The order of frames chosen (displayed in 
parentheses below) will determine whether a frame spans the height of the MasterBorder margin or ends at another frame’s edge.



HIDC_FRAME_BORDER



HIDC_PICTURE_TEXT_ALIGN



The value for the currently selected variable is displayed here. The values are displayed only and are not editable.



HIDC_RADIO_LEFT



HIDC_FINDPAGE



Displays the name of all pages in the current site. Enter a full or partial name of the desired page in the field above to jump to the 
desired page in this list box.



Click this icon to include a frame for the top of the current MasterBorder. The order of frames chosen (displayed in parentheses 
below) will determine whether a frame spans the length of the MasterBorder margin or ends at another frame’s edge.



Check this box to allow users to resize the current frame from within their browser window. If unchecked, the frame will be set to its 
current fixed height and width.



HIDC_ORIENTATION_SLIDER



Choose a date and/or time format to use for the current variable from the many formats below.



HIDC_ANCHORNAME



Displays a list of anchors defined for the page selected above. Select an anchor from this drop-down list to create or modify the 
internal link to an anchor within the selected page.



Click this icon to include a frame for the bottom of the current MasterBorder. The order of frames chosen (displayed in parentheses 
below) will determine whether a frame spans the length of the MasterBorder margin or ends at another frame’s edge.



HIDC_FRAME_BORDERSZ



Displays the current level of text rotation in degrees. Use the slider control on the left to adjust the number of degrees the text will be
rotated. If the Right angles check box below is checked, this number will be constrained to 90 degree increments.



HIDC_RADIO_RIGHT



HIDC_PAGENAME_INTERNALLINK



Displays a list of anchors defined for the current page. Select a new anchor from this list if changing the currently selected anchor.



HIDC_FRAME_BORDERSZ_SPIN



HIDC_STATIC_EXAMPLE



Select this option to create an internal link to a page within the current site. Enter a full or partial name of the desired page in the 
field (on the right) to jump to the desired page in the list box below.



Displays the current frame's name. The default names are Left Frame, Right Frame, Top Frame or Bottom Frame. You may enter a 
new name for the current frame in this field. NetObjects Fusion uses this name when generating the HTML source for your site.



If this box is checked, text rotation will be constrained to 90 degree increments. The current level of text rotation is displayed above. 
Use the slider control on the left to adjust the degree of text rotation.



HIDC_ORIENTATION_SLIDER2



Click here to make the current frame scrollable. Regardless of the frame's contents, site visitors will see scroll bars for this frame in 
their browser window.



HIDC_CHECK_RA2



Click here to make the current frame size not scrollable. Regardless of the frame's contents, site visitors will never see scroll bars 
for this frame in their browser window.



Click here to have browsers automatically determine whether to include scroll bars or not for the current frame. If the contents of the 
frame fits within the frame size, no scroll bars will be displayed. If the contents extend beyond the frame size (such as when users 
resize their browser window) scroll bars will be displayed.



Enter the number of the FTP port you would like to publish to.    Tthe default is 21. 



When this option is selected, descriptive comments are added to the generated HTML ouput.    These comments aid in reading the 
HTML source.



Check/uncheck this box to enable/disable the generation of a data (.MCF) file for Apple’s HotSauce (previously known as Project X) 
site map format.



HIDC_ARCHIVE



Click on this button to define a new text variable when the User defined type is selected above. Opens the New Variable dialog, 
where you name and assign a value to a new variable.



HIDC_ARCHIVE_FORMAT



Enter a name for the new User defined variable here.



Enter a value for the new User defined variable here.



Enter an indent level for this style in the field, or use the spin buttons to adjust the level. Note: each indent level increment of 1.00 is 
equal to 40 pixels.



Displays the name of the currently selected anchor. If creating a new anchor, enter its name here.



Enter the number of directory levels you wish to limit this import to, or use the spin buttons to adjust the value.



Select the text alignment (Left, Center or Right) to be used for this style.



Click on this button to remove the currently selected anchor from the page.



Enter the maximum number of pages to import from the chosen site in this field, or use the spin buttons to adjust the value.



HIDC_SLURPHOMEPAGE



Adjust the height of the top margin. Enter or adjust the number in this field.



HIDC_SLURPMAXTIMEOUT



HIDC_TOP_MARGIN_SPIN



Click the up or down arrows to change the top margin width.



HIDC_SLURPLOCALPATH



Adjust the height of the bottom margin. Enter or adjust the number in this field.



Click the up or down arrows to change the bottom margin width.



Select this option to have the imported site converted to NetObjects Fusion format. When converted all text, links, pictures and other
objects within pages are brought into Page view, and can be modified as any NetObjects Fusion page layout. When this box is 
unchecked, each page is considered an external HTML file, which can only be edited with the HTML editor specified in Edit | 
Preferences.



HIDC_SLURPLOCALPATH2



Displays the currently selected unit of measurement used in determining margin size. The Measurement unit preference can be 
changed at any time (Edit menu, Preferences, Page tab).



Enter the local path and filename of the page to be imported as the root or Home page. The standard filename is index.html 
(browsers look for and automatically open files of this name when pointed to a folder).



Displays the currently selected unit of measurement used in determining margin size. The Measurement unit preference can be 
changed at any time (Edit menu, Preferences, Page tab).



Enter the domain name used by the local site or referenced HTML. NetObjects Fusion will define imported assets as internal or 
external based on the domain name entered here. For example, links which include this domain name in their URL will be 
considered internal.



HIDC_TEXT_PD_BROWSE



HIDC_SLURPIMPORTOPTIONS



Click on this button to open the Text Settings dialog, where you may modify the text settings for the current style element.



Opens the Custom Names dialog, where you can customize the title, button name, banner name and file extension for the current 
page.



HIDC_DONTSHOW



HIDC_TEXT_SELECTITEMS



HIDC_SLURPDIRBROWSE



Enter the correct file or folder name in this field. Click on the Browse button to open a standard Open dialog.



Click here open the Paragraph Style dialog, where you select or modify the current style’s attributes. You may also select and 
format text (using the options on this property palette) and reselect the style in the drop-down list. The Reapply Style dialog will 
open, which will allow you to redefine the style with the character formatting of the selected text.



Choose an application to use as an HTML editor, which will be invoked for external HTML objects and referenced HTML pages. 
Enter the filename and path here, or click on the Browse button to open a standard file Open dialog to browse for a program file 
(.exe).



Displays the current display setting for the selected navigation bar. Click on the Set button to open the Nav Bar Display dialog and 
adjust the current display setting.



Click on this button to open the Text Settings dialog, where you may modify the text settings for the current style element.



Click here to include a background sound for the current page. The Background Sound dialog will open, where you locate a sound 
file and set options for its playback.



If checked, limits the number of pages NetObjects Fusion imports from the chosen site. Enter or adjust the maximum number of 
pages in the number field.



Displays the missing file or folder name which is no longer properly associated to its file asset.



Open a standard file Open dialog where you may browse for a program file (.exe) to use as an HTML editor, which will be invoked 
for pages which you associate with external HTML files.



Click here to create a new Paragraph Style. The New Paragraph Style dialog opens, where you name your new style. To define its 
attributes, either click on the Edit button (which opens a separate Paragraph Style dialog) or select and format text (using the 
options on this property palette) and reselect the style in the drop-down list on the left. The Reapply Style dialog will open, which will
allow you to redefine the style with the character formatting of the selected text.



Enter a name for your form here. The form name is used primarily for advanced scripting.



If checked, limits the depth of directory levels NetObjects Fusion will import from the chosen site. Enter or adjust the number of 
levels in the number field.



Opens a standard Windows file Open dialog, where you may browse for files or folders.



Check this box to allow your margins to resize when objects are dragged beyond the edges of the current page margins. When 
objects are placed or pasted outside of the current margins, they will automatically resize. Also allows you resize margins by 
dragging margin borders. This option is disabled by default.



HIDC_SLURP_ANMCONTROL



Select this option to use the current SiteStyle for this navigation bar or banner. For navigation bars, select the button type, either 
primary or secondary (defined by the SiteStyle), from the Button type group above. This option has no effect on text navigation bars.



HIDC_SLURPIMPORT_REMOTE



Click on this button to skip this file or folder and continue verifying file assets.



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Select this option to choose a style different from the selected SiteStyle for use only with the selected banner. Select a different style
to use for the selected banner from the drop-down list. 



HIDC_SLURPIMPORT_LOCAL



Lists all found missing file or sub-folders which were previously found in the missing folder.



Opens the Background Sound dialog, where you enter a sound file for the current page.



Select a style to use for the selected banner. This affects the current banner only.



Enter the path and filename of a sound file to use as the background sound for this page (.au, .wav and .mid files are supported). 
Click on the Browse button to open a standard file Open dialog to browse for sound files.



Opens the Nav Bar Display dialog, where you choose which levels and pages the selected navigation bar will display. See help on 
options within the Nav Bar Display dialog for further help.



HIDC_EDIT_BG_LOOP



Enter HTML or other script text to be inserted between the opening and closing Head tags (if Layout, Master or Frame HTML), or 
before the selected object's definition tag (if Object HTML). Click on the Insert button to open a standard file Open dialog to insert a 
text file into this field.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



Check this box to have the selected background sound repeat continuously when site visitors browse to this page.



Enter the URL address of the remote site you wish to import.



Enter HTML or other script text to be inserted between the opening and closing Head tags (if Layout, Master or Frame HTML), or 
before the selected object's definition tag (if Object HTML). Click on the Insert button to open a standard file Open dialog to insert a 
text file into this field.



Displays the font chosen. To change the current font click on the Set… button to open a standard Font dialog.



Opens a standard file Open dialog to browse for sound files (.au, .wav and .mid files are supported), or directly enter the path and 
filename of a sound file to use as the background sound for this page in the field. 



Enter HTML or other script text to be inserted at the beginning of, but not inside, the Body tag (if Layout, Master or Frame HTML), or
after the selected object's definition tag (if Object HTML). Click on the Insert button to open a standard file Open dialog to insert a 
text file into this field.



Click this button to flip the selected banner 180 degrees. 



HIDC_STATIC_FONT2



HIDC_STATIC_COLOR_WELL



Enter HTML attributes to be inserted inside the Body tag (if Layout, Master or Frame HTML), or inside the selected object's definition
tag (if Object HTML). This text is inserted inside the tag itself, so only applicable HTML attributes for the Body or object definition tag
will work. Click on the Insert button to open a standard file Open dialog to insert a text file into this field.



Click this button to add all fields listed above to this data list.



Enter HTML attributes to be inserted inside the Body tag (if Layout, Master or Frame HTML), or inside the selected object's definition
tag (if Object HTML). This text is inserted inside the tag itself, so only applicable HTML attributes for the Body or object definition tag
will work. Click on the Insert button to open a standard file Open dialog to insert a text file into this field.



Click on this button to add a new Component to the list of available components. Opens a standard file Open dialog where you can 
select a .NFX or NetObjects Fusion Component file. 



Enter HTML or other script text to be inserted at the beginning of, but not inside, the Body tag (if Layout, Master or Frame HTML), or
after the selected object's definition tag (if Object HTML). Click on the Insert button to open a standard file Open dialog to insert a 
text file into this field.



Displays the color chosen for the text.



Click on the spin buttons to the right to rotate the selected picture in 90 degrees increments.



HIDC_SERVER_LIST



HIDC_CLEAR_FILTER



Opens the Insert Variable dialog, where you may enter Date and Time, Site or User-defined variables into the selected field (where 
the cursor is currently located). See help within the dialog for further information.



Displays a number indicating the order of frames selected with the icons above. This order determines which frames span the height
or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above. This order determines which frames span the height
or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above. This order determines which frames span the height
or width of the MasterBorder margin or end at another frame’s edge.



Displays a number indicating the order of frames selected with the icons above. This order determines which frames span the height
or width of the MasterBorder margin or end at another frame’s edge.



HIDC_TEXTFIELD_URL



HIDC_TEXTFIELD_TEXT



HIDC_TEXTFIELD_HTML



When this option is checked, HTML frame borders will be generated and displayed in web browsers.



HIDC_TEXTFIELD_DBOPTIONS



HIDC_RADIO_NOCONVERT



HIDC_INPUTPROMPT



HIDC_FILEASSETTAB



Opens a standard Windows file Open dialog to browse for the Home page of your local site or section.



Click to cancel your modification to the property or parameter selected below.



HIDC_HTMLTAG



Click this button to open an applicable dialog (such as a standard Open or Color Picker dialog) to edit the selected parameter.



Select this option to create a new site based on a remote web site. The Set Remote Import dialog will open if you choose to create a
new site in this manner. See help for options within that dialog.



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder size, in terms of 
the selected unit of measurement.



Use these spin buttons to adjust the the number of directory levels you wish to limit this import to.



Select from a drop-down list of available .class used by this Java applet or servlet. To add or delete .class files from this list click on 
the List button, which opens the Java Applet Files dialog. This dialog allows you to manage a list of Java files used by this applet or 
servlet. 



HIDR_LAYOUT_MENU



Click the up or down arrows to change the left margin height.



Displays the currently selected unit of measurement used in determining margin size. The Measurement unit preference can be 
changed at any time (Edit menu, Preferences, Page tab).



Adjust the width of the left margin. Enter or adjust the number in this field.



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Enter a custom title for the current or selected page. Site visitors will see this title in the titlebar of their browser when viewing this 
page. This overrides the default page title, which takes from the page name displayed in Page properties (which is used as the 
HTML filename).



Displays the total Width and Height for the current page, which includes the current layout size and MasterBorder size, in terms of 
the selected unit of measurement.



Select this option to create a new site based on a local copy of a pre-existing web site. The Set Local Import dialog will open if you 
choose to create a new site in this manner. See help for options within that dialog.



HIDC_BUTTON3



HIDC_BUTTON4



HIDR_SITESLURP_FILECOPY_AVI



Click on this button to remove a Java .class file from the list.



Applies strikeout formatting to the selected text.



Check this box to enable the generation of a data file for NetObjects Fusion’s Sitemapper component.



HIDC_INSERT_SCRIPT2



Click this button to open the Text in Element Settings dialog, where you can edit text and text attributes to be placed on the selected 
object. See help on options within the Text in Element Settings dialog.



HIDC_PICT_TEXT_ORIENTATION



HIDC_EDIT4



HIDC_EDIT5



Enter value(s) here.



Enter or edit the selected property in this field. Click the check icon to save your changes, or the X icon to cancel the adjustment. 



Displays the currently selected unit of measurement used in determining page size. The Measurement unit preference can be 
changed at any time (Edit menu, Preferences, Page tab).



Displays the currently selected unit of measurement used in determining page height and width. The Measurement unit preference 
can be changed at any time (Edit menu, Preferences, Page tab).



HIDC_SLURPTIMEOUT_CHECK



HIDC_TEXT_LOCK2



HIDC_FIELD_VAL



Enter a custom banner title for the current or selected page. This overrides the default banner title, which takes from the page name 
displayed in Page properties. This applies to all banners, whether placed in the MasterBorder or in the page layout.



HIDC_STATIC_TEXT_BOX2



Enter a custom navigation bar button name for the current or selected page. This overrides the default navigation bar button name, 
which takes from the page name displayed in Page properties. This custom name for this page will be used in all navigation bar 
buttons throughout your site.



HIDC_SITE_CUSTOM_VALUE



HIDC_SLURPCASEURLS_CHECK



Click the up or down arrows to change the right margin height.



Displays the currently selected unit of measurement used in determining margin size. The Measurement unit preference can be 
changed at any time (Edit menu, Preferences, Page tab).



HIDC_ANCHOR



HIDC_CURSOR2



Shows a list the available properties for various objects. Depending on which type of property is selected, you will either see a field 
or drop-down combo box at top, and (when applicable) a set of spin buttons or a square button to the right. Enter values directly into
the field, or choose a value from the drop-down list. The spin buttons allow you to adjust numerical values, while the square button 
will open an applicable standard dialog for the selected property. Click the checkmark icon to save your changes, or the X icon to 
cancel the current adjustment. 



Use this slider to to adjust the degree of text rotation. In Page view, the text is re-oriented directly on-screen. Choose undo from the 
Edit menu to undo any changes made in this dialog. The current level of text rotation is displayed to the right. If the Right angles 
check box is checked, text rotation will be constrained to 90 degree increments. 



HIDC_TEXTFIELD_HTMLFILE



Adjust the width of the right margin. Enter or adjust the number in this field.



Displays the current background sound file you have selected for this page.



 Enter a custom file extension to use for the current or selected page. This overrides the default extension, which is set in the 
Location Properties dialog (opened from the Server Locations tab in the Publish Setup dialog in Publish view). This custom 
extension will apply to the current page's filename only.



When this option is selected, neither the grid nor guides are displayed in Page view.



Displays the external HTML file you have chosen to replace the current page layout.



Use these spin buttons to adjust the indent level for this style, or enter a number directly into the field. Note: each indent level 
increment of 1.00 is equal to 40 pixels.



Use these spin buttons to adjust the maximum number of pages to import from the chosen site or directly enter a value into the field.



HIDC_SPIN



Enter a default page or layout width, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



HIDC_PICTURE_TEXT_CENTER



Opens a standard file Open dialog, where you select an HTML file to replace the current page layout.



HIDC_PICTURE_TEXT_RIGHT



Applies subscript formatting to the selected text.



Enter or modify the text you wish to place on the current selected object or element. Modify settings for the text in element with the 
options below.



Applies superscript formatting to the selected text.



HIDC_SPIN_BG_LOOP



Enter a default page or layout height, in pixels, to be used throughout the current site, or use the spin buttons to adjust.



Click on these spin buttons to rotate the selected picture in 90 degrees increments.



Displays the selected button text.



Select this option to create a new site from scratch. A blank site with one page will open in Site view.



Select this option to create a new site based on a NetObjects Fusion AutoSite template. Choose an AutoSite template from the drop-
down list (on the right).



Opens a standard Windows file Open dialog to let you browse for NetObjects Fusion template (.nft) files. Choose from predefined 
templates or from .nft files you've created (Page templates, for example, can be found in the NetObjects Fusion\Templates\Pages 
folder). 



Displays the template path and filename you wish to base this new site on. You may directly enter or modify the path and filename 
here. Click on the Browse button to open a standard Windows file Open dialog, which lets you browse for NetObjects Fusion 
template (.nft) files. Choose from predefined templates or from .nft files you've created (Page templates, for example, can be found 
in the NetObjects Fusion\Templates\Pages folder). 



Select this option to create a new site based on a NetObjects Fusion template (.nft) file. Click on the Browse button (to the right) to 
open a standard Windows file Open dialog, which lets you browse for template files, or directly enter the full path and name in the 
field. Choose from predefined templates or from .nft files you've created (Page templates, for example, can be found in the 
NetObjects Fusion\Templates\Pages folder). 



Choose an AutoSite template from this list to create a new site based on a NetObjects Fusion AutoSite template. AutoSites 
templates displayed here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\AutoSites folder.



Select this option to insert a section based on a NetObjects Fusion Page template into the current site as a child of the selected 
page (in Site view). Choose a Page template from the drop-down list on the right. Page templates displayed here are .nft 
(NetObjects Fusion template) files found in the NetObjects Fusion\Templates\Pages folder.



Select this option to insert a section based on a NetObjects Fusion template (.nft) file into the current site as a child of the selected 
page (in Site view). Click on the Browse button (to the right) to open a standard Windows file Open dialog, which lets you browse for
template files or directly enter the full path and name in the field. 



Displays the path and filename of the template to be inserted into the current site. You may directly enter or modify the path and 
filename here. Click on the Browse button to open a standard Windows file Open dialog, which lets you browse for NetObjects 
Fusion template (.nft) files. 



Opens a standard Windows file Open dialog to let you browse for NetObjects Fusion template (.nft) files. 



Choose a Page template from this list to create a new site based on a NetObjects Fusion Page template. Page templates displayed 
here are .nft (NetObjects Fusion template) files found in the NetObjects Fusion\Templates\Pages folder.



Select this option to insert a local copy of a pre-existing web site as a section into the current site (as a child of the selected page). 
The Set Local Import dialog will open if you choose to insert a section of this type. See help for options within that dialog.



Select this option to insert a remote web site as a section into the current site (as a child of the selected page). The Set Remote 
Import dialog will open if you choose to insert a section of this type. See help for options within that dialog.



Opens a standard Windows file Open dialog, where you may browse for a picture file to use for this style's background.



Positions text horizontally to the left within the element. Not to be confused with the Relative Alignment buttons (see help on Relative
Alignment buttons for further information).



Positions text horizontally to the center within the element. Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text horizontally to the right within the element. Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text vertically to the top within the element. Not to be confused with the Relative Alignment buttons (see help on Relative 
Alignment buttons for further information).



Positions text vertically to the center within the element. Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Positions text vertically to the bottom within the element. Not to be confused with the Relative Alignment buttons (see help on 
Relative Alignment buttons for further information).



Select this preference if you want NetObjects Fusion to open in a maximized window when launched.



Adjust the current value with these spin buttons.



Enter a value in pixels with which to inset the text within the current text box.



Displays a list of available Link Assets of the selected type. You can select a link from this list for the current selection.



Choose an internet protocol type from the drop-down list to use for this external URL. You may also type directly into this drop-down 
list. 



HIDC_EDIT_INLINE



HIDC_LOOKUP2



HIDC_LOOKUP1



Check this radio button to optimize NetObjects Fusion's HTML generation for Netscape browsers. Optimized WYSIWYG support 
displays your previewed or published site in Netscape as it appears within NetObjects Fusion.



Check this radio button to optimize NetObjects Fusion's HTML generation for Microsoft Internet Explorer. Optimized WYSIWYG 
support displays your previewed or published site in Internet Explorer as it appears within NetObjects Fusion.



Choose a language dictionary to use for spell checking from this drop-down list.



Select this option to disable the conversion of High ASCII characters to HTML character entities (also called escape sequences). 
High ASCII character set conversion is useful for languages which use double-byte character sets.



Use these spin buttons to adjust the value in pixels with which to inset the text within the current text box.



Click here to leave the word in the Not found box unchanged.



Click here to open the Spell Check Options dialog, where you specify the lanaguage and personal dictionary to use when checking 
spelling in NetObjects Fusion.



Words not found in the dictionary and personal dictionary file (selected in the Spell Check Options dialog) are displayed here. For 
more information, view help for each control within this dialog.



Suggested spellings for the word not found are displayed here. A suggested word spelling will appear in the Change to box. Choose 
another word from the list of suggestions to replace the current entry in the Change to box. For more information, view help for each 
control within this dialog.



Displays the personal dictionary file in use. Click the Browse button to locate a dictionary file (*.dic) or enter its path and name here.



Click here to change all instances of the word in the Not found box to the word in the Change to box.



Click here to leave all instances of the word in the Not found box unchanged during this spell check.



Click here to add the word in the Not found box to the personal dictionary selected in Spell Check Options.



Click here to change the word in the Not found box to the word in the Change to box.



Click here to display a list of proposed alternatives for the word in the Change to box.



Click on this button to open the Insert Variable dialog where you may specify a Variable to be inserted into the HTML source of the 
active text box (at the insertion point), along with any other HTML tags or scripts entered in this dialog.



Locks minimum height of current text box. Use this feature to maintain a fixed minimal height, even when the box contains little text. 
This is helpful in preserving layouts when a site visitor's browser font size is smaller than the default, or when designing layouts 
before all text is entered. 



Hold down this button to view a superimposed outline of the HTML tables which will be generated for the current layout (grid lines 
and object outlines will disappear while this button is pressed). The Table Structure options above provide a choice in the method of 
HTML table generation (view help for the Columns and Rows options). This feature is primarily for advanced users who wish to view
the HTML table structure which NetObjects Fusion will generate. For further information, see NetObjects Fusion Help.



Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion generate, hold down the Show button. For further information, see NetObjects Fusion Help.



Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion will generate, hold down the Show button on Layout properties General tab. For further information, see NetObjects Fusion 
Help (Help menu, Help Topics).



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current frame source. 
Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion will generate, hold down the Show button on the Layout Properties General tab. For further information, see NetObjects 
Fusion Help (Help menu, Help Topics).



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current frame source. 
Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion will generate, hold down the Show button on the Layout properties General tab. For further information, see NetObjects 
Fusion Help (Help menu, Help Topics).



Assigns completion status to a selected page. When the status is set to Done, a small checkmark appears in the upper right of a 
page icon indicating that the page is complete.    The designation is internal only, and is optional.



Assigns completion status to a selected page. When the status is set to Done, a small checkmark appears in the upper right of a 
page icon indicating that the page is complete.    The designation is internal only, and is optional.



HID_DEFINE_FORM



HIDC_CHECK_ASKBACKUP



Enter a name for the new MasterBorder in this field.



HID_CHECKINOUT



Adjust the left, top, right and bottom margins of this MasterBorder with the number fields.



HID_GOTO_OUTLINEWND



HIDC_DRAWOBJ_ALTTAG



HIDC_NEWSITE_OPENWEBSITE



HIDC_FUNC_LIST



HID_VIEW_LOCKGUIDES



HID_TEXTEDIT_SHORTCUT_COPYRIGHT



HIDC_TEXT_UNINDENT



HID_TB_NFX_IMAGEROLLOVER



HIDC_COLORPICKER_HEX



HID_DRAW_PLUGIN



Shows the color of the parent of the selected section. To change the color of all selected pages in the section, click the Color button.



HIDC_ACTIVE_MB



HIDC_NEWSITE_AUTOSITE



HIDC_NEWSITE_LOCAL



HID_TB_WHITEBOARD



HID_IMPORTSECTION



HIDC_NEWSITE_IMPORTWEBSITE



HID_TB_NFX_FORMTOOL



Enter a UNIX permission string as the default for this server location.



HID_REFRESH



HID_PUBLISH_ASSIGNLAYOUTS



Select this option to import the <HEAD> tag section of the referenced HTML. You can either append the imported page's <HEAD> 
tag to the current page's <HEAD> or replace the current pages' <HEAD> tag.    Select one of these options in the drop-down list.



If the Import <HEAD> option is checked, select from the two options in this drop-down list.    You can either append the imported 
page's <HEAD> tag to the current page's <HEAD> or replace the current pages' <HEAD> tag.



Opens the Reference HTML Page dialog, where you select and set options for the new external HTML file you want to use. See 
help within the dialog for more information.    



HID_INSERT_DRAWLINE



HIDC_R_VALUE



HIDC_SAVE_SITE_TO



HIDC_A_LOOP_CHECK



HID_TB_POLYGON



Enter the new name for the selected MasterBorder in this field.



HIDP_OLE_INIT_FAILED2



HIDP_OLE_INIT_FAILED3



HIDP_OLE_INIT_FAILED4



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current layout region. 
Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion will generate, hold down the Show button on the Layout Properties General tab. For further information, see NetObjects 
Fusion Help (Help menu, Help Topics).



HIDC_HTMLCODE



Date the file was last modified.



HID_INSERT_FORMTOOLCOMP



HIDC_SERVERCONNECTNAMETEXT



HIDC_PAGE_TEMPLATE_LISTBOX



HID_INSERTTEMPLATE



HIDC_CUSTOMSCRIPT



HID_DRAW_HOTSPOTS



HIDC_PREVIEWQUIT_ICON



HID_TEXT_LEFT



HIDC_PARAMETERS



HID_TEXTEDIT_SHORTCUT_REGISTERED



Sets the layout region background to a solid color.    Click the Color button to select a color from the Color Picker dialog.



HID_VIEW_SHOWSUBTOOL_PICTURE



Sizes the selected layout region to occupy the layout. The layout region will be sized to the layout until you deselect this option. 



Name of this server location.    This name is used only within NetObjects Fusion. 



HIDC_COMBO_BUTTONTYPE



HID_EDIT_T2HTML



HIDC_SERVER_PROTOCOL



HID_ACTION_FMTSTRING



HID_IMAGE_LOAD



HID_DRAW_TICKTAPE



HIDC_NEWSITE_BLANKSITE



HID_VIEW_SHOWOBJECTS2



HID_TEXT_CENTER



HID_VIEW_CONTRULER



HIDC_LOCATION_NEW_SITE_REMOTE



Click this button to remove the selected alias from the list.    Click Add to add a new alias or Edit to edit the selected alias.



HID_DRAW_ZOOM



HIDC_POS_GROUP



HIDC_DOANCHOR



HIDC_LAYOUTONLY



HIDC_LAYOUTVIEW



HID_EDIT_PROPERTIES



HIDC_NEWSITE_MU_OPENFROM



Modify the name of this action in this field.    The name is displayed in the Actions dialog and the Actions properties tab.    Naming 
actions descriptively will help you organize a complex series of actions.



HID_ADDSTYLETOLIST_REMOVESTYLEFROMLIST



File or folder name.



File asset type.



Click here to select a message to send to the target object from the pop-up menu.    Messages are the heart of actions; sending or 
receiving information or instructions to the target object. Your choices for action messages are numerous, and will vary depending 
on the target object. For example, if you target the Layout, context-specific menus such as Window and Browser will appear on the 
pop-up menu. Messages can be triggers that kick off actions when received by target objects.



Click on this button to select a trigger event from the pop-up menu. A trigger event can be user inputs such as Mouse Over, browser 
states such as page loaded or exiting, action completion messages, or custom messages sent from other objects.



HIDC_TREE_STYLES



HIDC_14



HIDC_28



HIDC_33



HIDC_56



HIDC_OK



HIDC_T1



HID_TB_ROUNDRECT



HIDC_WB_COLOR_BACKGR_SAMPLE



HID_POPUP_ASSETMENU



HIDC_BEAN



HIDC_HAND



HIDC_INIT



HIDC_ISDN



HIDC_LOAD



HIDC_SAVE



HIDC_SERVER_PORTNUM



HIDC_BROWSER_NAME



This option determines the generated HTML output of your site when previewed or published.    Select either Nested Tables, Regular
Tables or CSS and Layers from this drop-down list. A description of each option is displayed below when selected.



HIDC_PARM_LIST



Click this button to open the New Alias dialog, where you can add a new alias. See help within that dialog for more information. Click
Remove to remove the selected alias or Edit to edit the selected alias.



HIDC_TRANS_CURSOR



HIDC_REMOTE_LIST



HID_MENUITEM33003



HID_OBJECT_MOVEBACK



Choose an orientation for the selected banner or navigation bar, either horizontal or vertical.    When placing a banner or navigation 
bar, the dimensions of the initial bounding box determines whether it will be vertical or horizontal.



HID_VIEW_MULTIUSERPALETTE



HID_TB_FORMAREA



HID_TB_FORMEDIT



HIDC_COPYCURSOR



HID_FILE_BACKUP_ONSERVER



HID_TB_NFX_COMPONENTS



When this option is selected, NetObjects Fusion compacts the active site's database whenever you exit the application. The feature 
is enabled by default. The result of compaction is decreased .nod file sizes. It is recommended that this option be enabled.



HID_NOT_IMPLEMENTED



HID_TEXT_RIGHT



HIDC_L_VALUE



HID_TB_NFX_POPMENU



HIDC_PALETTE



HID_TB_HOTSPOTROUNDRECT



HID_KILL_IMAGETHREAD



HID_INSERT_ACTIVEX



Click this button to remove the custom image from the selected navigation bar or banner.



Publishing errors and warnings are displayed here.



HIDP_OLE_INIT_FAILED



HIDC_DEBUG_OUTPUT



HID_FILE_CONNECT_TO_SERVER



HID_TB_FORMCOMBO



Sets the layout region background to transparent.



HIDC_TEXT_BREAKLEFT



HID_DRAW_NAVIMAGE



This option is available when the Size to layout option is selected. Select this option to have the contents of the text box (which can 
include pictures and other objects) wrap to the browser width. In some cases, the HTML output of the page will be generated without
tables, which will result in text and objects wrapping to the width of the browser. When using the Nested or Regular Tables HTML 
output    (see Publish Setup in Publish view) with a MasterBorder composed of frames or set to ZeroMargins, for example, the 
contents of a text box sized to the layout will wrap to the browser’s width.



HID_TB_FORMRADIO



File icon.



HIDC_COMBOBOX_JBUILDER



HID_DRAW_NAVTEXT



Select this option to have this message broadcast to all children of the target.    For example, if a custom message is sent to a layout
region, and this option is enabled, all objects within the layout region will receive the custom message.    This can be very useful and
time-saving when creating complex dynamic pages.



HID_DRAW_COMPONENTS



HID_TB_NAVBAR



HID_FRAME_COMMENTS



A description of the option selected above is displayed here.    For more information about these options, see NetObjects Fusion 
Help.



HID_VIEW_SHOWSUBTOOL_NAV



HIDC_STATIC2



HID_DRAW_WHITEBOARD



HID_FILE_NEW_IMPORTEDSITE_ONSERVER



HIDC_REVERT



HIDC_COMBOBOX_SQL



HIDC_LAYOUT_CHECKIN



HIDC_A_EDIT_PLAYER



Click this button to delete the selected server location.    The location properties will be permanently deleted.



HIDC_MB_CHECKIN



HIDC_REFRESH



HIDC_MU_OPEN_HOSTS



HIDC_XFILE_FREESTANDING



HID_TB_SHOCKWAVE



This option determines the directory structure of your site when published.    Select either Flat, By Site Section or By Asset Type 
from this drop-down list. A description of each option is displayed below when selected.



Displays the external HTML filename.    Click the Browse button to open the Reference HTML Page dialog, where you can select a 
new external HTML file to reference.



HIDC_H_VALUE



HIDC_INITLABEL



HID_FILE_NEW_SITEFROMTEMPLATE_ONSERVER



HIDC_CHECKIN



Click this button to clear all manual customizations made to the directory structure.    The directory structure will reset to the selected
directory structure when you click the OK button.



HIDC_A_PICK_FILE



HIDC_SHOWME



HIDC_BUTTON_PALETTE



HIDC_CUSTOMICON



HIDC_SOURCE



HID_ADD_MESSAGE



Click here to edit the selected server location. The Location Properties dialog will open, where you can modify the server location 
properties.



HID_TB_ARROWLINE



HIDC_XFILE_REFRESH



HIDC_EDITLOCATIONS



HIDC_DRAWOBJ_URL



HIDC_NEW_WELCOME_EDIT



Displays a list of current aliases.    Click the Add button to add a new alias, Remove to remove the current selection or Edit to modify 
the selection.



HID_TB_PLUGIN



HID_FIND



HID_DEBUG_BEANS



HIDC_PALETTE2



HID_TEXTEDIT_SHORTCUT_TRADEMARK



Select this option to hide the selected object when the page is initially loaded. This is used by actions which dynamically hide and 
show objects on the page, including transitions.



Select the Applet option if the selected Java .class file is an applet.



Select the Servlet option if the selected Java .class file is an servlet.



HIDC_EDIT_PALETTE



HIDC_NEWSITE_ONSERVER_BROWSE



HID_INSERT_JAVA



HID_SIZEMBTOELEMENTS2



HIDC_SPIN_RECT_LENGTH



HID_LAUNCH_EDITOR



When checked, the directory location of this file has been manually changed from the default set in Publish Setup, Directory 
Structure tab.



HID_DRAW_QUICKTIME



Date this file was last published.



HID_INSERT_POPMENUCOMP



HIDC_DRAWOBJ_Y2_SPIN



HIDC_A_PLAYBACK_CHECK



HID_OBJECT_FILLCOLOR3



HIDC_A_PAUSE_CHECK



HIDC_IMAGE_TYPE_MESSAGE



HID_LAYOUT_SIZE



HID_INSERT_STYLELINE



HIDC_DRAWOBJ_X2



HIDC_DRAWOBJ_Y2



HID_INSERT_TICKERTAPE



HIDC_SECTIONDEPTH



HID_INSERT_ELLIPSE



HID_TB_NFX_SITEMAP



HID_TB_VERTBANNER



File creation date.



HID_INSERT_BANNER



HID_DRAW_FORMS



HID_DRAW_LINES



HIDC_LAYOUT_CHECKOUT



HIDC_A_STATIC_PLAYER



HIDC_EDIT_GREEN



HIDP_SOCKETS_INIT_FAILED



HID_DRAW_XFILE



HIDC_STATIC_LENGTH



HIDC_RADIO_ADVANCED



HIDC_WEIGHT



HIDC_SSITENAME



HIDC_X2_UNIT



HID_DRAW_SHOCKWAVE_AUDIO



HID_TB_FORMBUTTON



HID_TB_QUICKTIME



HID_DRAW_EXTERNAL_HTML



HID_DRAW_SHOCKWAVE_FLASH



HID_EMBED_ALIGN_BOTTOM



Specify a message to send to the target object. Click on the menu button to select from the pop-up menu. Messages are the heart of
actions; sending or receiving information or instructions to the target object. Your choices for action messages are numerous, and 
will vary depending on the target object. For example, if you target the Layout, context-specific menus such as Window and Browser
will appear on the pop-up menu. Messages can be triggers that kick off actions when received by target objects.



Click here to select the appropriate parameter for this message from the pop-up menu. Some actions require or accept additional 
parameters that control some aspect of their activity. In most cases, you can select from a list of predefined parameter values. 
Select Values from the menu to set detailed parameter values for selected message above. Select Expression from the menu to 
write or insert a JavaScript expression to generate or control the parameter values. Once you have selected or set the parameter 
value, the name of the value appears here. 



Specify the appropriate parameter for this message.    Click on the menu button to select from the pop-up menu. Some actions 
require or accept additional parameters that control some aspect of their activity. In most cases, you can select from a list of 
predefined parameter values. Select Values from the menu to set detailed parameter values for selected message above. Select 
Expression from the menu to write or insert a JavaScript expression to generate or control the parameter values. Once you have 
selected or set the parameter value, the name of the value appears here.



Specify the appropriate parameter for this message.    Click on the menu button to select from the pop-up menu. Some actions 
require or accept additional parameters that control some aspect of their activity. In most cases, you can select from a list of 
predefined parameter values. Select Values from the menu to set detailed parameter values for selected message above. Select 
Expression from the menu to write or insert a JavaScript expression to generate or control the parameter values. Once you have 
selected or set the parameter value, the name of the value appears here.



Select a target object for this action (the default target is the object you’re adding the action to).    Click on the ellipsis button on the 
right to select from the pop-up menu.



Check this option to script this action manually, without the using the context-sensitive pop-up menus.    The Action section of the 
dialog will change to a large edit field, where you can directly enter script text.    To insert a text script file, click the Insert Script 
button. To insert a call which returns an action’s value, click the Insert Action button.



Enter your scripted action directly into this edit field.    Click the Insert Script button to insert a text script file. To insert a call which 
returns an action’s value, click the Insert Action button.



Opens the Actions dialog, where you can select an action (from the current object’s action list) to insert into a scripted action. A call 
which returns an action’s value is inserted, in the form $(Action).



Select a parameter value from this drop-down list.



HIDC_B_VALUE



HIDC_DUMMY



HIDC_X_UNIT



Sizes the selected text box to occupy the layout. The text box will be sized to the layout until you disable this option.    When a text 
box is sized to the layout, the Contents wrap to browser width option is available. View help on that option for more information.



Specify the maximum number of backup files to be maintained in the location specified above.    When the maximum number is 
reached, the earliest backups are deleted.    Enter a number directly or click the spin buttons to change.    The maximum allowed 
number of backup files is 20, the default setting is 2.



HIDC_ICON1



HID_TOGGLESMALLFONTS



HIDC_LIST3



HID_SIZE_FROM_POSTER



Click this button to add a new server location.    The Location Properties dialog will open, where you name the server location and 
provide information for publishing.



HID_INSERT_DBLIST



HIDC_S_VALUE



HID_INSERT_COMPONENT



HID_DEBUG_FILEASSETS



HIDC_EDIT_RED



Select a target object for this action (the default target is the object you’re adding the action to).    Click on the ellipsis button on the 
right to select from the pop-up menu.



HID_OBJECT_MOVETOBACK



Opens the Color Picker dialog to let you set the page icons of all selected pages to one color. This overrides any previous color 
settings.



Opens the Picture File Open dialog, where you can select a new picture to use a background for this layout region.



HIDC_PPLIBVIEW



HIDC_Y_UNIT



HIDC_SPIN_COLOR



HID_FILE_NEW_ONSERVER



HID_SHOWGUIDES



A warning prompt or informational message is displayed here.



HID_LAUNCHFILE



HIDC_CHOOSE_BROWSER



HID_TB_VERTBAR



HIDC_A_SPIN_PRELOAD



HIDC_BEFORETAG



HID_FILE_NEW_IMPORTEDSITE



HID_FILE_INSERT_EXISTINGWEBSITE



HIDC_SERVER_EXTENSION



HIDC_MB_CHECKOUT



HIDC_STATIC_SECTION_COLOR_SAMPLE



HID_TB_ACTIVEX



Date this file was last locally published or staged.



HID_EXPORT_PAGE_LAYOUT



Enter the FTP path for the alias.    This is the actual location which the virtual folder or alias points to.



HID_TB_FORMCHECKBOX



HIDC_SIZE_GROUP



HIDC_INFO_COMPONENT



HID_STYLE_EDIT



HIDC_ERROR_ICON



HIDC_ERROR_TEXT



HID_VIEW_HIDEALL



Display the picture file in use as the background for this layout region.    Click the Browse button to select a new picture file.



HID_TB_NFX_TIMEBASEPIC



HID_SHOW_OBJECT



HIDC_TEXT_BREAKRIGHT



HIDP_BUSY



HID_NEW_FOLDER



HIDC_VR_STATIC



HID_INSERT_RECTANGLE



Displays all available MasterBorders for this site.    You cannot rename or delete the ZeroMargins MasterBorder. 



HIDC_MB_REVERT



HIDC_CENTERPAGE



HID_DRAW_DRAWTOOLS



HIDC_PICTURE_MOVEABLE



HIDC_ABOUTBOX_SERIAL



HIDC_CURRENT_COLOR



HID_IMPORT_PAGE_LAYOUT



HIDC_A_STATIC_TEXT



When this box is checked, NetObjects Fusion's Automatic backup feature is enabled. Customize your automatic backup settings 
with the various options found below (in the Backup Settings group box). See help for each option below for further information. 
Automatic backup is enabled by default.



Select this option if you do not want to see this message or prompt appear again.



HID_IMPORT_DOCUMENT



HIDC_RADIO_IMAGE



HID_DRAW_RICHMEDIA



HIDC_METAPHOR



HIDC_GOTOPAGE



When checked, this file cannot be customized.    Certain internal files may be marked as read-only to preserve their required relative 
positions.



HIDC_INSIDETAG



HID_ASSET_USAGE



HIDC_A_EDIT_PRELOAD



Select a target object for this action from the Object Tree window (which pops up when you click this button).



HIDC_STATIC_FILE



HID_INSERT_BBSCOMP



HIDC_AFTERTAG



HIDC_CHECKOUT



HID_TB_HOTSPOTRECT



When checked, indicates this file needs publishing.      This attribute is set if this file has changed since it was last published.    For 
example, generated HTML files need publishing because the contents of pages change.



HID_INSERT_DOCUMENT



Select this option to apply the clear right attribute to the closing line break for the selected paragraph (in HTML, <BR 
CLEAR=RIGHT>). This breaks the line, and adds space until you have a clear right edge free of pictures or other inserted objects. 
Select both left and right to apply the clear all attribute    



Select this option to apply the clear left attribute to the closing line break for the selected paragraph (in HTML, <BR 
CLEAR=LEFT>).    This breaks the line, and adds space until you have a clear left edge free of pictures or other inserted objects.    
Select both left and right to apply the clear all attribute    



HID_TB_NFX_PICLOADER



HIDC_NEWSITE_ONSERVER



HID_DRAW_STYLELINE



HID_TB_ZOOMIN



HIDC_SERVERCONNECTNAME



HID_TB_NFX_TICKTAPE



Click here to add a new MasterBorder. The New MasterBorder dialog will open, where you name the new MasterBorder and choose
a MasterBorder to base it from.    To begin with an empty MasterBorder, you can base the new MasterBorder on the default 
ZeroMargins MasterBorder.



HIDC_PAGE_FILE



HID_INSERT_POLYGON



Selects a picture to use as the background for this layout region.    Click the Browse button to locate a picture file.



HIDC_SECTIONDEPTH_STATIC



HIDC_A_PRELOAD_TEXT



HIDC_JBUILDER_IMAGE_PROPS



HID_FILE_OPEN_ONSERVER



HID_MASTER_COMMENTS



HID_VIEW_SHOWSUBTOOL_DATA



HID_VIEW_SHOWSUBTOOL_DRAW



HID_VIEW_SHOWSUBTOOL_FORM



HIDC_EDIT_RECT_LENGTH



HIDC_CONTONOFFORMAT



Select a default proportional font for this site from the drop-down list. Select a default proportional font size from the second drop-
down list.



Select a default fixed width (or monospaced) font for this site from the drop-down list. Select a default fixed width font size from the 
second drop-down list.



Select a size for the default proportional font. Select a default proportional font from the first drop-down list.



Select a size for the default fixed width font. Select a default fixed width font from the first drop-down list.



HID_TB_ELLIPSE



HIDC_BUTTON



HIDC_DRAWOBJ_X_SPIN



HID_TEXT_INSERTRULE



HID_TB_ZOOMOUT



HIDC_SELECTLOCAL



HIDC_CANCEL



HID_INSERT_SITEMAPPER



HID_INSERT_ROUNDRECT



Click this button to rename the selected MasterBorder from the Rename MasterBorder dialog. You cannot rename the ZeroMargins 
MasterBorder.



Click this button to delete the select MasterBorder.    You cannot delete the ZeroMargins MasterBorder.



HID_TB_STYLELINE



HIDC_CUSTOM



HIDC_DRAWOBJ_Y_SPIN



Select a color for the layout region background by clicking the Color button, which opens the Color Picker dialog.



Click here to open the Advanced Settings dialog, where you can configure settings such as server port, permissions and aliases.



HIDC_CHECKOUTTEXT



HIDC_NEWSITE_OPENMRU



HIDC_TOCCHECK



HIDC_XFILE_ENTIREPAGE



Displays an icon indicating warning, information or other message type.



HIDC_WARN_TEXT



HID_TB_NFX_BBS



Publish status.    This attribute can be set on a page level from the Page Properties tab.



Enter a relative URL path for the alias. The alias is a virtual folder which will point to the location set below. Note that this path is 
relative to the root directory of your published site and is not a full URL.



HIDC_RADIO_SITE



HIDC_EDIT_ALTTAG



Select a method of generating quote characters in text boxes. Select "Straight Quotes", “Curly Quotes” or    “Newspaper Quotes" 
from this drop-down list. 



Choose an orientation for the selected banner or navigation bar, either horizontal or vertical.    When placing a banner or navigation 
bar, the dimensions of the initial bounding box determines whether it will be vertical or horizontal.



Select a file naming convention from the drop-down list.    Choose from either dated backup files or sequentially numbered backup 
files.



Assigns one MasterBorder to all selected pages. Select the MasterBorder from the drop-down list. This overrides the MasterBorder 
settings for each page.    



HIDC_LAYOUT_REVERT



HID_VIEW_SHOWSUBTOOL_MEDIA



Select this option to require the displayed file to be published.    This overrides the Publish changed assets only option available from
the Publish dialog (which opens when you publish in Publish view).    Even when that option is selected, this file will be published 
regardless of whether it has changed or not.



HID_VIEW_SHOWSUBTOOL_START



HID_CELL_TYPE



HIDC_MBCOMBO



HID_TB_PICTURE



HIDC_NEWSITE_SAVESITEON



Lists available server locations.    Click the Add button to create a new server location.    Click the Edit button to edit the selected 
server location.    Click the Delete button to remove the selected server location.



Specify the maximum number of backup files to be maintained in the location specified above.    When the maximum number is 
reached, the earliest backups are deleted.    Enter a number directly or click the spin buttons to change.    The maximum allowed 
number of backup files is 20, the default setting is 2.



HIDC_G_VALUE



HIDC_ENTIREPAGE



HIDC_DEFAULT_MB



HID_TB_ISAM



HID_TB_JAVA



HID_TB_LINE



HID_TB_POLY



HID_TB_RECT



HID_TB_TEXT



HID_TB_BANNER



HID_TB_SELECTION



HIDC_SECTIONDEPTH_SPIN



HID_VIEW_SHOWSUBTOOL_ZOOM



Open a dialog which lets you set the start value of the bulleted list (such as A,B,C or 1,2,3) selected for the current paragraph. 
Although the dialog only accepts whole numbers, they will correspond to their alphabetical or roman equivalents.



HID_IMPORT_TEMPLATE



HID_TB_FORMMULTIEDIT



HIDC_PRINTLIST



HIDC_DRAWOBJ_LINK



Displays the Object ID for the selected object.    This ID is used in the Object Tree palette.    You may modify this ID at any time, and 
all current references to the previous Object ID will be updated automatically.



HID_TB_SOUND



HID_TB_START



HID_TB_TABLE



HID_TB_VIDEO



HID_TB_XFILE



HIDC_AUTOBACKUP



HID_VIEW_SHOWOBJECTS



HID_VIEW_COLLAPSED



HID_TB_NFX_ROTATINGPIC



Opens the Select Folder dialog, where you may select an alternative folder for your backup files.



HIDC_SERVERNAMETEXT



HID_DRAW_SITEMAP



HID_TB_BACKGROUNDPICKER



HID_DRAW_SHOCKWAVE_DIR



HIDC_GBTEXT



Select Overlapping Objects. Identifies overlapping objects by selecting them. A message box reporting the number of overlaps is 
displayed. You may then correct any overlap by deselecting and individually repositioning objects.



Specify the location you wish to keep your backup site files.    Click on Browse to browse for a new location.    The default backup 
location is a "Backups" folder found within the current site folder (User Sites\sitename\Backups).



HIDC_DRAWOBJ_X2_SPIN



HIDC_EVENT_NAME



HIDC_CHECK_SHOW_ME_NOT



HIDC_PROTOCOLTEXT



HIDC_PAGE_JBUILDER_HTML



HIDC_PAGE_JBUILDER_JAVA



HIDP_FAILED_TO_CREATE



These two Table Structure options affect the method by which NetObjects Fusion generates HTML for the current layout region. 
Browsers' font preferences will affect the appearance of layouts, and text boxes will grow or shrink vertically based on these 
settings. With Columns selected, the space between text boxes and the object(s) beneath it will be preserved by generating HTML 
tables with a preference for columns (the relative vertical position of objects will be preserved more than the relative horizontal 
position of objects). When Rows selected, the relative horizontal positions of text boxes and other objects will be preserved more 
than the relative vertical position of objects. The Columns option is selected by default. To view the HTML table structure NetObjects
Fusion will generate, hold down the Show button on the Layout Properties General tab. For further information, see NetObjects 
Fusion Help (Help menu, Help Topics).



HID_TB_DBLIST



HID_TB_DBFIELD



HID_DRAW_NAVELEMENT



HIDC_Y2_UNIT



HIDC_DRAWOBJ_X



HIDC_DRAWOBJ_Y



HIDC_A_EDIT_TEXT



HIDC_EDIT_BLUE



HIDC_EDIT_HTML



HIDC_EDIT_PARM



Specify a message to send to the target object. Click on the menu button to select from the pop-up menu. Messages are the heart of
actions; sending or receiving information or instructions to the target object. Your choices for action messages are numerous, and 
will vary depending on the target object. For example, if you target the Layout, context-specific menus such as Window and Browser
will appear on the pop-up menu. Messages can be triggers that kick off actions when received by target objects. (In the JavaScript 
Expression dialog, enter your script in this edit field. In the Add Message dialog, name the new custom message in this edit field.)



Select a trigger event for this action. A trigger event can be user inputs such as Mouse Over, browser states such as page loaded or 
exiting, action completion messages, or custom messages sent from other objects.    Click on the menu button on the right to select 
from the pop-up menu.



Click this button to edit the selected HTML file in an HTML editor.    The HTML editor which is launched is set in Preferences, 
General tab (Edit menu, Preferences).    You can also double-click on the external HTML object to edit the file.



Click this button to open the Edit Alias dialog, where you can edit the selected alias.    Click Add to add a new alias or Remove to 
remove the selected alias from the list.



HIDC_METHODS



Select options below.    See help on each option below for more information.



If checked, NetObjects Fusion does not move or manage the assets of referenced HTML pages.



Enter the domain name used by the local site or referenced HTML. NetObjects Fusion will define imported assets as internal or 
external based on the domain name entered here. For example, links which include this domain name in their URL will be 
considered internal.



Enter the domain name used by the local site or referenced HTML. NetObjects Fusion will define imported assets as internal or 
external based on the domain name entered here. For example, links which include this domain name in their URL will be 
considered internal.



Assign completion status to all selected pages. When the status is set to Done, small checkmarks appear in the upper right of each 
page icon indicating that the pages are complete.    The designation is internal only, and is optional. 



Assign completion status to all selected pages. Small checkmarks appear in the upper right of each page icon indicating that the 
pages are complete.    The designation is internal only, and is optional.



Selects whether all selected pages are published or not. To exclude the selected pages from the published site, select the Don't 
Publish option. To include all selected pages, select the Publish option. A red dot appears in the upper right of each page icon when 
the Don't Publish option is set.



Selects whether the selected page is included in the published site. By default all pages are published. To exclude the selected 
page, select the Don't Publish option. To include an excluded page, select the Publish option. A red dot appears in the upper right of 
each page icon when the Don't Publish option is set.



Shows the color of the parent of the selected section. To change the color of all selected pages in the section, click the Color button.



Click here to find the next instance of the text you want to find.



Enter the text you want to find here.



Enter the text you want to replace the found text with.



Select this option to the match the exact case of the text you want to find.



Select this option to the match only the entire word entered above.    All instances of the text found inside larger words will be 
ignored.



Click here to replace all instances of the found text with the replacement text.



Click here to replace the current selected text with the replacement text.



Select a HTML output type for the current page or layout region from the drop-down list.    If the default Publish Setting is selected, 
the HTML Output option found in the Publish Setup in Publish view is used.    In that dialog box you’ll also find a description of each 
HTML output method (click the Setup button and go to the HTML Output tab).    For a Layout Region, the Parent Setting choice will 
base the HTML Output on the parent Layout or Layout Region’s setting. 



Select this option to designate the current selection as a form.    A Layout, Layout Region, Table or Text Box can be made into a 
form. Click the Settings button to configure the form.    



Select this option to view rulers and guides.



Select this option to view the grid.    To configure the grid, adjust the Width and Height fields.



Select this option to display small text labels and dividing lines for page areas such as the Layout and MasterBorder. This option is 
also available from the View menu.



Select this option to have objects snap to the guides you've placed on the page..



Select this option to view outlines around each object placed on your page. This option is also available from the View menu.



When selected, small icons representing links, anchors, HTML scripts, HTML tags (found within text boxes), actions and error 
conditions are displayed on objects. This option is also found on the View menu.



When selected, objects will snap to the grid. Grid settings can be modified on this tab or in the Preferences dialog (Page tab). This 
option is also found on the View menu.



When selected, an objects positioned near enough to another will snap to the adjacent object.



Adjust the width of the grid blocks.



Displays the currently selected unit of measurement used in determining the width of each grid block. You can change the unit used 
by choosing another Measurement Unit from the list above.



Click the up or down arrows to change the grid block height.



Adjust the height of the grid blocks.



Displays the currently selected unit of measurement used in determining the height of each grid block. You can change the unit used
by choosing another Measurement Unit from the list above.



Opens the Insert HTML dialog, where you can insert tags and fields, including user-defined variables, into the HTML of the text, at 
the insertion point.    The inserted HTML will be generated within the text at the selected point.



Select a publish location to publish this site to. To edit properties of the publish location selected from this drop-down list, click the 
Edit button. To add a new publish location, go to Publish Setup, Server Locations tab.    If you haven’t published before, you will 
need to set up publish locations and options from the Publish Setup dialog.



Select a publish location to publish this site to. To edit properties of the publish location selected from this drop-down list, click the 
Edit button. To add a new publish location, go to Publish Setup, Server Locations tab.    If you haven’t published before, you will 
need to set up publish locations and options from the Publish Setup dialog.



Click here to edit properties of the publish location selected from the drop-down list,. To add a new publish location, go to Publish 
Setup, Server Locations tab.    



Select this option to to re-publish only those assets which have changed since your last publish. This does not impact your site’s 
pages, which are always regenerated and reloaded when you publish your site. Note: NetObjects Fusion does not query the server 
to see if it has all the unchanged assets needed by the site. If you publish changed assets only, be sure you publish to the same 
location as you did previously, so unchanged assets are still available.



Select this option to create a layout region to use as a form container. Form objects must be placed within form containers (the 
Forms toolbar will display after your form area is created) You can also make any existing layout region, text box, table or layout a 
form container.    You can use layout regions, text boxes and tables as form containers to create multiple forms on a page.



Select this option to create a text box which is a form container. Form objects must be placed within form containers (the Forms 
toolbar will display after your form area is created) You can also make any existing layout region, text box, table or layout a form 
container.    You can use layout regions, text boxes and tables as form containers to create multiple forms on a page.



Select this option to create a table which is a form container. Form objects must be placed within form containers (the Forms toolbar 
will display after your form area is created) You can also make any existing layout region, text box, table or layout a form container.   
You can use layout regions, text boxes and tables as form containers to create multiple forms on a page.



Select this option to define the layout itself as a form container. Form objects must be placed within form containers (the Forms 
toolbar will display after your form area is created) You can also make any existing layout region, text box, table a form container.    
When the layout is defined as a form, you cannot have multiple forms on the page. You can use layout regions, text boxes and 
tables as form containers to create multiple forms on a page.



HIDC_CREATELAYOUT_STATIC



Select this preference to have NetObjects Fusion open the most recently used file each time you launch the application.    If this 
preference is unselected, the Welcome dialog will appear each time you launch NetObjects Fusion.



Select this preference to use small fonts in the properties palettes.    The palette itself will be smaller in size. This can be very useful 
if you’re concerned about conserving screen space. 



New Blank Site.  Opens the New Blank Site dialog.    Enter a name for the new site file and select a file location.    A folder 
containing the new site will be created in the selected location, by default the NetObjects Fusion User Sites folder. The site folder 
consists of the site file (yoursitename.nod) and an Assets folder.



New Site from Template.    Opens the Select a Template File dialog.    Locate a NetObjects Fusion Template File (.nft file) to base 
your new site on. NetObjects Fusion offers excellent Page, Form and Site Templates (or AutoSites), found in the installed Templates 
folder.    You may export any site as a template (see Export Site on the File menu).



New Site from Local Import.    Opens the Import Local Web Site dialog. A new NetObjects Fusion site is created from any site 
found on your local computer or local network (sites viewed as a file location in your browser).    To base a site on a Web site with a 
URL, use Remote Import. View help within the dialog for information on further options.



New Site from Remote Import.    Opens the Import Remote Web Site dialog. A new NetObjects Fusion site is based from any 
external site with a URL. To create a new NetObjects Fusion site from a local site (sites viewed as a file location in your browser), 
use Local Import. View help within the dialog for information on further options.



Open Site.    Locate the site you want to open from the Open dialog, and click Open. The active site will close and the selected site 
will open.



Save Site. Saves the current site to disk.



Save Site As. Opens the Save Site As dialog.    Enter a name and browse for a location for a new copy of the current site. The 
current site will close and the new copy will open. You proceed to work on the copy, and the original site will be untouched.



Import Local Web Site.



Import Remote Web Site.



Import Template.



Import HTML Page Imports an existing HTML document (*.htm or *.html file) into the layout. The HTML page you select from the 
standard Open dialog will be imported with all of its referenced assets as internal collection of new objects.This command cannot be
undone..



Reference HTML Page.



Export Site. Opens the Select Folder dialog which lets you save the current NetObjects Fusion web site as a template (.nft) file so 
that it can be imported into another NetObjects Fusion web site (necessary when developing across platforms).



Print Setup.  Open the standard Windows Print Setup dialog, with the addition of a Print to fit checkbox option.



Print Preview. Displays a preview of the printed Site Structure. The Site view will be replaced with the standard Print Preview 
controls, which include Zoom In and Out, Print and other buttons.



Print.  Open the standard Windows Print dialog, with the addition of a Print to file checkbox option.



Properties.



Exit.



Undo. Undoes the last command or action (displayed with the menu item) to the previous state. Multiple levels are possible. 



Redo. Redoes the previously undone action or command, which is displayed with the menu item. 



Cut. Cuts the selected object from the page and places it on the Windows clipboard. The object is then available for pasting to the 
same page or another page in your site until it is replaced on the clipboard by another Cut or Copy operation.



Copy. Copies the selected object and places it on the Windows clipboard. The object is then available for pasting to the same page 
or another page in your site until it is replaced on the clipboard by another Copy or Cut operation.



Paste. Pastes the contents of the Windows clipboard onto the current page.



Delete (object). Lets you delete an object from your site. What gets deleted depends on which view you're in:
Delete Page. Removes the selected page or pages from the site structure when in Site view.
Delete Object. Removes the selected object or objects from the page when in Page view.
Delete File Asset. Removed the selected file when in File Assets view.
Delete Link. Removes the selected link when in Link Assets view.
Delete Data Object. Removes the selected data object when in Assets Data Object view.
Delete Variable. Removes the selected user-defined variable when in Assets Variable view.



Select Section.



Select All. Selects all objects in the header, body, or footer of a page in Page view.



Select Next Object.



Select Previous Object



Select Layout



Select MasterBorder



Select Page



New (object). Lets you add a new object to your site. What gets added depends on which view you're in:
New Page. Lets you add a new page to your site when you're in Site or Page view.
New Style. Lets you create a new style when you're in Style view.
New File Asset. Lets you import a new external file such as a picture or a Java applet, when you're in File Assets view.
New Link. Lets you add a new external link when you're in Link Assets view.
New Data Object. Lets you create a new data object when you're in Data Object Assets view.
New Variable. Lets you add or create a new variable when you're in Variable Assets view.



Custom Names.



Find. Searches for specified text on a page.



Replace. Searches for and replaces specified text or formatting in the active document.



Spell Check. Choose this option to check the spelling of text within text objects on the current page. 



Word Count. Counts words, lines, paragraphs and characters within a single text box or on the whole page.



Preferences. Opens the Preferences dialog which has two tabs, General and Page. General preferences include selecting a default
browser and external HTML editor; Page preferences include setting the default page size and other page-level options.



Properties Palette. Toggles between viewing and hiding the floating Properties palette box.



Standard Tools. Toggles between viewing and hiding the floating Tools Palette.



Advanced Tools.



Component Tools.



Form Tools.



Object Tree.



MasterBorder. Choose this option to display the current Layout without displaying the MasterBorder. 



Page Labels. Select this option to display small text labels and dividing lines for page areas such as the Layout and MasterBorder. 
This option is also found on the View properties tab.



Object Outlines. Select this option to view outlines around each object placed on your page. This option is also found on the View 
properties tab.



Object Icons. When selected, small icons representing links, anchors, HTML scripts, HTML tags (found within text boxes), actions 
and error conditions are displayed on objects. This option is also found on the View properties tab.



Rulers & Guides.



Grid.



Snap to Guides.



Snap to Grid.



Snap to Object Outlines.



Page View Options.



Zoom 25%.



Zoom 50%.



Zoom 75%.



Zoom 125%.



Zoom 150%.



Zoom 200%.



Zoom 100%.



Site. Takes you to the Site view where you build, organize and edit the structure of your site. As you drag pages and sections to new
locations in your site, NetObjects Fusion updates all the links automatically.



Outline View. 



Files. Shows you a list of files (such as pictures, audio, video, external HTML documents, Java applets, etc.) that are associated 
with your site. You can use the list to manage these files and their associations.



Links. Shows you a list of page, smart, and external links that are associated with your site, as well as the page or pages on which 
each link appears.



Data Objects. Shows you a list of data objects that are associated with your site. Data objects define data-based information from 
either internal or external sources You can use the list to remove the data object from your site or edit the data object definition.



Variables. Shows you a list of User defined text variables that are used within your site, as well as the page or pages on which each
variable appears.



Page. Takes you to the Page view where you lay out your pages and add content. Content includes: text, pictures, drawn shapes, 
tables, sound, video, Java applets, Active X controls, Shockwave files, data-based information and form objects.



Style. Takes you to the Style view where you create, manage and browse the SiteStyles available for use within your site.



Style. Takes you to the Style view where you have centralized control over the look and feel of your site.



Assets. Takes you to the Assets view that lists all the files, links, data objects and variables that are associated with your site. This 
view allows for site-wide asset management.



Publish. Takes you to the Publish view where you configure your settings for staging or publishing your site to a local or remote web
server.



Next Page. Takes you to the page that appears to the right of the current page (on the same level) in the graphical site view.



Previous Page. Takes you to the page that appears to the left of the current page (on the same level) in the graphical site view.



Parent. Takes you to the page that appears above the current page in the graphical site view.



First Child. Takes you to the page that appears below the current page (the next child level) in the graphical site view.



Follow Link. Goes to the destination of the selected object's internal or structural link.



Go To. Opens a dialog that lets you perform a keyword search for items within the current view, such as an individual page in Site 
view or SiteStyles in Style view.



Last. Lets you toggle between the current view and the last one that was displayed.



Recent. Opens a scrollable selection list of views and pages that have been displayed during the current NetObjects Fusion 
session.



Preview. Creates HTML files and auto-generated images for every page in your site and places them in a Preview folder on your 
hard disk. Also opens your default browser to let you view either the entire site or the current page.



Align Objects Left. When more than one object is selected, this command aligns the objects to the left edge of the left-most object 
selected. For example, if you select two objects and then align left, the object on the right will be repositioned so its left edge is 
aligned with the left object's left edge.



Align Objects Right. When more than one object is selected, this command aligns the objects to the right edge of the right-most 
object selected. For example, if you select two objects and then align right, the object on the left will be repositioned so its right edge
is aligned with the right object's right edge.



Align Objects Top. When more than one object is selected, this command aligns the objects to the top edge of the top-most object 
selected. For example, if you select two objects and then align top, the bottom object will be repositioned so its bottom edge is 
aligned with top object's top edge.



Align Objects Bottom. When more than one object is selected, this command aligns the objects to the top edge of the bottom-most
object selected. For example, if you select two objects and then align bottom, the top object will be repositioned so its top edge is 
aligned with bottom object's bottom edge.



Align Objects Vertical Center. When more than one object is selected, this command centers the objects to the vertical center 
position between all selected objects.



Align Objects Horizontal Center. When more than one object is selected, this command centers the objects to the horizontal 
center position between all selected objects. 



Distribute Objects Vertically. When more than one object is selected, evenly distributes all selected objects vertically.



Distribute Objects Horizontally. When more than one object is selected, evenly distributes all selected objects horizontally.



Arrange Objects Bring to Front.



Arrange Objects Bring Forward.



Arrange Objects Send to Back.



Arrange Objects Send Backward.



Size Objects Width. If more than one object is selected, this command resizes the objects to match the width of the last object 
selected. For example, if you select three objects and then choose this item, the first two objects selected are resized (equidistant 
from the outer edges inward) to match the width of the third object.



Size Objects Height. If more than one object is selected, this command resizes the objects to match the height of the last object 
selected. For example, if you select three objects and then choose this item, the first two objects selected are resized (equidistant 
from the top and bottom edges inward) to match the height of the third object.



Size Layout to Objects. Choose this option to resize the current Layout to fit the objects within it. The layout is sized to the 
minimum height and width which accommodates all objects within it. When objects in the MasterBorder extend past objects in the 
Layout, the layout will be constrained to the minimum acceptable size.



Size MasterBorder to Objects. Choose this option to resize the current MasterBorder to fit the objects within it. The MasterBorder 
is sized to the minimum height and width which accommodates all objects within it.    When objects in the Layout extend past objects
in the MasterBorder, the MasterBorder will be constrained to the minimum acceptable size (this doesn’t apply to frames). Also 
remember when adjusting a MasterBorder that it may be shared by other pages.



Restore Original Size. Choose this option to resize the bounding box of the current image to fit the picture exactly. Regardless of 
the current size of the picture bounding box, it will reset to the picture's original dimensions.



Object Object.



Add Row.



Remove Row.



Add Column.



Remove Column.



Hide/Show Objects.



Show All Objects.



Link.



Anchor.



HTML.



Edit Text.



Show Text Invisibles.



Edit Text Styles.



Insert Picture.



Insert Layout Region.



Insert HR Rule.



Insert Text Object.



Insert Table.



Insert Navigation Bar.



Insert External HTML.



Insert Plug-In.



Insert Shockwave.



Insert QuickTime.



Insert Video.



Insert Sound.



Insert HTML. Opens the Insert HTML Tag dialog where you may specify HTML tags or scripts to be inserted into the HTML source 
for the active text box, at the insertion point. A small T icon will appear in the text box where the HTML was inserted if the Show links
and anchors option is checked in the View properties palette.



Insert Symbol. Provides a dialog for you to select ASCII characters (such as © or ™) from a list and insert them into the selected 
text box.



Insert Field.. Opens the Insert Field dialog where you may specify a field (either Date and Time, Site and General) or User defined 
variable to be inserted into the selected text box, at the insertion point. The variable will appear gray within your text box. 



Remove Style from List.



Add Style to List. 



Update Styles List. Updates your SiteStyle list (Style Gallery in Style view) by importing all styles found in your NetObjects Fusion\
Styles folder and removing all those not found. Styles found in the Styles folder but not found on your Styles list are imported, and 
styles found on your Styles list but not found in your Styles folder are removed from the list. 



Set Style. Applies the selected style to the current site.



Delete All Unused File Assets. Scans and deletes all unused file assets found in the File Assets view.



Verify All File Assets. Scans the File Assets view to verify which files are used in the current site, and whether any files in use have
incorrect path information. The Verifying Files (or Folders) Used by File Assets dialog opens if NetObjects Fusion finds any missing 
files. See further help within that dialog.
Verify All Links. Verifies that all external links in Link Assets view are up to date and working properly (internally links are 
dynamically updated). This action may take some time, depending on the number of external links and the speed of your internet 
connection. The status of the URL is displayed in the Verify Status column.



Publish Setup. Opens a dialog that allows for configuring your settings for local or remote staging or publishing. Also allows for 
choosing modifiers: text only, greyscale, and low-bandwidth versions.



New Folder (unused).



Delete Folder.



Rename Folder.



Publish Site. Publishes your final site by writing HTML, assets and other files to your hard disk or a web server.



Help Topics. Opens the NetObjects Fusion Help system. The Help window opens to the Contents tab, where you select a help topic
to be displayed. Use the Index or Find tab to search the help system for specific keywords or text.



NetObjects Fusion Web Site



Register NetObjects Fusion.



About NetObjects Fusion.



Launches a standard Open dialog to let you locate a local file for your file link.



Selecting a frame on this page from the drop-down list will target this link to open within the selected frame. 



Selecting a frame on this page from the drop-down list will target this link to open within the selected frame.



When a link is selected, opens the Object HTML dialog to let you enter or insert HTML or scripts directly into the link and object 
HTML.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the top of the object to the top of the text.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the center of the object to the bottom of the text.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the bottom of the object to the bottom of the text.



HIDC_EMBED_ALIGN_NOWRAP



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the left. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the center. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the right. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the left, 
wrapping text to the right of the object. 



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the right, 
wrapping text to the left of the object. 



Use this option to adjust equal space around the selected object.    This option is available only when left, center or right alignment is
selected above, when text does not wrap around the object.



Use this option to adjust equal space around the selected object.    This option is available only when left, center or right alignment is
selected above, when text does not wrap around the object.



Use this option to adjust equal space around the selected object.    This option is available only when left, center or right alignment is
selected above, when text does not wrap around the object.



Use this option to adjust the horizontal space between the selected object and the wrapped text.    



Use this option to adjust the horizontal space between the selected object and the wrapped text.    



Use this option to adjust the horizontal space between the selected object and the wrapped text.    



Use this option to adjust the vertical space between the selected object and the wrapped text.    



Use this option to adjust the vertical space between the selected object and the wrapped text.    



Use this option to adjust the vertical space between the selected object and the wrapped text.    



When this option is selected, the picture is displayed with the original dimensions of the source file. You can reduce (but not enlarge)
the dimensions of the picture using the sizing handles.    



When this option is selected, the selected picture can be stretched to any dimension.    Picture effects are do not Though the pThe 
original graphic file is not altered.    NetObjects Fusion generates its image files when previewing or publishing with the altered 
picture.    Text effects include



If the selected picture container is enlarged beyond the size of the graphic it contains, this option creates multiple images of the 
graphic and tiles the images to fill the container.



Click on this icon to change your pointer into an eyedropper, used to select a transparency color from the selected GIF picture.    
Click on a color from the picture to select the new transparency color.    After you select a color, your pointer will return and the Use 
color option will be checked automatically (if not already).



Select this option to use the displayed color as the transparency color for the selected GIF picture.    To select a transparency color 
from the picture itself, click on the eyedropper tool to change your pointer into an eyedropper. If you select a color with the 
eyedropper, this option will be checked automatically if it is not already. 



Adjust the thickness of the selected picture’s border with these spin buttons.



Adjust the thickness of the selected picture’s border with these spin buttons.



Click on these spin buttons to adjust the thickness of the border for the selected picture.



Opens the Picture File Open dialog to let you locate a picture file.



When this option is selected, the selected plug-in file or QuickTime movie will be displayed inline, at the current page position.    



When this option is selected, a picture is displayed to represent this plug-in file or QuickTime movie.    When the picture is clicked in 
the browser, the plug-in file or QuickTime movie will open by itself in the window.    Click Browse to select a custom picture.



When this option is selected, a picture is displayed to represent this plug-in file or QuickTime movie.    When the picture is clicked in 
the browser, the plug-in file or QuickTime movie will open by itself in the window.    Click Browse to select a custom picture.



Enter a value for the parameter named above.This value will vary in type depending on the parameter.



Add the parameter name here.    Make sure that this name corresponds exactly to the intended parameter name used by the plug-in.



Adjust the thickness of the border. 



Adjust the thickness of the border. 



When this option is selected, the default shaded attribute is used for this Horizontal Rule. The option is selected by default. When 
not selected, the NOSHADE attribute is applied to the horizontal rule, which results in a solid rather than embossed appearance.



Displays a list of all available styles for this site.    To add a new style click the New button.    To modify a style, select a style from this
list and click the Change button.    To delete the selected style from your site, click the Delete button.



Displays a preview of the style selected from the list.    A text sample is displayed with the attributes of the selected style.



Displays the selected style’s properties.    The descriptive names represent the style, paragraph and font settings for the style.



Click this button to add a new style to your site.    To modify a style, select a style from this list and click the Change button. 



Click this button to modify the style selected from the list. To add a new style click the New button.



Click this button to delete the selected style from your site.



Enter a name for your new text style here.    You cannot edit this name after the style is created.



Select a text style to base the current style on (if any). The based on style defines the current style’s default attributes. When this 
based on style selection is changed, any unspecified attributes default to the new selection’s attributes.



The style selected on this drop-down list will always follow a paragraph of the current style (as text is entered within the application). 
You must select a style from the list (it is set to the current style by default). You can use this option, for example, to have a 
subheading paragraph automatically follow a heading paragraph each time you enter heading and subheading text in NetObjects 
Fusion.



Displays a preview of the style selected from the list.    A text sample is displayed with the attributes of the selected style.



Displays the selected style’s properties.    The descriptive names represent the style, paragraph and font settings for the style.



Click here to open the Paragraph dialog, where you can modify paragraph attributes for the current text style.



Click here to open the Font dialog, where you can modify font attributes for the current text style.



Specify the number of units you want to indent the paragraph.



Specify the number of units you want to indent the paragraph.



Specify a bullet type from this list for the current text style.    To remove all bullets from the text style, select None from the list.



Select a paragraph alignment for this text style.    Select this option to set paragraph alignment to left.



Select a paragraph alignment for this text style.    Select this option to set paragraph alignment to center.



Select a paragraph alignment for this text style.    Select this option to set paragraph alignment to right.



HIDC_TEXT_CSS_PARA_MARGINS_L_SPIN



HIDC_TEXT_CSS_PARA_MARGINS_R_SPIN



HIDC_TEXT_CSS_PARA_BEFORE_CHECK



HIDC_TEXT_CSS_PARA_BEFORE



HIDC_TEXT_CSS_PARA_BEFORE_SPIN



HIDC_TEXT_CSS_PARA_LINE_CHECK



HIDC_TEXT_CSS_PARA_LINE



HIDC_TEXT_CSS_PARA_LINE_SPIN



HIDC_TEXT_CSS_PARA_AFTER_CHECK



HIDC_TEXT_CSS_PARA_AFTER



HIDC_TEXT_CSS_PARA_AFTER_SPIN



HIDC_TEXT_CSS_PARA_ALIGN



HIDC_TEXT_CSS_PARA_MARGINS_L



HIDC_TEXT_CSS_PARA_MARGINS_R



Select a font for this text style from this combo box. A text sample is displayed below.



Select an available font style for this font from this combo box. A preview is displayed below.



Select a font size for the text style from this combo box. A preview is displayed below.



Select this option to apply the superscript attribute to the font for this text style. A text sample is displayed below.



Select this option to apply the subscript attribute to the font for this text style. A text sample is displayed below.



Select this option to apply the strikethough attribute to the font for this text style. A text sample is displayed below.



Select this option to apply underlining to the font for this text style.    A text sample is displayed below.



Select this option to apply the text color defined by the SiteStyle (in Style view).    A preview is displayed below.



Select this option to choose a color for this font. Click the Color button to select a color.



Opens the Color Picker dialog where you can select a color to use for this text style. A preview is displayed below.



Opens the Color Picker dialog where you can select a color to use for this text style. A preview is displayed below.



Displays a text sample preview of the selected font attributes.    



HIDC_TEXT_CSS_FONT_BOLD



HIDC_TEXT_CSS_FONT_ITALIC



HIDC_TEXT_CSS_FONT_SMALLCAPS



HIDC_TEXT_CSS_FONT_PERCENT



HIDC_TEXT_CSS_FONT_ALLCAPS



When the loop option is selected for this QuickTime movie, select this option to set this QuickTime movie to play in reverse (from 
end to beginning) after the movie plays from beginning to end, in a continuous loop.



Adjust the initial volume setting for this QuickTime movie. You can enter a number from 0 to 256.



Select this option to set this QuickTime movie to replay each time it ends.



HIDC_QT_STATIC



HIDC_QT_URL_LINK



Select this option if you don’t want to show the QuickTime movie, but want to use it only as background sound.



Select this option to display the QuickTime control strip for this QuickTime movie



HIDC_QTVR_OPTIONS



Select this option to set this QuickTime movie to automatically begin playing when loaded in the browser.



Adjust the initial volume setting for this QuickTime movie. You can enter a number from 0 to 256.



Adjust the initial volume setting for this QuickTime movie. You can enter a number from 0 to 256.



Select this option to store the QuickTime movie in the cache on the site visitor’s system. If the visitor leaves the page and comes 
back, the movie will be available from the browser’s cache, and won’t need to be downloaded again.



When this option is selected, the Shockwave Flash movie is replayed each time it ends.



Select this option to play the Shockwave Flash movie automatically when the site visitor opens the page. 



Specify the Shockwave Flash movie’s alignment within the frame, Left, Right, or Top.



Specify the Shockwave Flash movie’s alignment within the frame, Left, Right, or Top.



Select a scale setting for this Shockwave Flash movie from the drop-down list. ShowAll displays the movie within the frame but 
maintains the image proportions. NoBorder fits the movie within the frame so it fills the frame but maintains the ratio of the 
animation. Some edges of the animation might be trimmed. ExactFit displays the movie exactly within the frame.



Select a scale setting for this Shockwave Flash movie from the drop-down list. ShowAll displays the movie within the frame but 
maintains the image proportions. NoBorder fits the movie within the frame so it fills the frame but maintains the ratio of the 
animation. Some edges of the animation might be trimmed. ExactFit displays the movie exactly within the frame.



Select a quality type for this Shockwave Flash movie from the drop-down list. AutoLow sets the default to normal quality. The host 
computer uses high quality if it has the capacity. AutoHigh starts the movie in high quality. The host computer uses low quality if it 
cannot display the movie in high quality. High anti-aliases the movie on any computer. Low uses a normal quality so the movie 
displays quickly.



Select a quality type for this Shockwave Flash movie from the drop-down list. AutoLow sets the default to normal quality. The host 
computer uses high quality if it has the capacity. AutoHigh starts the movie in high quality. The host computer uses low quality if it 
cannot display the movie in high quality. High anti-aliases the movie on any computer. Low uses a normal quality so the movie 
displays quickly.



Click here to open the Java Applet Files dialog, where you can add or delete .class files used by this Java applet or servlet.    When 
a .class file is placed with the Java tool (or dragged on a page) NetObjects detects which .class files are used by the chosen .class 
file.



This list shows all the .class files that NetObjects Fusion detects in the chosen .class file.



Select a smart link type. Smart links are internally managed links to structurally related pages (except for the special Blank link 
type). Smart link types include Home, Up, Down, Next Stacked Page, Previous Stacked Page, Next page and Previous Page. These
links will automatically update as your SiteStructure changes. Select a Blank link to create an empty link (in HTML, <A 
HREF="javascript:void(0)">) which lets you adds script or actions to the link.    When adding a Blank link to a text selection, the 
Actions button is available from the Link dialog.



Opens the Actions dialog where you can add, enable and reorder dynamic actions for the selected text link.    To add actions or 
scripts to the selected text without adding a working link, select a Blank link from the Smart Link tab.    This creates an empty link (in 
HTML, <A HREF="javascript:void(0)">) which lets you manually script or add actions to text selections.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the top of the object to the top of the text.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the center of the object to the bottom of the text.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to wrap text on both sides 
around the object, aligning the bottom of the object to the bottom of the text.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the left. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the center. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the right. 
Text falls to the next available line and is not wrapped around the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the left, 
wrapping text to the right of the object.



Choose an alignment and wrap option for the selected object in a text selection.    Select this option to align the object to the right, 
wrapping text to the left of the object.



Displays the current line color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
selected line.



Displays the current line color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
selected line.



Displays the current line color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
selected line.



Displays the current line tail color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line's tail. 



Displays the current line tail color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line's tail. 



Displays the current line tail color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line's tail. 



Displays the current line head color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line head.



Displays the current line head color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line head.



Displays the current line head color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line head.



Displays the current line head color. Click the Color button to open the Color Picker dialog, where you can select a new color for the 
line head.






